


 

 

 

 

 

 

常用工具软件大全 



 

内 容 简 介 

 

 

本书将当前最流行的面向个人电脑用户的工具软件进行了详细的分类，包括文件压缩、备份工具、软件卸

载、文件管理、系统维护等十三个类别，基本上涵盖了电脑使用的各个方面。现在由于网络上共享软件的发展，

各类新软件层出不穷，书中对各类软件进行了精选，所选入的均为目前最流行、最常用的，而且被各大软件下

载站点评为五星级的工具软件。本书介绍的软件均以目前的最新版本为准，并从实用功能角度出发，全面讲解

各个软件的使用方法。 

为了方便读者的学习和使用，本书配套的光盘中包括了本书所讲述的绝大部分的工具软件，非常实用。 

本书适合初、中级电脑用户和广大电脑爱好者使用，对于高级用户也有一定的参考价值。 



前     言 

 

 

随着个人电脑的普及，越来越多的个人和家庭购买了计算机。对于一个电脑的普通用户，如果能够熟练地

掌握和使用一些常用的工具软件，对计算机进行日常的管理和维护，既可以机器整体的性能，减少日常应用时

故障的发生，同时也大大方便了对电脑的学习和使用。 

我们在使用电脑的过程中，经常会发生各种各样的问题。例如当我们在Windows下工作时，如果同时打开

的窗口和应用程序过多，很容易出现系统的蓝屏，导致我们还没有来得及保存的工作成果付之流水。但如果我

们安装了一个防死机程序，例如 Norton CrashGuard，它就会抢在系统蓝屏之前给我们一个保存工作成果的机会，

而且也有可能解除系统的崩溃和死锁。 

以前曾经有一个朋友找到编者，说他的计算机 CPU是 Celeron433，可是在 Windows 下用起来和 486差不

多，而且经常死机。编者打开他的机箱一看，原来 CPU风扇早已停转了，恰好他的主板有 CPU温度过高自动

降速的功能，否则 CPU早给烧毁了。后来编者建议他买了一个可以测速的风扇（三线接口），并安装了一个系

统监测软件（如本书介绍的 MBM4 和 MBProbe），可以监测 CPU 的温度和风扇的转速，这样就不会再发生这

样的情况了。以上说明了在日常电脑使用中各种工具软件的重要性，可以说学会使用各种电脑工具软件是成为

一个电脑高手的必由之路。 

全书共分为 13章，分别介绍了文件压缩、备份工具、软件卸载、文件管理、系统维护、硬件管理、系统测

试、离线浏览、电子邮件等十三个方面的软件，基本上涵盖了日常电脑应用的各个方面。 

在每一章中，编者结合平时使用的经验和各大软件下载网站的评价，精选出了目前最流行、最具代表性的

工具软件进行介绍。书中并没有只是简单地罗列各个软件菜单、命令按钮的含义和使用，而是将各个软件的功

能提炼出来，以实例的形式向读者介绍，这样用户既可以简单上手，又能对整个软件有一个整体的把握。当然

由于篇幅所限，书中各个软件只是介绍了其主要功能和使用经验，有些细微之处还需读者在使用过程中去体会

和把握。 

本书为了方便读者，在配套的光盘中收录了书中介绍的绝大部分软件，用户可以直接安装使用，免去了四

处奔波查找之苦。光盘中还附赠了网上的其他一些免费资源，用户一定会有惊喜的发现。 

本书对于初、中级电脑用户来说，是非常理想的进阶读物，对于高级用户也有一定的参考价值。 

 

 

              编  者 
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在 Windows 系统下，目前最常用的压缩格式就是

ZIP、RAR 和 ACE，本章收集了对应的三个优秀的压缩

工具，即WinZip、WinRAR和WinACE，还有一个非常

有特色的 ZipMagic 2000。 

由于 Internet的发展，ZIP已经成为互联网上事实上

的压缩标准。WinZip在所有的 ZIP压缩工具中居于领袖

地位，目前版本已经发展到了最新的 8.0。ZipMagic 2000

也是一个非常优秀的 ZIP 压缩工具，它的最大特点是提

供了 Zip Folder功能，用户可以在Windows环境下象使

用普通的文件夹一样使用 Zip压缩包中的任何文件。 

WinRAR 的特点是 RAR 格式的压缩比较高，

WinACE 的特点是压缩和解压缩的速度非常快。鉴于目

前 ZIP格式的广泛流行，WinRAR和WinACE均支持 ZIP

格式的压缩和解压缩。 

 

 

第一章  文件压缩 

 

＝＝ 本章导读 ＝＝ 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

1.1  WinZip 

 

  

 

 

 

 

 WinZip是 Nico Mak Computer公司的产品，是目前非常著名的Windows 95下的 ZIP压缩文件管理器。

它支持多种压缩文档格式，而且可以和外部程序配合使用以支持更多的压缩格式。WinZip与Windows 95/98/NT

高度整合，全面支持Windows 95的 Drag & Drop技术，无需离开资源管理器即可完成文件的压缩与扩展。WinZip

内建支持最流行的 Internet文件格式，如 TAR、gzip、Unix compress、UUEncode、Xxencode、BinHex和MIME

等，安装相应的外部程序后，WinZip也可以支持 ARJ、LZH和 ARC压缩文件，使用WinZip可以访问几乎所

版本 8.0 
类别 共享软件 
主页 http://www.winzip.com/ 
功能 数据压缩、压缩包管理 
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有的从 Internet下载的文件格式。 

1.1.1  创建压缩包 

用 winzip创建一个 zip压缩包，具体步骤如下： 

 启动Winzip，界面如图 1-1。 

 

图 1-1  Winzip主界面 

 单击菜单条中的 New按钮，程序给出 New Archive对话框，如图 1-2。在其中设置压缩包的路径和

文件名，如果只希望创建一个空白压缩包，则可以取消左下角 Add Dialog选择框。单击 OK确定。 

 

图 1-2  New Archive对话框 

 如果上一步中选上了 Add Dialog选择框，则程序弹出 Add对话框，如图 1-3。在上边的文件列表框

中选择需要压缩的文件或文件夹。如果压缩的对象中包含子目录，可选中 Include subfolders 复选框。如果希望

保留被压缩对象的路径，可选中 Save full path info复选框。在 Compression下拉列表框中可以设置压缩比。如果

需要设置解压缩校验口令，可单击 Password按钮，在弹出的相应的对话框中输入口令即可。 
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图 1-3  Add对话框 

 设置完毕，单击 Add with wildcards按钮，程序开始压缩操作。 

如果要向一个已经存在的压缩包中添加文件，可单击程序界面的工具栏中的 Open 按钮，弹出一个 Open 

Archive 对话框，如图 1-4。在文件列表框中选择相应的压缩包文件，单击“打开”。然后单击工具栏中的 Add

按钮，程序会给出和图 1-3相同的 Add对话框，在其中选择需要加入的文件即可。 

 

图 1-4  Open Archive对话框 

如果想要删除压缩包中的文件，可先打开该压缩包，然后在WinZip主界面的文件窗口中选择想要删除的文

件，单击右键在关联的浮动菜单中选择 Delete命令或直接按下键盘的 Delete键即可。 

以上是使用 WinZip主界面进行文件压缩的通用方法，由于WinZip与Windows 95/98高度整合，我们可以

在系统资源管理器中直接完成文件的压缩。有如下两种方法： 

第一种方法是在系统的资源管理器中，选择需要压缩的文件或文件夹，例如选择文件夹“C:\PCS”，在该文

件夹图标上方单击鼠标右键弹出快捷菜单，如图 1-5所示。单击 Add to Zip命令，程序会弹出和图 1-3相同的

Add对话框，根据需要进行设置即可。如果单击 Add to Pcs.zip命令，则程序自动在当前路径下创建一个名为

“Pcs.zip”的压缩包。 
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图 1-5 鼠标右键关联菜单 

第二种方法是首先启动 WinZip 的界面，程序自动创建一个空白压缩包，然后打开资源管理器，是两者在

屏幕上均可见，在资源管理器中选择需要进行压缩的文件或文件夹，并按住鼠标左键将其图标拖至 WinZip 的

窗口中，此时程序会给出一个和图 1-3稍有不同的 Add对话框，如图 1-6，单击 Add按钮即可。 

如果要向一个已经存在的压缩包中添加文件，可先打开该压缩包，剩下的步骤和上面相仿。更简单的办法

是在系统的资源管理器中分别找到需进行压缩的文件/文件夹和压缩包的位置，并使两者的图标同时可见（可以

打开两个资源管理器窗口），然后拖曳需压缩对象的图标到相应压缩包文件的图标上，添加过程就完成了。 

 

图 1-6  Add对话框 

1.1.2  扩展压缩包 

扩展整个压缩包，步骤如下： 

启动 WinZip，单击工具栏内的 Open 按钮，打开需要扩展的压缩包，或直接在资源管理器内双击该压缩包

的图标也可以。然后单击工具栏内的 Extract按钮，程序给出如图 1-7所示的 Extract对话框。选择扩展文件的目

的路径，然后单击界面中的 Extract按钮即可。 
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图 1-7  Extract对话框 

还可以在系统资源管理器内直接扩展，首先在系统资源管理器内用鼠标右键单击需要扩展的压缩包，系统

弹出右键关联菜单，如图 1-8所示，其中提供了两个与文件扩展有关的命令，如果选择 Extract to …命令，会弹

出 Extract对话框，这与图 1-7相同，在其中设置扩展路径，然后单击 Extract按钮即可实现文件解压缩。如果选

择 Extract to folder …命令，程序会自动在当前路径下创建一个与压缩包文件同名的文件夹，并扩展全部文件到其

中。 

 

图 1-8  鼠标右键关联菜单 

扩展压缩包中的部分文件，步骤如下：   

首先打开需要扩展文件的压缩包，然后在界面窗口中选择需要扩展的文件，使用鼠标右键单击所选择的对

象，从关联菜单中选择 Extract命令，如图 1-9，或直接单击工具栏内的 Extract按钮，程序会给出和图 1-7一样

的 Extract对话框。选择扩展文件的目的路径，然后单击界面中的 Extract即可。 

 
图 1-9  右键关联菜单示意图 

1.1.3  对压缩包的管理 

WinZip提供了对压缩包的管理功能，其中包括压缩包的移动、复制、删除、换名等几个相关操作。首先在

主界面中打开需要进行操作的压缩包文件。 
l 删除压缩包：选择菜单 File → Delete Archive，在给出的删除确认对话框中单击 Yes即可。 
l 重命名压缩包：选择菜单 File → Rename Archive，在给出的对话框中键入新的压缩包文件名即可。 
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l 复制压缩包：选择菜单 File → Copy Archive，在给出的对话框中选择相应的目的路径然后单击 OK即
可。单击对话框中的 New按钮，可以进行新的文件夹的创建。 

l 移动压缩包：选择菜单 File → Move Archive，在给出的对话框中选择相应的目的路径然后单击 OK即
可。 

1.1.4  创建分卷压缩 

使用WinZip创建分卷压缩文件，其操作只能在软盘驱动器中进行。步骤如下： 

 在程序界面上单击工具栏中的 New按钮，程序给出如图 1-10的 New Archive对话框。 

 

图 1-10  New Archive对话框 

 将软盘插入相应的驱动器中，在“文件名”文本框中输入路径和压缩文件名（必须在软盘上，如“a：

\temp.zip”）。 

 单击 OK按钮，程序弹出 Add对话框，如图 1-11，选择需要加入的文件，这里值得注意的是Multiple 

Disk Spanning下拉列表框，它一共提供了三个分卷压缩的选项，其中缺省选项为 Automatic。 
l Automatic：自动检测软盘可用空间。 
l Automatic+wipe Afirst disk prompt：自动检测软盘可用空间，但在压缩时，首先给出提示信息，询问用

户是否删除软盘中已有的数据。 
l No spanning：不进行分卷文件创建，只向软盘中压缩数据。 

 
图 1-11  Add对话框 

 单击 Add with wildcard按钮，程序开始进行数据压缩操作，当第一张软盘满时，WinZip会给出提示

对话框，需要用户换盘，然后单击“OK”确定，如此直至完成。如果在上一步分卷方式选择的是 Automatic+wipe 

first disk prompt，程序会给出如图 1-12所示的对话框，Do not delete any files before creating the new Zip file表示

不删除软盘中已有数据进行压缩，Delete all files on the disk before creating the new Zip file表示先删除软盘中数

据，然后进行压缩。 
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图 1-12  Winzip分卷压缩提示对话框 

1.1.5  创建自扩展压缩文件 

使用WinZip创建自扩展压缩文件，步骤如下： 

 打开一个 Zip压缩文件，单击程序菜单条中的 Actions → Make .exe File命令，或直接在资源管理器

内右键单击该压缩文件，在弹出的关联菜单中选择 Create Self-Extractor（.exe），程序给出WinZip Self-Extractor 

Personal Edition对话框。如图 1-13。 

 

图 1-13  Winzip自解压对话框 

 在“Default‘Unzip To’folder”中设置自扩展文件的默认输出路径，如果空白，程序默认为系统的

temp 环境。在 Spanning Support 项中提供了分卷自扩展文件的设置，No spanning 表示不创建分卷文件、Safe 

spanning method表示使用安全拆分方式拆分文件、Old spanning method表示使用传统方式拆分文件。界面最下

方的 Overwrite by default表示当目标路径下有与扩展压缩包中的文件同名的文件时，自动覆盖文件。 

对于创建分卷自扩展压缩文件，程序提供的安全模式表示在进行拆分文件时，在第一张软盘上除了创建一

个 zip文件以外，还额外创建一个用于扩展的.EXE文件，运行它即可以进行压缩包的扩展。即使没有这个.EXE

文件，我们仍然可以扩展这个压缩包。而使用传统方式拆分文件时，在第一张软盘上创建的是.EXE可执行文件，

其中包含了文件扩展信息和压缩数据。 

 单击 OK，程序开始转换，结束后，程序会询问是否测试.EXE，单击 Yes 确定，程序弹出对话框如

图 1-14所示，在 Unzip to folder文本框中设置扩展路径，然后单击 Unzip即可。 

 

图 1-14  Winzip自解压文件测试对话框 
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1.1.6  压缩包的软件安装/校验 

WinZip提供了压缩包的软件安装功能，如果压缩包中含有安装文件，如 Setup.exe、Install.exe等，打开该

压缩包后，程序界面的菜单栏最右边会多出一项 Install按钮。单击它，或单击菜单 Actions → Install …，程序

会弹出如图 1-15的 Install对话框，Minimize during install表示当软件安装时，WinZip界面最小化。单击 OK，

软件开始安装。安装结束后，程序给出一个对话框，通知用户安装过程结束，按下 OK 后回到 WinZip 程序界

面。 

WinZip还提供了对压缩包的校验功能，程序不仅将压缩包内的所有文件进行扩展，而且可为压缩包创建一

个程序组，我们可以直接检查运行压缩包内的应用程序。如果压缩包中不含有安装文件，打开该压缩包后，程

序界面的菜单栏最右边一项变成 CheckOut按钮。单击它，或单击菜单 Actions → CheckOut，程序会弹出如图

1-16的 CheckOut对话框 

    

图 1-15  Install对话框                     图 1-16  CheckOut对话框 

在 Folder文本框中键入扩展文件的目标路径，在 Group Name文本框中键入将创建的程序组名。单击 OK，

程序开始扩展压缩包，并为其创建一个如图 1-17所示的程序组。 

当要退出WinZip时，程序会弹出如图 1-18所示的对话框，如果想删除刚才创建的程序组和相应的扩展文

件，单击 Yes。 

 

 

图 1-17  CheckOut 建立的程序组 

 
图 1-18 CheckOut对话框 

1.1.7  运行环境设置 

下面介绍一下 WinZip一些重要的选项。单击菜单 Options → Configuration …，程序弹出如图 1-19所示设

置对话框。 
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图 1-19  Configuration设置对话框 

其中包括六个标签： 

l View：其中比较重要的是 Column项，可以选择文件的显示选项：包括Modified（更新日期）、Size（大

小）、Radio（压缩率）、Packed（压缩后）、Path（路径）等。 

l Toolbar：选择工具栏的显示方式。Use Explorer-style toolbar buttons选择是否使用资源管理器风格工具

栏按钮，Use large toolbar buttons 选择是否使用大工具栏按钮，Show button text 选择是否显示按钮文字，Show 

tool tips 选择是否显示工具提示，Use flat toolbar buttons选择是否使用平面工具栏按钮，Use high color toolbar 

buttons when possible选择是否尽量使用高彩色工具栏按钮。 

l Folders：其中提供了程序在启动时可自动打开的默认文件夹 Start-up folder、程序扩展压缩包时使用的

文件夹 Extract folder、添加文件时使用的文件夹 Add folder、程序默认工作夹 Working folder、使用 CheckOut

功能时使用的文件夹 CheckOut base folder、临时工作文件夹 Temp folder。 

l System：选中复选框 Associate WinZip with archives，单击 Associations按钮可以设置程序可支持的压缩

包类型与WinZip的关联。Include WinZip in the Startup menu表示在系统的开始菜单中添加程序快捷图标。Include 

WinZip on the desktop表示在桌面上添加程序快捷图标、在 Show Add dialog when dropping files on项中，可以设

定当拖放文件到资源管理器中的压缩文件或打开的WinZip文件窗口时，是否显示 Add对话框。 

l Program Location：其中提供了应用程序定位设置，包括：文件观察器 Viewer、自扩展文件创建工具

Make exe、病毒检测工具 Scan program及运行参数 Parameters、程序可支持的压缩包（Arj、Lha、Arc）的产生

工具的位置。 

l Miscellaneous（杂项）：在 Start-up项中，Next time start with the Wizard interface表示下次启动时采用向

导界面，Automatically show the Open Archive dialog box表示Winzip启动时自动打开 Open Archive对话框。Other

项中的设置一般缺省即可。 

1.2  WinRAR 

 

 

 

 

 

 WinRAR for Windows 95是 Eugene Roshal推出的一款优秀的压缩工具。该工具压缩数据时有很高的压

缩比，特别是压缩可执行文件和大型文件时优势更加明显。WinRAR 支持 ZIP、ARJ、LHZ 等其他压缩格式，

并可以将上述格式文件转换成 RAR 格式的压缩包。WinRAR 还提供了创建多卷压缩、创建自解压文件、修复

受损文件、加密文件等功能。 

版本 2.71 
类别 共享软件 
主页 http://www.rarsoft.com/ 
功能 数据压缩、压缩包管理 
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1.2.1  创建压缩包 

 启动程序，其界面如图 1-20所示。从界面中的系统文件列表窗口中选择需要压缩的文件或文件夹。 
 单击 Add按钮，程序给出如图 1-21所示的压缩包参数设置对话框。在 Archive文本框中设置欲创建

的压缩包名称。在 Archive format 项中设置压缩包格式，有 RAR和 ZIP两种选择。在 Compression method项中

设置压缩比。如果要创建分卷压缩文件，可在 Volume size下拉文本框中选择，Create SFX archive复选框可以

创建分卷压缩文件，Create solid archive表示采用紧固模式压缩。Use Multimedia compression表示使用多媒体压

缩。 

 

图 1-20  WinRAR主界面 

 

图 1-21  压缩包参数设置对话框 

 设置完毕单击 OK 确定，程序开始压缩，同时给出如图 1-22 所示的进程对话框。其中有一个

Background按钮，单击它可以将当前的压缩工作调到系统后台运行。 

 

图 1-22  压缩进程对话框 

在图 1-21所示的压缩包参数设置对话框中，如果需要创建分卷压缩，在 Volume size下拉文本框中选择需

创建的分卷文件的大小，程序提供了 1.44M 标准软盘格式，如果选择 Autodetect，可以让程序自动检测软盘空
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间，然后进行文件分割。我们还可以在文本框中自行定义分卷大小，直接在文本框中输入数值即可，单位是 bytes。

WinRAR支持在硬盘上建立分卷压缩文件。 

如果需要创建自扩展压缩，选择 Create SFX archive复选框，WinRAR生成.EXE结尾的自扩展压缩文件。

需要解压缩时，双击该文件图标，弹出如图 1-23 所示对话框，在文本框键入扩展路径，然后单击 Extract 按钮

即可。 

 

图 1-23  WinRAR自解压文件扩展界面 

安装WinRAR以后，程序会在自动在系统鼠标右键菜单中添加自己的命令项，我们可以在系统资源管理器

中直接完成文件的压缩。首先在系统资源管理器中选择需要压缩的文件或文件夹，然后用鼠标单击所选择的对

象，弹出快捷菜单，如图 1-24所示。单击WinRAR → Add to archive命令，程序会弹出和图 1-21相同的对话

框，根据需要进行设置即可。如果选择WinRAR → Add to“xxx.rar”,则程序自动在当前路径下创建一个名为

xxx.rar的压缩包。 

 

1-24  WinRAR系统右键快捷菜单 

如果要向一个已经存在的压缩包中添加文件，首先在WinRAR的系统文件列表框中选择需要添加的文件，

然后单击程序界面的工具栏中的 Add按钮，弹出和图 1-21相同的对话框，在 Archive文本框中填入相应压缩包

的名字，或单击 Browse按钮在弹出的文件列表框中选择相应的压缩包，然后单击“确定”即可。 

对于向压缩包中添加文件，更简单的方法是系统的资源管理器中分别找到需进行压缩的文件/文件夹和压缩

包的位置，并使两者的图标同时可见（可以打开两个资源管理器窗口），然后拖曳需压缩对象的图标到相应的压

缩包文件图标上，添加过程就完成了。 

如果想要删除压缩包中的文件，可在 WinRAR 的系统文件列表窗口中双击该压缩包，进入该压缩包内，

（WinRAR系统文件列表窗口把压缩包文件当作文件目录一样），程序界面稍有变化，如图 1-25所示。然后在该

压缩包的文件列表窗口中选择想要删除的文件，直接按 Delete键即可。 
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图 1-25  进入压缩包内时WinRAR主界面 

1.2.2  扩展压缩包 

启动WinRAR，在系统文件列表窗口中用鼠标双击需进行扩展的压缩包，或直接在系统资源管理器中用鼠

标双击需进行扩展的压缩包文件图标，进入该压缩包内。单击程序界面工具栏内的 Extract按钮，程序自动将压

缩包扩展到当前路径下（压缩包所在路径）。单击 Extract to按钮，程序弹出如图 1-26所示的 Extraction path and 

Options对话框，在其中的 Destination path文本框中设置文件扩展的目的路径，或在界面右边的系统文件列表窗

口选择文件扩展路径，在 Overwrite mode中设置文件覆盖操作方式，然后单击 OK即可。 

 

图 1-26  扩展路径和设置对话框 

如果希望扩展压缩包内的部分文件而不是全部文件，打开该压缩包后，在该压缩包的文件列表窗口中选择

需要进行扩展的文件或文件夹（使用 Ctrl或 Shift键配合鼠标左键选择多个对象），接下来的步骤同前面相同。 

与建立压缩包一样，我们还可以利用系统鼠标右键菜单对压缩包进行扩展。在系统资源浏览器窗口中，使

用鼠标右键单击需扩展的压缩包文件，弹出如图 1-27 所示的右键菜单。单击菜单命令 WinRAR → Extract 

files …，弹出和图 1-26相同的 Extraction path and Options对话框，选择压缩路径后，单击 OK即可。单击菜单

命令WinRAR → Extract to xxx\，程序在当前路径下创建与压缩包名字相同的文件夹，然后将压缩包扩展到该

路径下。 
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图 1-27  系统鼠标右键关联菜单 

1.2.3  WinRAR的其他功能 

1．修复压缩包 

WinRAR可以修复被损坏的压缩包文件。首先打开 WinRAR，在系统文件列表窗口内用鼠标左键选择欲修

复的压缩包文件，然后单击工具栏内的 Repair按钮，或单击菜单命令 Commands → Repair archive，程序弹出

如图 1-28所示对话框，修复结束后，WinRAR还会自动生成一个名为_reconst.rar的修复备份压缩包。 

 

图 1-28  修复压缩包对话框 

2．添加注释 

打开欲添加注释的压缩包，然后单击工具栏内的 Comment按钮或选择菜单命令 Commands → Add archive 

comments，程序弹出如图 1-29所示对话框。 

 

图 1-29  添加注释对话框 

在文本框中加入注释，单击 OK，压缩包注释如图 1-30所示。 
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图 1-30  压缩包的注释显示 

3．测试压缩包 

当我们创建一个压缩包后，可以测试一下该压缩包的完整性，即 CRC校验。首先打开想要测试的压缩包，

单击界面工具栏内的 Test按钮后，程序就开始自动测试，然后给出测试结果。 

4．保护和锁定压缩包 

WinRAR提供了压缩包保护和锁定的功能。保护功能可在最大限度上防止压缩包在使用和保存过程中受到

损伤，这项功能的原理实际上是在压缩包内加强文件的 CRC校验，以使当部分压缩文件受到损伤时，可以最大

限度使用程序提供的数据校验功能进行恢复。如果需要保护压缩包，打开该压缩包后，单击工具栏内的 Protect

按钮，或单击菜单命令 Commands → Protect archive from damage。 

如果需要锁定一个压缩包，打开该压缩包后，单击工具栏内的 Lock按钮，或选择菜单 Commands → Lock 

archive。锁定一个压缩包以后，将不能再向其中添加文件，也不能删除或编辑其中的文件。而且一个压缩包一

旦被锁定后，就不能被取消。 

1.2.4  运行环境设定 

WinRAR的使用比较简单，运行环境参数大多使用默认设置。下面介绍常用的设置。 

启动WinRAR，单击菜单 Options → Setting…，设置界面如图 1-31所示， 

 
图 1-31  WinRAR运行环境设置界面 

l General Toobar项中，Large buttons表示工具栏内的按钮以大图标显示，Show buttons text表示显

示按钮名称。 

l Paths：Folder for temporary files可以设置临时文件的放置目录。 

l Integration：Associate WinRAR with从中选择和WinRAR关联的文件类型。在 Interface项中，选择是

否在桌面或系统开始菜单中建立快捷方式，是否为WinRAR建立程序组。Shell Integration项中，Integrate 

WinRAR to shell选择是否将WinRAR整合到系统资源管理器中，Cascaded context menus选择是否在

鼠标右键菜单中显示折叠菜单。Icons in context menus选择在右键关联菜单中是否显示图标。 
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l Viewer：On Enter run是当双击或回车时，选择打开文档的程序：内置查看器、外部查看器、关联程序。

External viewer name选择外部查看器。 

l File List：List type选择文件列表类型设置：List view表示列表查看，Details表示详细资料查看。Selection

表示选择方式，可以选择单击或者双击来打开一个项目。 

1.3  ZipMagic 2000 
 

 

 

 

 

 ZipMagic是由Mijenix公司推出的一款老牌的优秀的文档压缩管理工具。ZipMagic最大的特点是为我

们带来了全新概念上的压缩文件管理功能 Zip Folder，这项功能是将把所有的 Zip文件视为普通的文件夹，用

户可以在 Windows 环境下象使用普通的文件夹一样使用 Zip 压缩包中的任何文件。程序还提供了压缩格式转

换、创建自扩展文件、修复压缩包等功能。新版本的 ZipMagic 2000全新设计了界面的风格，并提供了许多新

的功能，包括一整套基于 Internent用户的辅助功能，如 E-mail附件管理、压缩文件下载管理等，使用非常方便。 

1.3.1  软件的安装 

ZipMagic2000 的安装方式比较简单，运行安装文件后，连续单击安装界面中的 Next 按钮即可完成。在安

装过程中，程序会给出如图 1-32所示的界面，其中提供了三个设置项目，可根据自己的需要进行设置。然后程

序会给出 ZipMagic Plug-Ins 设置界面，Install E-mail Plug-Ins 表示提供 E-mail 附件管理功能，Enable 

DownloadMagic表示提供压缩文件下载管理功能。安装结束后，安照程序要求重新启动Windows即可。 

 

图 1-32  程序安装设置界面 

1.3.2  使用 Zip Folder功能 

Zip Folder是 ZipMagic最具代表性的功能。该项功能驻留系统后，Windows把压缩包视为普通文件夹，这

样就可以直接在资源管理器中打开压缩包，而不需要进行解压缩过程。 

ZipMagic驻留系统后，会在系统任务栏内显示一个带有 Zip标志 Tray图标  ，使用右键单击该图标，

弹出关联菜单如图 1-33所示，Show Zip Folders表示启动 Zip Folder功能，Hide Tray Icon表示隐藏系统任务栏

的图标，ZipMagic 2000表示启动 ZipMagic主程序，单击 Properties命令可以弹出程序运行环境设置界面。 

Windows 会将所有的压缩包视为普通文件夹，原来的 zip 压缩包文件的图标变成了  。如果需要浏览

压缩包中的文件，直接打开相应的 Zip Folder即可。在 Zip Folder浏览窗口中，可以运行其中的文件，也可以进

行编辑、移动、删除、复制、重命名等操作。 

版本 3.0 
类别 共享软件 
主页 http://www.mijenix.com/ 
功能 数据压缩、压缩包管理 
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此外，在系统资源浏览器窗口标题栏的右上角，多出一个 Zip按钮，单击后会出现如图 1-34所示的菜单。

Disable ZipMagic表示在当前窗口中禁止 ZipFolder功能，Show Zip Files …表示在当前窗口中使用 ZipFolder功

能，单击 ZipMagic Properties可以弹出 ZipFolder运行环境设置界面。 

         

图 1-33  Tray图标的右键关联菜单             图 1-34  Zip按钮菜单 

1.3.3  创建压缩包 

用 ZipMagic创建一个 zip压缩包，具体步骤如下： 

 启动 ZipMagic 2000，程序界面如图 1-35所示。 

 
图 1-35  ZipMagic主界面 

 单击工具栏中的 New按钮，程序弹出对话框如图 1-36所示，在“文件名”文本框中输入新建的压

缩包文件名。如果想创建分卷压缩包，输入文件名时加上软盘盘符，如“a：\pcs.zip”。程序会自动拆分文件，

ZipMagic不支持在硬盘中创建分卷压缩文件。 

 

图 1-36  新建压缩包对话框 

 单击 OK，程序弹出 Add to file对话框，如图 1-37，在界面上边的文件列表框中选择需要压缩的文

件，如果要压缩一个目录，进入该目录内，并在“文件名”文本框内输入“*.*”，Paths项中提供了压缩文件路

径保存方式，在 Compression项中提供了压缩比设置，Include Subfolders表示压缩时包含子目录，在 Password

文本框内可以设置压缩口令。 
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图 1-37  添加文件对话框 

 单击 OK，程序开始压缩，完成后回到主界面。 

安装 ZipMagic以后，程序会在自动在系统鼠标右键菜单中添加自己的命令项，我们可以在系统资源管理器

中直接完成文件的压缩。首先在系统资源管理器中选择需要压缩的文件或文件夹，然后用鼠标单击所选择的对

象，弹出快捷菜单，如图 1-38所示。 

 

图 1-38  系统右键关联菜单 

单击其中的 Zip …命令，程序会弹出如图 1-39所示的对话框，在 Destination Zip archive中设置压速路径和

压缩包文件名，如果需要设置压缩比等其他选项，可以单击 Option按钮。设置完毕，单击 OK即可。 

 

图 1-39  创建压缩包对话框 

如果要向一个已经存在的压缩包中添加文件，首先在 ZipMagic的主界面上单击工具栏中的 Open按钮，在

弹出的对话框中选择相应的压缩包，单击“打开”后回到主界面，然后单击 Add 按钮，程序弹出和图 1-37 相

同的对话框，在文件列表框中选择需要添加的文件，然后单击 OK即可。 

对于向压缩包中添加文件，更简单的方法是系统的资源管理器中，把需添加的文件像拷贝到普通目录一样

拷贝到相应的 Zip Folder即可。 

如果想删除压缩包中的文件，可在主界面中打开该压缩包后，在文件列表窗口中选择要删除的文件，按Delete

键即可。也可以在系统资源管理器的 Zip Folder中删除该文件。 

1.3.4  创建自扩展压缩包 

1．将 Zip文件转换为 EXE自扩展文件 
 首先在 ZipMagic 主界面中打开需要转换的压缩包文件，然后选择菜单 Actions → Advanced → 

Convert EXE …，程序给出界面如图 1-40。单击 Navigate按钮可以重新选择压缩包文件，否则直接单击 Next。 
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图 1-40  ZipConvert界面之一 

 程序给出界面如图 1-41所示，在其中设置新建 EXE文件的保存路径和文件名。 

 

图 1-41  ZipConvert界面之二 

 如果需要设置生成的自扩展压缩包文件的属性，可单击 Properties按钮，程序会给出如图 1-42所示

的界面，type项中可以设置生成的 EXE文件的类型，Title可以设置压缩包扩展标题信息，Folder可以设置压缩

包默认扩展路径。设置完毕，单击 OK 

 

图 1-42  ZipConvert界面之三 

 单击 Next，程序开始创建 EXE自扩展文件，完成后给出如图 1-43所示的信息，单击 Done结束。 
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图 1-43  ZipConvert界面之四 

还可以在系统资源管理器中直接进行转换，首先选择需要进行转换的压缩包文件，单击鼠标右键，在弹出

的关联菜单中选择 ZipMagic → Convert Zip to Self-Extracting EXE …，程序弹出如图 1-40所示的界面，接下来

的步骤和前面相同，不再赘述。 

2．创建 EXE自扩展压缩包 
ZipMagic 还提供了直接创建 EXE 自扩展压缩包功能，首先在系统资源管理器中选择想要压缩的文件或文

件夹，然后单击鼠标右键，在弹出的关联菜单中选择 ZipMagic →  Create New Self-Extracting EXE …，程序弹

出如图 1-40所示的界面，接下来的步骤和前面相同，不再赘述。 

1.3.5  扩展压缩包 

 启动 ZipMagic，单击 Open按钮，打开欲扩展的压缩包。 

 单击工具栏中的 Extract按钮，程序给出如图 1-44所示的 Extract对话框，在 Extract to文本框中设

置扩展路径，在 Extract What中设置文件扩展对象，如果需要扩展整个压缩包，可选择 All files in archive复选

框，如果只是扩展所选择的一个或几个文件，可选择 Selected files复选框。 

 

图 1-44  Extract对话框 

 单击 Extract，程序开始扩展压缩包。 

与建立压缩包一样，我们还可以利用系统鼠标右键菜单对压缩包进行扩展。在资源浏览器窗口中，使用鼠

标右键单击需扩展的压缩包文件，在弹出的关联菜单中选择 ZipMagic → Extract …，弹出和图 1-3-44 相同的

Extract对话框，选择压缩路径后，单击 Extract即可。选择 Extract to folder x：\xxx，程序自动在当前路径下创

建与压缩包名字相同的文件夹，然后将压缩包扩展到该路径下。 
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另外，如果已经使用了 ZipFolder功能，扩展压缩包其实可以直接在系统资源浏览器内将相应的 Zip Folder

文件夹中的文件复制到扩展路径下即可。如果是需要使用压缩包中的文件，根本不需要扩展压缩包，直接使用

Zip Folder文件夹即可。 

1.3.6  ZipMagic的其他功能 

1．压缩格式转换 

ZipMagic提供了将它支持的其他格式的压缩包转换成 Zip格式的功能。 

 启动 ZipMagic，单击 Open按钮，打开欲转换的压缩包（例如 RAR格式文件）。 

 选择菜单Actions → Advanced → Convert to Zip，程序弹出界面如图1-45所示。在Convert to zip file

文本框中设置转换后的 Zip文件名称，如果不再需要原始文件，将 Delete original file after the conversion复选框

选上。 

 

图 1-45  压缩格式转换对话框 

 单击 OK，程序开始转换。 

2．快速安装打包的应用程序 

如果压缩包中含有安装文件，如 Setup.exe、Install.exe等，可使用 ZipMagic的 EasySetup功能快速安装该

程序。首先使用 ZipMagic 打开相应的应用程序，然后单击工具栏中的 EzSetup 按钮，程序给出如图 1-46 所示

对话框，单击 Advanced按钮，可以设置其他选项，不过一般缺省设置即可。单击 Install按钮，程序开始安装。 

 

图 1-46  Easy Setup对话框 

3．检测和修复压缩包 

当我们创建一个压缩包后，可以测试一下该压缩包的完整性，即 CRC校验。首先用 ZipMagic打开想要测

试的压缩包，选择菜单 Action → Advanced → Test Integrity …，程序弹出如图 1-47所示的对话框，如果压缩

包设置了密码，需要在文本框中输入密码，否则直接单击 Test，程序开始自动测试，然后给出测试结果。 

如果压缩包中的数据发生错误，不能正确地解压缩还原，可以使用 ZipMagic 提供的修复功能。首先用

ZipMagic打开想要修复的压缩包，选择菜单 Action → Advanced → Repair …，程序弹出如图 1-48所示的对话

框，在 Archive 文本框中输入需要修复的压缩包名称，单击 Next，程序开始自动修复，完成单击 Done 回到主
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界面。 

 

 

图 1-47  测试压缩包对话框 

 

图 1-48  修复压缩包对话框 

1.3.7  运行环境设置 

下面简要介绍 ZipMagic常用的设置选项。 

从系统开始菜单中启动 Zip Properties，或启动 ZipMagic，选择菜单命令 View → Properties，设置界面如

图 1-49所示。 

l Properties：Show icon on the Taskbar表示在系统任务栏中显示图标，Show Zip button in title bar表示在

系统窗口标题栏上显示“Zip”按钮。Include ZipMagic Shortcut可以设置 ZipMagic快捷方式。 

l Zip Folders：设置 Zip Folders功能，即是否将压缩包文件看作文件夹。 

l Zip Window：Confirm before deleting file表示删除文件前确认，Beep after archive options表示压缩包的

操作完成后发出提示声音，Use local folder when editing a file in a archive表示当编辑压缩包的文件时使

用当前目录。 

l File Associations：设置与 ZipMagic的文件关联。 

l Context Menus：在“Menus”项中选择在系统右键菜单中出现的 ZipMagic命令。Show menus in a cascaded 

popup menu表示以级联菜单显示。 

l Anti Virus：选择反病毒程序。 
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图 1-49  ZipMagic运行环境设置界面 

1.4  WinACE 

 

 

 

 

 

 WinACE是一款支持流行的压缩格式 ACE的多功能文档压缩工具。当采用 ACE格式压缩时，WinACE

在不牺牲压缩时间的情况下可以达到很高的压缩比。WinACE还有以下功能： 

l 支持 ACE, ZIP, LHA, MS-CAB等格式的压缩，支持对 ACE, ZIP, LHA, MS-CAB, RAR, ARC, ARJ, GZIP, 

TAR, ZOO等格式文件的解压缩。支持对 ACE, ZIP, CAB格式文件的分卷压缩，支持 ACE、ZIP文件

格式的自解压。 

l 全面支持Windows 95的 Drag&Drop功能，可以直接在系统的资源管理器内进行压缩文档处理。 

l 采用“Solid”压缩算法，大大提高压缩比，尤其是在压缩很多数量的小文件时。 

l 鉴于 ZIP格式的普及率，全面充分支持 ZIP格式。 

1.4.1  WinACE界面介绍 

启动 WinACE，程序缺省界面如图 1-50 所示。左边是格外信息窗口，右边是文件列表框。我们可以利用

View菜单根据自己的需要来选择界面的显示风格。 

View菜单和界面显示有关的部分如图 1-51所示，As webpage是按照Web页的格式显示。文件列表共有四

种风格：Large Icons（大图标）、Small Icons（小图标）、List（列表）、Details（详细资料）。Extra Information表

示显示额外信息窗口，Folder view表示显示文件夹查看窗口，Quickview表示显示快速查看窗口。Toolbar可以

选择工具栏的显示内容。 

版本 1.32 
类别 共享软件 
主页 http://www.winace.com/ 
功能 数据压缩，压缩包管理 
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图 1-50  WinACE主界面 

 

图 1-51  WinACE主界面中的 View菜单 

例如文件列表可以选择 Details，取消 Extra Information不显示额外信息窗口，选择 Folder view显示文件夹

查看窗口。程序主界面变成如图 1-52所示。 

 

图 1-52  自行定制WinACE主界面 

1.4.2  创建压缩包 

用WinACE创建一个压缩包，具体步骤如下： 

 启动WinACE，在右边的系统文件列表框中选择需要压缩的文件或文件夹，单击工具栏中的 Create

按钮，程序给出界面如图 1-53 所示。首先看到的是 Selection 标签，可以在上边的文件列表框中重新选择需要

压缩的文件或文件夹，在 Archive文本框中重新填入新建的压缩包路径和文件名。 
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图 1-53  创建压缩包对话框之 Selection标签 

 切换到 Options 标签，其界面形式如图 1-54所示。在其中的 Archivetype项中选择生成的压缩包格

式，程序默认是 ACE，在 Action项中设置压缩方式，其中包括 Add（添加）、Move（移入）、Refresh（更新）。

在 Compression项中设置压缩比，在 Folder项中提供了有关文件夹的设置，其中 Include subfolders表示压缩时

包括子文件夹，Store full path表示压缩时保存压缩文件的路径结构。在 Sfx module项中提供了创建自扩展压缩

文件的设置。如果需要创建分卷压缩文件，可以在 Volumes项中选择分卷文件大小，如果需要给压缩包添加口

令设置，选择 Use password encryption复选框，然后在 Password文本框中键入口令。在 Ace-Option项中提供了

创建 ACE格式压缩文件时的设置。 

 切换到 Comment标签，可以在其中设置压缩包注释信息。 

 设置完成后，单击 Add按钮，程序开始压缩文件，完成后回到主界面。 

安装WinACE以后，程序会在自动在系统鼠标右键菜单中添加自己的命令项，我们可以在系统资源管理器

中直接完成文件的压缩。首先在系统资源管理器中选择需要压缩的文件或文件夹，然后用鼠标单击所选择的对

象，弹出快捷菜单，如图 1-55 所示，单击“添加到…”命令，程序会弹出和图 1-53 相同的对话框，根据需要

进行设置即可。如果选择“添加到‘xxx.ace’”，则程序自动在当前路径下创建一个名为“xxx.ace”的压缩包。 

 

 

图 1-54 创建压缩包对话框之 Options标签 
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图 1-55  鼠标右键快捷菜单 

如果要向一个已经存在的压缩包中添加文件，首先在WinACE的系统文件列表框中选择需要添加的文件，

然后单击程序界面的工具栏中的 Add 按钮，弹出和图 1-53 相同的对话框，在 Archive 文本框中填入相应压缩

包的名字，或单击  按钮，在弹出的文件列表框中选择相应的压缩包，然后单击“确定”即可。 

1.4.3  扩展压缩包 

启动WinACE，在系统文件列表窗口中选择需进行扩展的压缩包，单击程序界面上工具栏内的 Extract按钮，

程序弹出如图 1-56 所示的 Extract 对话框，在左边的路径选择框中选择扩展路径，或在右边的“To”文本框中

直接键入扩展路径，然后单击 OK即可。 

如果希望扩展压缩包内的部分文件而不是全部文件，打开该压缩包后，在该压缩包的文件列表窗口中选择

需要进行扩展的文件或文件夹（使用 Ctrl或 Shift键配合鼠标左键选择多个对象），接下来的步骤同前面相同。 

我们还可以利用系统鼠标右键菜单对压缩包进行扩展。在资源浏览器窗口中，使用鼠标右键单击需扩展的

压缩包文件，弹出如图 1-57所示的右键菜单，选择 Extract to …，弹出和图 1-56相同的 Extract对话框，选择压

缩路径后，单击 OK即可。选择 Extract to x：\xxx表示在当前路径下创建与压缩包名字相同的文件夹，然后将

压缩包扩展到该路径下。 

 

图 1-56  Extract对话框 

 

图 1-57  鼠标右键快捷菜单 

1.4.4  创建自扩展压缩包 

创建自扩展文件的步骤与前面创建压缩包基本相同，但程序提供了一些更多的功能，这样可以创建出具有

软件安装风格的自扩展文件。 

首先启动WinACE，在右边的系统文件列表框中选择需要压缩的文件或文件夹，单击工具栏中的 Create按

钮，程序给出界面如图 1-58所示。 
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图 1-58  创建压缩包对话框 

在 Selection 标签中设置压缩包的文件名和保存路径，然后切换到 Options 标签，在 Sfx module 项中选择

“Win95/98，NT4.x”，在 Language项中设置自扩展文件的解压缩界面语言，然后单击界面中的 Options按钮，

程序给出如图 1-59的设置界面。 

 

图 1-59  SFX Options对话框 

在界面中的 Additional headline …设置文件扩展界面的标题栏。在 Target directory设置默认扩展路径，在 Run 

program设置压缩包扩展结束后自动运行的文件。在 Information中设置文本信息，这个信息框将在自扩展文件

运行前自动给出，单击“Load text…”可以从文件中加入信息。 

设置结束后，单击 OK按钮退回上一设置界面，单击界面中的 Add按钮，程序创建压缩包，完成后退出。 

除了可以创建自扩展文件以外，程序还提供了将.ace 文件转换为.exe 格式的自扩展文件的功能。首先在程

序的系统文件列表框中选择需要转换的压缩包文件，单击菜单中的 Archive → Create Sfx命令，程序给出界面

如图 1-60所示。单击 Options按钮，弹出和图 1-59相同的对话框，可以进一步进行设置。设置完毕，单击OK，

程序开始转换。 
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图 1-60  Create Sfx对话框 

1.4.5  WinACE的其他功能 

1．修复压缩包 
WinACE 可以修复被损坏的压缩包文件。首先打开 WinACE，在系统文件列表窗口内选择欲修复的压缩包

文件，然后单击菜单 Archive → Repair archive命令，程序开始修复压缩包，同时给出如图 1-61所示修复进程

对话框，修复结束后，WinRAR还会自动生成一个名为“Fixed_xxx.rar”的修复备份压缩包。 

 

图 1-61  修复进程对话框 

2．测试压缩包 

当我们创建一个压缩包后，可以测试一下该压缩包的完整性，即 CRC校验。首先打开想要测试的压缩包，

然后选择菜单 Archive → Test archive …命令，程序开始测试压缩包，同时给出如图 1-62所示测试进程对话框，

测试结束后，WinACE给出测试结果，单击 Close回到主界面。 

 

图 1-62  测试进程对话框 
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3．优化压缩包 
WinACE提供的所谓优化其他格式的压缩包功能，实际上就是将需要优化的其他格式的压缩包全部解压缩，

然后用.ace 格式重新压缩，如果发现压缩后的文件比压缩前大，就不进行优化，否则予以保留。方法是单击菜
单命令 Tools → Optimize Archive，程序即自动开始进行转换。 

4．保护和锁定压缩包 
WinACE提供了压缩包保护和锁定的功能（仅限于 ACE格式）。保护功能可在最大限度上防止压缩包在使

用和保存过程中受到损伤，这项功能的原理实际上是在压缩包内加强文件的 CRC校验，以使当部分压缩文件受
到损伤时，可以最大限度使用程序提供的数据校验功能进行恢复。如果需要保护压缩包，从程序的系统文件列

表窗口中选择该压缩包后，选择菜单命令 Archive → Protect Archive from damages。 
如果需要锁定一个压缩包，从程序的系统文件列表窗口中选择该压缩包后，选择菜单命令 Archive → Lock 

Archive。锁定一个压缩包以后，将不能再向其中添加文件，也不能删除或编辑其中的文件。而且一个压缩包一
旦被锁定后，就不能被取消。 

1.4.6  WinACE运行环境设定 

下面简要介绍 WinACE 常用的设置选项。启动 WinACE，选择菜单命令 View → Options，设置界面如图

1-63所示， 

 

图 1-63  WinACE运行环境设定对话框 

l General：在其中的 General 项中，Display comments automatically 表示自动显示注释，Save window 
position 表示保存窗口位置，Add WinAce to your Desktop 表示在桌面创建 WinAce 快捷方式，Add 
WinAce to your Start Menu表示将WinAce加入到开始菜单中。Priority项设置WinAce的优先级。Display
选项设置字体类型和大小。Temp folder设置临时文件夹。Program language设置界面语言。 

l File List：定义文件列表窗口的外观。 
l Archive：左边窗口中显示了WinAce支持的压缩文件格式，如果想改变设置，单击相应的压缩格式。

Choose Icon可为该压缩类型的文件选择图标，Associate this archive type with WinAce表示将该压缩格
式与WinAce相关联。Activate context menu “Extract…”表示对于该压缩格式激活系统右键菜单中的
“Extract…”命令。Show contents in properties表示在属性中显示注释。 

l Program Locations：External Viewer 可以设置外部文件观察器，Editor 中设置编辑器，Optional virus 
scanner设置可选择的杀毒程序，在 Parameter中设置该杀毒程序的运行参数。 

l Compression：设置压缩时的默认参数。Archivetype选择压缩格式，Compression设置压缩比，Dictionary

设置压缩字典，这个值越大，压缩比越大，但所需的内存越多。Create Solid archive表示采用“紧固”
模式压缩，Protect archive from damage表示对压缩包进行保护，Include subfolders表示包含子文件夹，
Store full path表示保存完整路径。 
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本章介绍了三个功能各不相同的备份工具。 

Norton Ghost 对于复制硬盘和重装系统来说是非常

好的工具软件。虽然重装系统对于Windows下的用户可

以说是家常便饭，不过有了 Norton Ghost，重装一个

Windows 可以在两分钟之内搞定，怎么样，大家一定动

心了吧。 

用户在日常工作中，会经常有一些重要的文档需要

备份，本章提供了一个非常好用的文档备份工具

Backup2001，它曾荣获 TUCOWS 的五头牛最高评价。

这个工具采用向导方式操作和高级模式操作两种方式，

适合初学者和专家级别的所有用户。 

WinRescue 98对于备份系统文件非常有效，当系统

崩溃时，可以轻松地用该工具来恢复。 

 

 

第二章  备份工具 
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2.1  Norton Ghost 6.0 

 

 

 

 

 

 

 Norton Ghost是由 Symantec公司开发的一款硬盘克隆工具，利用该软件用户可以将整个硬盘或分区原

样复制到另一个硬盘或分区中，这样当用户升级硬盘时，可以十分方便的将老硬盘上的操作系统和资料转移到

新硬盘中。此外，用户还可以将整个硬盘或分区制作成一个镜像文件，这样当硬盘崩溃时，可以使用 Ghost安

全恢复，免去了重新安装操作系统、各种驱动程序和应用软件之苦，两分钟即可重装系统。 

Ghost 工作的基本方法不同于其他的备份软件，它是将硬盘的一个分区或整个硬盘作为一个对象来操作，

可以完整复制对象，包括对象的硬盘分区信息、操作系统的引导区信息等等，并打包压缩成为一个映像文件

版本 6.0 

类别 免费软件（单机个人版） 

功能 硬盘复制 

主页 http://www. symantec.com/ 
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（IMAGE），在需要的时候，又可以把该映像文件恢复到对应的分区或对应的硬盘中。它的功能包括两个硬盘

之间的对拷、两个硬盘的分区对拷、两台电脑之间的硬盘对拷、制作硬盘的映像文件等，我们用得比较多的是

分区备份功能，它能够将硬盘的一个分区压缩备份成映像文件，然后存储在另一个分区硬盘或大容量软盘中，

万一原来的分区发生问题，就可以将所备件的映像文件拷回去，让或分区恢复正常。 

Ghost是一个 DOS下的应用程序，如果在Windows 95/98下运行有可能导致以下问题： 

l 文件可能处于被其他任务打开或修改的状态，如果这些文件克隆将导致目标文件不连续。 

l 重写硬盘或分区将导致硬盘重新启动。 

l 操作系统的卷不能被重写。 

l Ghost无法自动重起系统。 

l 显示的硬盘空间比实际空间小，Ghost无法进入全部硬盘空间。 

所以建议用户在 DOS环境下运行 Ghost，如果在 DOS下运行 Ghost，为了方便可以预先运行鼠标驱动程序，

否则可能没有鼠标支持，不过用户也可以用键盘完成全部操作。方法是：用方向键在菜单之间切换；用 TAB键

在按钮之间切换；用 Enter键进行确认。 

启动 Norton Ghost，程序界面非常简洁，如图 2-1所示。 

菜单中的 Local子菜单是关于本地硬盘的克隆，Norton Ghost还支持通过网络进行一点对多点的克隆，这个

功能主要是面向企业内部网或者是电脑机房而设的，因为这些地方电脑很多，如果每台电脑都单独安装软件系

统的话，就太麻烦了，所以还是用硬盘克隆。菜单中的 LPT、Multioasting和 NetBios就是做网络硬盘克隆的，

由于个人用户日常很少使用这项功能，这里就不做详细介绍了 

 

 
图 2-1  Norton Ghost主界面 

下面我们介绍一下程序的主要功能。Ghost 的操作对象分为整个硬盘和单个分区，不过二者的操作步骤基

本相同。做为普通个人用户，主要是使用 Ghost来备份和恢复主分区和操作系统，所以最常用的就是分区操作。 

2.1.1  克隆硬盘分区 

将一个硬盘分区克隆到另一个硬盘分区。 

 启动 Norton Ghost，选择菜单命令 Local → Partition → To Partition，弹出对话框如图 2-2所示，

在其中选择源驱动器，（千万不要将源驱动器和目标驱动器弄混）。 

 
图 2-2  选择源驱动器 
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 单击 OK，在弹出的对话框中选择该驱动器中被克隆的分区。 

 

图 2-3  选择被克隆的分区 

 单击 OK，在弹出的对话框中选择目标驱动器。 

 

图 2-4  选择目标驱动器 

 单击 OK，在弹出的对话框中选择该驱动器中克隆的目标分区。 

 

图 2-5  选择克隆的目标分区 

 单击 OK，程序给出对话框，警告目标分区的数据将被永久性覆盖。 

 

图 2-6  警告对话框 

 如果想继续进行，单击 Yes，开始克隆操作，并显示操作进度，如图 2-7所示。 
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图 2-7  显示克隆操作进度 

 克隆完毕，如果需要继续进行其他操作，单击 Continue，回到程序主界面，否则单击 Reset Computer，

重新启动系统。 

2.1.2  镜像硬盘分区 

我们可以将硬盘中的某一分区（通常是主分区）备份成一个镜像（Image）文件，需要时可以用其进行恢复。 

 在程序主界面中选择菜单命令 Local → Partition → To Image，弹出对话框如图 2-8，在其中选择

源驱动器。 

 

图 2-8  选择源驱动器 

 单击 OK，在弹出的对话框中选择该驱动器中需要备份的分区。 

 

图 2-9  选择需要备份的分区 

 单击 OK，在弹出的对话框中设置镜像文件的文件名、文件类型和保存路径。 
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图 2-10  设置镜像文件参数 

 单击 Open按钮，程序询问镜像文件的压缩方式。Fast表示压缩速度快，但压缩比较小。High表示

压缩比高，但压缩时间较长。用户可以根据自己的需要进行选择。 

 

图 2-11  询问镜像文件的压缩方式 

 程序给出对话框，询问用户是否确认此次分区转储操作。 

 

图 2-12  确认对话框 

 单击 Yes，程序开始镜像操作，同时给出操作进度示意图。 

 
图 2-13  显示操作进度 

 程序给出对话框提示操作完毕，单击 Continue回到程序主界面。 

2.1.3  恢复硬盘分区 

在备份完成以后，如果经过备份的分区被破坏，可以使用备份的映象文件对分区进行恢复。我们可以备份

一个干净的 Windows 操作系统（最好已经安装好各种驱动程序），日后需要重装系统时，利用 Ghost的恢复功
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能只需几分钟，十分方便。 

 在程序主界面中选择菜单命令 Local → Partition → From Image，弹出对话框如图 2-14，在其中选

择备份的镜像文件。 

 单击 Open，如果镜像文件中有多个分区，可以在图 2-15所示的对话框中进行选择。 

 

图 2-14  载入映像文件对话框 

 

图 2-15  选择需要恢复的分区 

 单击 OK，在给出的对话框中选择需要恢复的目标驱动器。 

 

图 2-16  选择需要恢复的驱动器 

 单击 Yes，程序给出对话框，警告目标分区的数据将被永久性覆盖。 

 

图 2-17  警告对话框 

 单击 Yes，程序开始镜像操作，同时给出操作进度示意图。 
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图 2-18  显示操作进度 

 克隆完毕，如果需要继续进行其他操作，单击 Continue，回到程序主界面。否则单击 Reset Computer，

重新启动系统。 

2.1.4  对整个硬盘进行操作 

有时当我们要升级硬盘时，可以利用对整个硬盘的克隆将老硬盘上的操作系统和所有数据资料原封不动的

转移到新硬盘中。 

在 Norton Ghost主菜单中选择 Local → Disk，程序会给出和对分区操作相同的三个选项。对于硬盘之间的

克隆（To Disk）、将整个硬盘备份到一个镜像文件中（To Image）和从镜像文件恢复硬盘（From Image）的用法

与对分区操作基本类似。需要注意的是，克隆整个硬盘时，目标磁盘的容量一定要大于源磁盘的容量。 

2.1.5  完整性检查 

在 Norton Ghost主界面中选择 Local → Check，就启动了软件的另一项主要功能：完整性检查。这项功能

主要是检查整个硬盘/分区或映像文件，看是否可能因整个硬盘/分区或映像文件被破坏造成备份或恢复失败。

检查分为两种，一种是检查 Image 映象文件，就是菜单中的 Image File；另一种是检查整个硬盘，就是菜单中

的 disk项，选择后，软件会扫整个硬盘。图 2-19为检查硬盘时的程序界面。 

2.1.6  恢复指定文件 

Norton Ghost软件包中还提供了一个Windows外壳工具 Ghost Explorer，它可以在Windows下运行，但不

能完全脱离 DOS下的主程序运行所以使用起来并不是太方便，不如在 DOS下直接操作，不过，这个外壳还有

个很好用的功能，就是用户在恢复备份的映象文件时，可以方便地恢复单个指定的文件。 

启动 Ghost Explorer程序，单击工具栏中的 Open按钮  ，打开镜像文件，界面如图 2-20所示。右边窗

口以文件夹形式显示镜像文件的各个文件和文件夹，在要恢复的文件或文件夹上单击鼠标右键，从打开的快捷

菜单中选择 Restore，即可将文件和文件夹恢复到指定的目录下。 



常用工具软件大全 36

 
图 2-19  检查硬盘的程序界面 

 

图 2-20  Ghost Explorer程序界面 

2.2  Backup 2001 
 

 

 

 

 

 

 Backup 2001是一个基于Windows系统的文档备份工具。程序支持常见的软盘、硬盘、网络驱动器、

Zip驱动器、、CD-R/CD-RW、等常见的存储设备。程序提供了良好的文档备份过滤控制功能，用户可以根据自

己的需要选择按照文件创建日期、存放路径等进行文档备份操作。而且可以将这个过程创建为一个备份策略文

件，以方便使用。 

Backup 2001内建一个 Zip编码压缩器，使用这项功能可以在备份文档的同时会备份文件进行压缩，用户也

可以使用 Zip文件管理工具直接察看或管理备份文档。程序还提供了备份系统注册表及启动配置文件、Windows

的 System子文件夹功能，可以有效地帮助用户维护Windows系统。 

Backup 2001 提供了创建备份任务的计划任务功能，这项功能可以在指定的时间开始备份任务，不需要用

户干预操作。下面开始介绍程序的主要功能。 

2.2.1  创建新的备份策略 

程序采用向导和专家两种方式，以分别满足不同用户的使用要求。单击View菜单中的Wizard mode和Expert 

mode即可进行切换。 

版本 2.0 

类别 共享软件 

功能 文档备份 

主页 http://www.Zipstore.com/ 
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1．向导方式 
 启动 Backup 2001，程序界面如图 2-21所示。 

 
图 2-21  Backup 2001主界面 

 单击界面工具栏中的 New按钮，或单击菜单命令 File → New Backup Set，程序给出如图 2-22所

示界面，在其中 The name of your backup set项中设置当前创建的备份策略文件名称，建议根据备份文件的内容

和属性确定名称，以便于日后管理。 

 

图 2-22  设置备份策略文件名称 

 单击界面中的 Next按钮，程序给出如图 2-23所示界面。其中提供了选择备份对象设置，包括： I want 

to add a drive（备份指定驱动器）、I want to add a folder（s）（备份指定文件夹）、I want to add a folder（s）with 

subfolder（s）（备份指定文件夹及其子文件夹）、I want to add a file（s）（备份指定文件）、I want to find（自己查

找定义备份对象）。用户可以在此设定备份对象。 

 

图 2-23  设定备份对象 

例如我们选择备份指定文件夹及其子文件夹，单击该项右边的打开按钮  ，弹出对话框如图 2-24。在其
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中的系统文件夹列表窗口中选择需要备份的文件夹，双击即可。如果需要指定备份特定类型的文件，可在界面

下边的 Specify files项中设置（例如希望只备份 DOC文档，可在其中输入*.doc）。如果需要保持子文件夹的路

径，选中复选框 Preserve the subfolder tree。设置完成后单击 OK按钮返回上一界面。如果需要继续添加备份对

象，可按照以上步骤重复操作，直至所有备份文件夹全部添加结束。 

 

图 2-24  选择备份文件夹 

 单击 Next，程序给出如图 2-25 所示界面。其中提供了使用文件创建日期过滤功能。如果需要使用

该项功能，可选中界面中的 Use a date filter复选框，然后在 Date minimum和 Date Maximum项中设置备份时间

限制区域。还有一个 Exclude项，可以设置可排除使用时间过滤器的文件设置。 

 

图 2-25  创建备份策略向导之三 

 单击 Next，程序给出如图 2-26 所示界面。在该界面中的第一个项目中直接输入保存备份文件的驱

动器或文件夹，也可以单击该项目右边的 Browse 按钮，弹出“打开”对话框，在其中的系统文件列表窗口中

选择保存路径。需要注意的是，该对话框是选择保存路径，所以对话框中的文件名（缺省为 backup）和文件类

型（缺省为 backup）并无实际意义，不要修改。 
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图 2-26  创建备份策略向导之四 

界面中的第二个项目是选择文件的备份方式，其中包括： 

l Full：备份所有文件，不论是否有存档属性（archive attribute，一般当一个文件被改动或被新建后，会

自动产生该属性值）。备份一个文件以后，自动取消该文件的存档属性。 

l Copy：备份所有文件，不论是否有存档属性。但备份一个文件以后，并不取消该文件的存档属性。 

l Incremental：只备份具有存档属性的文件，且备份一个文件以后，自动取消该文件的存档属性。 

l Differential：只备份具有存档属性的文件，但备份一个文件以后，并不自动取消该文件的存档属性。 

一般第一次进行备份时，建议选择 Full方式。 

界面中最后一个项目是设置是否保留备份文件的副本以及该副本文件可以保存的时间周期，使用这项功能

可以更加安全的管理备份文档，不过如果用户的备份文档不是高度重要，不设置使用该项功能也可以。 

 单击 Next，程序给出如图 2-27所示界面。Verify backup set表示设置校验备份设置，使用这项功能

可以提高备份操作的安全性。Protect by password项可以给备份文件添加密码。由于 Backup 2001使用 Zip格式

创建备份文件的。界面中最下边一个设置项目是设置备份文件的压缩比，建议用户使用 Full高压缩比，这样可

以有效减小备份文件的容量。 

 

图 2-27  创建备份策略向导之五 

 单击 Next，程序给出如图 2-28所示界面。 
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图 2-28  创建备份策略向导之六 

选择 Save表示只保存当前的备份策略设置，选择 Save and Backup表示保存备份设置并开始文件备份操作。

如果选择 Save and Backup，单击 Finish按钮，程序开始进行文档备份操作并显示操作进度，如图 2-29。 

 

图 2-29  显示备份操作进度 

2．专家方式 
对于高级用户，Backup 2001提供了一项更加简单的备份方式。选择程序界面中的菜单命令 View → Expert 

Mode，切换成专家模式，程序给出如图 2-30 所示界面。在界面左边的窗口中依次设置新建备份策略文件的文

件名、需要备份的文件夹、是否保存备份文件夹结构、可包括的文件类型、可排除的文件类型、是否使用文件

日期过滤器、保存备份文件的文件夹、可备份的文件类型、是否使用备份文件校验、是否设置备份文件口令、

是否对备份文件进行压缩等。设置完毕，单击 OK按钮确定即可。 

 

图 2-30  专家模式程序界面 
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2.2.2  文件的备份与恢复 

1．备份操作 
在程序界面 New按钮右边的下拉文本框中选择一个备份策略，然后单击工具栏中的 Backup按钮，程序即

开始按照既定的备份策略进行备份操作，同时显示备份操作进度。笔者建议用户当一个备份任务建立且已经完

成第一次备份操作以后，可以将备份方式（backup type）修改成 Incremental，这样每次备份操作时，程序只备

份更新的文件，比 Full方式备份所有文件大大减小了工作量。如果需要修改备份策略，在程序界面 New按钮右

边的下拉文本框中选择需要修改的备份策略，单击菜单命令 File → Modify Backup Set即可。 

2．恢复操作 
Backup 2001提供了恢复备份的文件功能，在此介绍向导模式下的操作步骤。 

 单击程序界面工具栏中的 Restore 按钮，程序会给出如图 2-31 所示的界面。在该界面中的下拉文

本框中选择需要恢复的备份策略文件，“Before replacing file， prompt me”可以选择替换文件时是否询问用户。

此时如果单击界面中的 Finish按钮，程序会恢复最后一次的备份文件。 

 

图 2-31  恢复备份向导之一 

 如果已经创建了多个备份文件副本，需要选择特定的备份文件时，可单击 Next 按钮，程序给出如

图 2-32所示界面。 

 

图 2-32  恢复备份向导之二 

在其中的下拉文本框中选择需要恢复的备份文件（程序以备份时间相区分）、恢复备份文件的目标文件夹等。

如果需要全部恢复文件，可单击 Finish按钮确定， 
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 如果只需要恢复备份文件中的指定文件，可继续单击 Next 按钮，此时程序会在界面中给出备份文

件中打包的文件列表，如图 2-33。用户可以选择需要恢复的文件，之后单击该界面中的 Finish按钮以完成文件

恢复操作。此外，由于程序的备份文件是以 Zip格式存放的，你也可以使用 Zip文档管理工具入Winzip打开并

扩展启动的文件。 

 

图 2-33  恢复备份向导之三 

2.2.3  自动备份功能 

Backup 2001 提供了以计划任务方式自动执行备份策略文件功能，使用该项功能可以给备份工作提供许多

方便。 

单击程序界面工具栏中的 Schedule Job按钮，程序会给出如图 2-34所示界面。从图中可以看到，在界面窗

口中给出了所有曾经创建的备份策略文件列表。 

 

图 2-34  设置计划任务界面 

使用鼠标右键单击界面列表框中需要启动的备份策略文件，并从关联的菜单中选择 Add a job命令，程序会

给出一个 Schedule Job设置界面，这是一个向导方式操作的设置界面，其中包括设置当前备份策略文件的启动

时间和运行周期，根据自己的需要进行设置，之后单击 Finish按钮确定即可。设定自动备份任务以后，从系统

开始菜单的 Backup 2001程序组中启动“Tbackup2001”程序，程序界面如图 2-35所示，此时可以看到我们设

置的备份策略文件已经添加到该窗口中了，备份计划任务已经启动。 
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图 2-35  计划任务列表框 

2.2.4  备份系统文件 

Backup 2001提供了备份系统启动文件和系统 System文件夹功能，使用这项功能可以进行系统备份，以及

在系统崩溃时进行恢复。如果需要使用该项功能，可使用鼠标单击程序界面菜单条 Action项下拉菜单中的 Quick 

System Backup命令，程序会给出关联的设置界面，在其中提供了可供选择的备份项目：Registry database（系

统注册表）、Ini files（系统初始化文件）、“<Windows\system>”（Windows 的 System/Systemm32 文件夹）、

Autoexec.bat（系统启动批处理文件）等，用户可以根据自己的需要选择，然后单击界面中的 OK按钮确定即可，

程序会自动将该备份策略文件命名为 QSB。 

 

图 2-36  备份系统文件 

2.3  WinRescue 98 

 

 

 

 

 

 

 WinRescue 98是一个基于Windows 98的系统备份急救工具。该程序只针对Windows 98设计，提供了

对系统重要文件的备份，包括*.ini文件、系统启动文件、桌面上的快捷方式、系统开始菜单等等，非常全面。

当Windows 98出现问题时，就可以用备份的文件进行恢复。WinRescue 98还具有以下几个特点： 

l 制作紧急启动盘 

l 提供 DOS版的程序用于紧急恢复 

版本 4.19 

类别 共享软件 

功能 系统备份急救 

主页 http://www.Superwin.com/ 
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l 能够用软盘多卷备份和恢复 

l 可设置WinRescue 98自动备份 

l 可以压缩并且整理备份注册表 

启动WinRescue 98，如果用户使用的是未注册版本，会弹出注册窗口，几秒钟后按界面窗口中的 Continue

按钮进入程序主界面，如图 2-37所示。WinRescue98的程序主界面相对简单，界面中并排了六个标签项分别是：

Backup（备份）、Crash Fixer（恢复）、RegPack（注册表优化）、Extractor（扩展文件）、Boot Disk（系统盘）、

Help（帮助）。 

 
图 2-37  WinRescue 98主界面 

下面介绍程序的具体功能。 

2.3.1  系统备份 

单击 Backup 标签，程序给出界面如图 2-38 所示。程序允许用户自定义四个备份配置 config1－4。进行备

份以前，首先要进行有关设置。 

 
图 2-38  系统备份界面 

单击 Change Backup Properties按钮，程序给出WinRescue 98 Preferences对话框，其中有六个标签。 

l Backup Properties 

备份设置。单击该标签，设置界面如图 2-39所示。 
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图 2-39  Backup Properties标签项 

在 Backup Config下拉列表框中可以选择需要设置的备份配置。界面下方有 5个标签。Introduction中主要

是一些说明信息。 

单击 Settings标签，设置界面如图 2-40。其中 Backup Config是选择文件的备份方式，其中包括： 

·  Full：备份所有文件，不论是否有存档属性（archive attribute，一般当一个文件被改动或被新建后，会

自动产生该属性值）。备份一个文件以后，自动取消该文件的存档属性。 

·  Copy：备份所有文件，不论是否有存档属性。但备份一个文件以后，并不取消该文件的存档属性。 

·  Incremental：只备份具有存档属性的文件，且备份一个文件以后，自动取消该文件的存档属性。 

·  Differential：只备份具有存档属性的文件，但备份一个文件以后，并不自动取消该文件的存档属性 

一般第一次进行备份时，建议选择 Full方式。Target项可以设定备份文件的保存文件夹。Compression Level

可以选择压缩等级。 

 

图 2-40  Settings标签项 

单击Winfiles标签，设置界面如图 2-41所示。在列表框选择需要备份的项目，其中 User Profile类的项目

对恢复系统并没有用处，但记录了用户Windows的各项设置。 
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图 2-41  Winfiles标签项 

单击 Other Files标签，设置界面如图 2-42所示。 

 

图 2-42  Other Files标签项 

用户可以选择备份一些其他文件，这些文件将备份在一个 Zip压缩包中。单击 Add按钮，程序给出 File to 

Backup对话框，如图 2-43。中间的 Select项中列出了很多文件类型按钮，用来选择某一类型的文件。例如按下

TXT Files按钮  ，就表示选择文件夹中*.txt类型的文件，将其加入到备份列表中。在最下方的 Name of this 

Zip Package中可以设置压缩包的名称。单击 OK，回到图 2-42所示界面，会发现列表框中多出了一个 Backup1

项目，将该项目选中，表示备份该项目中的文件。 

 

图 2-43  备份用户文件对话框 
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在Misc标签中，可以给备份和恢复操作设置密码。全部设置完毕， 

l Backup Manager 

备份管理器。单击该标签，设置界面如图 2-44。列表框中列出了最近保存的备份。可以对备份进行管理，

界面中 Rename 按钮可以对备份重命名，Add 和 Delete 可以添加和删除备份。最下方还有两个数字选择框，

Maximum backups设置程序保留的备份的最大数目，超出该数目将覆盖日期最早的备份。Keep设置程序保留的

备份数目，例如设成 3，则前三个备份将永远不会被程序自动覆盖。 

 

图 2-44  Backup Manager标签项 

l Automation 

自动计划备份功能。单击该标签，设置界面如图 2-45。 

 

图 2-45  Automation标签项 

其中可以设置如下几种事件的计划执行时间： 

·  Start Winrescue 98 and Wait：自动执行Winrescue 98并等待用户操作； 

·  Back up xxx Setup（x Config）：自动按第 x种（1－4）备份配置进行备份操作； 

·  Automatically perform Regpack：自动对注册表压缩整理。 

Winrescue98提供几种时间选择，如每天 daily、每周 weekly、两周 bi－weekly、每月 monthly和不执行 Do 

not Perform。如果其中某项选择了 Use Scheduler，使用Win98计划任务程序设置自动备份，那么具体的时间安

排请按左下方的 Setup the Task Scheduler按钮进行设置。 
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l Advanced 

该标签中列出了一些选项，当WinRescue 98使用默认设置不能正常工作时，可以对其进行修改。不过一般

默认设置即可。 

l Win98 Backups 

当Windows 98每天第一次启动或WinRescue 98进行备份时，Windows 98都会自动生成Win98备份（Win98 

backup）。在该标签中列出来存在的Win98备份，用户可以单击 Delete按钮删除选定的Win98备份。用户还可

以可以修改Win98 backup的存放文件夹和保存数目。 

l Desktop Icons 

在该标签中用户可以为WinRescue 98的各项常用操作在桌面上建立快捷图标。 

2.3.2  系统恢复 

单击程序主界面中的 Crash fixer标签，界面如图 2-46所示。 

 
图 2-46  系统恢复界面 

其中共有两个项目，第一个项目中可以设置系统恢复使用的方法，用户可以根据具体的情况进行设定。 

l Win98 Backups：恢复Win98备份文件。Win98备份是Win98启动时自动对一些系统文件生成的备份，

备份文件的最大数量通常为 5个，可以在WinRescue 98中重新设置。 

l Spare Registriy：在WinRescue 98做任何一种备份时，都会另外拷贝一份以前的注册表，将其放置在

Windows目录下，叫做 user.ray和 system.ray，也就是 Spare Registry，这种情况下恢复的只有这些注册

表文件，没有其他设置文件。 

l WinRescue Backup：恢复永久备份文件。选择该选项，程序自动弹出文件列表框，用户可以选择其中

一个备份，Most Recent Backup是指最新的备份。 

l Diskette：磁盘备份恢复。如果是多卷备份，先插入最后一张盘，然后再按提示插入第一张盘。 

l Original Registry：恢复最初的注册表。最初的注册表是指刚安装完Win98时的注册表。选择该项将使

所有应用程序的注册表信息都将被覆盖，这种方法通常是在上面几种方法都不见效时才使用。 

第二个项目可以选择恢复额外的信息。该项中的复选框会随着第一个项目的选择不同而稍有变化。用户可

以根据需要选择恢复。 

单击界面右边的 Restore 按钮，程序就将备份的文件恢复到系统中，从新启动系统就可以回到备份时的状

态。 

2.3.3  其他功能 

1．优化注册表 

WinRescue98可对注册表进行压缩和整理，单击主界面中的 Regpack标签，程序给出界面如图 2-47。用户

可以选择优化方式：Quick RegPack和 Expanded RegPack。一般可以选择 Quick RegPack，如果 Quick RegPack

不能正常工作或用户的Windows 98设置成多用户时，可以选择 Expanded RegPack。单击 Check the Registry按

钮扫描注册表是否有错，然后单击左边的 RegPack按钮对注册表进行优化压缩。 
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图 2-47  优化注册表界面 

2．制作启动盘 

如果系统破坏后，连Win98都进不了，可以使用 DosRescue 98程序在 DOS下恢复备份，它的备份功能和

WinRescue98相同，但只能够恢复注册表文件、初始化文件、Autoexec.bat和 Config.sys（如果是磁盘备份，必

须放置在第一张盘），不能恢复 Backup 永久备份和磁盘备份中其它的文件，这些文件只能在用 DOS 版的

WinRescue 98恢复Win98后，在Win98中恢复。 

WinRescue 98 作为 Win98 的急救员，有一项必不可少的功能就是制作紧急启动盘，选择主界面窗口中的

Boot Disk标签，在给出的界面中单击 Boot Disk按钮，程序首先弹出一个对话框，如图 2-48所示，在其中输入

软驱的盘符（A或 B）。 

 

图 2-48  输入软驱盘符 

接着询问用户是否格式化磁盘。然后程序开始创建启动盘，并显示操作进度，如图。 

 
图 2-49  显示操作进度 

如果以后系统出现了问题不能启动，就可以用这张紧急启动盘重新启动机器，执行 DOS 版的恢复程序

DosRescue 98，恢复了备份的系统文件后，再进入Win98恢复其它文件，系统就可以起死回生了。 

3．扩展指定文件 

用户可以从WinRescue生成的备份中扩展指定文件，建议用户在扩展 Other Files（备份时的非系统文件）

使用该项功能。单击主界面中的 Extractor标签，在给出的界面中单击 Extractor按钮，程序弹出 Extract files from 

Backup对话框，如图 2-50所示。 
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图 2-50  扩展指定文件对话框 

在 Backup File项中选择备份文件（单击右边的浏览按钮），在备份文件列表框列出该备份中包含的内容文

件，可以根据需要进行选择。Check All Files表示选中所有文件，Uncheck All Files表示取消所有文件。在 Extract 

to下拉列表框中可以设置扩展目标文件夹，其中Original Location表示指定文件的原始路径，Temporary Directory

表示临时文件夹，Specified Location表示指定文件夹，选择该项后，程序弹出系统文件夹列表框供用户从中进

行选择。 

设置完毕，单击 Extract按钮，程序开始扩展指定文件。 

4．备份与恢复向导 

WinRescue 还在主界面的左边提供了备份向导和恢复向导两个按钮，用户可以在向导的帮助下一步一步进

行备份和恢复操作，这里不再介绍。 
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现在的软件更新速度越来越快，可是安装一个新软

件后能否顺利卸载，恢复原样，却很让人头疼。时间长

了，Winows目录下和注册表中会留下大量的垃圾，严重

影响的系统的运行速度。本章介绍了两个重量级的软件

反安装工具： Norton CleanSweep2000 和 McAfee 

UnInstaller。它们的功能很相像，除了软件的反安装以外，

还有系统和硬盘清理的功能。在细微的差别上，MaAfee

的 UnInstaller对于系统的分析清理强于 CleanSweep，但

CleanSweep对于应用程序安装的监视和反安装却要技高

一筹。 

 

 

第三章  卸载软件 

 

＝＝ 本章导读 ＝＝ 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

3.1  Norton Cleansweep 2000 
 

 

 

 

 

 

 Norton Cleansweep 2000（以下简称 CS）是由 Symantec公司出品的大名鼎鼎的 Norton系列工具软件

之一，是非常优秀的软件反安装和磁盘清理工具。它的功能十分全面，能够监视软件的安装过程，需要时可以

彻底地卸载程序；能够清理硬盘中不需要的文件；删除访问 Internet 后保存在硬盘上的临时文件；删除多余的

备份文件及系统组件等。程序还内建了安全机制可以防止所需的文件遭意外删除。程序所有的功能都有直观的

向导和提示，便于用户使用。 

启动 Cleansweep，主界面如图 3-1所示。界面左边有四个功能选项：CleanUp、Internet、Programs、Advanced。

下面分别作一介绍。 

版本 4.70 

类别 商业软件 

主页 http://www. symantec.com/ 

功能 软件卸载，系统清理 
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图 3-1  Norton CleanSweep主界面 

3.1.1  CS功能选项之一 ：CleanUp 

该选项包括三个组件。 

1．Uninstall Wizard（卸载向导） 

卸载向导可以彻底卸载程序，不仅删除程序中的有关文件，而且可以删除程序的外部连接，诸如程序的图

标、系统注册表中的有关项目等等，对于与其它程序共享的组件则会完整保留。首先介绍一下 CleanSweep监视

软件安装的功能。 

单击程序左上角的 Options按钮，在给出的界面中选择 Smart Sweep/Internet Sweep标签，设置界面如图 3-2

所示。 

 

图 3-2  Smart Sweep/Internet Sweep标签 

选择 Turn Smart Sweep/Internet Sweep on，系统任务栏内多出两个图标如图 3-3所示。 

 

 
图 3-1-3  CS的 Tray图标 

Load Smart Sweep/Internet Sweep on Startup 表示系统启动后自动加载 Smart Sweep/Internet Sweep。

Automatically Monitor Installs when Loading表示自动监视程序安装。右下方的 Names按钮作用是告诉 CS哪些

Smart Sweep Internet Sweep 
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文件名是安装执行文件，如 Setup、Install 之类，程序已内建了足够多的文件名，一般不用再添加。Logs 按钮

可以查看具体的已安装内容。 

如果选中 Automatically Monitor Installs when Loading，加载 Smart Sweep/Internet Sweep后，一般软件的安

装过程会被自动记录。对于自动检测不到的软件安装，可以采用手动检测，方法如下。 

安装一个软件之前，右键单击 Smart Sweep图标，在弹出的关联菜单中单击 Start Logging命令，CS就会自

动记录之后的安装过程。对于大多数软件安装，CS可以自动检测到其安装结束，并生成记录；少部分需要你在

安装结束后，右键单击任务栏图标，原先的 Start Logging变成了 Stop Logging。单击该命令，同样生成记录。 

下面介绍卸载向导的使用。 
 单击 Uninstall Wizzard组件，CS给出界面如图 3-4所示。右边的列表框中显示了三种程序：被 Smart 

Sweep监测其安装的程序、“开始”菜单中的程序、Windows桌面上的程序（有快捷方式的程序）。如果在列表

框中找不到要卸载的程序，可以单击 Search按钮进行搜索。 

 选择需要卸载的程序，单击 Next，CS询问卸载前是否备份该软件，可以用于日后恢复，缺省建议

为 Yes，如图 3-5所示。 

 
图 3-4  下载向导之一 

 
图 3-5  下载向导之二 

 单击 Next，在给出界面的对话框中键入备份文件的路径，或单击旁边的“ …”按钮进行备份文件路

径的定位。一般缺省的路径即可。 
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图 3-6  下载向导之三 

 单击 Next，CS询问卸载时是否对每一项都要进行确认，缺省建议为 No。 

 

图 3-7  下载向导之四 

 单击 Next，如果想查看该卸载程序的具体组件，单击界面中的“View”按钮。单击 Finish，CS 开

始卸载该程序，完成后给出卸载的详细清单。 

 

图 3-8  下载向导之五 
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2．Fast & Safe Cleanup（快速安全清除） 

Fast & Safe Cleanup是释放硬盘空间最为快捷、安全的方法。它会寻找可安全删除的特定文件类型（如：

临时文件、Internet 浏览缓冲存储器中的文件、回收站中的文件）。单击该组件，弹出的图形化界面快速显示了

可释放硬盘的空间大小，如图 3-9所示。单击 Clean Now，程序开始清除这些占据硬盘空间的文件。 

 

图 3-9  Fast & Safe Cleanup对话框 

3．Restore Wizard（恢复向导） 

Restore Wizard帮助用户将以备份过、压缩过或移动过的文件和程序恢复至原来的状态。下面介绍恢复向导

的使用。 
 单击 Restore Wizard组件，CS首先询问是否恢复最近备份的程序，如果不是想要恢复的程序，选择

No。 

 

图 3-10  恢复向导之一 

 单击 Next，在给出的界面中选择需要恢复的程序。最下面的文本框可以设置备份文件的存放路径，

如图 3-11。 

 选择 ZipMagic 2000，单击 Next，选择文件的恢复方式。All the files表示恢复所有文件，Only the files 

selected below只恢复下面列表框中选定的文件，如图 3-12。 

 单击 Next，程序给出界面如图 3-13所示。上面的单选按钮框是选择文件覆盖方式：Replace older files 

only（替换创建比较早的文件），Replace all files（替换所有文件）、Never replace files，only add new files（不替

换文件，只增加文件）。下面的按钮框是选择进行文件替换时，是否给出提示。 
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图 3-11  恢复向导之二 

 

图 3-12  恢复向导之三 

 

图 3-13  恢复向导之四 

 单击 Next，程序询问是否将程序恢复到原先所在的目录。 
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图 3-14  恢复向导之五 

 单击 Next，如果想查看该恢复程序的具体组件，单击界面中的 View按钮。单击 Finish，CS开始恢

复该程序，完成后首先询问是否删除备份文件，然后给出恢复的详细清单。 

 

图 3-15  恢复向导之六 

3.1.2  功能选项之二：Internet 

Internet功能主要是清理一些 Internet操作后的不必要的遗留文件，包括对下载文件、Cache、Cookie、Plug-in

和 ActiveX控件的清理。该选项包括 5个组件。 

1．Internet Uninstall（下载程序卸载） 

Internet Uninstall可以卸载从网络上下载的程序。方法及界面同 Unintall Wizard。 

2．Internet Cache Cleanup（缓存清除） 

用浏览器浏览网页，时间长了会在硬盘中留有很多的 Cache 文件，从而占用了硬盘空间，Internet Cache 

Cleanup可以快速的清除这些文件，十分简便。 

3．Cookie Cleanup（Cookie清除） 

当用户上网时，有一些 Cookie会存储在硬盘上。Cookie也会占用内存，使用 Cookie Cleanup可以方便地删

除 Cookie以释放空间，而且可以防止用户的个人资料泄漏出去。 

4．Plug-in Cleanup（插件清除） 

我们通常使用的浏览器中都会带有一些附件，如果从来都不使用，可以用 Plug-in Cleanup将其清除。 

5．ActiveX Cleanup（ActiveX清除） 

ActiveX controls是上网时使用的，用户不使用时会占用很多硬盘空间，使用 ActiveX Cleanup可以清除此

类程序。 
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3.1.3  功能选项之三：Programs 

1．Archive Wizard（压缩向导） 

Archive Wizard 可以帮助用户压缩不常用的程序。该项压缩功能实际上是将原程序卸载，然后生成保存有

程序文件内容、结构的压缩包，同时在程序原来所在的地方创建该压缩程序的图标。如图 3-16所示。而当需要

该程序时，单击其压缩图标，CS就会调用 Restore Wizard来恢复。 

 

图 3-16  被 CS压缩的程序图标 

下面介绍使用压缩向导的具体步骤： 

 单击 Archive Wizard选项，程序给出界面如图 3-17，从中选择需要压缩的程序，如果在列表框中找

不到，可以单击 Search按钮进行搜索。 

 
图 3-17  压缩向导之一 

 单击 Next，在文本框中输入保存压缩包的文件夹。 

 

图 3-18  压缩向导之二 

 单击 Next，如果输入路径不存在，程序会询问是否建立新的文件夹，单击 Yes程序给出向导界面如

图 3-19。如果想查看该移动程序的具体信息，单击界面中的 View按钮。单击 Finish，程序开始压缩操作。 
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图 3-19  压缩向导之三 

2．Backup Wizard（备份向导） 
Backup Wizard创建一个程序的压缩备份。和 Archive Wizard不同在于 Backup Wizard并不会将原程序卸载，

只是将所选的程序进行压缩备份。 

3．Move Wizard（移动向导） 
Move Wizard可以将选定的程序转移到其它的驱动器或文件夹中，而且在移动过程中，同时修改系统注册

表的相关项目，保证完整地移动该程序。 

 单击Move Wizard选项，CS给出界面如图 3-20，从中选择需要移动的程序。 

 

图 3-20  移动向导之一 

 单击 Next，在文本框中输入移动的目标路径。 
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图 3-21  移动向导之二 

 单击 Next，如果输入路径不存在，程序会询问是否建立新的文件夹，单击 Yes程序给出向导界面如

图 3-22。如果想查看该移动程序的具体信息，单击界面中的 View按钮。单击 Finish，CS开始移动该程序。 

 

图 3-22  移动向导之三 

4．Transport Wizard（传送向导） 
Transport Wizard可以把程序、文件转移拷贝到别的磁盘或其它存储介质上，也可以在局域网中的不同计算

机间拷贝程序（自动检测拷贝一些必须的 dll和 ocx文件）。Transport功能将该应用程序所有的文件、与之相关

联的动态连接库、系统注册表中相关的项目全部打包成一个 exe文件。将该文件拷贝到另一台计算机中直接运

行即可安装。 

 单击 Transport Wizard选项，程序给出界面如图 3-23，从中选择需要传送的程序。 
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图 3-23  传送向导之一 

 单击 Next，在文本框中输入移动的目标路径。 

 

图 3-24  传送向导之二 

 单击 Next，如果输入路径不存在，程序会询问是否建立新的文件夹，单击 Yes，程序给出向导界面

如图 3-25。如果想查看该移动程序的具体信息，单击界面中的 View按钮。单击 Finish，CS开始移动该程序。 
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图 3-25  传送向导之三 

3.1.4  功能选项之四：Advanced 

1．Registry Sweep（注册表清理） 
单击该项目后，CS首先对注册表进行全面扫描，这需要一定的时间，然后列出扫描结果。如图 3-26所示。 

 

图 3-26  注册表清理对话框 

其中每一项目前面都有一个复选框，绿色的是表示删除后对系统肯定没有影响的，CS已经默认将其选中；

黄色则要需要慎重考虑。选中所有需要删除的项目，单击 Clean，程序首先询问是否备份，然后开始清除注册

表。 

2．Duplicate File Finder（重复文件查找） 
同一程序多次下载在不同的目录中，或统一文件在不同位置间的拷贝，都会导致重复文件的产生，Duplicator 

File Finder可以帮助查找并删除同名称的复制文件以释放硬盘空间。 

3．Redundant DLL Finder（多余 DLL查找） 
一些程序在安装的时候，经常会往系统中添加一些 dll、ocx文件，而在卸载的时候又不能完全清理干净，

就需要使用 Redundant DLL Finder来清除。和 Registry Sweep一样，该功能也是将检测到的无用的 dll文件分成

3个等级，用户在删除的时候要小心一些。 

4．Unused File Type Finder（不常用文件查找） 

用户计算机中往往会有许多不常用的电子数据表或从网上下载的文件，从而占据了硬盘空间，Unused File 
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Type Finder可以帮助查找这些无用的文件并按用户意愿将其安全删除。 

5．Orphan Finder（孤立文件查找） 

当用户不用专门的卸载工具如 CleanSweep来删除程序时，很可能导致硬盘中的文件发生混乱，使用 Orphan 

Finder 可以查找那些离群的文件和与之相关的 INI 文件，与程序相关却不在盘上的文件，以及和程序没有连接

上的快捷方式等。 

3.1.5  CleanSweep运行环境设定 

单击主界面上的 Options按钮，设置界面如图 3-27所示。 

 

图 3-27  CleanSweep运行环境设置界面 

设置选项共分四个标签。 

l Safety Sweep（安全清除）：Fast Analysis（快速分析）：“On”表示只有被 Smart Sweep/Internet 

Sweep记录的程序被分析；“Off”表示全部程序都被分析，操作时间较长。Safety Sweep（安全清

除）：“On”表示只有绿色的项目可以被选择处理，所有被选项自动备份；“Off”表示黄色和绿色

的条目均可被选择处理。 

l Smart Sweep/Internet Sweep：该项在 3.1.1节中已有叙述。 

l Backup Restore（备份/恢复）：Default backup folder 文本框：可以修改默认得备份目录。“In 

Uninstall Wizard, ask if confirmation is wanted”选择是否在卸载向导中显示“确认”提示信息。“In 

Restore Wizard, ask what action to take if file already exists”选择在恢复向导中，如果文件存在，是

否显示“确认”提示信息。Remind me if any backups created while uninstalling are older than选择如

果备份文件过期，是否显示“确认”提示信息。 

l View（浏览）：View Master Log 浏览主日志：主日志中保存 CleanSweep 的一切操作。View 

Savings浏览保存情况：浏览 CleanSweep备份占用的空间。View folder Usage浏览文件使用情况：

浏览硬盘详细使用情况，包括硬盘分区、文件夹、文件。Default report file：修改默认报告文件路

径。 

3.2  McAfee UnInstaller 

 

 

 

 

 

全称 Norton Cleansweep 2000 

版本 4.70 

类别 商业软件 

主页 http://www. symantec.com/ 



常用工具软件大全 64

 Mcafee的UnInstaller是和Norton CleanSweep齐名的程序卸载和硬盘清理工具。它为用户提供了快速、

安全、和方便地清理计算机系统的强大功能。用户可以使用 UnInstaller卸载、转移和压缩备份应用程序，能够

清理硬盘中的垃圾文件，包括从网络下载的多余文件。被 UnInstaller删除的文件，以后需要的时候还可以重新

恢复。 

启动UnInstaller，程序界面如图 3-28所示。界面是典型的Mcafee风格，左边有四个功能选项，分别为Uninstall

（卸载）、CleanUp（清理）、Advanced（高级）、Activity Log（活动日志）每个功能选项下面还有子功能选项。

下面介绍程序的具体功能。 

 

图 3-28  UnInstaller主界面 

3.2.1  清理磁盘空间 

清理硬盘空间的功能主要集中在 CleanUp 选项中。单击 CleanUp 按钮，程序给出三个子功能选项：

SpaceMaker、QuickClean、PowerClean。以下分别介绍。 

1．SpaceMaker（整理空间） 

 单击 SpaceMaker 按钮，一般每次启动 UnInstaller，第一次执行操作前，程序都会先给出对话框如

图 3-29，询问今天是否安装过新的应用程序，如果是，单击 Yes，程序重新分析检测系统，更新数据库。否则

直接单击 No即可。 

 

图 3-29  询问“是否安装了应用程序” 

随后程序给出向导界面如图 3-30。在其中的驱动器列表框中选择需要整理的硬盘分区。下方的 As much as 

possible复选框表示整理出的硬盘空间越多越好，一般默认选择即可。 

 单击 Next，选择可以被删除的文件类型。Junk files（垃圾文件）包括临时文件、回收站中的文件、

备份文件、Internet缓存文件；Non-critical files（非重要文件）包括帮助文件、安装文件、字体文件、压缩包文

件、屏保、墙纸等；Multimedia files（多媒体文件）包括WAV、JPG、AVI等各种类型的多媒体文件；Old date 

files（超过一定时间的过期文件）。单击 Settings按钮，可以设置删除操作前需要备份的文件类型和文件过期时

间,如图 3-31。 
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图 3-30  SpaceMaker向导之一 

 

图 3-31  SpaceMaker向导之二 

 单击 Next，程序开始检查指定硬盘分区，并显示检查进度。如果需要中止操作，单击界面中的 Stop

按钮。检查完成后，显示结果如图 3-32所示。选择左边目录窗口中的任一类型，右边的文件列表窗口中列出该

类型的所有文件。单击任一文件左边的小复选框可以选中或取消该文件。 

 单击 Next，在界面中的文件列表框中确认需要删除的文件。“Create a backup of the deleted files in：”

复选框表示生成被删除文件的备份，如果选中该项，可以在下面的文本框中设置备份文件的存放文件夹，或单

击右边的 Browse按钮进行文件夹的定位。Confirm the deletion of all files选择是否删除文件前是否进行确认，如

图 3-33。 
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图 3-32  SpaceMaker向导之三 

 

图 3-33  SpaceMaker向导之四 

 单击 Next，程序程序开始整理操作，并显示操作进度。如果需要中止操作，单击界面中的 Stop 按

钮。检查完成后，显示整理结果。单击 Finish，回到主界面。 

2．QuickClean（快速清除） 

QuickClean可以安全地清除整个硬盘中无用的文件和快捷方式以及注册表中无用的项目等。 

 单击 QuickClean按钮，程序给出向导界面如图 3-34。在 Cleaner列表框中选择需要进行清除操作的

项目。 
 单击 Next，程序开始对整个硬盘进行检测，同时显示检测进度。完成后给出检测结果如图所示。可

以单击每一项目前面的“＋”号查看详细信息,如图 3-35。 
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图 3-34  QuickClean向导之一 

 

图 3-35  QuickClean向导之二 

 单击 Clean，程序开始进行清除操作，完成后给出清除结果。单击界面中的 Finish，回到主界面。 

3．PowerClean（强力清除） 

PowerClean为高级用户提供了强大的文件管理功能。在这里主要可以完成如下操作： 

l 删除、压缩、移动或复制选定的文件或程序组。 

l 找出和一个选定文件相关联的所有应用程序。 

l 可以对程序组进行管理，生成自定义的程序组。 

l 可以添加程序和文件到系统的“开始”菜单中。 

单击 PowerClean按钮，程序给出操作界面如图 3-36。左边的目录框中包括了很多程序组，单击程序组图标

左边的“＋”号可以将该程序组打开，右边的列表框是打开的程序组中的文件和目录。在一些文件图标的左边

有不同形状的各种彩色图标，其含义为： 

l  ：无论何时都不允许用户删除的文件或注册表项目。 

l  ：对系统安全很重要的文件和注册表项目，默认情况下不允许用户删除，如果一定要删除，可以

单击菜单Options → Settings …，在给出的设置界面中选择PowerClean项目，然后在右边的Never delete 

items marked in red复选框前取消加号。 

l  ：删除前必须仔细考查，因为有可能有应用程序需要此文件和设置。方法是选择该文件后单击鼠

标右键，在弹出的关联菜单中选择 File Links命令，程序给出该文件的使用情况。 

l  ：可以安全删除，不会对系统安全造成任何影响。 
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底部的文本框中的内容由下面的三个按钮控制，这三个按钮分别为 Advice（建议）、Report（报告）、Viewer

（观察器）。 

 

图 3-36  PowerClean操作界面 

为了慎重起见，PowerClean缺省为只读模式，用户不能对其中的项目进行删除、压缩以及移动等操作，如

果需要打开只读模式，可以单击菜单 Options → Settings …，在给出的设置界面中选择 PowerClean项目，然后

在右边的 Read-Only mode复选框前取消加号。 

单击 Options按钮，可以发现下面比平常多出了四个子菜单，上面集中的 PowerClean的所有的操作命令。

进行操作时，首先选择需要操作的程序组或程序组里面的文件，然后选择该菜单上的命令即可。下面简要介绍

一些比较重要的命令。 

在 File菜单或右键关联菜单中， 

l Delete Permanently：彻底删除而不作备份。 

l File Links：在文件列表框中列出使用选定文件的所有程序或文件。如果选定文件为可执行文件，文件

列表框同时也列出该文件执行所需要的所有文件。 

l 在 Tools菜单中， 

l Archive：删除原程序，然后生成保存有程序文件内容、结构的压缩包可供日后恢复该程序。 

l Connect to Start menu：可以添加程序和文件到系统的“开始”菜单中。 

l Create Custom Group：生成自定义的程序组。 

3.2.2  管理应用程序 

1．移动应用程序（Move） 

UnInstaller既可以移动整个应用程序，也可以移动程序内的特定文件，但一般建议用户移动整个程序。 

 单击 Advanced 按钮，选择其子功能 Move，程序给出向导界面如图 3-37。从中选择需要移动的应

用程序图标或其快捷方式（如果选择整个程序组，需要双击该程序组图标，将其打开）。本例中选择“Sonique”

程序组。如果程序不在“开始”菜单或桌面上，可以单击 Browser按钮进行选择。 
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图 3-37  移动向导之一 

 选定需要移动的程序，单击 Next，在中间的文本框中键入移动的目的路径，也可以单击 Browse按

钮进行目的路径的定位。单击 Detail按钮，可以查看移动程序的详细信息。 

 

图 3-38  移动向导之二 

 单击 Move，程序开始移动操作，如果设置的目标文件夹不存在，程序会弹出对话框询问是否新建

该文件夹。操作完成后程序给出操作结果，如图 3-39。单击 Continue，可以继续移动其它程序，单击 Close，

回到程序主界面。 

 

图 3-39  移动向导之三 
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2．卸载应用程序（Remove） 

 单击 Advanced 按钮，选择其子功能 Remove，程序给出向导界面如图 3-40。从中选择需要移动的

应用程序图标或其快捷方式（如果选择整个程序组，需要双击该程序组图标，将其打开）。本例中选择

“QuickTime”程序组。 

 

图 3-40  卸载向导之一 

 单击 Next，如果需要卸载的程序自己具有反安装（uninstall）的特性（现在的Win95应用程序一般

都有），UnInstaller会弹出对话框询问是否利用该程序自己的反安装功能特性，建议选择 Yes。 

 

图 3-41  询问“是否利用程序反安装功能” 

 如果选择 Yes，系统开始运行被卸载程序自己的反安装功能，完成后重新回到 UnInstaller 界面，如

图 3-42。单击 QuickClean按钮，查找程序自己的反安装功能没有清理干净的地方，以确保文件系统和注册表的

清洁。单击 Continue，可以继续移动其它程序，单击 Close，回到程序主界面。 

 
图 3-42  卸载向导之二 

3．压缩应用程序（Archive） 

UnInstaller 的压缩功能就是首先卸载原程序，然后生成保存有程序文件内容、结构的压缩包可供日后恢复

该程序。 

 单击 Advanced 按钮，选择其子功能 Remove，程序给出向导界面如图 3-43。从中选择需要移动的
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应用程序图标或其快捷方式，本例中选择“Kvw3000”程序组。 

 

图 3-43  压缩向导之一 

 单击 Next，程序开始检测，然后给出如下向导界面，如果检测出有和被压缩程序相关联的程序，可

以选择是否将其一起压缩。 

 

图 3-44  压缩向导之二 

 单击 Next，设置存放压缩文件的目标文件夹（可以单击界面中的 Browse 按钮进行定位）、压缩文

件的名称（不超过 32个字符）、压缩文件的描述（不超过 64个字符）。 

 

图 3-45  压缩向导之三 

单击 Next，如果目标文件夹不存在，程序询问是否新建该文件夹，单击 Yes。 
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图 3-46  询问“是否新建文件夹” 

 
 界面中的 Confirm deletion of all files and folders复选框表示删除文件时是否确认。单击 Archive，程

序开始压缩操作。 

 

图 3-47  压缩向导之四 

 压缩完毕，给出压缩操作结果。单击 Continue，可以继续移动其它程序，单击 Close，回到程序主

界面。 

4．传送应用程序（Transport） 
如果想将一台计算机中的某一应用程序复制到另一台计算机中，仅仅将该程序的所有文件拷贝过去，一般

并不能使用。这种情况可以使用 UnInstaller的 Transport功能。Transport功能将该应用程序所有的文件、与之相

关联的动态连接库、系统注册表中相关的项目全部打包成一个 exe文件。将该文件拷贝到另一台计算机中直接

运行即可安装。 

 单击 Advanced按钮，选择其子功能 Transport，程序给出向导界面如图 3-48。从中选择需要移动的

应用程序图标或其快捷方式。本例中选择“UltraEdit-32”快捷方式。 

 
图 3-48  Transport 向导之一 
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 单击 Next，程序开始检测，然后给出如下向导界面，如果检测出有和被传送程序相关联的程序，可

以选择是否将其一起传送。 

 

图 3-49  Transport 向导之二 

 单击 Next，设置存放传送压缩文件的目标文件夹、压缩文件的名称、压缩文件的描述。 

 

图 3-50  Transport 向导之三 

单击 Next，如果目标文件夹不存在，程序询问是否新建该文件夹，单击 Yes。 

 
图 3-51  询问“是否新建文件夹” 

 传送完毕，给出传送操作结果。 

5．监视应用程序安装（Monitor） 

UnInstaller 提供了监视应用程序安装的功能，可以将安装前后系统中的文件和注册表的变化记录在一个压

缩文档中。这样当该应用程序被卸载的时候，可以更安全和彻底。 

可以设置 UnInstaller的自动监视功能。单击程序主界面中的菜单 Options → setting …，在程序给出运行环

境设置界面中选择 BackTrack选项，设置界面如图 3-52。Programs that match a specific name表示监视符合特定

名称的应用程序。可以在 File Names中添加和删除这些特定名称。Compressed and Installshied files表示包括压
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缩的、Installshied类型的安装文件。在界面的最下方可以设置 BackTrack压缩文档的保存天数。 

 

图 3-52  设置 UnInstaller的自动监视功能 

如果选择了自动监视功能，启动系统后会自动加载 UnInstaller gardian程序，在系统任务栏中显示一个红色

的小图标。如图 3-53。 

 

图 3-53   UnInstaller gardian的 Tray图标 

在该图标上单击鼠标右键，在弹出关联菜单中通过 Load on startup命令，可以选择系统启动时是否加载程

序的自动监视功能。也可以在“开始”菜单中的 UnInstaller程序组里选择“Mcafee gardian”程序而直接启动自

动监视功能。 

如果没有设置自动监视功能，或遇到程序不能识别的安装程序，可以自行设定监视。 

 在程序主界面中单击 Advanced按钮，选择其子功能 BackTrack，程序给出界面如图 3-54。 

 单击上图中的Monitor按钮，程序弹出如图 3-55所示对话框，在文本框中键入需要监视的安装程序

的路径和名称，或单击 Browse按钮在弹出的文件列表框中进行文件定位。 

 
图 3-54  手动监视安装之一 
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图 3-55  手动监视安装之二 

 单击Monitor按钮，程序开始运行选定的安装程序并自动记录其安装过程。对于一般的安装程序，

UnInstaller会自动检测到安装过程的结束，弹出如图确定对话框。 

 

图 3-56  手动监视安装之三 

单击“确定”，程序要求输入文字，用于描述生成的记录安装过程的压缩文档。 

 
图 3-57  手动监视安装之四 

 单击 OK，监视过程结束。 

6．卸载监视过的应用程序 

对于监视过的应用程序，在记录安装过程的压缩文档的帮助下，其卸载会更加安全和彻底。 

 在程序主界面中单击 Advanced按钮，选择其子功能 BackTrack，程序给出界面如图 3-58。 

 

图 3-58  BackTrack向导之一 

 直接单击 Next，在界面中的列表框中选择欲卸载应用程序的压缩文档，单击 Delete 按钮可以删除

列表框中选择的压缩文档。可以程序下面的文本框中键入压缩文档的存放路径，也可以单击 Browse 按钮进行

路径定位 
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图 3-59  BackTrack向导之二 

 单击 Next，程序开始卸载选定的应用程序，完成给出卸载信息。单击 Finish，完成卸载操作。 

3.2.3  恢复文件和应用程序 

UnInstaller可以恢复压缩过或备份过的文件或应用程序。 

 在程序主界面中单击 Advanced按钮，选择其子功能 Restore，程序给出界面如图 3-60。界面下面的

下拉列表框可以选择压缩文件夹或备份文件夹。如果文件夹不是缺省的，可以单击 Browse 按钮进行定位。选

择文件夹后，上面的文件列表框中列出该文件夹中的压缩或备份文件。如果想删除某一文件，可以单击 Delete

按钮，选定某一文件后，单击 Next。 

 

图 3-60  Restore向导之一 

 在界面中的下拉列表框中选择文件的覆盖方式，默认选择为“用最新的文件覆盖最旧的文件”。下

面的 Yes和 No单选按钮表示当覆盖文件时是否进行确认。 
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图 3-61  Restore向导之二 

 单击 Restore，程序开始进行恢复操作，完成后给出操作结果。单击 Finish回到主界面。 
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大多数用户都使用Windows提供的资源管理器来进

行日常的文件管理，如果你对此觉得不太满意，可在此

使用本章介绍的Windows Commander和 Explor2000，两

者均是功能强大的文件管理工具，足可以让Windows的

资源管理器“下课”。 

对于查找大量的同类文件（如 Word文件），如果一

个个的用相关的应用程序打开来查看，一定非累得吐血

不可。这时文件观察器就派上了用场。QuickView Plus

是这方面最著名的工具软件。该工具目前可支持 225 种

以上的常用的文件格式，用户可以随心所欲的查看各种

文档内容，十分方便。 

在日常应用中，如用软盘拷贝文件、利用 Email 发

送文件，会经常用到文件分割这项功能。本章介绍的 1toX

可以说是这方面的翘楚。 

 

 

第四章  文件管理 

 

＝＝ 本章导读 ＝＝ 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

4.1  Windows Commander 

 

 

 

 

 

 

 Windows Commander 是一个基于 windows 95/nt环境的功能强大的文件管理工具。该软件可以方便地

管理 windows系统中的磁盘文件，并集中了压缩文件管理、文件拆分、ftp连接、文件过滤、快速查看等文件工

具，程序全面支持 windows95的 drag&drop技术，用一只鼠标就可以完成各种对文件和目录的操作。 

4.1.1  程序界面介绍 

从开始菜单启动Windows Commander，由于Windows Commander是共享软件，未注册时，启动后先弹出

版本 4.03 

类别 共享软件 

主页 http://www.ghisler.com/ 

功能 文件管理 
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提示对话窗口，需要按照窗口中的数字提示，用鼠标点击其中的数字按钮才能进入程序主界面，如图 4-1。 

 

图 4-1  Windows Commander主界面 

WINDOWS COMMANDER的界面有两个系统文件列表窗口，所有的文件管理操作都在这两个窗口中进行，

拖动中间的分隔栏可以调整两个窗口的大小比例。在程序界面中除了菜单和工具条外，其文件列表窗口的下部

还有命令输入栏和常用快捷按钮。 

4.1.2  文件基本操作 

1．复制 

点击左窗口上方的驱动器下拉列表框，选择盘符。列表中的“/”符号是访问网络邻居的选项。如图 4-2。 

 

图 4-2  选择驱动器 

拖动文件列表窗口的滚动条，双击选择的文件目录，文件窗口就可列出该目录下的文件。点击鼠标右键选

择需要复制的文件，选取的文件项将显示红色。如图 4-3。 

 
图 4-3  选择文件/文件夹 

按下键盘的 F5键，或用鼠标单击程序界面底部的 F5Copy按钮，出现如图 4-4所示的对话框。 
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图 4-4  复制文件对话框 

在该对话框中设置文件的目的路径（如果输入一个不存在的目录，则 Windows Commander 建立一个新目
录），也可以单击 Tree按钮，在关联的系统目录结构列表中进行定位。单击 OK按钮，完成复制操作。 

Windows Commander全面支持Windows95的 Drag&Drop技术，进行文件/文件夹复制时，可以在一个文件
列表窗口中选择需进行复制的文件/文件夹，在另一个文件列表窗口中使目的路径可见，使用鼠标拖曳需进行复
制的文件图标到目的文件夹图标即可。如果是建立新目录，在文件列表窗口中定位目的路径后，单击程序界面

底部的 F7MkDir按钮，在出现的对话框中输入新目录的名称即可。 

2．删除 
删除文件或文件夹时，可首先在文件列表窗口选择好相应的对象，然后按下按下键盘的 F8 键或单击程序

界面底部的 F8 Delete按钮，此时程序给出一个警告对话框，单击 Yes确认删除操作。此外，直接按键盘的 Delete
键也可以。 
如果希望直接对文件进行彻底删除，可在程序菜单条的 Configuration → Options → Operation 项的

“Win95/NT specific”框中禁止使用“F8/DEL delete to recycle bin”项，如图 4-5，被删除的文件将不放入回收
箱中。在删除时使用 Shift ＋ F8/Delete组合键也可以。 

 

图 4-5  文件删除设置 

3．移动/重命名 
对于文件/文件夹的移动/重命名，可在选择好需进行操作的对象后，按下键盘的 F6键，或用鼠标单击程序

界面底部的 F6RenMov按钮，出现如图 4-6所示的对话框。在其中键入相应的目的路径/新的文件名，然后单击

OK确认。 

 

图 4-6  移动/重命名对话框 



常用工具软件大全 

 

81 

移动文件或文件夹时，同样可以像复制那样，在两个文件列表窗口中使用鼠标拖曳进行。但在用鼠标拖曳

时要同时按住 Shift键，到达目标路径时，松开鼠标左键就会出现移动/重命名对话框。单击 OK确认。 

重命名文件或文件夹时，先单击选择需要操作的文件/文件夹， 再单击一下，就会出现文本框，输入新的

名字即可(不要连续双击，连续双击是运行或打开文件)。 

4.1.3  文件选择与查找 

1．文件/目录选择 

Windows Commander提供了两种多个不连续对象的多选功能，一种是使用类似 Norton Commander的对象

多选功能，就是使用鼠标右键、空格键、小键盘的 Insert 键等三种方法进行多个不连续文件的选择；另一种是

使用标准的Windows 95提供的对象的多选功能，也就是使用鼠标左键＋键盘的 Ctrl和 Shift键进行多个对象的

选择。程序默认的是第一种方法。 

我们可以根据自己的喜好来设置。单击程序界面菜单条的 Configuration → Options → Operation项，在其

中的Mouse selection mode框中进行设置，如图 4-6。Use right mouse button（as in NC）表示使用类似 NC的鼠

标右键多选功能；Left mouse button（Windows standard）表示使用标准的Windows 95提供的对象的多选功能。 

2．文件查找 

单击界面菜单中的 Command → Search命令，弹出如图 4-7所示的对话框。 

 
图 4-7  查找文件对话框 

在 Search for文本框中键入需进行扫描的完整的文件名或特征字符，在 Search for文本框中键入扫描范围，

可以单击旁边的 Drive按钮，选择驱动器。选择 Search archives复选框，可以同时扫描程序能够识别的压缩文

件包。选择 Find text复选框,可以按照键入的字符串是否包含在文件内部来检索文件。 单击 Start search按钮，

程序开始进行扫描工作，扫描结果以列表形式显示在界面下方的列表框中。 

4.1.4  查看与编辑文件 

Windows Commander并没有提供文件观察器，而只是利用系统提供的 Notepad进行文件观察操作。在程序

界面中的系统文件窗口中选择需进行观察的文件，使用鼠标单击程序界面下方的 F3View按钮，或直接按下 F3

键即可。 

如果要编辑文件，首先在程序界面中的系统文件窗口中选择需进行编辑的文件，使用鼠标单击程序界面下

方的 F4Edit按钮，或直接按下 F4键即可。 

系统还提供了外部扩展文件观察器和编辑器的程序接口，设置步骤如下： 

单击程序界面菜单 Configuration → Options，在弹出的界面中选择 Edit � View标签，设置界面如图 4-8。 
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图 4-8  设置外部文件观察器和编辑器 

在 Viewer for F3项中可以设置外置文件观察器。选择 External Viewer，单击 Associations按钮，弹出对话框

如图 4-9所示。在这里可以设置和某一具体类型的文件相关联的程序。例如在右上角的下拉文本框中输入 bmp，

在 Associate with文本框中输入关联的程序，也可以单击“New type …”按钮，在关联的系统文件列表窗口中选

择关联程序。完毕后单击 OK。 

 

图 4-9  设置外置文件观察器 

在 Default文本框中可以设置缺省的文件观察器，可以直接输入外部文件观察器的文件名及其所在路径，也

可以用鼠标单击该文本框旁边的浏览按钮，在关联的系统文件列表窗口中选择关联程序。建议选择 Quick View 

Plus！for Windows 95作为缺省的观察器。 

在 Editor for F4项中可以设置外置文件编辑器。可以直接输入外部文件编辑器的文件名及其所在路径，也

可以用鼠标单击该文本框旁边的浏览按钮，在关联的系统文件列表窗口中选择关联程序。 

4.1.5  改变文件/文件夹的属性 

单击程序菜单中的 File → Change attributes命令，弹出如图 4-10的设置界面。在 Change attributes项中设

置相应的文件属性，如果选择要进行操作的对应文件夹下的所有文件，选中 Recurse subdirectories 复选框。如

果要更改文件的创建日期（我们不能更改文件夹的创建日期），单击 Change date/time复选框，然后在其中的 Date

和 Time文本框中设置新的文件创建时间。单击 OK,保存设置退出。 
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图 4-10  改变属性对话框 

4.1.6  压缩包管理 

Windows Commander提供了非常强大的压缩包管理功能，在程序的系统文件列表窗口中，用户可以像使用
文件夹一样使用压缩包和其中的文件。双击压缩包文件图标，即可打开盖压缩包，而且可以像使用普通文件一

样对压缩包内的文件进行操作。虽然程序提供了文件压缩操作功能，但用户必须首先在系统中安装相应的压缩

工具，否则压缩操作并不能实现。例外的是对于 ZIP格式，程序提供了独立压缩功能。 
1．设置文件压缩选项 
单击菜单条中的 Configuration → Options命令，然后单击 Packer标签，设置界面如图 4-11所示。 
这里是有关非 ZIP的压缩格式的设置。Treat archives like directories表示把压缩包当作文件夹对待。如果需
要设置某一压缩格式的压缩工具，例如 RAR格式，在 RAR Packer文本框中键入该压缩程序的路径和文件名，
也可以单击右边的浏览按钮进行文件定位。Use internal un-RAR if possible表示尽可能使用内置 ZIP解压缩功能。 
下面对 ZIP格式进行设置。单击 Zip packer标签，设置界面如图 4-12所示。 
在 ZIP项中，ZIP packer表示设置 ZIP压缩工具，ZIP unpacker设置 ZIP解压缩工具。Use internal ZIP packer

复选框表示使用程序内建的 ZIP压缩功能，Always use internal unzipping（if possible）表示使用程序内建的 ZIP
解压缩功能。Internal ZIP comression（0-9）项，设置程序在压缩过程中使用的压缩比。Directory for temporary files
（internal ZIP）项，设置压缩过程中可使用的临时工作目录。Additional Settings项中有两个选项，“Use 8.3 short 
filenames”表示将基于Windows 95的长文件名改为 DOS的 8.3格式、Set ZIP date to file newest date表示设置压
缩包的创建时间为压缩包文件中最新的文件的创建时间。 
设置完毕后，就可以进行压缩包的创建和扩展操作。 

 

图 4-11  设置非 ZIP压缩工具 
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图 4-12  设置 ZIP压缩工具 

2．创建压缩包 

在程序界面的系统文件列表中选择需要进行压缩的文件或文件夹，单击菜单条中的 File → Pack …命令，

程序弹出文件压缩设置对话框，如图 4-13所示。 

 

图 4-13  文件压缩设置对话框 

在该对话框中的 Packer 项中选择需创建的压缩包格式，单击下面的 Configure按钮，可以进行前面所述的

压缩格式的设置。在 Pack files to the archive文本框中键入压缩包文件的保存路径和文件名，也可以单击 Tree

按钮在列出的目录树中进行保存路径的定位。“Also pack path names （only recursed）”复选框表示保存被压缩

对象的路径。Recursively pack subdirectories复选框表示在对文件夹进行压缩时，连同该文件夹下的所有子目录

及其中的文件一同压缩。Multiple disk archive是设置多卷压缩（只对 ZIP和 ARJ格式适用）。Create self extracting 

ZIP archive表示生成自解压文件。单击 OK，程序开始压缩操作。 

3．扩展压缩包 

在程序界面的系统文件列表中选择需要进行扩展的压缩包文件，单击菜单条中的 File → Unpack specific 

files …命令，程序弹出文件扩展设置对话框，如图 4-14所示。在该对话框中的文本框中键入文件扩展的目的路

径，单击 OK即可。 

 
图 4-14  文件扩展设置对话框 
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如果只想扩展压缩包内的部分文件，可在程序的系统文件列表窗口中打开相应的压缩包，然后在其中选择

需进行扩展的压缩包文件，按以上方法进行操作即可。 

4.1.7  文件分割 

文件分割就是将一个大的文件分成几个小的文件，以便于存储和网络传输。当要使用时，在将分割成的小

文件合并成成大文件。 

首先选择需要分割的文件，单击菜单 Files → Split Files命令，弹出对话框如图 4-15所示。 

在文本框中键入原文件的保存路径，也可以单击 Tree按钮在列出的目录树中进行保存路径的定位。在 Bytes 

per file下拉列表框中选择分割后文件的大小然后单击 OK即可。 

 

分割成的文件中将有一个 RCR后缀名的索引文件，该文件记录了拆分文件的信息。如果要合并文件，只需

先选定索引文件，再单击菜单命令 Files → Combine Files即可。 

Windows Commander 的文件分割功能并不强大，它不能生成自动合并的分割文件，想要合并 Windows 

Commander分割的文件，系统中必须安装Windows Commander。 

 

图 4-15  分割文件对话框 

4.2  Explor2000  

 

 

 

 

 

 

 Explor2000 是一个 Windows95/98 环境下的优秀的文件管理器。程序全面支持对象拖曳，一只鼠标即

可完成绝大多数文件管理操作。程序提供了独立双窗口显示方式，与多数基于 Windows 的应用程序不同，

Explor2000并没有提供菜单条，而是全部采用功能按钮，或者是按钮关联菜单，类似Mac机的界面风格，看上

去非常漂亮。如图 4-16。 

 

图 4-16  Explor2000主界面 

版本 1.52 

类别 共享软件 

功能 文件管理 

主页 http://www.cmaufroy.com/ 
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Explor2000集合了Windows的 Explorer、Microsoft Winfile和 Norton Commander的全部优点，使用非常方

便。 

4.2.1  自定义程序界面 

Explor2000提供了两个独立的文件列表窗口，用户可以改变这两个窗口的排列形式。例如单击图 4-16工具

栏中的  按钮可以切换成横向排列形式。如图 4-17。 

 

图 4-17  横向排列文件列表窗口 

每个窗口的工具条最左边都有一个  按钮，通过该按钮可以将每个窗口拆分为一个树形文件夹列表窗

口，和一个与之关联的文件列表窗口，如图 4-18，这样既可以在单个窗口/单一驱动器列表操作，也可在不同的

窗口/驱动器列表之间操作。 

 

图 4-18  拆分窗口 

单击界面中的  按钮，可以将界面在单窗口和双窗口中切换。单击界面中的  按钮，可以交换两个

窗口的位置。 

用户还可以控制文件列表窗口的文件显示方式和排列方式。 

以下五个按钮可以控制文件的显示方式。 

l  ：以缩略图的形式显示图片，不显示其他文件。界面如图 4-19所示。 

l  ：以大图标方式显示文件。 

l  ：以小图标方式显示文件。 

l  ：以列表方式显示文件名。 

l  ：以列表方式显示文件的详细信息。 
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图 4-19  以缩略图方式显示图片 

以下四个按钮可以控制文件的排列方式。 

l  ：按文件名称顺序排列。 

l  ：按文件名称逆序排列。 

l  ：按文件长度排列。 

l  ：按创建日期排列。 

4.2.2  文件管理 

1．复制 

对于文件/文件夹的复制，程序支持 Windows 的对象拖曳。在界面中的两个列表窗口中使需要复制的文件

和复制目的路径都可见，在一个窗口中选择需要复制的文件（利用键盘的 Ctrl、Shift键配合鼠标左键可以选择

多个文件），然后使用鼠标拖曳选择的对象图标到另一个窗口中的目的文件夹图标上（或者是本列表窗口中的文

件夹），松开鼠标左键即可。需要注意的是，程序默认如果是在不同的驱动器之间进行文件拖曳操作，表示进行

复制操作，如果是在同一驱动器的不同路径之间交换文件，程序默认是移动文件。 

2．移动 

在界面中的两个列表窗口中使需要复制的文件和复制目的路径都可见，在一个窗口中选择需要复制的文件

（利用键盘的 Ctrl、Shift键配合鼠标左键可以选择多个文件），然后使用鼠标拖曳选择的对象图标到另一个窗口

中的目的文件夹图标上（或者是本列表窗口中的文件夹），松开鼠标左键即可。 

Explor2000的文件列表窗口支持鼠标右键菜单，使用鼠标右键单击要复制或移动的文件/文件夹，程序会给

出关联的右键菜单，这是典型的系统菜单，在其中可使用系统提供的粘贴、复制、剪切功能实现文件/文件夹的

复制或移动。 

3．重命名 

最简单的方法是使用 F2键。或者使用鼠标左键单击选择某一文件/文件夹，然后单击该文件/文件夹名称（两

次单击不要间隔过短），，可以发现文件名被反显，周围有一个方框，用户在其中输入新的名字即可。 

4．删除 

可在选择好删除对象后，按下键盘的 Delete键即可。这实际上是系统提供的，所有的删除文件也会被保存

到系统的回收站中。如果不需要保存，可使用“Shift + Del”组合键进行删除操作。 

5．新建 

对于新建文件/文件夹，可首先切换到相应路径，然后在文件列表窗口的空白位置单击鼠标右键，在程序给

出的关联菜单中选择 New命令，在其子菜单中提供了创建文件夹 Folder，已经在所有系统注册表中设置可以新

建的文件列表，使用鼠标直接选择，即可完成创建。 
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4.2.3  文件观察与编辑 

程序提供了一个文件内容观察器 Fast View，该功能会自动识别被打开的文件，并提供正确的显示方式。使

用 Fast View，可以在文件列表窗口中选择需要查看的文件，然后单击菜单栏中的  按钮即可。该项功能并

不仅仅是一个文本观察器，程序可以很好的识别并支持 bmp、gif、jpg、png、tif、pcx、wmf、ico 格式的图形

文件和 Zip压缩文件，它也可以根据不同的打开文件类型提供不同的功能，如图形文件的显示控制、压缩文件

的文件列表。图 4-20为查看 Zip压缩文件包的界面，其中列出了压缩包内文件的详细信息。 

 

图 4-20  查看 Zip压缩文件包 

这个观察器也提供以十六进制方式打开文件，并支持字符串的复制、查找、替换、打印等功能。如图 4-21

为打开一个文本文件的界面。 

单击界面中的  按钮，程序以十六进制打开该文件，如图 4-22。 

     

图 4-21  打开一个文本文件                   图 4-22  以十六进制方式打开文件 

对于文档文件的编辑，程序没有提供编辑器，而是使用Windows提供的写字板和记事本，如果需要编辑这

些格式的文件，最直接的方法就是使用鼠标双击相应的文件名，系统即可调用与之有关联创建的应用程序打开，

这样编辑起来更快速一些。 

4.2.4  菜单调用 

Explor2000没有提供菜单条，但是提供了两个菜单按钮。 

单击工具栏左边第一个Main Menu按钮  ，程序给出菜单如图 4-23所示。TaskBark Menu调用系统的

开始菜单。单击Disk，弹出子菜单，上面主要包括Windows常用的磁盘操作命令。单击 Options可以对 Explor2000

进行设置。Save/Restore表示存储或恢复程序和Windows的布局。 

单击工具栏左边第二个Windows Menu按钮  ，程序给出菜单如图 4-24所示。上面列出了Windows系

统内的常用项目，非常方便调用。 
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图 4-23  系统菜单                            图 4-24  Windows菜单 

4.2.5  文件夹比较 

Explorer2000 提供了比较文件夹功能，这样可以快速发现其中的不同。首先在程序界面的两个列表窗口中

打开需要进行比较的文件夹，然后单击按钮条中的  按钮，程序即用不同的图标表示两个文件夹中相同的和

不同的文件，此时的程序界面如图 4-25所示。 

 

图 4-25  文件夹比较界面 

在界面顶端的工具栏中提供了三个与文件比较有关的复选框。Recursive Comparision表示循环比较，Show 

Missing File表示显示不同的文件和 Show Same File表示显示相同的文件。在界面中的比较文件列表窗口按钮条

中，也提供了几个与比较有关的控制按钮，其中包括： 

l  Missing Select：表示选择没有的文件。 

l  Newer Select：表示选择创建日期新的文件。 

l  Older Select：表示选择创建日期旧的文件。 

l  Different Select：表示选择文件大小不同的同名文件。 

l  Similar Select：选择相似的文件（各种属性全部相同）。 

有了这些控制按钮，比较操作就变得简单多了。 

4.2.6  运行环境设定 

单击主界面中的Main Menu按钮，在弹出的菜单中选择 Options命令，程序给出设置界面如图 4-26。其中

共有三个标签。 

l General Hide项中可以设定不显示的项目，包括 DriveBar（驱动器栏）、PathName（路径）、Status 

Bar（状态栏）、Folders（文件夹）、Hidden Files（隐藏文件）、Virtual folder（虚拟文件夹）和 File extensions 

for Known file types（文件扩展名）。在 HighLight项中可以设置高亮显示的文件类型。在Miscellaneous
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项中，Explor2000 AutoRun表示系统启动时自动运行 Explor2000；Save configuration on exit表示退出

程序时保持设置；“FastView： Always On Top”表示 FastView窗口总是在最前面； Automatic sorting 

after drops/deletes 表示自动排列文件；Recursive Comparison 表示循环比较；Open Zip Archive

（double-click）表示双击可以打开 Zip压缩包；Display date in “System Tray”表示在系统任务栏中显

示日期。 

l Colors：可以选择在文件列表窗口中各种类型文件的显示色彩和样式。 

l Picture Browser：选择浏览图片时缩略图的大小。 

 

图 4-26  运行环境设定界面 

4.3  QuickView Plus 6.0 

 

 

 

 

 

 

 QuickView Plus 6.0是基于Windows 95/98/NT环境的非常著名的文档内容观察器。该工具目前可支持

225 种以上的常用的文件格式，包括各种各种文本文件、数据库文件、电子表格、超文本文件和图形文件等，

用户可以随心所欲的查看各种不同平台、不同格式、不同版本的文档内容，十分方便。除此以外，程序还具有

以下功能： 

l 支持微软的中文 Office文档，用户可以不用启动 Office即可查看相关文档； 

l Windows 95系统提供的 Drag & Drop （对象拖曳）技术； 

l 在观察文件内容的同时，可以对文件内容进行复制与粘贴操作。 

l 提供对 ZIP格式压缩文件进行管理的功能； 

l 提供对文本文件的查找功能； 

l 提供文件打印功能，在程序主界面中可以直接将浏览的显示文件输送到本地的打印机中； 

l Win95中内建的 Exchange、E-mail、Internet及有关的网络驱动器，用户可在其中直接使用程序快

速观察文件的内容，如果满足自己的使用要求再下载。 

l 内建文件信息模糊检测功能，即使文件的扩展名不正确，程序仍可以根据文件内部代码进行正常显示

输出。 

 

下面介绍程序的常用功能。 

版本 6.0 

类别 共享软件 

功能 文档内容观察 

主页 http://www. jasc.com/ 
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4.3.1  观察文档内容 

启动 QuickView Plus，程序界面如图 4-27所示。界面中的  按钮，可以显示或关闭目录树窗口和文件

列表窗口。如果需要快速预览和查找文件，可以在程序界面中的目录树窗口和文件列表窗口选择文件，该文件

的内容就显示在右边的文件观察窗口中，十分方便。如果是在系统资源管理器中利用鼠标右键观察文件，建议

关闭目录树窗口和文件列表窗口。 

在系统资源管理器选择需要观察的文件，单击鼠标右键，在弹出的关联菜单中选择 Quick View Plus命令，

可以快速查看文件。程序界面中有个  按钮，此时如果在资源管理器中观察不同的文件，程序将打开不同

的观察窗口。单击该按钮，其图标变成  ，此时程序在观察不同的文件时将使用相同的观察窗口。 

 

图 4-27  QuickView Plus主界面 

QuickView Plus一经启动后即驻留内存，在系统任务栏中的 Tray图标如图 4-28。当关闭了程序的文件内容

观察窗口时，并不会将程序从内存中撤出。如果需要退出程序，可单击主界面菜单条中的 File →Exit QuickView 

Plus命令，或用鼠标右键单击程序的 Tray图标，在弹出的右键关联菜单中选择该命令。 

 

图 4-28  QuickView Plus的 Tray图标 

QuickView Plus还提供了快速打印功能，在系统资源管理器中或程序的文件列表窗口中选择需要打印的文

件，单击鼠标右键，在弹出的关联菜单中选择 Quick Print，程序即将该文档送往打印机打印。 

 

Quick View Plus观察文件内容时，针对不同格式的文件提供了丰富的控制功能。 

1．文档文件 

如果打开的是文档文件，程序提供了编辑、保存副本、调用系统中与之有关联创建的应用程序打开文件等

功能。例如图 4-29为观察Word文档时的程序界面，如果用户想复制粘贴观察内容，可以按住鼠标左键选定需

要复制的内容后，单击工具栏中的  按钮，就可以将选定内容复制到剪贴板中。 

QuickView Plus并不能直接编辑所观察的文件，如果用户希望编辑程序窗口所显示的文件内容，可使用鼠

标单击  按钮（该按钮是显示与观察的文件关联的程序图标，不同类型的文件关联程序会有所不同），也可

以单击菜单命令 File → Open xxx for editing，程序会自动调用系统中已安装的与该文档格式有关联的应用程序

（本例中为Word）对该文件进行编辑。 
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图 4-29  观察Word文档 

如果需要保存程序界面中所显示的文档的副本（含格式），可使用鼠标单击程序界面菜单条中的 File → 

Save Copy命令，并该关联的对话框中设置相应的文件名及保存路径即可。 

如果需要查找，可以在上图中工具栏内的文本框中输入查找内容，然后单击右边的Find Next和Find Previous

按钮即可。 

对于文档观察，程序还提供了三种浏览方式，其中包括 Draft（草稿）、Normal（普通）和 Preview（预览）， 

工具栏中有关文件显示的按钮有： 

l  ：将显示字体放大。 

l  ：将显示的字体缩小。 

l  ：恢复原来的字体。 

l  ：草稿方式观察文件。 

l  ：普通方式观察文件。 

l  ：预览方式观察文件。 

程序也可以采用十六进制的方式观察文件，方法是选择菜单命令 View → View as → Hexadecimal。 

2．图形文件 

打开一个图形文件，程序界面如图 4-30所示。 

 

图 4-30  观察图形文件 

程序提供了比较丰富的图形显示控制功能，可以利用鼠标右键的关联菜单，如图 4-31。 
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图 4-31  鼠标右键关联菜单 

选择 Full screen项，可实现全屏显示；Size项中提供了图形显示方式控制，其中包括适合窗口、满足图形

高度、满足图形宽度、保持图形原有尺寸等四个选项；在菜单中的 Rotation项中提供了图形的显示旋转控制，

直接选择即可；界面工具栏和鼠标右键菜单中都提供了显示缩放功能 Zoom，这样可以方便的控制图形的显示

比例。程序提供了将当前显示的图形文件转换为系统墙纸功能，方法是选择主界面 File菜单中Make Wallpaper

命令，如果显示的图形文件不是 BMP格式，程序会首先将该图形格式转换为 BMP格式，然后再设置成系统墙

纸。 

3．压缩包文件 

QuickView Plus提供了对压缩包内容进行观察的，程序会直接提供压缩包文件列表，此时的程序界面形式

如下图 4-32所示。 

 

图 4-32  观察压缩包文件 

程序不仅可以对压缩包内容进行观察，而且可以扩展其中的文件。在压缩包内容显示窗口中单击鼠标右键，

弹出右键菜单如图 4-33。 

 

图 4-33  鼠标右键关联菜单 

其中包括 Extract This File（扩展当前鼠标指向的单个文件），Extract Selected Files（扩展所选择的多个文件），

Extract All Files（表示扩展整个压缩包）。用户可根据需要在右键菜单中选择相应的命令，程序会给出关联对话

框如图 4-34，在其中选择需要扩展文件的目标路径，然后单击界面中的 OK按钮确定就可以了。界面中的 Stored 

Directories 项中提供了在扩展文件时是否恢复压缩时的文件路径结构设置，程序默认不保留（Ignore），不过需

要保留，可选择 Restore with files复选框。 
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图 4-34  扩展文件对话框 

程序还提供了快速压缩功能。在系统资源管理器中或程序的目录树窗口/文件列表窗口中，选择需要压缩的

对象，然后单击鼠标右键，在弹出的关联菜单中选择 Quick Compress，程序会给出级联菜单，如图 4-35。 

 

图 4-35  Quick Compress系统右键菜单 

其中包括 Create Zip File（生成 Zip压缩包），Add To Zip File（将压缩对象添加到一个已存在的压缩包中），

Add to xxx.zip（直接当前路径下生成和压缩对象同名的 zip压缩包）。  

4.3.2  运行环境设定 

单击程序界面菜单 View → Options，弹出设置界面如图 4-36。 

 

图 4-36  运行环境设定对话框 

其中共有四个标签。 

l General：在该标签项中，Display Quick View Plus logo on startup表示在程序启动时显示启动画面。在
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New Views have项中提供了观察新文件时，是否使用前一次操作设置的运行环境，一般可以选择 Auto，

让程序自己决定。Unsupported File Types项设置当程序打开不能正确识别的文档时，采用何种方式。

Ask user what to do表示弹出对话框询问用户；Open in registered application表示使用程序中相关联的

应用程序进行打开操作；View file as an unknown file type使用程序强行观察。 

l Display：界面中 Default font项可以设置程序使用的默认字体。View unknown file as项设置当程序遇到

不能识别的文件格式时，以何种方式打开，程序提供 Text（文本）、Hexadecimal（十六进制）和 Do not 

view（不进行观察）。Character set for text files项可以程序默认使用的字符库，一般选择 Chinese（GB）

（简体中文）即可。 

l Clipboard：Formats to place on the clipboard 表示可以放置在剪贴板中的格式，一般全部选中即可。

Default font for clipboard项可以设置剪贴板中的默认字体，可以单击 Change按钮进行修改。 

l Navigation：File Navigation Options可以设置目录树窗口和文件列表窗口与文件观察窗口之间的相对位

置。Archive View Options项中有两个复选框，第一个复选框表示观察压缩包时，在一个分隔窗口中显

示压缩包内的文件内容。第二个复选框表示如果压缩包内只包含了一个文件，则将该文件扩展并显示

文件内容。 

程序界面中还有一个设置选项。单击程序界面菜单条中的 View → Configure Quick View Plus命令，或者

是使用鼠标右键单击程序在系统任务条中的 Tray图标，并从关联的菜单中选择 Configure Quick View Plus命令，

可激活创建该应用程序与其他程序的关联功能，如图 4-37所示。 

 

图 4-37  设置与其他程序的关联 

其中有两个标签项。比较重要的是 Application项，界面中提供了可将 Quick View Plus内嵌到其中的应用程

序列表，根据自己的需要直接选取即可。如果需要进阶设置，可选择相应的应用程序列表项，然后单击界面中

的 Properties按钮，程序会给出一个关联的设置界面，在其中单击 Scan按钮，由程序扫描可以内嵌其中的应用

程序主文件，或者单击界面中的 Browse 按钮，自己选择该应用程序。以后在相应的应用程序中可以直接调用

Quick View Plus观察文件。 

4.4  文件分割工具 1toX 

 

 

 

 

版本 1.62 

类别 共享软件 

功能 文件分割 

主页 http://www.logipole.com/ 
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 1toX是一个Windows95/98和 NT4.x环境下的文件切割工具，能将一个大文件分割成几个小文件，并

可以完整将其重新合并。在日常应用中，如用软盘拷贝文件、利用 Email发送文件，会经常用到文件分割这项

功能。 

1toX 切割文件有两种方式。一种是程序给每一个切割的小文件（称 1toX 文件）加上一个用以描述整个文

件的头信息，另一种方式是每一个 1toX 文件只是原文件的一部分（需要生成一个.bat 批处理文件）。分割后的

第一个文件又称根（root）文件。 

所以用户可以生成三种形式的 1toX文件： 

l .1TX：标准的 1toX文件，用户可以添加口令。分割后的文件格式为 test.1tx、test.001、test.002⋯⋯用

户必须利用 1toX来合并文件。 

l .1TB：生成.bat批处理文件，用户不可以添加口令。分割后的文件格式为 test.bat、test.1tb、test.001、

test.002⋯⋯用户执行 test.bat来合并文件。 

l .EXE：自合并 1toX文件，用户可以添加口令。分割后的文件格式为 test.exe、test.001、test.002⋯⋯用

户执行 test.exe来合并文件。 

决定分割后的文件大小有两种方式，一种是用户在分割原文件时选择生成的 1toX文件大小，另一种是程序

根据目标盘（通常是软盘）的剩余容量来确定。为了节省空间，用户在分割原文件可以选择压缩文件。 

1toX 还可以识别和合并其他分割软件生成的分割文件，支持的程序包括 AxMan, Splitter, Splitty, EZSplit, 

MasterSplitter, RZSplit 97, Fsplit, Winfrag等等。 

1toX的程序界面非常简洁，如图 4-38，上面只有几个大的快捷按钮图标，比较重要的是 Cut和 Uncut两个

命令按钮。 

 

图 4-38  1toX程序界面 

下面介绍程序的主要功能。 

4.4.1  分割文件 

 单击程序界面中的 Cut按钮，或单击菜单命令 1toX → Select and Cut，程序给出 select the file to cut

对话框，如图 4-39。在其中选择需要分割的原文件。 

 

图 4-39  选择需要分割的文件 

 单击“打开”按钮，程序给出设置对话框如图 4-40 所示。在该界面中共有两个三个标签，程序首

先给出的是 Cut Options（分割选项）设置界面。 
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图 4-40  设置分割操作参数 

在 Target文本框中可以设置分割文件的存放路径，可以单击右边的浏览按钮进行路径定位。程序还显示了

所选磁盘的容量（只对移动小容量磁盘有意义）。 

在 Format项中用户可以设置生成的 1toX文件的大小。 

l Select：可以选择常见软盘容量（360KB到 4MB之间）和 ZiP软盘容量（100MB或 250MB）； 

l Fixed：用户可以在第一个文本框中自行设定分割文件的大小，在第二个下拉列表框中设置容量单位。 

l Scan：让程序根据目标盘（通常是软盘）的剩余容量来确定分割文件的大小。 

l Slice：用户自行设定生成的分割文件的数量，然后程序根据用户的设定将原文件平均分割。 

在 1toX files suffix项中可以选择生成的分割文件的后缀（除了根文件）。 

在 1toX file type项中可以设置分割类型。1toX一共可以生成三种分割文件，即标准、批处理和自合并。 

选中复选框 Add a password，可以给分割文件设置口令。 

在 Add a comment文本框中可以给生成的根文件添加注释。 

在界面左下方还有一组复选框，其含义分别为： 

l Suppress the original file：压缩后删除原文件（该选项只有选中 Zip the file before splitting时有效）。 

l Short name (8.3)：使用 8.3形式的短文件名。 

l Keep path：保存原文件的路径。 

l Add a CRC check：进行文件校验。 

l Format floppies：向软盘中切割文件时先格式化软盘。 

l Zip the file before splitting：切割文件前先压缩原文件。 

 如果选择切割文件前先压缩原文件，单击 ZIP setup标签，设置界面如图 4-41。 
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图 4-41  设置文件压缩选项 

Maximum of compression表示使用最大压缩比，但压缩时间会长一些。Suppress the original file：压缩后删

除原文件。Target Zip folder可以选择 Zip压缩文件的存放目录。 

 单击“确定”，程序开始分割文件，同时显示操作进度。 

4.4.2  合并文件 

 单击程序界面中的 Uncut按钮，或单击菜单命令 1toX → Uncut，程序给出 select the file to uncut

对话框，如图 4-42。在其中选择需要合并的头文件。 

 

图 4-42  选择需要合并的头文件 

 单击“打开”，程序给出设置对话框如图 4-43。其中共有四个标签，程序首先给出的是 Uncut Options

设置界面。Target folder 可以设置合并后的文件的存放路径，可以单击右边的浏览按钮进行定位。Ask before 

overwrite：当目标路径中含有相同文件名的文件时，询问用户是否覆盖。Delete pieces of files after uncutting：合

并文件后删除原来的分割文件。Create a shorcut with the restored file：给合并文件生成一个快捷方式。Create path 

if it exists in the file：还原被切割的原文件的路径。Unzip：如果分割时选择了压缩文件，则合并文件后自动解压

缩。 
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图 4-43  合并文件选项设置 

单击 Unzip标签，其中 Always Overwrite表示直接覆盖同名文件，Recreate the path表示重新生成路径。 

单击 Check integrity标签，该选项只能对分割时选择 Add a CRC Check复选框的分割文件有效。Check all the 

files表示校验所有文件，Check only the selected files表示只校验选定的文件。单击 Check按钮，程序开始检查

文件的 CRC。 

 单击“确定”按钮，程序开始合并文件。 
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使用计算机要注意系统的维护。Windows95/98不太

稳定的特点大家可能都有领教，如果做好日常的维护工

作不仅能够提高系统的稳定性，而且可以提高机器的整

体性能。在这方面 Norton Utilities 2000无人可以匹敌，

该软件包提供了各种系统维护工具，几乎涵盖了

Windows 下的日常应用的各个方面，在此笔者强烈向用

户推荐。 

本章还介绍了 Norton 家族的另一个成员 Norton 

CrashGuard，有了它，你就再也不怕Windows突然蓝屏，

工作成果来不及保存了。 

System Mechanic是一个小巧的系统维护工具包，程

序虽然不大，但包括了一整套维护系统必备的工具，可

以保证系统安全、快速、高效地运行。 

 

 

第五章  系统维护 

 

＝＝ 本章导读 ＝＝ 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

5.1  Norton Utilities 2000 

 

 

 

 

 

 

 Norton Utilities 2000是 Symantec公司出品的Norton Utilities系列的最新版。Norton Utilities系列从DOS

时代的 NU8到Windows时代的 NU3.0和 4.0，一直是最著名的 PC系统维护工具，作为一个集成的工具箱，它

可以帮助用户查找和修复系统中出现的问题，优化系统的性能，并可以进行预防性的维护工作，是日常维护系

统必备的工具。 

在 NU2000中一共有 18个子工具，比如著名的 Disk Doctor、Speed Disk、Registry Editor等，通过它们可

以实现磁盘检测、磁盘维护和优化、注册表维护等许多功能，基本上涵盖了几乎所有Windows下常用的系统维

版本 4.5 

类别 免费软件（单机个人版） 

功能 系统维护 

主页 http://www. symantec.com/ 
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护和优化任务，同时它也继承了 Norton系列一贯稳定、快速的作风。新版本中每个工具的功能都有所增强，不

同工具之间的结合更加紧密，运行速度也有了一定的提高。在 NU2000中每个子工具都是一个单独的应用程序

软件，可以在系统开始程序菜单的 Norton Utilities程序组中直接调用。 

为了介绍方便，我们启动 Norton Utilities Integrator（NU集成管理器），其中包括了工具箱中所有的工具，

界面如图 5-1所示。 

 

图 5-1  Norton Utilities Integrator主界面 

界面左边是它的四个主要功能分类，右边为相应的子功能。使用的时候，只要利用鼠标来单击需要调用的

功能按钮就可以了。下面我们分别介绍一下如何使用这些功能来维护自己的系统。 

5.1.1  查找和修复工具 

单击 Find and Fix Problems按钮，程序给出四个子功能选项。 

1．Norton System Check 

通过该功能可以对硬盘驱动器、Windows操作系统中的文件和目录结构、重要的系统文件、无效的快捷方

式、注册表等等进行一个全面的检测。 

启动该工具，程序首先给出说明对话框，选中左下角的 Don’t show me this again，下次就不再显示该对话

框。 

 

图 5-2  Norton System Check 说明对话框 

然后用户选择检测项目，在此选择 Check your system（检测系统），其中 Find disk problems表示检测磁盘

错误、Find Windows problems表示检测Windows错误、Improve performance表示改进系统性能、Preventative 

maintenance表示预防维护。如果想恢复程序以前的修改，可以选择 Undo previous repairs。 
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图 5-3  选择检测项目 

程序检测完成后，将检测到的错误显示在界面列表窗口中，如图 5-4 所示。程序还标明错误的严重性，如

High、Medium、Low 等。选择需要修复的项目，单击 Repair 按钮即可。如果需要快速修复程序发现的所有问

题，可选择 Repair All。 

 
图 5-4  显示检测结果 

2．Norton Windoctor 

WinDoctor是一个专门用于维护Windows注册表的工具，使用该工具可以轻松查找到系统注册表中存在的

错误，并提供自动修改。 

启动该工具，程序给出如图 5-5所示对话框。Perform all Norton WinDoctor tests表示选择程序内建的所有检

测项目；Let me choose which tests to run表示由用户选择需要检测的项目；View Repair History and （optionally）

undo change表示查看修复错误历史记录。 
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图 5-5  选择检测项目 

WinDoctor可以把注册表中无效的链接（如空键值等）、错误的设置和反安装时遗留下来的残余信息进行查

找，并将所有的错误分成了 Low、Medium和 High三种对于系统存在危害的等级。查找结果如图 5-6所示。选

择需要修复的项目，单击 Repair按钮即可。如果需要快速修复程序发现的所有问题，可选择 Repair All。 

 
图 5-6  显示检测结果 

3．Norton Disk Doctor 

Disk Doctor（磁盘医生）是 NU2000中的一个磁盘诊断程序，它可以对磁盘的错误与可能导致错误的问题

进行处理，以避免数据的丢失。 

启动该工具，程序给出如图 5-7 所示对话框，从中选择需要诊断的硬盘分区，选中左下角的复选框

Automatically fix error表示自动修复错误。在 Options选项中可以选择是否测试 CMOS、分区表、引导记录、文

件结构、目录结构、压缩磁盘和磁盘表面测试等项目，还可以对文件的时间和日期进行检测，用户可以根据自

己的情况来选择不同的选项进行磁盘扫描。 
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图 5-7  选择需要诊断的硬盘分区 

单击 Diagnose，程序开始检测，如果开始没有选择自动修复，当检测过程中发现磁盘错误时，程序会弹出

询问对话框如图 5-8 所示。用户可以选择修复该错误、修复该路径下所有相似的错误、忽略该错误或忽略该路

径下所有相似的错误。 

 

图 5-8  NDD修复错误对话框 

如果用户选择进行修复，有时程序会给出 Create Undo File对话框，如图 5-9，询问用户是否创建该错误信

息的备份，以便在修复失败时进行恢复，如果需要这样做，可单击 Create按钮，并在关联的对话框中选择需建

立恢复文件的盘符，程序会自动创建一个名为“nddundo.dat”的修复恢复文件，然后程序开始修复错误并继续

进行磁盘检测；如果不需要这样做，可选择 Skip按钮，跳过该项操作直接进行修复。 

 
图 5-9  Create Undo File对话框 

在检测过程中，当进行到检测磁盘表面（Surface Test）时，如果不想检测该项，可以单击 Skip跳过。在整

个检测完成后，Disk Doctor会提供一个详尽的诊断报告。 
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4．UnEraze Wizard 
安全恢复删除的文件。启动该功能，原先桌面回收站的图标就多出一个 Norton独有的盾牌标志。这时用鼠

标右键单击回收站就会多出一个 Empty Norton Protected Files的选项，如果使用该命令来清空回收站，就可以使
用 UnEraze Wizard来恢复文件。 
启动该工具，程序给出反删除向导界面如图 5-10。其中可以选择查找最近删除的文件、搜寻受到 UnErase

保护的或者是硬盘中所有可能恢复的文件。 

 
图 5-10  UnEraze向导之一 

确认恢复模式后单击“下一步”，程序开始寻找原先用户删除的文件，然后将寻找结果显示在如图 5-11 所

示的文件列表框中。选择需要恢复的文件并单击 Recover按钮，该文件就被安全恢复。 

 
图 5-11  UnEraze向导之二 

 5.1.2  优化性能工具 

单击 Improve Performance按钮，程序给出两个子功能选项。 
1．Speed Disk 
磁盘加速工具。通过整理硬盘中的磁盘碎片，来达到加速的目的。每隔一段时间，硬盘上都会生成很多文

件碎片，如果不及时进行整理，会严重降低硬盘的存取速度。Speed Disk不仅对磁盘碎片的整理速度非常快，
而且还可以自定义磁盘碎片整理、优化设置非常出色，可以有效的帮助用户组织磁盘中的文件结构、使磁盘中

各种相关的文件保持连续存放，回收磁盘中自由的剩余空间，提高磁盘数据的存取速度。 
启动该工具，程序首先自动检测 C盘的文件结构，如果发现存在问题，会自动中断并建议用户使用 Norton 

DiskDoctor进行修复，如果未发现问题，会弹出“建议”对话框如图 5-12。并给出程序建议使用的优化方式。
其中 Full Optimization表示进行全面优化；Unfragment Files Only表示只优化不连续存放的自由空间；Unfragment 
Space Only表示只优化不连续存放的自由空间；Optimize Swap File表示是否对虚拟内存交换文件进行优化。 
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图 5-12  Speed Disk建议对话框 

单击 Start按钮，程序开始对磁盘进行优化，不需要用户进行干预。界面如图 5-13所示，其中单击 Hide Map
按钮可以隐藏右边磁盘映像显示。C盘整理完毕，用户可自行设定其他硬盘分区的整理。 
在使用该工具进行磁盘碎片整理时，为保证系统中所有数据的安全，建议用户在进行操作前应将系统中运

行的所有前、后台程序一并关闭，尤其是一些按时间间隔进行磁盘访问的程序。 

 

图 5-13  Speed Disk整理进度示意图 

2．Norton Optimization Wizard 
通过整理 Windows 中几个关键的文件，达到优化操作系统的目的。启动该工具，程序给出如图 5-14 所示
向导界面， 

 

图 5-14  Optimization向导之一 
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单击“下一步”，图 5-15中的复选框 Test my drivers for speed表示测试机器中安装的磁盘存取速度，以便将
该系统的 Swap虚拟交换文件创建到该磁盘中。 

 

图 5-15  Optimization向导之二 

单击“下一步”，图 5-16中的复选框 Configure swap file for optimal perform表示优化Windows虚拟内存交
换文件。 
单击“下一步”，图 5-17中的复选框 Optimize my Registry表示压缩注册表。 
单击“下一步”，单击界面中的 Reboot按钮，程序开始优化注册表，完成后系统重新启动，进行磁盘的优
化整理,如图 5-18。 

 
图 5-16  Optimization向导之三 

 

图 5-17  Optimization向导之四 
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图 5-18  Optimization向导之五 

 5.1.3  预防维护工具 

单击 Preventive Maintenance按钮，程序给出四个子功能选项。 

1．Norton System Doctor 

System Doctor（系统医生）通过多个图例来提供计算机各个主要部件的工作情况，使用户能够及时发现问

题。该工具能够实时监视计算机的工作状态，一旦有问题发生时，它会给你一个预警信号，然后自动解决一些

常见的问题。 

 
图 5-19  Norton System Doctor界面 

用户可以通过 Sensors 菜单向监测窗口中添加内存、磁盘、系统、网络等子项目。从这个窗口中可以了解

硬盘可用空间、CPU的占用率、GDI可用资源等信息，如果想得到某个选项更为详尽的信息，可以双击该选项

图标。在添加完之后，可别忘记让它最小化以图标形式运行在后台。 

对于某些关系到系统健康的子项(如 CPU的占用率、硬盘可用空间等等)，可以通过双击来设置一个最低数

值的安全警戒线。一旦可用资源下降到警戒线时，System Doctor就会自动弹出报警。倘若你发现窗口中的某个

黄灯亮着，就说明已经存在了安全隐患，需要注意一下了；如果红灯亮着，就要马上使用 NU2000中其他的功

能组件来检测系统，因为这时系统已经处于崩溃的边缘。 

2．Norton WipeInfo 

彻底删除文件或文件夹。和前面介绍的 UnErase Wizard相反，该功能可以将硬盘中选定的文件或者是文件

夹彻底删除，无论你使用什么恢复软件也无法将其复原。因为普通的删除只是将文件的首字节改变一下，如果

它原来的磁道还没有被写入的话，还是可以通过其它软件来复原的，但WipeInfo则是在删除之后马上将这个磁

道进行覆盖性写入，使得这个文件做到真正意义上的删除。 

启动该工具，程序首先给出如图 5-20所示界面，选择删除文件还是文件夹。 
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然后单击“下一步”，在图 5-21所示的界面中单击 Add to list将需要删除的文件添加到删除列表中。 

然后根据向导的提示单击“下一步”，最后弹出一个对话框警告次删除是不可恢复的，确认之后就可以将该

文件彻底从硬盘中删除。 

 

图 5-20  Norton WipInfo向导之一 

 

图 5-21  Norton WipInfo向导之二 

3．Image 

对系统结构进行备份。Image 可以迅速把当前系统启动记录、文件分配表和引导信息备份下来。一旦用户

计算机遭到意外的格式化、病毒侵害或者是物理损坏的话，可以通过 Disk Doctor和 UnErase这两个程序来使用

这个备份生成的文件进行恢复。 

启动该工具，程序给出如图 5-22所示界面。先选择相应的驱动器，然后单击 Image按钮， 程序一个 image.dat

文件，而同时自动将最后一次备份的文件更名为 image.bak。 

需要利用备份的 Image 文件进行恢复时，首先将备份的 Image 文件覆盖被损坏分区根目录下的 Image.dat

（应先取消该文件的只读属性），然后调用 Norton Disk Doctor工具，对该损坏分区进行修复，最后还可以运行

UnEraze Wizard查找恢复丢失的文件。 
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图 5-22  Image程序界面 

4．Norton Registry Tracker 

注册表跟踪。实时跟踪注册表的修改记录，以备后用。当 Windows95下，大多数应用程序安装时，通常会

修改Windows的注册表，而这些修改之处在程序反安装的时候往往很难清理干净。Registry Tracer对注册表和

ini文件进行实时的监测，并且可以将修改的内容记录下来，这样在卸载程序的时候就能很方便的将系统恢复到

初始状态。 

启动该工具，它会将注册表中所有变更过的子键打开，如图 5-23所示， 

 

图 5-23  Norton Registry Tracker程序窗口 

从该窗口中可以得知在何时注册表中关于 HKEY_LOCAL_MACHINE 键值更改情况和 Windows 目录、

Windows/System目录下文件改变的情况，同时也提供了 win.ini、system.ini、config.sys和 autoexec.bat这几个文

件的修改状态。 

界面上的菜单栏中各项按钮的作用为： 

l  By File：按文件类型和位置分类显示改动过的文件或键值。 

l  By Snapshot：按照快照日志的版本来显示改动过的文件或键值。 

l  Compare：调用 Norton File Compare程序。 

l  Quick Fix：取消最近的一次改动，并重新生成一份快照日志。 

l  Restore：利用所选择的项目进行恢复，并重新生成一份快照日志。 

程序在每次运行前都会为系统创建一份快照日志，在监视运行期间如果注册表发生改变也会自动生成一份

快照日志。其中如果某个键值或者是文件的备注信息为 Changed，那就说明已经被更改过了，可以在选取该键

值或者是文件后点击工具栏中的 Compare 按钮  ，如果选择的键值或文件在最新的快照日志中，程序会自

动将其与前一版本比较，如果选择的键值或文件在老版本中，程序会询问用户是与该版本的前一版本（Previous）

比较，还是与当前版本（Current）比较。 
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图 5-24  比较版本选择对话框 

选择一种比较版本，程序调用 Norton File Compare进行比较，这时更改的地方会以醒目的红色表示出来，

如图 5-25。 

 
图 5-25  Norton File Compare窗口 

如果想修改，可以单击界面工具栏中的 Edit Text按钮  ，程序弹出如图 5-26所示对话框，单击上面的

Edit Left File按钮或 Edit Right File按钮即可进行修改。 

 

图 5-26  Edit File Selection对话框 

5.1.4  系统信息诊断工具 

单击 Troubleshoot按钮，程序给出四个子功能选项。 

1．Norton Diagnostics 

硬件诊断工具。NU2000中的 Diagnostics是个新增的硬件检测功能，从主板、内存、显卡、键盘和鼠标到

声卡、音箱、调制解调器、打印机，都能使用它来进行全方位的检测。使用时先要选择需要检测的硬件类型，

此时右边的窗口中就显示出当前所选部件的测试内容，单击 Test按钮，程序开始测试，完成后给出测试结果。 
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图 5-27  Norton Diagnostics程序界面 

2．System Information 

系统信息。启动该工具，界面中共有 9个标签来提供系统信息，几乎包括了Windows中设备管理器和物理

属性中所有的信息。但和Windows不同的是，它将所有的信息全部显示在一个页面上，这就使得我们查找相关

的信息更加方便，并且所有提供的信息都很详尽。 

 
图 5-28  System Information程序界面 

在 System和 Drives 标签中，多出一个 Benchmark 按钮，单击该按钮，NU2000 会自动进行测试，例如在

System中，程序给出当前系统的分值以及和其它参考系统的比较，使用户能够直观地了解自己使用的计算机所

处的水平。 

 

图 5-29  Benchmark for System对话框 
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3．Norton Registry Editor 

注册表编辑器，对注册表和一些 ini系统文件进行编辑。 Windows中的注册表是非常重要的，但Windows

附带的注册表编辑器 RegEdit 仅能对注册表维护管理提供有限且十分薄弱的支持，不能满足广大用户的需要。

作为一个优秀的注册表编辑工具，Norton Registry Editor可以编辑、查询、导入、导出注册表项目信息；可以跟

踪监视注册表的变化、恢复改变的部分以及对经常访问的注册表项目定义书签等。 

启动该工具，程序界面如图 5-30所示。 

 

图 5-30  Norton Registry Editor程序界面 

整个界面分成三个部分。左上角为注册表主键目录窗口：以树形结构显示注册表中分类组织的各个主键和

各个系统 INI 文件的区段（Section）。右上角为注册表项目窗口:显示当前主键或者 INI 区段的键名和键值。下

半部位分类窗口：其中的 BookMarks标签中可以让用户定义书签标记，双击该书签可直接跳转到相应的主键中；

Find Results标签中用 Root、Branch、Value和 Data指出查询结果的确切位置；Undo标签中能够将以前注册表

的修改恢复过来，这样在修改注册表时再也不必担心出错了；Tracer History标签中可以调用 Registry Tracer来

查看注册表和其它 ini文件的修改记录。 

下面简要介绍一下 Norton Registry Editor的用法。 

l /恢复注册表 

由于注册表是 Windows 系统中最基本最重要的数据库，所以对注册表进行任何操作前最好先将其备份。

Norton registry Editor支持对注册表的整体或局部备份。 

整体备份：选择菜单命令 File → Backup Entire Registry…，然后指定备份文件的路径和文件名即可。 

局部备份：局部备份是对注册表中部分主键进行备份。首先在主键目录窗口中选择某个主键，选择菜单命

令 File → Export Registry File，然后指定备份文件的路径和文件名即可。 

恢复注册表：恢复注册表是指从备份文件中将注册表进行恢复。选择菜单命令 File →Import Registry File，

然后指定备份文件的路径和文件名即可。 

l /删除主键 

增加主键：在主键目录窗口中选择某个主键，单击菜单命令 Edit → New → Key（单击鼠标右键在关联菜

单中选择该命令也可以），然后填写主键名称即可。 

删除主键：在主键目录窗口中选择某个主键，单击鼠标右键在关联菜单中选择 Delete命令，或直接按下键

盘上的 Delete键即可。 

l 增加、修改、删除注册键名/键值 

在主键目录窗口中选择某个主键，单击鼠标右键在关联菜单中选择新建某一注册键（如二进制、字符串、

数值等），然后填写键名即可。 

修改和删除操作都可以通过鼠标右键快捷菜单的相应项目完成。 

如果想修改某一键值，直接单击该键名，在弹出的对话框中输入键值即可。 

l 查找与替换 

查找：单击菜单命令 Edit → Find，弹出对话框如图 5-31。 

注册表主键目录窗口 注册表项目窗口 

分类窗口 



常用工具软件大全 114 

 
图 5-31  Find对话框 

在 Find What文本框中填入被查找的关键字。Match Whole String Only表示匹配整个字符串。在 Find Where
下拉列表框中选择查找范围：Local Registry（整个注册表）、Local INI Files（所有 INI文件）、Local Registry and 
Local INI Files、Control.INI、System.INI、Win.INI。 

l /删除书签 

定义书签：在主键目录窗口中选择某个主键，单击菜单命令 Bookmarks → Bookmarks This即可。 
删除书签：在界面下方的分类窗口中单击 Bookmarks标签，选择相应的书签后单击菜单命令 Bookmarks → 

Remove Bookmark即可。 
l /打开书签文件 
Norton Registry Editor的书签可以保存到文件中。书签扩展名为 NBK。 
保存：单击菜单命令 Bookmarks → Save Bookmarks，在弹出的保存对话框中设置保存路径和文件名即可。 

打开：单击菜单命令 Bookmarks → Load Bookmarks，在弹出的打开对话框中设置保存文件的路径和文件
名即可。 

l 撤销（Undo） 
单击菜单命令 Edit → Undo，对注册表最新的修改将被取消。 
l 禁止修改 
用户可以设置 Norton Registry Editor禁止修改注册表。方法是选中 Registry菜单中的 Read Only选项。只读

方式防止无意修改注册表，一面造成不必要的损失。 

4．Norton File Compare 
文件比较。该功能只能对以 txt、ini、htm（l）和 sys结尾的文件进行比较。运行后程序会要求打开两个文

件，然后在如图 5-32所示界面中显示。如果两个文件中有不同之处，File Compare会用醒目的红色标识出来，
以供用户修改。 

 

图 5-32  Norton File Compare界面 
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5.2  Norton CrashGuard 2000 

 

 

 

 

 

 

 在Windows95/98系统下经常会出现程序崩溃、非法操作和系统死机等现象，最常见的要算那个“A fatal 

error was occurred as ⋯”的蓝屏了。Norton CrashGuard 就是专门防止系统死机、应用程序死锁的软件，启动后

自动在后台监视系统的运行，在系统任务栏中的图标如图 5-32所示。CrashGuard会自动截获应用程序的崩溃，

为用户提供解决办法，帮助存储正在打开的文件，并能够分析应用程序的死锁，增强的系统的稳定性，减少重

新启动计算机的次数。CrashGuard功能强大，易于使用，而且驻留内存时与其它应用程序的兼容性极好，是非

常优秀的防死机程序。 

 

图 5-32  CrashGuard的 Tray图标 

在 Norton 2000系列中 Norton CrashGuard与 Norton Utilities被整合在了一起。在安装 Norton Utilities时可

以选择安装 Norton CrashGuard，也可以单独安装 Norton CrashGuard。启动 CrashGuard，程序界面如图 5-33。 

 

图 5-33  Norton CrashGuard主界面 

5.2.1  应用程序的崩溃和死锁 

崩溃（Crash）是指某一应用程序试图进行不属于它的操作，从而引起自身或其它应用程序停止运行的情况。

所有的程序都由一系列指令组成，用来执行任务和对用户的操作响应。如果由于某种原因使这个指令链中间断

开，程序就不能继续正确地运行。 

死锁（Freeze）就有些不一样。有时一个程序已经停止运行了，但其界面仍然在屏幕上显示，但不再对用

户或系统的指示有任何反应，这种情况下我们就称该程序死锁了。死锁的发生有时是因为程序在等待此时永远

也不会发生的事件，有时是因为程序处于一个循环的永不停止的任务中。 

崩溃和死锁在这里最大的区别是 CrashGuard自动检测崩溃的发生，并提供给用户从中恢复的手段。因为程

序的死锁和操作系统的某些活动非常相像，所以 CrashGuard不会直接对其进行检测。当应用程序发生死锁时可

以调用 CrashGuard对其进行处理。 

版本 4.01 

类别 免费软件（个人单机版） 

功能 防止系统死机 

主页 http://www.symantec.com/ 
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5.2.2  CrashGuard的功能模块 

CrashGuard有三个功能模块，分别是：Freeze Check（死锁检查），用于程序停止响应而Windows还在响应

的情况下；Statistics（统计），用于统计程序发生崩溃和死锁的次数以及提示是哪部分软件和模块导致错误；Crash 

Assistant（崩溃助手），用于系统已经停止响应的情况。 

1．Freeze Check 

当某一应用程序已经停止响应而 Windows 仍然可以响应的情况下（该程序发生死锁），可以打开 Freeze 

Check功能，最简单的办法是用鼠标左键双击系统任务栏内的 Crash Monitor 的 Tray图标，也可以按下 Ctrl＋

Alt＋Del组合键，在“关闭程序”对话框中调用 FreezeCheck，或在 CrashGuard的主界面中调用。弹出对话框

如图 5-34。在列表中选择已经死锁的应用程序，然后单击 FreezeCheck按钮。 

 

图 5-34  FreezeCheck对话框 

在列表中选择已经死锁的应用程序，然后单击 FreezeCheck按钮。程序调用 Crash Assistant对死锁程序进行

分析，并弹出对话框提供诊断结果的详细信息，如图 5-35，用户可以据此选择相应的恢复选项。一般来说，程

序界面中提供的恢复选项会根据具体的死锁程序而稍有不同。 

 

图 5-35  Crash Assistant界面 

Crash Assistant对死锁程序（frozen program）的分析有如下几种诊断结果。 

l The program is disabled：程序被禁止。现象是程序看起来还在运行，但已经不作任何响应。如果用户
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认为程序还在运行，可以尝试等待；如果想让 CrashGuard 中断程序，可以选择 AntiFreeze 选项。

AntiFreeze 会尽可能让程序重新恢复反应，不过在恢复过程中该程序的功能也可能被削弱，此时应马

上保存以前的工作成果。 

l The program is not responding：程序失去响应。现象是程序看起来还在等待响应，实际上已经停止运行

了。此时使用 AntiFreeze选项，CrashGuard会让程序停止等待，并重新接受用户的命令。 

l The program is not busy：程序在等待输入。在这种情况下，程序的一些控制功能已经被削弱，但某些

部分可能还是好的，还可以接受用户的命令输入。此时使用 AntiFreeze，它会尝试激活程序的其它窗

口。 

l The program appears ready：程序完好，CrashGuard没有发现问题。此时选择 Cancel退出即可。 

Crash Assistant一共提供了五种恢复选项，其中大部分选项在处理应用程序的死锁（Freeze）和崩溃（Crash）

中共用。另外，程序界面中提供的恢复选项会根据具体的死锁程序而稍有不同， 

l Vital Save（适用于 Freeze和 Crash）：用于崩溃时保存程序未保存的数据，同时正常关闭程序。一般处

理含有需要保存数据的应用程序时，才会出现该选项。 

l Quickload（一般针对浏览器程序）：浏览器发生崩溃的原因很多，有时是由于它们自身的程序发生崩

溃，有时则是因为访问的网页引起浏览器崩溃。如果用户正在访问一些比较复杂的网址，而且没有记

录网址，如果此时浏览器发生崩溃，用户重新启动浏览器后就要花费大量的时间重新查找。Quickload

选项可以安全的关闭浏览器，同时重新启动恢复至用户最后一次访问的状态。 

l AntiFreeze（只适用于 Freeze）：我们常会遇到屏幕死锁的情况，也就是一个程序完全停止运行了，但

其屏幕仍然显示在屏幕上，而对于用户或Windows的指令却不作任何反应的现象。AntiFreeze可以帮

助对死锁程序进行解冻，使得用户可继续运行操作。 

l Revive（只适用于 Crash）：发生崩溃时，用户最关心的可能就是要恢复文件，该选项可帮助用户恢复

程序至崩溃前的状态，使得用户可以继续操作。。需要注意的是，虽然用户重新回到程序中，但此时该

应用程序的控制能力及功能可能已经被削弱甚至完全丧失，所以用户首先要马上保存文件，然后重新

启动该程序以避免再次崩溃的发生。 

l Terminate（适用于 Freeze和 Crash）：该选项用于正常关闭程序。此时，程序中最后一次保存后的信息

都将会丢失。如果该程序中的数据并不要紧，Terminate就是最好的选择。 

2．Crash Assistant（崩溃助手） 

当系统中应用程序发生崩溃（Crash）时，Crash Assistant窗口就会弹出，界面如图 5-36所示。 

 

图 5-36  Crash Assistant窗口 

该窗口向用户提供了详细的崩溃信息和恢复选项，以下分别介绍。 

l Crash information（崩溃信息） 
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崩溃信息中会显示崩溃程序的名称、当时发生的情况和程序中正开启的文件。 

l Program and System 序和系统） 

提供了程序的崩溃状态和系统的稳定性情况。对于应用程序的崩溃（Program），各种图标的含义为： 

 ：程序运行发生了较小的故障，但 CrashGuard并没有检测到威胁系统安全的情况。 

 ：程序已经受到一定程度的可以检测到的损害。用户可以回到程序中并继续运行，但程序的功能已经

受到了损害。 

 ：程序的某一组件已经发生严重故障。即使缺少该组件程序仍然能够运行，还是建议利用“Revive”

功能选项对程序进行恢复操作。 

 ：CrashGuard 认为如果继续使用该崩溃程序，系统会发生崩溃。此时用户不应该再使用“Revive”功

能选项，而是直接使用“Terminate”中止程序的运行。 

对于系统状况（System），各种图标的含义为： 

 ：系统稳定性正常，CrashGuard检测不到任何威胁系统稳定性的情况发生。 

 ：CrashGuard认为如果继续使用当前的崩溃程序，系统会变得不稳定。 

l Crash Advisor（崩溃建议） 

根据崩溃程序和系统的具体情况相用户推荐恢复方法。 

l SafeOriginal（初始保护状态） 

 ：表示打开了系统的初始保护功能。所谓初始保护功能（SafeOriginal）是指当一个崩溃程序试图向一

个打开的文件进行写入操作时，CrashGuard立即生成该文件原始状态的一个只读（Read-only）的副本，并将该

副本保存在“SafeOriginal”文件夹中。具体的设置方法可以参考下一节“运行环境设定”。 

 ：表示关闭了系统的初始保护功能 

l Revovery Options（恢复选项） 

提供给用户从当前情况下恢复的方法。在程序崩溃状态下，Crashguard一共提供四种恢复选项：Vital Save、

Quickload、Revive 和 Terminate（没有 AntiFreeze）。具体功能在上一节中已有说明。一般来说，程序界面中提

供的恢复选项会根据具体的死锁程序而稍有不同，在本例中，Crash Assistant界面中提供了 Revive和 Terminate

两个恢复选项。 

如果选择恢复程序，单击 Revive 按钮，程序自动进行应用程序的恢复操作，然后给出如下图 5-37 所示的

对话框，并在界面中给出应用程序可能进行的文件保存操作。 

 

图 5-37  Crash Assistant检测死锁对话框 

如果选择关闭程序，单击 Terminate按钮，Crash Assistant给出如下对话框，询问用户在关闭程序后是否重

新启动该程序（Program），或者是重新引导系统启动（Windows），用户根据自己的需要选择即可。 
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图 5-38  Crash Assistant关闭对话框 

3．Statistics（分析） 

如果某个应用程序死锁过于频繁，用户可以使用该选项来分析。启动 CrashGuard，在主界面中单击 Statistics

按钮，程序给出界面如图 5-39。 

 
图 5-39  CrashGuard Statistics窗口 

单击界面底部的 Clear Statistics 按钮，可以清除界面中的记录。过一段时间再回来查看，可以得知自上次

清除记录后某一程序的崩溃次数。 

5.2.3  运行环境设定 

使用鼠标右键单击系统任务栏中 CrashGuard的 Tray图标，从关联菜单中选择 Settings命令，程序给出设置

界面。 

 

l General（常规） 

在 Crash Assistant项目中，Enable Crash Assitant status表示是否显示 Crash Assistant status对话框，如图 5-37；

Enable Crash Assitant restart option表示显示重新启动对话框，如图 5-38。 

在 Close Program wndow项目中，Enhance Close Program Window表示在Windows的 Alt＋Ctrl＋Del组合键

的关联菜单中提供 CrashGuard的相关按钮。 

在 Splash screens项目中，Disable Splash Screen表示不显示程序的启动画面。 
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图 5-40  General标签 

 

l SafeOriginal（初始安全） 

Enable SafeOriginal 表示当程序崩溃时，制作文件的保存副本，这样可以防止覆盖原有的文件。Create 

shortcuts to SafeOriginal files表示创建保留文件的快捷方式。在中间的文本框中可以输入备份文件的保存路径，

也可以单击旁边的 Browse 按钮进行路径定位。最下边可以设置备份文件在硬盘中的保留天数等，以上一般使

用程序的默认设置即可。 

 

 

 

图 5-41  SafeOriginal标签 

 

l Advanced（高级） 

在此程序提供了应用程序崩溃恢复测试，其中又分为 32位和 16位应用程序的崩溃恢复。 
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图 5-42  Advanced标签 

如果想试一试程序的恢复操作步骤，例如单击 Generate 32-bit crash按钮，程序给出如图 5-43所示对话框。

在其中选择需要测试的崩溃类型，然后单击 Test Crash按钮即可。对于处理应用程序崩溃的具体操作，前面已

有介绍，此处不再给出。 

 

图 5-43  32位应用程序崩溃测试 

5.3  System Mechanic 

 

 

 

 

 

 

 对于普通用户来说，最常用的操作系统是 Windows 9.x。随着时间的推移，安装的应用软件或游戏越

版本 3.5c 

类别 共享软件 

功能 系统清洁 

主页 http://www.iolo.com/ 
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来越多，Windows系统也就随之变得越来越庞大。若是应用程序卸载不完全，会注册表中留下了不少“垃圾”，

有时系统在某些特定情况下还会产生不少“垃圾”文件，使系统运行速度越来越慢，因此做好系统维护工作是

非常必要的。System Mechanic就是这样一款优秀的系统维护工具，程序虽然不大，但包括了一整套维护系统必

备的工具，可以保证系统安全、快速、高效地运行。 

启动 System Mechanic，程序界面如图 5-44所示。 

 

图 5-44  System Mechanic程序界面 

程序内置的工具主要分为三大类：Files类、System类和 Internet类。下面分别介绍。 

5.3.1  文件工具类（Files） 

单击程序主界面中的 FILES按钮，程序给出如下四个工具选项： 

1．Find and remove junk and obsolete files 

查找和清除垃圾文件。大部分Windows 9.x环境下的应用软件在运行时会生成一些临时文件，一般来说，

程序关闭时这些临时文件会被自动删除，但如果程序出错或是死机，这些临时文件就会因此而保存下来。同时，

运行硬盘检测程序或整理碎片程序也会产生一些“垃圾”文件。长期以往便会造成硬盘空间的浪费，并且极有

可能导致新的程序错误。SYSTEM MECHANIC可以查找并清除这些危害系统安全的“垃圾”文件（如*.tmp、

*.??~、*.---、*.gid等）。 

单击该功能选项，程序给出如图 5-45所示对话框。 

 

图 5-45  查找和清除垃圾文件对话框 

其中有 5个标签： 
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l Drive（s）to Scan：指定查找文件的驱动器。 

l Files to Find：选择查找文件的类型。 

l Folders：用于添加或排除查找文件的文件夹。该标签有上下两个文件夹列表区，其中上面的列表区用

来添加要查找的文件夹，该文件夹的所有文件都将会被自动查找。下面的列表区用于添加要排除的文

件夹，该文件夹中的文件将不会被查找。如果想添加文件夹，单击旁边的 Add Folder按钮，在弹出的

Select Directory对话框中选择需要添加的文件夹即可。如果想删除已有的文件夹，在文件列表区选中

该文件夹后，单击旁边的 Remove按钮即可。 

l Other Considerations：该标签中有五个复选框：Only find files that have not been accessed in xx days表示

仅查找 xx天未使用得文件，Skip read-only and system files表示查找时跳过只读文件和系统文件；Skip 

files that are currently being used by their associated application表示查找时跳过正在被当前活动的应用程

序使用的文件，以免将其删除造成应用程序的崩溃；Find unused files in the Windows "Temporary" folder

表示查找Windows临时文件夹中不再使用的文件；Find zero length files表示查找零字节文件。 

l Removel：设置被删除文件的处理方法。Move removed files to recycle bin表示将被删除的文件移到系

统回收站中。Permanently delete removed files表示永久性删除文件。“Move removed files to：”表示将

被删除文件移到指定的文件夹中。 Confirm before removing files复选框可以选择删除文件前是否确认。 

选择完毕，单击界面中的 Scan按钮开始查找，完成后界面变成如图所示。 

 

图 5-46  查找垃圾文件结果对话框 

在界面下边显示出找到的文件列表，选择需要删除的文件（可以利用 Ctrl键或 Shift键配合鼠标左键选择多

个文件），直接单击文件列表上方的 Remove按钮即可。也可以单击 Remove按钮右边的下拉按钮，弹出菜单如

图 5-47。 

 

图 5-47  Remove下拉菜单 

Remove Selected File（s）表示删除选定文件。Remove all listed files表示删除所有文件。用户也可以在要删

除的文件上单击鼠标右键，从关联的快捷菜单中选择响应的删除命令。 

2．Find and fix broken shortcuts 

查找和修复被损坏的快捷方式。这些快捷方式已经与目标程序脱离了关联，如果该目标程序还存在的话，

可以利用该功能进行修复。 

单击该功能选项，程序给出如图 5-48所示对话框。 
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其中有 2个标签： 

l Where to look：指定查找的驱动器。在驱动器列表框下方有三个复选框：Only scan Start Menu表示仅

查找开始菜单中被损坏的快捷方式；Automatically scan for moved shortcut targets表示自动查找与被损

坏的快捷方式关联的程序；Exclude shortcuts with targets referring to CDROM or network drives表示查找

时排除 CDROM和 Network网络驱动器。 

l Removal：设置被删除快捷方式的处理方法。具体内容与查找垃圾文件工具中的 Removal选项相同。 

单击界面中的 Scan按钮开始查找，完成后，在文件列表框中显示被损坏的快捷方式。同时列表窗口上方会

显示三个按钮：Remove用于删除无效的快捷方式；Find target用于查找和快捷方式关联的程序，如果找到关联

程序，可单击 Fix shortcuts进行修复。 

 

图 5-48  查找和修复快捷方式对话框 

3．Find and remove duplicate files 

查找和删除重复文件。单击该功能选项，程序给出如图 5-49所示对话框。 

 

图 5-49  查找和删除重复文件对话框 

其中有 6个标签： 

l Drive（s）to scan：指定查找的驱动器。 

l Files：设置查找文件的方式。All Files表示查找所有文件。“Files named …”表示按指定的文件扩展名

查找文件，选择该单选按钮，界面中出现文件扩展名列表框，可以单击旁边的 Add、Edit 和 Remove
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按钮来添加、编辑和删除列表框中的扩展名。 

l Folder：指定查找的文件夹。All Folders表示查找所有文件夹。“Folders named …”表示查找指定的文

件夹，选择该单选按钮，界面中出现文件夹列表框，可以单击旁边的 Add、Edit 和 Remove按钮来添

加、编辑和删除列表框中的文件夹。 

l Exclusions：排除查找的文件和文件夹。上面的“Excluded Folders …”列表框用于添加排除查找的文件

夹，下面的“Exclued Files…”列表框用于添加排除查找的文件。 

l Find Options查找选项设定。在 Requirements for Duplicate Matches项目中：Same date & time表示查找

日期和时间相同的文件；Same name表示查找同名文件； Same size表示大小相同的文件。在 Advanced 

Options 项目中，Use floppy drive contents as master file list 表示查找与软盘内容相同的文件；Skip 

SYSBCKUP folder跳过查找系统备份文件夹；Skip Windows Virtual folders跳过查找Windows虚拟文件

夹。Skip zero-length files跳过查找零长度文件。 

l Removal：设置删除重复文件的处理方法。单击 Scan按钮开始查找，完成后，在对话框中显示出找到

的重复文件列表。对于不需要的文件，单击选中后，在单击 Remove 按钮删除。单击 Exclude Folder

按钮可以输入下次查找时排除的文件夹。 

4．Securely delete files and folders 

安全删除文件。当用户使用Windows回收站删除文件时，这些文件很容易使用一些特殊的软件来恢复。使

用该工具可以永久性地删除文件，并消除任何恢复的可能。单击该功能选项，程序给出如图 5-50所示界面。 

 

图 5-50  Incinerator对话框 

单击界面中的 Install Incinerator按钮，程序在桌面上建立一个“焚烧炉”（Incinerator）图标。如图 5-51所

示。 

 

在系统的资源浏览器中想要彻底删除的文件/文件夹上单击鼠标右键，在关联的右键菜单中会比平时多出一

项命令 Send to Incinerator，如图 5-52所示。 

               

                        图 5-51  Incinerator桌面图标              图 5-52  系统右键关联菜单 

单击该命令，程序将被选择的文件送入“焚烧炉”中，打开焚烧炉，其界面和系统的资源浏览器差不多。

在“文件”菜单中有几项重要的命令：Restore表示恢复选择的文件，Incinerate Selected表示彻底删除选择的文

件，Incinerate All表示彻底删除“焚烧炉”内所有的文件。 
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5.3.2  系统工具类（System） 

1．Clean system Registry 

清除系统注册表中的垃圾信息。启动该功能选项，程序给出如图 5-53所示对话框。 

 

图 5-53  注册表清理优化对话框 

其中有三个标签： 

l Scan Options： 用于指定查找的根键。 

l Undo Information：用于对注册表进行操作后，恢复原先的注册表信息。 

l Backup \ Restore：备份和恢复注册表。其中 Perform Complete Registry Backup Now表示对注册表进行

备份，Restore From a Backup File表示对注册表进行恢复。 

单击 Scan Registry按钮，程序开始扫描注册表，完成后将在列表框中显示无效的项目，选择需要清除的项

目，单击 Remove按钮即可。 

2．Windows StartUp manager 

Windows启动程序管理。启动该功能选项，程序给出界面如图 5-54。 

 
图 5-54  启动管理器窗口 

窗口中列出了Windows启动时自动运行的程序文件。单击选中某个程序后，可以使用工具栏上的按钮对其

进行各种操作。其中 Disable表示禁止Windows启动时执行该程序；Enable表示将禁止后的程序重新恢复；Add

用于添加启动时执行的程序；Edit 用于编辑或查看启动程序的描述信息、执行的程序文件和其位置。Delete 表

示从列表框中删除不需要的启动文件。 
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3．Customize Windows settings 

定制Windows特性。使用该项功能，用户可以随心所欲的修改Windows中的各项特性。启动该功能选项，

程序给出如图 5-55设置界面。 

 
图 5-55  定制Windows特性对话框 

界面左边提供了多种设置选项，下面我们对其中常用的几种给予介绍。 

l Start Menu（“开始”菜单）：单击 Alphabetize Start Menu Programs按钮，程序会将系统“开始”菜单

中的快捷方式和程序组按字母顺序排列。Make Control Panel applets accessible directly from Start Menu

表示在“开始”菜单中建立一个程序组，通过该程序组可以直接访问系统控制面板中的各种设置选项。

Show Favorites folder表示显示“收藏”文件夹。Show Documents folder表示显示“文档”文件夹。Start 

Menu reaction speed滑动条可以设定“开始”菜单的响应时间。 

l CD-ROM：Automatically start data CDROM's when they are inserted表示当插入光盘时自动运行上面的

可执行程序。Automatically start playing audio CD's when they are inserted表示当插入 CD时自动播放。 

l Windows Explorer（Windows资源管理器）：Use Explorer when opening "My Computer"表示打开“我的

电脑”时使用Windows资源管理器，对于习惯使用资源管理器的用户可以选中该复选框。Place “Open 

with...” on explorer right click menu在资源浏览器中的鼠标右键菜单中加入“打开方式”命令（系统

默认单击鼠标右键时需要按下 Shift键才能出现该命令）。Automatically refresh open explorer windows 

when changes occur当有变化发生时自动刷新打开的资源浏览器窗口。 

l Appearance：Automatically focus windows when mouse passes over them表示当鼠标移动到某一窗口上方

时自动激活该窗口。Display arrows on shortcut icons表示在快捷方式的图标左下角显示小箭头。 

l 以上各项设置只有重新启动系统后才会起作用。 

l Boot / Shutdown该项目中有三个标签。在 Boot Menu标签中，Enable F4, F5, F6, F8 as boot keys表示允

许使用 F4, F5, F6, F8 作为启动选择键。Automatically show boot menu at startup表示系统启动时自动显

示启动菜单。Boot Parameters 标签中可以设置各种启动参数，不过一般缺省设置即可。在 The Boot 

Screens标签中，可以选择是否显示启动（startup）画面、“Please wait …”画面、关闭（shutdown）画

面，而且可以单击“Change screen”按钮来选择自己喜好的画面（Bmp文件，而且最好是 256色以下）。 

4．Remove invalid uninstaller information 

删除系统中无效的 Uninstall信息。在系统控制面板中有一个“添加/删除”选项，可以利用它来卸载应用程

序，不过有些软件在卸载后信息仍然保留在“添加/删除程序”中。 

启动该功能选项，程序给出如图 5-56所示界面。程序将查找得到的无效信息显示在列表框中。选择需要删

除的项目，单击上方的 Remove按钮即可。 

5．Safe Installer 

安全安装。用户可以使用该功能选项进行软件安装。在安装过程中自动监视被安装软件对系统的改变，完

成后生成一个报告文件，用户可通过查看该报告文件了解安装软件对系统的改动。启动该功能选项，界面如图
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5-57所示。 

 

图 5-56  删除无效连接对话框 

 

图 5-57  安全安装对话框 

该对话框共有六个标签： 

l Action：该标签中有两个单选按钮。单击下面的单选按钮可以生成一个未安装软件之前的报告文件，

以便和软件安装后生成的报告文件进行比较。单击上面的单选按钮，需要在 Install program框中输入

安装程序的名称，在 Report Description框中输入报告文件的描述文字。 

l Comparison Options：在上面的磁盘列表框中指定监视软件安装时将被改变得磁盘。下面有两个单选按

钮：Compare files time（faster）表示按文件改变的时间进行比较，安装完成后如果文件时间不同则表

示该文件被改变，速度较快。Compare entire Disk contents（More Reliable）表示比较整个磁盘内容，

更安全可靠。 

l Files：指定跟踪的 INI文件。 

l Ready：指定报告文件的存放位置。 

l Snashot：单击界面中的 Start按钮开始安装程序。完成后，单击 Done：Report按钮生成报告文件。 

l Report：显示报告文件。该标签只有在报告文件生成后才会出现。使用该项功能不能进行应用程序的

卸载和恢复，所以不太实用。 

5.3.3  Internet工具类（Internet） 

1．Ensure your Privacy 

保护个人隐私。在 Windows 系统下，用户通常会留下自己的“行踪”，如“开始”菜单中“文档”文件夹

下的文件列表、运行对话框中的程序名称、保存在硬盘中的 Internet Cache、Cookie等。使用该功能选项可以清

除以上内容。 
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启动该功能选项，程序给出如图 5-58所示对话框。 

 

图 5-58  The Eraser对话框 

该对话框中共有四个标签： 

l General：该标签中有四个复选框。Erase "Find Files or Folders" history表示清除“开始”菜单中“查找

文件或文件夹”对话框中的历史记录；Erase "Find Computer..." history表示清除“开始”菜单中“查找

计算机”对话框中的历史记录；  Erase "Start -> Run..." history表示清除“开始”菜单中“运行”对话

框中的历史记录；Erase "Start -> Documents" history表示清除“开始”菜单中“文档”文件夹中的文件

列表记录。 

l Internet History：该标签中有四个复选框。Erase Internet Cookie Files表示清除 Internet Cookie文件；Erase 

Internet Cache information表示清除保存在硬盘中的 Internet Cache内容；Erase recently typed URL list 

from browser表示清除在浏览器地址栏中的 URL地址列表记录；Erase history record files of visited web 

pages表示清除浏览器中曾经访问过的Web页的历史记录。 

l Internet Explorer Specific：该标签只适用于 IE浏览器。其中可以设置 Internet Cache中内容的保存天数。 

l America Online：清除保存在硬盘中的 Cache中美国在线的内容。对于国内用户来说，没有什么用处。 

l Other：设定其他应用程序的历史记录，包括：MS Office系列、Windows媒体播放器、Real Audio Player、

Winzip、Outlook Express和 Opera浏览器。 

2．Optimize Internet and network speed 

优化网络速度。单击该功能选项，程序调用内置的NetBooster工具，界面如图 5-59所示。其中包括四个标

签： 

l Optimizations：优化网络配置。在 Your connection type 下拉列表框中设置网络类型。    单击 Use 

optimum settings for your configuration按钮，NetBooster将根据用户的网络类型和其他一些因素为用户

设定最佳的网络配置。建议普通用户使用该种方式。单击 Edit settings manually按钮可以让用户手工设

定各种网络配置参数。单击 Restore settings before using NetBooster按钮可以恢复使用 NetBooster优化

前的网络设定。 

l Diagnostics：分析网络的数据流量。界面下方有三个数据分析显示区，分别为 Incoming Data（流入数

据流量）、Outgoing Data（流出数据流量）和 Total Data（总数据流量）。Network Transfer Statistics项

中显示了数据流入、流出和总的传输速率。Graph Style项中可以设定下方数据分析图表的形式，缺省

为 3D条形图。界面上方有两个滑动条：Transfer Interval表示数据采集时间间隔；Data Points表示数

据分析显示区中的图形包括多少个数据点（历史纪录） 

l Relative Speed Test：相关速度测试。Test to perform可以设定测试的数据流量：100K、500K或 1M。

用户还可以自行选择测试文件，选中Manually specify a file to download单选按钮，在 HTTP file URL

文本框中键入测试文件的 URL。Display in项选择数据显示单位：Byte或 KB。程序下方数据显示区显

示的数据分别为：Elapsed Time（已经进行的时间）、Data Received（接收到的数据流量）、Current Speed

（当前传输速度）、Average Speed（平均传输速度）以及 Peak Speed（最高传输速度）。 

l Logs：操作记录。 
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图 5-59  NetBooster对话框 

5.3.4  其他功能选项 

1．Maintenance Wizard 

维护向导。该向导中包括了三项维护内容：查找和清除垃圾文件、清理注册表和清除 Internet 遗留文件。

使用该功能，单击程序主界面上方的Maintenance Wizard按钮，一步步按向导的指示操作即可。具体步骤在此

不再介绍。 

2．Scheduled Maintenance 

计划维护。程序可以根据用户的设定自动对系统进行定时维护。单击程序主界面下方的 Scheduled 

Maintenance按钮，程序给出对话框如图 5-60所示。 

 

图 5-60  定期维护对话框 

计划任务共有三项：Junk Files（清理垃圾文件）、Privacy（保护个人隐私）和 Registry Cleaner（清理注册

表）。对于每一项，选中 Enabled复选框表示启动该项计划任务。对话框中还有一个标签 General Options，可以

设定当磁盘剩余空间低于指定值时自动执行计划维护任务。 

对话框右方有三个按钮。单击 Change Schedule 按钮，在打开的对话框中可以设定维护的具体时间；单击

Define Actions按钮，可以设定每一项计划任务维护的具体内容；单击 Run Now按钮，可以对系统马上进行维

护。 
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本章集中了和硬件相关的几个工具。PartitionMagic

是硬盘分区管理的最好工具，可以在不破坏硬盘数据的

前提下，对硬盘分区进行随意的改变。 

现在的硬盘容量越来越大，主流硬盘的容量动辄几

十 G，所以可以有条件利用硬盘空间来虚拟光盘，这样

既可以得到飞快的速度，也不用将光盘来回插取，避免

了光驱的损耗。Virtual Drive 是目前最好的虚拟光驱工

具。 

现在的超频热潮一浪高过一浪，对于超频的用户来

说，CPU降温软件 CPUIDLE 和系统监控软件 MBProbe

实属必备的工具。而且现在不光 CPU，显卡也要超频，

对于这些用户，PowerStrip可以轻松地满足你虐待显卡的

要求。 

 

 

第六章  硬件管理 

 

＝＝ 本章导读 ＝＝ 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

6.1  硬盘分区 PartitionMagic 5.0 
 

 

 

 

 

 PartitionMagic是由 PowerQuest公司推出的硬盘分区工具。最新版本是基于Windows95/NT的 5.0版。

PartitionMagic最突出的功能是：可以在不破坏硬盘中原有数据的情况下，将硬盘中的剩余空间根据自己的需要

进行重新划分。通过它，可以实现对硬盘分区的创建（Create）、删除（Delete）、格式化（Format）、更改容量

（Resize）、移动（Move）和隐藏（Hide）等操作。PartitionMagic支持世面上流行的各种操作系统，如 DOS/Windows

的 FAT16和 FAT32、WindowsNT的 NTFS、OS/2的 HPFS和 Netware、UNIX等网络系统的文件系统，并支持

各种文件系统的格式转换。 

版本 5.0 
类别 / 
主页 http://www.powerquest.com/ 
功能 硬盘分区、硬盘管理 
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6.1.1  界面介绍 

启动 PartitionMagic 5.0，操作界面如图 6-1所示。 

 

图 6-1  PartitionMagic 5.0主界面 

l 工具栏 

工具栏中包括了大部分常用的操作。如果系统中装有多个驱动器，可以从最左边的下拉列表框中选择需要

操作的驱动器。剩下的按钮介绍如下： 

 Resize / Move Partition：更改分区容量/移动分区。 

 Create Partition：创建新的分区。 

 Delete Partition：删除分区。 

 Set Label for Partition：设置卷标。 

 Format Partition：格式化分区。 

 Copy Partition：复制分区。 

 Check Partition for errors：检查分区。 

 Partition Information：分区信息。 

 Apply the changes that are pending：应用所做的改动。 

 Discard the changes that are pending：取消所做的改动。 

l 分区映像图 

分区映像图按比例显示了所选驱动器所有的分区，每个分区用不同的颜色表示它所采用的文件系统。逻辑

分区显示在扩展分区中，映像图中还显示了没有分配的自由空间（不属于任何分区的空间）。 

l 分区列表 

分区列表显示了每一分区的详细信息：盘符、卷标、文件系统类型、容量、所用和未用空间、是否是活动

分区以及是主分区还是逻辑分区。 

l  

向导可以一步一步地引导你完成一些常用的分区操作任务，这对于初级用户尤其适用。向导中主要包括四

种操作。 

·  Create new partition：创建新的分区。 

·  Resize partitions：更改分区容量。 

·  Redistribute free place：重新分配自由的空间。 

·  Merge Partitions：合并分区。 
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6.1.2  常用分区操作 

1．更改分区容量/移动分区 

 启动 PartitionMagic，如果系统中有多个硬盘，在工具栏最左边的磁盘下拉列表框中选择需要操作

的硬盘。 

 在分区映像图或分区列表中选择需要更改容量的分区盘符。也可以单击菜单 Partitions选择。 

 单击工具栏上的 Resize � Move Partition按钮  ，弹出“Resize / Move Partition”对话框，如图

6-2所示。也可以单击菜单命令 Operations → Resize / Move …，或在分区映像图或分区列表中需要更改容量的

分区盘符上单击鼠标右键，在弹出的关联菜单中选择 Resize / Move…，效果相同。 

其中各项的含义为： 

l Free Space Before：在原分区前面开辟自由空间（不属于任何分区的空间）。 

l New Size：更改后的分区容量。 

l Free Space After：在原分区后面开辟自由空间。 

l Cluster Size：定义簇的大小（建议不要修改）。 

还可以在该界面上部的分区映像图中直接修改。如图 6-3 所示，分区的边界线像两个“把柄”一样，当把

鼠标移动到其上方时，鼠标的形状变成双箭头  ，按下鼠标左键拖动“把柄”即可得到所需的分区容量。

当把鼠标移动到中间时，鼠标的形状变成十字箭头，按下鼠标左键，可以左右移动整个分区，改变该分区前后

的自由空间。 

 

图 6-2  “Resize / Move Partition”对话框 

 

 

 
图 6-3  分区映像图示意 

  设置完毕，单击 OK，回到主界面，可以看到分区映像图和分区列表中已经发生了相应的变化。这

只是预览结果，如果对预览结果不满意，想恢复到原来的状态，可以单击“Discard …”按钮  ，或单击菜单

命令 General → Discard Changes。如果对预览结果满意，可以单击“Apply …”按钮  ，或单击菜单命令

General → Apply Changes，程序开始对分区进行操作。 

2．创建新的分区 

 在工具栏最左边的磁盘下拉列表框中选择需要操作的硬盘。 

 在分区映像图或分区列表中选择一块未分配的自由空间。也可以单击菜单 Partitions选择。 

 单击工具栏上的 Create Partition按钮  ，弹出 Create Partition对话框，如图 6-4所示。 
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图 6-4  Create Partition对话框 

其中各项的含义为： 

l Creat as：生成逻辑分区（Logic Partition）或主分区（Primary Partition）。如果该分区装有别的操作系

统，应该设置成 Primary Partition；否则采用缺省格式 Logic Partition，它将从属于原来的 Primary 

Partition。 

l Partition Type：可选择的格式有： 

·  FAT：分区格式为 FAT16。 

·  FAT32：分区格式为 FAT32。 

·  Hpfs：OS/2的文件系统格式，一种 IBM开发的操作系统分区格式。 

·  NTFS：Windows NT的文件系统格式。 

·  Linux ext2：Linux分区格式。 

·  Linux Swap：Linux交换分区格式。 

·  Unformatted：未定义的格式。 

如果操作系统为Windows98，建议选择 FAT32。 

l Label：设置卷标。 

l Size：设置创建分区的容量。 

l Position：可以选择： 

·  Beginning of free space：在自由空间块的前部创建新分区。 

·  End of free space：在自由空间块的后部创建新分区。 

 设置完毕，单击 OK，回到主界面，可以看到分区映像图和分区列表中已经发生了相应的变化。如

果想恢复到原来的状态，可以单击按钮  ，否则单击按钮  ，程序开始对分区进行操作。 

3．删除分区 

在分区映像图和分区列表中选择需要删除的分区盘符。单击工具栏上的 Delete Partition 按钮  ，弹出 

Delete Partition 对话框，如图 6-5。输入 OK确认删除操作，然后单击 OK即可。 

 

图 6-5  Delete Partition 对话框 

4．更改分区卷标 

在分区映像图或分区列表中选择需要更改卷标的分区盘符。单击工具栏上的 Set label …按钮  ，弹出对

话框如图 6-6，输入 OK确认删除操作，然后单击 OK即可。 
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5．格式化分区 

在分区映像图或分区列表中选择需要格式化的分区盘符。单击工具栏上的 Format Partition 按钮  ，弹

出对话框如图 6-7，输入 OK确认删除操作，然后单击 OK即可。 

     
   图 6-6  Label Partition对话框             图 6-7  Format Partition对话框 

6．复制分区 

在工具栏最左边的磁盘下拉列表框中选择需要操作的硬盘。在分区映像图或分区列表中选择一块未分配的

自由空间，单击工具栏上的 Copy Partition按钮  ，弹出对话框如图 6-8。在 Disk下拉列表框中选择目标磁

盘，然后在下面的分区映像图或自由空间块列表中选择一个未分配的自由空间块。完成后单击 OK即可。 

 

图 6-8  Copy Partition对话框 

7．合并分区 

在工具栏最左边的磁盘下拉列表框中选择需要操作的硬盘，在分区映像图或分区列表中选择一块未分配的

自由空间。单击菜单命令 Operations → Merge…，弹出对话框如图 6-9所示。 

在Merge Options项中选择将哪一个分区作为第一分区（合并后扩大的分区），将哪一个分区作为第二分区

（被合并的分区），该分区内的所有文件将被作为一个目录并入第一分区。在Merge folder项中设置第二分区的

目录名称。在 File System Type项中选择文件系统类型。 

选择完毕，单击 OK确定即可。 
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图 6-9  合并分区对话框 

6.1.3  其他功能介绍 

1．格式转换 

选择需要转换格式的分区，例如是 FAT格式（即 FAT16），打开菜单 Operations→ Convert，则上面的 FAT to 

FAT32命令可见，单击该命令，程序给出确定对话框，单击 OK即可。 

2．隐藏分区 

选择需要转换格式的分区，单击菜单命令 Operations → Advanced → Hide Partition …，程序给出确定对话

框，单击 OK即可。如果想取消隐藏，可以单击菜单 Operations → Advanced → Unhide Partition…。 

3．驱动器映射（DriveMapper）工具 

在创建、删除和隐藏分区时，各个分区的盘符标识会发生变化，这会使某些应用程序不能正常运行。驱动

器映射（DriveMapper）工具专门用于当用户创建了新的硬盘分区而导致系统的磁盘分区盘符重新分配后，调整

Windows系统中相关应用程序与磁盘分区盘符有关的配置信息。 

 在 PartitionMagic的主界面中，单击菜单命令 Tools → Drive Mapper，程序首先弹出一个 Introduction

对话框。 

 单击 Next继续，程序弹出如图 6-10所示对话框，可以在其中设置盘符变化任务列表。 

单击界面中的 Add按钮，程序弹出对话框如图 6-11所示。在其中设置原始盘符（Original drive letter），变

化后的新盘符（New drive letter），如果进行了分区的合并操作，设置合并时第二分区的目录（Merge folder）。 

 

图 6-10  创建任务列表对话框 



常用工具软件大全 

 

137 

 

图 6-11  添加任务对话框 

 设置完毕，单击 Finish，程序开始复制分区。 

4．移动向导（MagicMover）工具 

移动向导工具，可以将一个硬盘分区中已经安装过的Windows应用程序完整的移动到另一个分区中，在移

动过程中，可以自动实现该应用程序的所有文件的移动，并可自动修改该应用程序在系统中的所有配置信息。 
 首先在 PartitionMagic的主界面中，单击菜单命令，程序给出向导界面如图 6-12所示。 

在右边的程序列表框中选择需要移动的程序，如果希望节约搜索时间，可以单击“Options …”按钮，在弹

出的对话框（如图 6-13所示）中选择程序所在的分区和目标分区，单击 OK回到上一层界面。 

 

 

图 6-12  MagicMover向导之一 

 

图 6-13  Options对话框 
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 单击下一步继续，程序经过检索后，给出如图 6-14所示的向导界面，在 Select the destination folder

文本框中设置移动的目标文件夹，也可以单击 Browse按钮，进行文件夹定位。 

 

 

图 6-14  MagicMover向导之二 

 

 设置完毕，单击Move按钮，如果目标文件不存在，程序会询问是否建立新的文件夹，单击“是”，

程序开始移动操作。完成后给出结果对话框。单击 Close回到主界面。 

 

 

图 6-15  MagicMover向导之三 

 

 

6.1.4  使用向导 

新版本的 PartitionMagic强化了向导的功能，程序中一共提供了四个向导功能，以下分别介绍。 

1．Creat new partition（创建新的分区） 

 单击程序界面上向导栏内的按钮，程序给出介绍对话框，如果想进一步得到详细信息，单击 Hint

按钮。 
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图 6-16  Create New partition向导之一 

 单击 Next，程序询问是否安装新的操作系统，如果不安装，保持缺省设置 No，如图 6-17所示。 

 单击 Next，选择新建分区的文件系统格式，如果是使用Windows95 OSR2以上版本，请选择 FAT32，

如图 6-18所示。 

 

图 6-17  Create New partition向导之二 

 

图 6-18  Create New partition向导之三 

 单击 Next，选择分区类型，如果前面选择不安装新的操作系统，这里只能选择 Logical（逻辑分区）。 
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图 6-19  Create New partition向导之四 

 单击 Next，选择新建分区的位置。 

 

图 6-20  Create New partition向导之五 

 单击 Next，选择从哪些分区中分割自由空间。 

 

图 6-21  Create New partition向导之六 

 单击 Next，设定新分区的容量和卷标 



常用工具软件大全 

 

141 

 

图 6-22  Create New partition向导之七 

 单击 Next，程序给出前后分区变化示意图，单击 Finish，完成操作。 

 
图 6-23  Create New partition向导之八 

2．Resize Partitions 

 单击程序界面上向导栏内的按钮，程序给出介绍对话框，如果想进一步得到详细信息，单击 Hint

按钮。 

 

图 6-24  Resize Partitions向导之一 

 单击 Next，选择需要更改容量的分区。 
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图 6-25  Resize Partitions向导之二 

 单击 Next，输入更改后的分区容量。 

 

图 6-26  Resize Partitions向导之三 

 单击 Next，如果上一步中分区容量变小了，程序会询问将释放出的空间给那个分区。如果如果上一

步中分区容量变大了，程序会询问将从哪个分区中取得额外的空间。 

 

图 6-27  Resize Partitions向导之四 

 单击 Next，程序给出更改后的结果，单击 Finish回到主界面。 
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3．Redistribute free space（重新分配自由空间） 

如果系统中有空闲的自由空间，可以使用该项功能将这些自由空间重新分配利用。 

 单击程序界面上向导栏内的按钮，程序给出介绍对话框，如果想进一步得到详细信息，单击 Hint

按钮， 

 
图 6-28  Redistribute free space向导之一 

 单击 Next，选择接收自由空间的分区。 

 
图 6-29  Redistribute free space向导之二 

 单击 Next，程序给出更改后的结果，单击 Finish回到主界面。 

 
图 6-30  Redistribute free space向导之三 

4．Merge Partitions 

 单击程序界面上向导栏内的按钮，程序给出介绍对话框，如果想进一步得到详细信息，单击 Hint

按钮， 
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图 6-31  Merge Partitions向导之一 

 单击 Next，选择第一个分区（合并后扩大的分区）。 

 

图 6-32  Merge Partitions向导之二 

 单击 Next，选择第二个分区（被合并的分区），该分区内的所有文件将被作为一个目录并入第一个

分区。 

 

图 6-33  Merge Partitions向导之三 

 单击 Next，填入文件夹的名称。 
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图 6-34  Merge Partitions向导之四 

 单击 Next，选择合并后分区的类型 

 

图 6-35  Merge Partitions向导之五 

 单击 Next，程序警告将改变盘符。 

 单击 Next，程序给出更改后的结果。单击 Finish，回到主界面。 

6.1.5  使用注意事项 

最后强调一下使用 PartitionMagic进行磁盘分区操作时，需要注意的事项。 

l 进行分区操作前应进行硬盘数据备份，至少应将硬盘中最为重要的部分文件进行备份，以便由于操作

不慎导致系统崩溃时进行恢复。 

l 在运行 PartitionMagic时，尽量不要同时运行其他程序。 

l 不要在压缩盘中安装运行 PartitionMagic。 

6.2  CPU降温 CpuIdle 5.6 

 

 

 

 

 

 

版本 5.6 

类别 共享软件 

主页 http://cpuidle.home.pages.de 

功能 CPU降温 
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 现在的 CPU频率越来越高，速度越来越快，发热量也越来越大（尤其是 AMD的 K6、K7系列），再

加上很多发烧友都希望能将自己的 CPU 超频使用，能以较少的 money 换取更快的速度和更强整体性能，这样

CPU的散热就成为了一个非常重要的问题。 

高频率本身对 CPU并没有什么危害，超频后带来的高温才是 CPU的杀手。一般 CPU正常工作时的内部温

度应该维持在 75℃以下，而外部温度则保证低于 50℃左右，但是在超频的时候，尤其增加了 CPU的内核电压

后，这个标准就很难保证了。随着 CPU 温度的升高，CPU 内部电子的能量也随之增加，运动也就更为活跃，

容易形成电子漂移现象。 电子漂移现象并不是马上就发生的，一般来说都是随着 CPU超频使用时间的增加，

电子漂移程度也就越厉害，直到最后完成了从量变到质变的本质性转变时，你的 CPU也就寿终正寝了。 

对付 CPU的高温有两种办法，一种是提高硬件的散热效果，例如使用更大功率的风扇、使用散热硅脂等等。

另一种就是利用软件降温。 

使用软件对 CPU降温的原理就是程序监测 CPU的工作状况，当发现 CPU空闲时就向其发出 HLT 指令，

让 CPU转入低耗休眠状态，减少热量的产生，以达到降温的目的。对于一些 CPU占用率不高的工作，降温效

果还是很明显的，例如笔者的机器将 celeron300A超到 450 使用，在运行 Word等软件时，CPU 的温度只比环

境温度高 2～3℃。但如果运行 CPU运算密集的大型程序或游戏，软件降温就没有效果了。由于只是在 CPU空

闲的时候对其发送 HLT指令，所以不会严重降低系统的性能（性能降低是有的，一般 1～2％左右）。 

CpuIdle是一个由德国人编制的老牌的 CPU降温软件，降温效果较好，而且性能稳定，兼容性好，可以针

对不同种类的 CPU进行优化设置。CpuIdle还提供了对系统监控软件MBM4的应用程序接口，也算是它的一个

特点之一。 

安装 CpuIdle后，系统启动时自动载入。CpuIdle在系统任务栏中的 Tray图标如图 6-36所示。 

 

图 6-36  CpuIdle的 Tray图标 

双击该图标，关闭 CpuIdle，其图标变成  ，再双击该图标，又可以将其打开。右键单击该图标，程序

给出设置界面如图。上面有 5个标签项，其中比较重要的选项有。 

l CPU Info 

其中显示了系统中的 CPU的详细信息和物理内存大小，如图 6-37。 

 

图 6-37  CPU Info标签项 

l StartUp 

其中给出了关于启动的一些设置选项。 
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图 6-38  StartUp标签项 

Start with Windows 表示 Windows 启动时自动运行 CpuIdle。Splash Screen 表示 CpuIdle 启动时是否显示

“Splash screen”，如图。Optimize CPU features表示对 CPU进行优化，建议选中该项。Auto-disable on high CPU 

load表示当 CPU全负荷工作时自动禁止 CpuIdle，建议选中该项。 

 

图 6-39  启动时的 Splash screen 

l Display 

有关 CpuIdle的显示设置。在 Idle display in task bar项中，Numeric display表示用数字显示 CPU的空闲程

度，Graphical display表示用图形表示 CPU的空闲程度。在 Update interval中，可以拖动滑块设定程序检测 CPU

的时间间隔，这个间隔如果设定地太小，会增加 CPU运行负担。一般设为 1～2S比较合适。 

 

图 6-40  Display标签 

l Monitor 

CpuIdle提供了对系统监控软件 MBM4（Motherboard Monitor 4）的程序接口。如果系统中安装了MBM4，

程序会自动检测出来，单击Monitor选型卡，程序界面如图 6-41所示。 
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图 6-41  Monitor标签 

Selected MBM Sensor表示和 CpuIdle关联的监测器，这一项在MBM中设定。通常设成监测对象为 CPU的

监测器。Current temperature表示监测对象的温度。 

还可以设定警戒温度，如图 6-41设成 55（单位是摄氏度）。Perform this action设置当温度超过警戒温度时

程序采取的行动：Ignore表示什么也不做；Increase priority stepwise表示适当地提高 CpuIdle运行的优先级；Run 

at highest priority表示在 CPU所有的时间（不是空闲时间）向 CPU发送 HLT指令，强制 CPU转入低耗状态。

Immediately shutdown Windows表示立即关闭Windows。 

Update Interval表示监测的时间间隔，一般设为 0.5～1分钟比较合适。 

单击Monitor按钮，程序调用MBM4，在其高级设置界面中单击 CPUIdle标签，界面如图 6-42所示。可以

在其中设置和 CpuIdle关联的监测器，通常设成监测对象为 CPU的监测器。还可以设置当温度高于某一数值启

动 CpuIdle，同时可以选择播放自行设定的声音文件。当温度低于某一数值时禁止 CpuIdle，同时可以选择播放

自行设定的声音文件。 

 
图 6-42  MBM4的 CpuIdle标签 

MBM4功能比较全面，但其体积较大，驻留内存需要占用 4.2M左右的空间，而下一节介绍的Mbprobe和

其功能类似，却只占用 400KB左右的内存空间。所以建议用户将 CpuIdle和 Mbprobe配合使用：利用 CpuIdle

对 CPU降温，利用Mbprobe对系统进行监控。 

6.3  系统监控 MBProbe 

 

 

 

 

 

 

 随着计算机硬件设备的高速发展，加上目前超频风气的流行，大家对系统的安全和稳定越来越重视。

版本 1.21e 

类别 免费软件 

主页 http://web.bham.ac.uk/ 

功能 系统硬件监控 
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现在市场上很多主板（Mainboard）都内置了硬件监控芯片，如（LM 系列、Winbond 系列等），用户开机时在

BIOS中可以查看 CPU温度、主板温度、各种电压参数和风扇转速等信息。使用 MBProbe可以在 Windows环

境下直接查看以上信息，而且还提供了各种警戒参数，必要时向用户发出警告。 

MBProbe功能全面，但体积并不大，只有 100多 KB，而且不用安装即可执行，是典型的“绿色”程序。

MBProbe占用内存很小，与其他程序兼容性极好，而且是免费软件，对很多超频的用户来说，实在是个好东东。 

将 MBProbe直接加到 Windows开始菜单的“启动”程序组中，系统启动后自动载入 MBProbe，系统的任

务栏中多出一个液晶显示的小图标，如图 6-43所示。 

 

图 6-43  程序的 Tray图标 

用鼠标左键双击该图标，弹出程序主界面如图 6-44所示。 

 

图 6-44  MBProbe主界面 

主界面中显示了三类信息：电压（Voltage）、温度（Temperature）和风扇转速（Fan Speed）。选中某一项目

前的复选框，该项目右边的绿色小灯点亮，表示程序对该项目进行监测。在 Voltage项中，Vccp1表示 CPU内

核电压，其余表示主板提供的各种电压参数。在 Temperature中，Motherboard、CPU、Aux1分别表示主板、CPU、

CPU风扇的温度。在 Fan Speed中，Chassis、CPU、Power分别表示机箱风扇、CPU风扇、电源风扇的转速。

对于风扇来说，必须是三针接口、并直接接在主板上的才能检测到转速。不过现在市场上三针接口的 CPU风扇

越来越多，很容易买到。 

单击界面有下方的 Porperties按钮，程序给出设置界面如图 6-45。 

 

图 6-45  MBProbe属性设置对话框 

其中有六个标签，下面分别介绍。 

l General：如图 6-45所示。其中给出了 CPU和系统的相关信息，可以了解 CPU的类型和内核电压，以

及主板中的监控芯片类型。 

l Voltage：如图 6-46所示。在 Normal Voltages项中设置各项电压的正常数值，在 Threshold设定警戒阀
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值，例如图 6-46中 10％表示当某一电压低于和高于正常数值的 10％时，程序发出警告。 

l Temperature：如图 6-47所示。在Warning Limit中，用鼠标单击上下箭头设置主板、CPU、风扇温度

的上限，超过该温度时，程序发出警告。通常情况下程序均能自动监测出监控芯片的各个监测器监测

的对象，如果程序监测对象错误，例如把主板和 CPU的监测器弄反了，使显示的主板的温度高于 CPU

的温度（一般来说这是不可能的）。我们可以在右边的 Sensor 下拉列表框中为各个对象自行设定监测

器。 

     

图 6-46  Voltage标签                             图 6-47  Temperature标签 

l Fan：如图 6-48所示。设定各个风扇的正常转速。在Warning Below 项中设定警戒阀值，例如图中的

70％表示当某一风扇转速低于正常转速的 70％时，程序发出警告。 

l Tasks：如图 6-49所示。在 On Warning项中可以设定发生警告时，程序可以做的动作。Bring Window to 

Top表示激活Mbprobe窗口，并显示在最前；Beep Speaker表示系统蜂鸣器发出嘀嘀的警告声；Blink 

Status Icon表示闪烁系统任务栏中的 Tray图标；Execute Program可以选择发生警告时，可以执行的程

序。在 On Critical Event项中可以设定当温度高出多少时可以认为是紧急事件。在下面的下拉列表框

中选择可以采取的动作：do nothing表示什么也不作；suspend表示中止执行一切操作；shutdown表示

关闭系统；execute program表示运行用户指定的程序，可在下面的文本框设定（可以单击旁边的  按

钮进行文件定位）。 

     
图 6-48  Fan标签                               图 6-49  Tasks标签 

l Display：如图 6-50所示。Status Icon Temperature表示在程序的 Tray图标中显示的温度，如果选择多

于一个温度，在 Tray图标中会轮流显示，我们通常更关心 CPU的温度，所以这里可以只选择 CPU。

Temperature Units表示选择温度单位：摄氏（Celsius）还是华氏（Fahrenheit）。在 ToolTip项中，可以

设置 Tray图标的浮动状态栏中显示的信息。例如这里选择主板温度、CPU温度和 CPU风扇转速。当

将鼠标移动到程序 Tray图标上方时，显示的浮动状态栏如图 6-51。 
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图 6-50  Display标签 

 

图 6-51  浮动状态栏 

6.4  显卡超频 PowerStrip 

 

 

 

 

 

 PowerStrip是一个基于Windows 95/NT环境下的系统显示控制和系统桌面增强工具，该工具主要是对

系统的显示器和显示卡提供软件加速功能，可以支持目前流行的几乎所有的显示硬件。程序支持 DirectX 和

OpenGL，并针对Windows提供增强的应用程序接口支持。PowerStrip还提供了对显示卡进行超频使用的功能，

可以充分发挥显示设备的潜在功能。 

启动 PowerStrip，程序主界面是一个工具条，如图 6-52，上面包括了大部分重要的工具命令。 

 

图 6-52  PowerStrip 主界面 

我们还可以通过菜单使用 PowerStrip，可以有两种方法打开菜单，一种从系统任务栏中单击程序图标，如

图 6-53。 

另一种方法是单击程序工具条最右侧的“PowerStrip配置”按钮，如图 6-52，弹出的菜单如图 6-54所示。 

          

                  图 6-53  PowerStrip的 Tray图标                  图 6-54  PowerStrip菜单 

下面介绍一下 PowerStrip的主要功能。 

版本 2.70 
类别 共享软件 
主页 http://www.entechtaiwan.com/ 
功能 显示系统控制 
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6.4.1  显示设备的检测信息 

1．显示器的检测 

单击程序工具条界面上的“监视器配置”按钮  ，此时程序给出当前系统显示器的基本参数设置，界面

如图 6-55所示。 

 

图 6-55  监视器配置对话框 

单击界面中的“DDC2B监视器”按钮，程序开始自动检测、分析显示器，完成之后给出如图 6-56所示的

检测结果界面。Powerstrip 给出的检测结果非常详细、准确，涵盖了目前市面上的大部分显示器，如果程序的

数据库中没有当前的显示器信息，它会给出一个相近的显示器类型。这里值得注意的是，看看程序建议的各种

分辨率下的“喜好的重描速率”是否符合自己的要求，否则可以自己修改。单击“存储”按钮，对以上设置进

行保存，然后单击界面中的“确定”按钮退出。 

 

图 6-56  监视器监测结果 

2．显示卡的信息显示 

单击程序工具条界面中的“图形系统资讯”按钮  ，弹出信息显示界面如图 6-57，其中给出了显示卡

的类型、当前的显存占用、显示性能等详细信息。 
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图 6-57  图形系统资讯对话框 

此外，在程序的版权信息界面中也提供了当前显示卡的检测信息。用鼠标单击系统任务栏中的程序图标，

从关联菜单中选择“进阶选项”→“关于 PowerStrip”命令，此时程序会给出如图 6-58所示的界面，上面的信

息更加详细。 

 

图 6-58  关于 PowerStrip界面 

6.4.2  设定桌面显示 

用鼠标左键单击程序工具条最左边的“PowerStrip配置”按钮，弹出界面如图 6-59所示，可以从中选择色

彩、桌面尺寸、刷新速率，单击“套用”，程序会按照设置改变桌面的设置，同时弹出一个确认对话框，如果觉

得新的设置合适，单击“确定”，否则单击“取消”。 
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图 6-59  PowerStrip配置 

此外，在 PowerStrip工具条界面、鼠标菜单中提供了 5个默认的显示环境设置选项，单击相应的按钮，即

可快速切换当前的显示状态到该种形式，使用起来很方便。 

我们还可以改变这 5个默认的显示环境，方法如下： 

单击单击程序工具条最左边的“PowerStrip配置”按钮，弹出界面如图 6-59，选择“预设”，界面变成如图

6-60所示。 

 

图 6-60  预设标签 

系统第一个默认设置为 640X480（256色），我们把显示设定中的调色盘设成“HiColor（16 bit）”，，桌面尺

寸设为 800X600，然后在显示设置框内按住鼠标左键拖至第一个默认设置的图标上方，此时鼠标变成  ，

松开左键，单击套用，第一个默认设置即变成 800X600（16 bit）。 

还可以用 PowerStrip来调整显示器的显示画面。用鼠标单击程序界面中的“屏幕调整”按钮  ，程序给

出如图 6-61所示的设置界面。当改变系统的刷新速率后，可以重新调整屏幕的显示位置和显示范围，以达到最

佳的显示效果。 
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图 6-61  屏幕调整对话框 

6.4.3  显卡的超频 

使用 PowerStrip对显示卡进行超频很简单。首先用鼠标右键单击系统任务栏中的程序图标，从关联菜单中

选择“进阶选项”→“关于 PowerStrip”，选择“执行效能调整”，设置界面如图 6-62，在“记忆体时脉”项中

给出了当前显示卡的显存时钟频率，我们可以用鼠标拖动其中的滑块向右移动一点，（例如 5个MHz），然后单

击“套用”按钮使之生效。滑块下方的 Fast memory timing选上也可以提高显存的效率，但要注意有些品牌的

显存选上 Fast memory timing后有可能不能正常工作。 

 
图 6-62  “执行效能调整”对话框 

在 Engine clock项中给出了当前显示卡的显示芯片时钟频率，我们可以用鼠标拖动其中的滑块向右移动一

点，（例如 5个MHz），然后单击 Apply按钮使之生效。 

对显卡超频时要注意不要一下超得太多，以免显卡不能正常工作，甚至将显卡烧毁。将显卡超频后，应加

强显卡的散热，并运行一些程序来检验超频的稳定性，例如运行“极品飞车”等需要 3D 功能的游戏等。如果

想调回原来的频率，单击“预设”或 default按钮，然后再单击“套用”或 Apply以使之生效。 

6.5  虚拟光驱 Virtual Drive 2000 
 

 

 

 

 

版本 5．0 

类别 共享软件 

主页 http:// www.farstone.com/ 

功能 利用硬盘虚拟光驱 
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 Virtual Drive 2000是由 Farstone公司出品的目前最流行的虚拟光驱软件。它的工作原理是先产生一部

或多部虚拟光驱，并生成光盘图标，Windows 95/98 会把其当成系统中真实光驱一样。然后可以将光盘上的所

有数据全部压缩成一个虚拟光盘文件，存放在硬盘上。把该虚拟光盘文件加入到虚拟光驱中，我们就可以像使

用真实光盘一样使用其中的文件和资料。 

使用虚拟光驱，既可以延长光驱的使用寿命，又可以获得很高的传输速度，现在的硬盘容量越来越大，所

以虚拟光驱的软件已成为日常必备的工具之一。 

安装 Virtual Drive 2000以后，程序自动在系统任务栏中生成一个小图标    ，双击该图标，可以调用 Virtual 

Drive Manager（虚拟光驱总管）。我们也可以让其在系统启动时不自动载入，方法是单击系统“开始”菜单，

选择“程序”→“附件”→“系统工具”→“系统信息”，在“Microsoft 系统信息”界面中，单击“工具”菜

单中的“系统配置实用程序”，选择“启动”标签，如图 6-63所示。取消“Virtual Drive”项目，下次系统启动

时就不会自动载入该程序。 

 
图 6-63  系统使用配置程序对话框 

6.5.1  虚拟光盘文件管理 

1．创建虚拟光盘文件 

启动 Virtual Drive 2000，程序界面如图 6-64。 

 

图 6-64  虚拟光驱总管界面 

将光盘放入光驱中，单击工具栏中的 Build VCD按钮  ，单击菜单命令“档案”→“建立 VCD档案”，

程序给出对话框如图 6-65。 
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图 6-65  Build VCD对话框 

在 CD－ROM项中显示的“H：”为用户系统中真实光驱的盘符，“[393.0 M]”为光驱中光盘的容量。复选

框 Use exhausted read method表示采用“穷读法”，由于光盘的规格繁乱，录制光盘（CDR）软硬件种类非常多，

因此难免会有部分光盘并未依照标准规格烧录，可能造成光盘虚拟后不能正确使用。因此如果用户使用一般方

法建立的虚拟光盘不能正确使用时，可以将该复选框选中后再重新创建一次。在 Hard disk下拉列表框中选择将

虚拟光盘文件存放在哪个硬盘中。在 File name和 Description文本框中输入虚拟光盘文件的名称和注解。如果

系统中设置了多个虚拟光驱，可在 Default VCD drive中选择虚拟光驱盘符。Use data compression表示是否对光

盘进行压缩，Virtual Drive 提供了不压缩、适中和最大压缩三种选择，最大压缩会将光盘压缩到最小容量，但

需要较多的运算时间。 

设置完毕，单击 OK，程序开始压缩，同时显示压缩进度和时间如图 6-66。 

 
图 6-66  创建虚拟光盘进度显示 

完成后单击 OK确定，回到程序主界面，在右边的虚拟光盘列表框中多出了一个刚才新建的光盘图标，如

图。如果系统内设置了多个虚拟光驱，首先用鼠标左键在左边的光驱列表框选择一个盘符，在右边的光盘列表

框中选择想要插入的光盘，然后单击 Insert按钮  ，就可以像使用真实光盘一样使用该虚拟光盘了。如果想

从某一虚拟光驱中取出光盘，选择该光驱，单击 Eject按钮  即可。 
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图 6-67  虚拟光驱总管界面 

2．加入和删除虚拟光盘 

当硬盘中有建好的虚拟光盘文件时，可以单击菜单命令“档案”→“加入 VCD 档案”，在弹出的“加入

VCD文件”对话框中选择相应的虚拟光盘文件即可。 

如果想删除虚拟光盘文件，可以单击菜单命令“档案”→“删除 VCD档案”，程序给出 Delete VCD file对

话框，如图 6-68。 

  

图 6-68  Delete VCD file 对话框 

选择 Delete ALL，则虚拟光盘的图标和硬盘上的虚拟光盘文件就会一起被删除。如果选择 Delete Icon，只

是删除虚拟光盘图标，硬盘中的虚拟文件仍然存在，下次需要时单击“档案”→“加入 VCD 档案”将其加入

即可。 

用户还可以自行设定虚拟光驱的数目。单击菜单“档案”→“设定虚拟光碟机数目”，在弹出的对话框中键

入虚拟光驱的数目，重新启动系统即可生效。 

6.5.2  创建 CD Audio虚拟光盘 

Virtual Drive 2000还可以将 CD Audio创建成 VCD文件。首先选择“档案”→“唱片压成 VCD档案”，或

单击工具栏中的 Build VCD from CDAudio按钮  ，程序给出如图 6-69所示对话框。 
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图 6-69  Build VCD from CDAudio对话框 

首先在左边的 Select tracks列表框中选择需要制作的曲目，单击上方的 Select All，可以选择所有曲目。单

击右边的 Select Format按钮，可以设置声音格式，选择不同的声音格式会影响到音乐虚拟光盘的品质和文件大

小。较高的品质会占用较大的硬盘空间，如果需要较高音质，可以选择 PCM格式（44KHz，16Bit，立体声），

不过每分钟数据有 10MB左右。否则可以选择 Microsoft ADPCM（22KHz，4Bit，立体声），每分钟只有 1.2M

大小。 

在 File和 Description文本框中键入 VCD文件的名称和注释。单击左下方的 Volume Control按钮，可以调出系

统的“音量控制”对话框。 

设置完毕，单击 Start Recording，程序开始压缩 CD光盘。 

6.5.3  光驱加速功能 

Virtual Drive还提供了一个称为“Rapid Cache”的光盘加速工具。它采用了最先进的光盘快取技术－递增

快取，这种技术的原理就是拿硬盘或内存来做 Cache（高速缓存），然后直接从内存和硬盘中读取。它作为一个

Win9X 虚拟设备驱动程序，使用智能缓存算法和动态预读缓冲来确保它的高性能，Rapid Cache 支持所有的光

驱。 

单击工具栏中的 Launch Rapid Cache Manager按钮  ，或单击菜单“档案”→“超速总管”，程序给出

Rapid Cache Manager设置界面如图 6-70所示。 

 
图 6-70  Rapid Cache Manager对话框 

在Cache Settings标签中，可以把Cache Control项设置成Cache all files（缓存所有文件），并选择Max Caching 

Mode（最大缓存方式）。对于其他标签，这里就不作介绍了。 

6.5.4  运行环境设定 

单击菜单命令“档案”→“选项”，程序给出设置界面如图 6-71。 

 

图 6-71  Settings对话框 

其中有两个标签。在Miscellaneous settings标签中有四个复选框。Show program logo while startup表示启动



常用工具软件大全 160

虚拟光驱总管（Virtual Drive Manager）时显示版本信息和版权资讯。Restore（Insert）Virtual CDROM on boot

表示开机时还原（插入）虚拟光盘，如果选中该选项，虚拟光驱总管会记录每一部虚拟光驱的状态，若关机时

虚拟光驱内有虚拟光盘，下次开机时自动插入。CDROM Autorun表示光驱自动执行，选中该选项，当用户把光

盘插入光驱后，系统自动运行光盘上的自动执行程序，该选项同时影响虚拟光驱和真实光驱；在 Animation 标

签中，可以选择插入或退出光盘时是否用动画表示。 
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很多电脑用户买了电脑之后，很希望能了解自己机

器的详细硬件信息和性能指标，本章向用户提供了几个

这方面的工具软件。 

HARDiNFO是一个老牌的 DOS下的硬件检测工具，

其版本升级很快，能够识别很多最新的硬件。该工具的

体积很小，可以装在一张软盘中，对于装机的用户很有

帮助。 

SiSoft Sandra 2000是一个强大的机器硬件检测和系

统性能测试工具，其特点是能够对用户的配置提出优化

建议。 

WinBench99是著名的 ZD实验室出品的系统测试软

件，其测试数据比较权威，经常出现在各种评测文章中。

3DMark 2000对于显卡的 3D性能（主要是在游戏中）的

测试比较科学，对于用户了解自己的 3D 加速卡很有帮

 

 

第七章  系统测试 

 

＝＝ 本章导读 ＝＝ 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

7.1  HARDiNFO  

 

 

 

 

 

 HARDiNFO 是由 Ultimate Systems 公司开发的一个基于 DOS 环境的计算机硬件性能检测软件。

HARDiNFO提供非常简单的操作方式，检测速度快，检测结果非常准确，可以检测目前非常新的硬件设备。该

工具体积非常小，只有 800多 KB，是装机时检测硬件设备型号的必备工具。 

在纯 DOS环境启动 HARDiNFO，程序界面如图 7-1所示。 

版本 4.71 
类别 共享软件 
主页 http://www.hardinfo.com/ 
功能 系统硬件检测 
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图 7-1  HARDiNFO程序主界面 

下面对主要检测项目做一介绍。 

7.1.1  Info（系统信息） 

单击 Info菜单，程序界面上图所示。从中可以了解的硬件信息包括：主板芯片组、处理器、内存、BIOS、

显示卡、硬盘、系统总线类型等项，十分全面。 

1．Mainboard Info（主板信息） 

单击该项菜单命令，显示界面如图 7-2所示。 

l Main Processor：系统处理器为 Intel的赛扬，主频为 450MHz。 

l Mainboard Chipset：主板芯片组为 Intel的 440ZX。 

l First Level Cache：CPU内部的一级缓存为 32KB（指令缓存和结构缓存各 16KB）。 

l Second Level Cache：CPU内部的二级缓存为 128KB（On－chip：芯片内集成）。 

l Total：系统总内存为 128M。 

l BIOS Manufacturer：系统的 BIOS为 AWARD BIOS V4.51PG。 

 

图 7-2  系统信息 

还可以使用上下光标键选择项目进行详细信息显示。首先选择Main Processor，按下回车键，程序界面如图

7-3所示。界面中的 Processor Clock Ratio：表示该系统的 CPU的当前倍频为 4.5。如果是 PIIICPU，还可以看到

处理器的内置序列号（Processor Number）。如果显示项目比较多，可以用 Page Up和 Page Down键翻页。 按“ESC”

键回到上一层界面。 
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图 7-3  CPU详细信息 

接下来选择内存进行详细信息显示。用光标键选择Memory项，按下回车键，显示界面如图 7-4所示。 

内存项中显示项目比较多，可以用 Page Up和 Page Down键翻页，其中重要的项目有： 

l Module Size：内存模块大小为 64MB（本系统内存为 64MB×2）。 

l Memory Type：内存类型为 SDRAM。 

l Memory Speed：内存可以支持速度为 100MHz。 

l SPD Version：SPD模块版本为 1.2。（PC100以上的 SDRAM均有 SPD）。 

l CAS 2：Supported。（速度为 100MHz时支持 CAS为 2）。 

l CAS 3：Supported。（速度为 100MHz时支持 CAS为 3）。 

按 ESC键直到退回到主界面。 

 

图 7-4  内存模块信息 

2．Video Info（显示系统信息） 

单击菜单 Info → Video Info，显示界面如图 7-5所示。 

l DDC Monitor Name：显示器类型为 HYUNDAI，型号为 587B。 

l Video Chipset：显卡芯片为 nVDIA RIVA128ZX。 

l Video Memory Size：显存大小为 8MB，SGRAM。 

l Video RAMDAC：显卡的 RAMDAC。 

l Video BIOS Version：显卡的 BIOS版本。 
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图 7-5  显示系统信息 

还可以使用上下光标键选择项目进行详细信息显示。选择 DDC Monitor Name，按下回车键，程序界面如

图 7-6所示。 

l Monitor Name：显示器类型。 

l Serial Number：序列号。 

l Date of Manufacture：制造日期。 

l Gamma：显示器的伽玛值。 

l 按 ESC键直到退回到主界面。 

 

图 7-6  显示器信息 

3．Drive Info（驱动器信息） 

单击该项菜单命令，显示界面如图 7-7所示，上面显示了系统中所有的 IDE驱动器。 

 

图 7-7  驱动器信息 

使用上下光标键选择驱动器进行详细信息显示。首先选择 Primary Master，按下回车键，程序界面如图 7-8
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所示。 

 

图 7-8  IDE硬盘驱动器物理信息 

l Fixed Disk Capacity：硬盘的容量为 6，150MB。 

l Cache Buffer Size：硬盘的缓存。 

l Disk Model：硬盘的型号为昆腾火球 EX6.4A。 

按 ESC键回到上一层界面。接下来选择 Secondary Slave－ATAPI Device，按下回车键，显示界面如图 7-9

所示。 

 

图 7-9  ATAPI光盘驱动器信息 

l Drive Model：设备型号为 ATAPI 40倍速光驱。 

l Device Type：设备类型为 CD-ROM。 

l Maximum Speed：最大传输速度。 

l Current Selected Speed：当前传输速度。 

l Buffer Size：光驱缓存。 

按 ESC键直到退回到主界面。 

4．Peripherals Info（周边设备信息） 

单击该项菜单命令，显示界面如图 7-10所示，上面显示了系统中的周边设备。 
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图 7-10  周边设备信息 

l Floppy Drive：软驱为 1.44MB 3 1/2寸。 

l Sound Card：声卡芯片为 Ess Maestro-2。 

l Keyboard Controller：键盘。 

7.1.2  Benchmarks（性能指标） 

菜单 Benchmarks中含有三项：CPU、Disk、CD-ROM。下面分别介绍。 

1．CPU benchmark 

单击该项菜单命令，程序开始进行测试，完成后显示测试结果如图 7-11所示， 

 
图 7-11  CPU测试分数 

l 16-bit Integer：16位整数运算。 

l Floating Point Index：浮点运算。 

l 32-bit Integer Index：32位整数运算。 

l MMX Index：多媒体指令运算MMX。 

可以使用上下光标键选择一种指标，例如选择浮点运算，按下回车键，比较结果如图 7-12所示。 
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图 7-12  FPU速度比较示意图 

如果是 Intel的 CPU，和上面的数据进行比较；如果是 AMD 的 CPU，和下面的结果进行比较。二者的刻

度并不相同。 

2．Disk benchmark 

单击该项菜单命令，程序开始进行测试，完成后显示测试结果如图 7-13所示（本系统中装有两个硬盘）。 

 

图 7-13  磁盘测试分数 

l Read Transfer Rate：读取传输速率。Buffered：缓存读取，Random：随机读取。 

l Average Seek：平均寻道时间。 

3．CD-ROM benchmark： 

单击该项菜单命令，程序开始进行测试，测试前提示需要插入一张至少含有一个体积在 20MB以上的文件，

完成后显示测试结果如图 7-14所示。 

 

图 7-14  光驱测试分数 

Average Transfer Rate：平均寻道时间。（×15）表示相当于 15倍速。 

需要说明的是，该数据与所用的盘片有关。如果所用盘片很难读，所得数据会很低。 

7.1.3  Test（测试） 

该项目共分两项。 

l Test CPU errata：检测 CPU是否有错误。 

l Sensor Status：查看系统监测器状态。如果系统主板上有系统监测器（检测 CPU温度、电压、风扇转

速等），程序给出如图 7-15所示界面。 
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图 7-15  系统检测器状态 

·  Sensor Chip（s）Present：当前监测器芯片。图中为Winbond WB37810D。 

·  Motherboard Temperature：主板（系统）温度。 

·  Internal Temperature：CPU温度。 

·  xxx Voltage：电源提供的各种电压数据。 

·  CPU Fan Speed：CPU风扇转速。前提是 CPU风扇支持测速（三针接口，且接在主板上）。 

 

7.1.4  Setup 

进行有关系统测试的设置。并可将设置保存作为缺省设置。一般该项缺省即可。 

l About：有关 HARDiNFO的版本信息。 

l Quit：退出 HARDiNFO。 

l  

7.2  SiSoft Sandra 2000 

 

 

 

 

 

 

 

 SiSoft Sandra 2000是基于Windows 95的机器硬件检测和系统性能测试工具。它能提供有关用户计算

机的硬件、软件和其他装置方面的信息，并能给出优化配置建议。 

该工具提供的项目非常丰富，程序界面比较简单，所用的功能选项都以图标形式表现出来，如图 7-16所示。 

程序中提供了将近 60个检测模块，查找起来有些不便，我们可以将界面中不经常使用的检测模块图标暂时

删除，而保留那些经常使用的部分。方法很简单，选择想要删除的检测模块图标，单击菜单命令 Modules → 

Delete Module，或单击菜单栏内的 Delete Module按钮  即可，直接按下键盘的 Delete键也可以。 

 

版本 2000.7.6.49 
类别 共享软件 
主页 http://www.sisoftware.co.uk/ 
功能 硬件测试、系统性能测试 
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图 7-16  SiSoft Sandra 2000主界面 

如果想恢复以前删除的图标，单击菜单命令Modules → Add New Module …，或单击菜单栏内的 Add New 

Module Wizard按钮  ，程序给出如图 7-17所示界面。从中选择需要进行恢复的模块，然后单击 Finish按钮

即可。 

 

图 7-17  添加模块向导 

SiSoft Sandra 2000 提供了系统的各种硬件设备和操作系统的相关信息，按功能主要分为四大类，下面分别

加以说明。 

7.2.1  检测系统信息 

启动SiSoft Sandra 2000，单击程序界面工具栏中的 Information Modules按钮  ，或单击菜单命令View → 

Information Modules，此时程序在界面中只出现该类图标，如图 7-18所示（该步骤不是必须的，只是为了观察

方便）。 
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图 7-18  系统信息模块 

从图中可以看出，程序提供了 System Summary（系统摘要）、Mainboard（主板）、CPU & BIOS、PCI & AGP

（系统总线）、Video System（显示设备）等信息项。用鼠标双击界面中的相关选项图标，程序会自动检测并给

出检测结果。例如图 7-19为 CPU & BIOS项检测的结果对话框。 

 

图 7-19  CPU & BIOS信息 

结果对话框中显示的是处理器和系统 BIOS的各种信息，界面上面的 Device下拉列表框可以选择处理器或

BIOS，界面底部的 Back和 Next按钮的作用是运行当前测试项目的前一个或后一个项目，如果想连续进行测试，

直接单击这些按钮即可。“Options …”按钮作用是设置程序对于该选项可检测的项目，单击后，程序给出类似

如图 7-20所示的对话框，程序提供了相关的检测选项，可以从中根据需要进行选择。 
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图 7-20  设置模块中的检测项目 

SiSoft Sandra 2000还提供了对当前系统的硬件配置和软件运行环境的优化建议功能，即通过对系统的各种

资源的检测，同时与程序内定的优化模式进行比较，指出当前系统的不足，同时给出优化配置的建议。以下是

具体操作步骤。 

 单击程序界面中的 Performance Tune-up Wizard图标，程序给出如图 7-21所示对话框，上面给出了

有关该项操作的说明。 

 

图 7-21  优化配置向导之一 

 单击 Next，在程序给出的界面中选择检测结果的处理方式：在屏幕上显示、保存到硬盘上或打印出

来，默认方式为在屏幕上显示。 
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图 7-22  优化配置向导之二 

 单击 Next，程序开始检测，完成后给出检测结果如图 7-23所示，检测结果分为 Tip（建议）、Warning

（警告）、Error（错误）三个级别，给出了当前系统的软、硬环境中存在的可能进行优化的建议，用户可以从

中选择进行优化。 

 

图 7-23  优化配置向导之三 

7.2.2  测试机器性能 

SiSoft Sandra 2000提供了对系统的 CPU、内存、硬盘和光盘等硬件进行全面性能测试的功能。单击程序界

面工具栏中的 Information Modules按钮  ，或单击菜单命令 View → Information Modules，此时程序在界面

中只出现该类图标，如图 7-24所示。 

用户可以根据自己的需要从中选择相应的图标双击即可。例如图 7-25是程序对 CPU的检测结果对话框，

图中除了本系统（Current Processor）的检测结果外，还提供了 AMD Athlon 1GHz、Intel PIII 1GHz，AMD Duron 

700和 Intel Celeron 600的测试数据，可供用户进行比较。程序还在下面的文本框中给出了当前测试机器的 CPU

的详细说明。系统中其他硬件的测试与此类同。 
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图 7-24  性能测试模块 

 

图 7-25  CPU测试得分 

7.2.3  系统配置信息 

SiSoft Sandra 2000 提供了对系统的各种配置文件的快速观察功能。单击程序界面工具栏中的 Listing 

Modules按钮  ，此时程序在界面中只出现该类图标，如图 7-26所示。 
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图 7-26  配置信息模块 

程序提供了系统启动配置文件 Config.sys、Autoexec.bat、MsDos.sys、System.ini 等的相关图标，用户可以

根据自己的需要从中选择相应的图标双击即可。例如图 7-27是Win.INI的观察界面。美中不足的地方是程序没

有提供编辑功能，有点不方便。 

 

图 7-27  Win.ini内容观察 

7.2.4  系统诊断功能 

SiSoft Sandra 2000提供了非常强大的对系统硬件设备的运行环境进行全面测试的功能，可以随时了解系统

中是否有硬件冲突。单击单击程序界面工具栏中的 Testing Modules按钮  ，此时程序在界面中只出现该类

图标，如图 7-28所示。 

程序提供了 CMOS Dump、Hardware IRQ Settings、DMA Settings、I/O Settings等项目的测试功能，用户可

以根据自己的需要从中选择相应的图标双击即可。例如图 7-29是 Hardware IRQ Settings的检测结果。 
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图 7-28  硬件测试模块 

 

图 7-29  Hardware IRQ Settings检测结果 

7.3  ZD WinBench 99 
 

 

 

 

 

 

WinBench 99是著名的 ZD Benchmark系列测试软件之一，主要用于测试系统的总体性能，主要包括 CPU、

图形、硬盘、视频等项目，在很多电脑报刊杂志上的评测报告中经常会引用该程序的测试结果。下面介绍该程

序的具体应用。 

7.3.1  测试注意事项及准备工作 

为了使测试结果更准确，采用WinBench进行测试时要注意以下几点： 

l 测试前应停止一切正在运行的其他程序并去除网络连接。 

l 测试前重新启动系统，并建议使用自动功能（例如使用.ZDR批处理文件）进行所有测试。 

l 每次测试都应至少运行两次，以确保测试结果具有可重复性。 

l 对于同一测试，要保证测试过程相同，例如第一次测试前整理（defrag）硬盘，则第二次测试前也应

整理硬盘。 

l 为了提高磁盘子系统的得分，测试前应先整理硬盘碎片，可以使用 Windows 95 的 defrag 或 Norton 

版本 1.1 

类别 免费软件 

功能 系统性能测试 

主页 http://www. zdbop.com/ 
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Utilities的 Speed Disk。 

l 如果系统设定了节能模式，测试前应在 BIOS或Windows中将该项功能关闭。 

l 为了节省物理内存，建议取消系统启动时自动加载的程序。可以使用WinBench自带的 Startup Manager

工具，从系统的开始程序菜单的WinBench程序组中启动该工具，程序界面如图 7-30所示，在列表框

中取消某一程序前面的复选框，系统启动后便不会再自动加载该程序。 

l 系统任务栏的某些属性设置有可能影响WinBench的测试结果。单击Windows菜单“开始”→“设置”

→“任务栏和开始菜单”，设置界面如图 7-31。建议取消“总在最前”，选中“自动隐藏”。 

     

                      图 7-30  Startup Manager程序主界面                图 7-31  任务栏属性设置对话框 

7.3.2  测试过程 

 准备工作完成并重起系统后，启动WinBench 99，程序界面如图 7-32。 

 在 Function面板中的 run下拉列表框中选择需要检测的项目组，可以选择 All Tests，进行所有项目

组的测试，也可以选择任一单项进行测试。大多数测试项目组的步骤基本相同，例如我们选择FPU WinMark（CPU

的浮点运算能力）。然后单击左边的 Run 按钮，程序给出关联对话框如图 7-33，通知用户程序将首先检测一些

有关本台测试机器的基本信息，黑色的对号表示系统满足最低要求，可以进行测试；黄色的叉号表示系统不满

足最低要求，但可以进行测试；红色的叉号表示测试的机器不满足最低要求，不能进行测试。 

 

图 7-32  WinBench 99主界面 



常用工具软件大全 

 

177 

 

图 7-33  系统配置问题对话框 

 单击“下一步”，程序给出当前机器的硬件配置信息和程序运行所需的最小配置要求，如果存在问

题，需退出程序进行修改。 
 单击“下一步”，程序给出 Other Requirements对话框，在该界面中程序检测系统是否满足测试的其

他要求，如系统任务栏和其他程序是否妨碍WinBench使用整个屏幕，屏幕的分辨率是否是 96 pixels per inch，

系统中是否有测试程序所需的字体等。如果存在问题，需退出程序进行修改。 
 单击“下一步”，还是 Other Requirement对话框，程序在界面下方的列表框中给出了在内存中运行

的不必要的程序。建议退出程序进行修改，虽然可以继续进行测试。 

 单击“下一步”，程序给出如图 7-34所示界面。复选框 Enable system configuration problem detection

表示使用系统存在问题检测功能。单击 Finish按钮，程序开始进行测试。 

 

图 7-34  使用系统存在问题检测功能 
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 测试完成后，程序给出测试结果对话框如图 7-35 所示，上面给出了当前测试项目组的分值。单击

对话框右上角的 System Info按钮可以查看系统信息。 

 

图 7-35  测试结果对话框 

如果想保存测试结果，可单击Funtion面板中的Save Results按钮，程序给出如图7-36所示的Save to Database

对话框，单击 Database按钮可以修改数据库文件名称，在界面中间的文本框键入相应的描述信息，单击右边的

System Info可以查看修改系统信息，程序会将测试时的系统信息一并保存。 

 

图 7-36  Save to Database对话框 

如果想进行测试结果的比较，可以单击Function面板中的Compare Results按钮，程序调用Benchmark Results 

Viewer工具，如图 7-37。该工具的使用非常简单，直接在界面中调入保存的测试结果文件即可。程序会以列表

方式给出每个测试项目组的详细数据，并以红色给出每个类别的最高值。 
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图 7-37  查看测试结果 

7.3.3  使用 Batch（批处理）文件 

如果用户需要在一台或多台机器中进行多次重复测试，那么可以建立批处理文件，只要该机器中装有

WinBench 99，在系统资源浏览器中双击该批处理文件，系统就会按设定的参数进行测试。 

如果要创建一个批处理文件，单击Winbench主界面中的菜单 Run → Create Batch File …，程序给出 Create 

Batch File对话框，如图 7-38。单击 Database按钮可以选择测试结果文件（.ztd），建立的批处理文件将使用和

所选择的测试结果文件相同的各种设定。在 Batch file options项中，可以选择是否保存结果，以及是循环测试

还是测试完毕自动关闭程序或Windows。在 Include in batch file项中，可以选择批处理文件中包含的参数设定。

Current test settings表示包括当前的测试项目组设定，System information fields you have changed表示包括系统信

息中用户改变的项目组，Refresh rate、color type and color reproduction tests表示包括显示器刷新频率、色彩类

型和色彩重现测试。 

 

图 7-38  创建批处理文件对话框 

设定完毕，单击 OK，程序给出 Save batch file对话框，在其中设置批处理文件的名称和保存路径即可。 
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7.3.4  查看修改系统信息 

一般在Winbench主界面的左下角有两个最小化的窗口 Table of Results（结果显示）和 System Info（系统信

息）。单击 Table of Results窗口右上角的 System Info按钮，或单击 System Info窗口右上角的 Edit按钮，程序给

出 System Info对话框 如图 7-39。单击任一标签，就可以在其中查看和修改当前测试所使用的系统信息。 

 

图 7-39  系统信息对话框 

7.3.5  测试项目组管理 

在 Function面板上的 Run下拉列表框中列出了程序预先设定的各种测试项目组，用户也可以对列表框中的

测试项目组进行管理。 

测试项目组管理命令主要集中在主界面的 Suite菜单中，共有四个命令： 

l Create：新建一个测试项目组并自动加入到测试项目组列表框中； 

l Load：将一个已存在地测试项目组加入到测试项目组列表框中； 

l Edit：编辑测试项目组列表框中的某个测试项目组的具体内容； 

l Delete：从测试项目组列表框中删除某个测试项目组。 

我们以新建一个测试项目组为例。单击 Run → Create命令，程序给出 Create Custom suite对话框，如图

7-40。 

 

图 7-40  新建测试项目组 

在 Suite Name中设定测试项目组名称。在 Test Suite项中，程序列出了预设的各种项目组，种类比 Run列
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表框中的丰富得多。在 Tests 项中，程序列出了项目组中具体的测试项目。选中要添加的测试项目/项目组，单

击中间的 Add 按钮，即可将其加入到新建测试项目组中。Remove 按钮表示删除新建项目组中的测试项目，

Remove all表示删除新建项目组中的所有测试项目。 

设定完毕，单击 OK，程序给出 Save Suite in file对话框，在其中设置批处理文件的名称和保存路径即可。 

7.3.6  测试环境设定 

单击菜单命令Edit → Test Settings，程序给出Test Settings对话框，如图 7-41。在Common标签中，Disk Drive

下拉列表框可以设置测试使用的工作磁盘，在 Error Handling 项中设置当测试过程中发现冲突时的处理方式，

可以设置程序重试的次数，当重试失败时，ignore the error and continue testing表示忽略错误，继续进行测试；

halt tests and display error message表示停止测试并显示错误信息。在 DirectDraw和 Use DirectDraw标签中提供

了显示驱动程序设置和测试窗口显示方式设置。在 Disk Inspection标签中提供了磁盘测试过程中 CPU占用率和

数据传输速度测试设置。在 GDI标签中提供了用户自定义 GDI测试可使用的 BMP位图设置。 

 

图 7-41  测试环境设置 

7.4  3DMark 2000 Pro 

 

 

 

 

 

 

 3DMark 2000 Pro是目前比较流行的专业显卡测试软件，主要侧重于系统在 3D游戏中的性能表现。

3DMark可以给出显卡的各种性能参数，用户可以据此比较各种类型显卡在不同机器中的性能表现。 

3DMark主要是在虚拟的 3D环境中测试各种 3D加速卡的 3D加速性能。大多数用户主要用 3D显卡来玩

游戏，所以 3DMark在大多数测试结果中会偏重这方面的应用。 

在最新的 2000版本中，新增的功能有： 

l DirectX 7.0； 

版本 2000 

类别 共享软件 

功能 3D显卡测试 

主页 http://www.remedy.fi 
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l 对 Intel和 AMD的 CPU分别进行优化设计的新的 3D引擎； 

l 全新设计的、有针对性和对比性的游戏测试； 

l 新增纹理渲染的速度测试； 

l 新增环境凸凹贴图测试； 

l 同时支持 16位和 32位色彩测试。 

启动 3DMark 2000 Pro，程序界面如图所示。程序首次给出对话框，单击 New Custom Benchmark，用户可

自行设定环境进行显卡测试。单击 Run Default Benchmark，程序按缺省环境进行测试。单击 Cancel，可进入程

序主界面。 

 

图 7-42  3DMark 2000 Pro程序主界面 

7.4.1  系统要求 

1．最低配置 

l Pentium MMX 或兼容处理器，主频至少在 166MHz以上； 

l 64M内存； 

l 操作系统为Windows95、98、Win98SE（第二版）或Windows 2000专业版； 

l DirectX 7.0或更新； 

l DirectX 7.0的 3D加速卡。 

2．推荐配置 

l 300MHz以上的 CPU； 

l 128M内存； 

l 操作系统为Windows 98或更新； 

l 主流的 3D加速卡（至少应 99年以后生产的）。 

7.4.2  测试注意事项 

为了使测试结果更准确，采用 3DMark进行测试时要注意以下几点： 

l 测试时停止一切正在运行的其他程序； 

l 测试时去除网络连接及网上文件共享； 

l 为保证结果应对同一显卡至少作三次以上测试，并且每次进行新的测试都要重新启动计算机； 

l 尽可能的设置好硬件使其减少 CPU占用率。对于专业用户，如果是进行正式的测试，为了得到准确的

和可重复性的结果，除了上面所述以外，还需要注意以下几点： 

l 进行 3D加速卡对比测试时，对所有的加速卡都应使用相同的 CPU，并且 CPU的设置也应完全相同； 
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l 进行加速卡对比测试时，要保证使用的各种测试参数相同。包括：屏幕分辨率、显示色深（16位还是

32位）、纹理尺寸、Z－Buffer格式、缓冲模式和屏幕刷新频率设定等。 

l 如果比较 CPU的 3D性能，要保证系统中其他设备尽量相同。 

7.4.3  测试过程 

启动 3DMark 2000 Pro，单击对话框中的New Custom Benchmark按钮即可创建新的测试方案。如果已经进

入系统主界面中，可以单击菜单命令 File → New。程序给出对话框如图 7-43。 

单击 Project Description项中的 Edit按钮，程序给出 Change Project Description对话框，如图 7-44。可以在

Project Name 文本框中键入测试名称，然后在 Comments 文本框中添加一些注释信息，如机器配置、测试人、

测试时间等等，以便日后查看。单击 OK关闭该对话框。 

 

图 7-43  新建测试方案对话框 

 

图 7-44  设定方案名称和注释 

单击图 7-43中 Select Tests项中的 Change按钮，程序给出 Select Tests对话框，如图 7-45。其中有两个标签。

在Normal选型卡中，Overall Performanc可以选择测试项目，Game1、Game2和CPU速度测试。在Theorectial Speed

（理论速度）项中，可以选择测试各种速度参数：Fill Rate（像素填充速率）、High Polygon Count多边形生成速

度、Texture Rendering Speed（纹理渲染速度）、Bump Mapping（凸凹贴图）。在 Virtual Tests中，Image Quality

表示测试图像质量。在 Custom标签可以对测试的具体项目进行选择。单击“确定”关闭该对话框。 

单击图 7-43中 Testing Options 项中的 Change按钮，程序给出 Options 对话框，如图 7-46。在 Benchmark

项中，Diable the screens between tests表示取消测试项目之间的屏幕显示，Test repeat count可以设置测试的重复

次数，如果选中 Looping，表示测试循环进行。在 Demo Mode中可以设定是否取消音乐，是否循环测试。单击
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OK关闭该对话框。 

 

 

图 7-45  选择测试项目 

 

图 7-46  测试选项设置 

单击 Display and CPU Settings项中的 Change按钮，程序给出 Display and CPU Settings对话框，如图 7-47。

其中 Rendering Platform选择需要测试的显卡。Screen Resolution and Color Depth可以选择色深和分辨率。Buffers

可对缓冲进行设置，一项为 z-buffer缓冲，另一项为 frame-buffer（帧缓冲）。根据显卡的不同在 Z缓冲中有 16-Bit、

24-Bit和 32-Bit三种选择；在帧缓冲中则有 Single（单线性过滤）、Double（双线性过滤）和 Triple（三线性过

滤）。在CPU Optimization中，D3D Software T&L表示由CPU进行T&L运算，所谓T&L，就是 tranform and lighting

的缩写，即坐标变换和光源处理。如果用户的显卡属于 Geforce级别，支持硬件加速 T&L，该下拉列表框中还

会多出一项 D3D Hardware T&L。用户可以根据自己显卡的情况，选择相应的参数。单击 OK关闭该对话框。 
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图 7-47  显示系统和 CPU设置 

以上选择完毕，单击 Benchmark，系统按照设定的参数进行开始自动进行测试。 

在这一过程中如果需要截取图像，则需要用户手动完成。一般来说 3DMARK 会自动截取零时刻图像，如

果需要截取任意时刻的图像，可以按下 F12（此键是 3DMARK 用来抓图的快捷键），这一时刻的图像就被以

shotxxxx..bmp的名称和格式保存在 3DMARK所在的目录中，如图 7-48。被抓下来的图也可以用来和 3DMARK

中提供的几幅参考图像做质量对比。有一点需要注意的是，抓下来的图应尽量与 3DMARK 提供的测试图像保

持一致，这样既可以减少对比图像时带来的不便，用增加了对比结果的准确度。 

 

图 7-48  测试画面 

3DMARK 测试完成后，给出结果对话框如图 7-49所示，上面给出了测试的分数。如果想保存结果，可以

单击右边的 Save Project按钮，在给出的“保存为”对话框中设置项目文件（.3dp）的文件名称和保存路径即可。

如果用户使用的 3DMARK 2000是在线注册版本，可以单击右边的 ResultBrowser按钮调用 ResultBrowser程序

对测试结果进行编辑和比较。 
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图 7-49  测试结果对话框 

如果用户有上网条件，可以单击界面中间的 Online ResultBrowser按钮，连接到 www.madonion.com网站上，

与该网站中的数据库中的数据进行比较。 
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Internet的魅力无法抗拒，但高额的上网费用却令大

多数网迷们头疼。鉴于此，各种各样的离线浏览器应运

而生。离线浏览器的作用就是将用户想浏览的网站内容

一次性地下载到硬盘中，然后用户就可以在断开网络连

接的情况下，慢慢地浏览自己感兴趣的网页内容了。 

Teleport pro号称网上的瑞士军刀，是一个老牌的离

线浏览器，它不仅具有很高的稳定性和简易的操作性，

而且功能十分强大，缺点是没有内嵌浏览器。WebZip最

大的特点是将下载的整个网站文件以 Zip 格式压缩打包

保存，这样可以有效的节省磁盘空间占用。Offline 

Explorer是新一代的离线浏览器，支持多线程下载，下载

速度非常快，其独特的Map显示功能对于了解下载页面

的链接结构很有帮助。 

 

 

第八章  离线浏览 

 

＝＝ 本章导读 ＝＝ 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

8.1  Teleport Pro 

 

 

 

 

 

 

 Teleport Pro由美国 Tennyson Maxwell公司开发的最经典的离线浏览器，曾被 PC Magazine评为“编

辑选择奖”、 ZDNet 评为五星。它可以完全或部分下载一个网站上的内容，使用户能够离线浏览；可以在硬盘

上创建一个与原网站完全相同的镜象；可以在网站上寻找并下载某一类型的文件；可以探测并记录一个网站的

所有网页和文件的清单；可以从一个中心网站探测每一个与之链接的网站。Teleport Pro支持 HTML4.0、CSS2.0、

DHTML和 Java applet ,实现了能够处理所有类型网站上的文件；它可以同时打开十个进程来下载文件，速度极

快，并支持断点续传；另外，我们还可以设定计划任务时间表，让 Teleport Pro在指定的时间自动拨号联接、完

成指定的任务后再自动挂断。 

版本 1.29 

类别 共享软件 

功能 离线浏览 

主页 http://www.tenmax.com/ 
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Teleport Pro的功能强大，但界面却非常简洁，如图 8-1所示。 

 

图 8-1  Teleport Pro主界面 

8.1.1  创建下载项目 

对于创建下载项目，Teleport Pro提供了向导和手动两种方式，下面分别进行介绍。 

1．向导方式 

 用鼠标单击工具栏中的 New Project Wizard按钮  ，或从 File菜单中选择 New Project Wizard命

令，程序给出新建项目向导对话框，如图 8-2。 

 
图 8-2  新建项目向导之一 

该向导界面中共提供了六种项目类型： 

l Create a browsable copy of a website on my hard drive：在用户的硬盘上建立一个可以离线浏览的站点副

本，包括所有必须的文件。对于只想要离线浏览网页的用户来说，该类型的项目是最简单和最快速的。

需要注意的是，在下载过程中，Teleport Pro有可能将一些文件名加以改动，以避免文件名的冲突。 

l Duplicate a website, including directory structure：在用户的硬盘上建立远程站点的镜像。远程服务器上

的所有文件将以和在服务器上的存放结构一样存放在项目主目录的子目录中，并且文件名和服务器上

的也会保持一致。 

l Search a website for files of a certain type：在站点上搜索用户需要的文件，如：图形文件、声音文件、

ZIP压缩包以及可执行文件等。Teleport Pro将会从用户给定的地址开始搜索指定类型的文件并加以下

载。 

l Explore every site linked from a central site：扫描链接到一个中心站点的所有站点。Teleport Pro将只取

回这些站点上的文件名，将它们像文件一样列在文件列表中，而不将这些文件取回，这样会很快得到

文件列表窗口 

进度状态条 

状态显示栏 

目录列表窗口 
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结果。用户可以通过 Teleport Pro提供的 Retrieve Now功能将自己感兴趣的文件下载回来，也可以设

置在扫描站点的同时将文件全部取回。 

l Retrieve one or more files at known addresses：从确定的地址中下载文件。 

l Search a website for keywords：根据关键字搜索站点。这一项目将建立和第一种类型一样的站点副本，

但是取回的网页中必须包含用户给出的关键字，这些网页中内含的文件也将被测试是否包含这些关键

字以决定是否下载。 

这里我们选择第一种类型。 

 单击“下一步”，在程序给出的向导界面中设置需要下载的网页地址（URL）和该下载项目的标题。 

可以直接输入准备下载的网站主页地址或某一网页的地址，也可以用浏览器浏览该网页，然后将该网页的

URL粘贴过来。一般建议用户不要轻易下载整个网站的内容，那将会很浪费下载时间和硬盘空间，我们可以用

浏览器浏览网站中我们感兴趣的内容，然后将该网页的 URL复制粘贴到这里，只下载该网页及其相关的内容。 

 

图 8-3  新建项目向导之二 

 单击“下一步”，在给出的向导界面中指定下载文件类型，有以下四个选项： 

·  Just text：只下载文本文件； 

·  Text and graphics：下载文本和图形文件； 

·  Text，graphics and sound：下载文本、图形和声音文件； 

·  Everything：所有的文件。 

如果只是离线浏览网页，可以选择第二项，只下载文本和图形文件。如果用户要访问的站点需要帐号和口

令，可以在 Account和 Password文本框中输入，否则 Teleport Pro 不能访问该站点。 
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图 8-4  新建项目向导之三 

 单击“下一步”，程序给出向导界面如图。单击界面中的“完成”按钮，程序给出项目文件保存对

话框，设置保存路径和文件名（文件类型为.tpp），单击“保存”即可。 

采用向导方式建立下载项目是一个简单快捷的方法，但有两点需要注意：第一点是要注意下载项目（Project）

和起始下载地址（Starting Address）是两个不同的概念，一个下载项目中可以包括多于一个的下载地址。用户

可以自行在下载项目中添加和删除开始地址，也可以对开始地址属性进行修改。 

第二点是虽然向导已经按照用户的指示自动设置了下载项目的属性（Project Properties），但用户可以按照

自己的需要对属性进行修改。 

 

 

图 8-5  新建项目向导之四 

 

2．手工方式 
对于熟练用户，可以采用手工方式创建下载项目，这样可以有更大的灵活性。 

首先建立一个空白下载项目。单击工具栏中的 New Project按钮  ，程序新建一个空白的下载项目。 

然后向空白下载项目中添加开始下载地址。单击工具栏中的  按钮，或单击 Project 菜单中的 New 

Starting Address命令，程序给出对话框如图。 

 

 

图 8-6  起始下载地址属性对话框 

 

在 URL 文本框中粘贴需要下载网页地址，在 Title 文本框中为该起始地址设置一个标题。在 Exploration  

Depth  and  Boundaries 项中设置下载搜索的深度和范围。 “ Explore  pages  up ___ links  away  from  this  
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address,  but  not  to  farther  than”表示设置搜索下载的链接层数，一般为了避免错过某些内容，用户将该

项限制数字设置的大一些，但下面的搜索范围选项就要设置的谨慎一些了。Addresses that begin with 

http://kaoyan.fanso.com/kaoyan/fuxi/more/表示将搜索范围限制在起始目录中， addresses that begin with 

http://kaoyan.fanso.com/表示将搜索范围限制在起始服务器内，anywhere within the path of external links表示允许

搜索外部链接服务器，files up to ___ links away from any external links表示设置搜索下载外部服务器的链接层数。

如果允许搜索外部服务器，一定要谨慎，否则有可能浪费大量的上网时间和硬盘空间。 

如果是访问需要帐号和密码的网站，可以在 Account和 Password中设置。 

如果需要添加多个起始下载地址，可以重复以上步骤。 

8.1.2  设置下载项目属性。 

单击工具栏中的 Project Properties按钮  ，程序给出设置界面如图 8-7。 

 

 

图 8-7  设置下载项目属性 

 

其中共有七个标签项，下面分别介绍。 

l Summary  

见图 8-7。界面列出了该下载项目的摘要。单击 Clear Project Database可以清除项目数据库，也就是初始化

Teleport Pro。最下面一个选项是自动保存项目数据库时间。 

l File Retrieval（取回文件） 

如图 8-8。在该界面中提供了下载文件类型控制设置。第一个单选按钮设置下载文件的大小限制，超过限

制的文件不下载，如果设置为 0，则下载所有文件。第二个单选按钮指定下载的文件类型，单击 Add按钮从弹

出的列表框中选择即可。在 Retrieval Modes（取回模式）项中，前三个复选框分别表示下载图片和声音等内嵌

文件、下载页面背景图片和下载 Java程序，值得注意的是最后一个复选框 Retrieve only file names，如果选择该

项，Teleport Pro将只取回站点文件的名字，而不下载真实的文件。 
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图 8-8  File Retrieval（取回文件）标签项 

l Browsing / Mirroring(浏览/映像) 
如图 8-9。Always save HTML pages表示完整保存为 HTML文件，该项一定要选上，否则打开下载的网页
会看不到图片。Replicate the directory structure of remote servers表示复制远程服务器的目录结构，如果不选该项，
所有下载文件将放置到同一目录下。Use MSIE-compatible filenames表示使用MSIE兼容的文件名，因为有些网
页文件并不以 html 或 htm 为后缀，选中该项 Teleport Pro 会自动检查文件并识别文件。Localize links for all 
retrieved files表示修改下载网页中的链接，使之本地化，可以离线浏览。在 Links for unretrieved files项中可以
设置未能取回文件的链接，包括连接到信息文件（提示没有下载的原因）、连接此文件网络中的地址和连接本地

保存文件的地方。Link using 8.3 filenames表示使用 DOS文件名格式。Relink all files in the project folder now表
示重新连接项目中的下载文件。 

l Exploration  
如图 8-10。在 Advanced links项中，第一个复选框表示探索服务器端的映射图像（每隔___个图点探索一次），

第二个复选框表示探索框架（Frame）文件，第三个复选框表示尽可能探索表格。在 Tenacity（方案）项中，第
一项设置下载文件的线程数目，第二项设置如果连接超过多少时间就自动断开下载，第三项设置让 Teleport Pro
在无法连接服务器的情况下可以尝试连接的次数以及对无法下载的文件的重复下载次数。 

 

图 8-9  Browsing / Mirroring(浏览/映像)标签项 
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图 8-10  Exploration（探索）标签项 

l Exclusions  

如图 8-11。设置下载时将排除的内容。用户可以在第一个文本框中设置想排除的关键字。可以用通配符，

比如*、？等。Match case表示符合大小写，Match whole word表示符合整个字符串。不同关键字可以利用分号

格开。第二个文本框中可以设置想排除的 DOS 格式的文件名，例如输入*.wav，则网页中所有的*.wav 文件都

将不被下载。不同文件名可以利用分号隔开。第三个文本框中设置想排除的网站，也可以利用通配符，注意每

一个地址要独占一行。 

 

图 8-11  Exclusions（排除）标签项 

l Netiquette（网络格式） 

如图 8-12。Enable Domain Dispersed Querying 表示把每次下载的连接请求分散到其他主机中，以加快下载

下载速度。Enable Server Overload Protection表示启动过载保护，对于连接不上和下载缓慢的服务器将减少连接

次数。Obey the Robot Exclusion Standard表示遵循服务器排除标准，让 Teleport Pro不到无权进入的地方尝试下

载文件。Wait ___ seconds before requesting more than two files at once from a single server可以设置对于同一服务

器连接的最小等待时间。Agent Identity项可以进行程序识别设置，因为有些服务器需要认证访问者的浏览器信

息或者需要口令，在这里有五个选项：匿名；告诉服务器是 Teleport Pro；伪装成 IE 浏览器；伪装成 Netscape

浏览器；使用其他身份。 
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图 8-12  Netiquette（网络格式）标签项 

l Advanced  

如图 8-13。这里可以设置Teleport Pro的自动操作。第一个复选框表示打开下载项目时自动运行Teleport Pro；

第二个复选框设置 Teleport Pro的运行时间；第三个复选框为不间断地运行，在停止多少秒后自动运行；第四项

为下载项目完成后自动退出程序。 

 

图 8-13  Advanced（高级）标签项 

为了避免每次重新设置的麻烦，可以在一个项目属性设置完成之后，单击菜单命令 File → Save Project 

Configuration，保存文件的后缀为.cfg。以后需要载入该文件时，单击菜单命令 File → Load Project Configuration。 

8.1.3  下载项目管理 

以下是工具栏中管理下载项目的常用按钮。 

·  打开项目文件，单击工具栏中的  按钮。 

·  保存项目文件，单击工具栏中的  按钮。 

·  开始下载一个项目，单击工具栏中的  按钮。 

·  暂停下载一个项目，单击工具栏中的  按钮。 

·  停止下载一个项目，单击工具栏中的  按钮。 

·  退出下载一个项目，单击工具栏中的  按钮。 

另外，如果需要设置项目中某一起始地址的属性，可以单击菜单 Project → Starting Address Properties。 
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8.1.4  离线浏览 

当下载项目全部完成以后，就可以离线浏览了。在程序界面左边的目录列表窗口选择根目录，单击鼠标右

键，在弹出的快捷菜单中选择 Open，程序会自动在系统默认的浏览器中打开起始页面，我们就可以进行离线浏

览了。也可以在程序界面右边的文件列表窗口中寻找起始文件，一般为 index.htm或 default.htm等，双击该文

件，在系统浏览器中打开即可。 

单击界面工具栏中的  按钮，程序会打开一个资源浏览器窗口，可以浏览下载的所有文件（没有路径）。 

8.1.5  其他功能 

1．多项目同时下载 

单击菜单 File → New Window，程序打开一个新的窗口，在其中设置下载项目进行下载即可。不过如果用

户的网络连接不是很通畅，多项目下载文件时，容易造成传输堵塞，反而得不偿失。 

2．使用代理服务器（Proxy Server）下载 

单击菜单 File → Proxy server，出现如图所示的对话框。选上最上边的复选框，在 Address栏中输入代理

器的 IP地址，单击 OK确定后，即可使用代理服务进行文件下载。通常使用局域网的用户要通过代理服务器才

能进入 Internet，利用 Teleport Pro下载文件必须使用此设置。 

 

图 8-14  设置代理服务器 

3．计划任务下载 

使用计划任务自动进行文件下载，是 Teleport Pro的优越功能之一。启动时间表有两种方法：一是打开 Project

菜单中的 Schedule项，程序将给出 Teleport Pro Scheduler窗口，如图 8-15；二是在系统开始菜单的 Teleport Pro

程序组中，运行“Teleport Pro Schedule”。 

 
图 8-15  Teleport Pro计划任务窗口 

单击计划任务窗口工具栏中的  图标或打开 Edit菜单中的 Add Project项，将出现图 8-16所示的 Project 

Schedule窗口。 
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图 8-16  设定计划任务 

在 Project 文本框中输入想要进入时间表的计划项目名称。如果不存在项目名称，可单击 New 按钮根据提

示创建一个新的计划项目。 

单击 Schedule标签进入时间安排表设置，根据用户的需要可以方便地设定文件下载的月份、星期、小时等

具体参数。 Parameters标签项中可以设定自动连接的设置以及下载完成后断开连接。 

如果要进行多个计划项目的时间表运作，只须重复上述步骤即可达到目的。对于相同时间内的两个计划项

目要同时连接时，通过 File菜单中的 Preference项，可以对某一计划项目设置优先权，以利于文件数据的顺利

传输。 

8.2  Offline Explorer 

 

 

 

 

 

 
 OfflineExplorer是由MetaProducts Corporation公司推出的新一代的离线浏览器，该程序的下载速度非

常快，而且功能全面。其主要特点有： 

l 续传； 

l 支持 HTTP和 SOCKS4 Proxy，用户可以设定代理服务器来下载文件； 

l 程序支持多线程，最多可同时下载 100个文件； 

l 程序内置了一个浏览器，直接使用 IE内核，可以在线或离线浏览站点； 

l 支持浏览器的鼠标拖曳和剪贴板的粘贴方法； 

l 支持 JavaScript和 Java类，用户可以轻易下载各种网页文件； 

l 支持使用进度表定期下载和使用命令行下载。 

对于离线浏览，除了可以使用内置浏览器外，程序还提供了与外置浏览器的接口，并提供浏览控制面板，

这样可以在界面窗口中直接浏览下载的网页内容，使用起来很方便。对于下载网页的浏览，程序提供了一个切

换到全屏幕方式浏览网页功能。此外，程序也提供了直接从系统中安装的 IE 或 Netscape 中读取保存的书签文

件功能，这样就可以轻松的将自己喜欢的网站下载到硬盘中，而且完全不用费时地输入下载地址。 

8.2.1  程序界面介绍 

Offline Explorer的程序界面如图 8-17所示。 

版本 1.2 

类别 共享软件 

功能 离线浏览 

主页 http://www.metaproducts.com/ 
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图 8-17  Offline Explorer主界面 

下面分别介绍界面中各个部分。 

① 程序菜单条 

② 程序工具栏 

③ 地址条：包括 Address（URL地址）文本框、Level（页面层次）下拉文本框和 Download按钮。用户可

以在此快速建立一个下载项目，本节后面将有介绍。 

④ Project / Map标签：用户可以在此切换 Project（项目）和Map（页面结构）窗口。 

⑤ 内置浏览器工具栏 

⑥ 项目列表框：用户可以在此对下载项目进行管理。 

⑦ 内置浏览器窗口：用户可以在此在线浏览 Internet网页，也可以离线浏览 Offline Explorer下载的网页。 

⑧ 下载状态窗口：显示各个下载线程的状态。 

⑨ 状态显示栏：其中 Downloaded显示已经下载的文件数，Queue显示已经加入下载队列准备下载的文件

数，Size显示已经成功下载的文件体积，Speed显示当前的下载速度。 

用户还可以根据需要改变界面布局。程序菜单条中的 View菜单如图 8-18所示。其中 Toolbars可以设置工

具栏中的按钮显示外观。Status Bar可以控制显示或取消状态显示栏。Schedule Manager表示计划任务管理窗口。

Explorer Bar有三个选项：可以控制 Project（项目）、Map（页面结构）和 Internal Browser（内置浏览器）三个

窗口的打开或关闭。Message中包括两项：Panel（线程状态显示）和Window（信息窗口）。 

 

图 8-18  View菜单 

8.2.2  运行环境设置 

在使用 Offline Explorer下载文件以前，必须先进行一些选项设置。单击工具栏中的 Options按钮，或单击

程序菜单 View → Options，程序给出设置界面如图 8-19。 
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图 8-19  Connection标签项 

下面分别介绍各个选项的设置。 
l Connection  
程序首先给出的是 Connection标签项。其中在 Internet connection中，Number of connections表示连接个数

（同时运行的下载线程数）。Timeout（seconds）表示等待时间（等待连接网页的时间，超过设定时间无响应则
会断开连接）。Delay between downloads表示下载间隔。复选框 Limit numbers of retries to表示限制重试次数（连
接失败时重试的次数），为防止 Offline Explorer不断重试连接无效 URL，降低效率，建议选中该项，并设置适
当次数（例如 50）。 
复选框 Internal HTTP server表示使用程序内置 HTTP服务器，该项有两个作用，一个是解决某些网页下载
后不能正常浏览的问题，另一个是在局域网内，可以让别的计算机的用户访问自己下载的网页内容。由于不同

的网络连接和网页结构的不同，有时选中该项反而会使用户下载的网页不能正常浏览，所以建议用户取消该选

项，当遇到下载网页不能正常浏览的问题时，在试着将该选项选中。Agent identification 表示代理设置（是指
Offline Explorer相对于其他服务器程序代表自己的方式），不过一般并不常用，使用默认值即可。 

l Proxy Server（代理服务器） 
其中有 HTTP和 FTP两个子标签。Offline Explorer 支持通过 HTTP、SOCKS4和 User@site三类代理服务

器访问互联网。此类用户可通过该项设置代理类型和具体地址、端口、用户名和密码。 
l Tools（工具） 
其中有三个子标签，分别可以设置网页的外部浏览器、查看器和编辑器。单击 External Browsers子标签，

程序给出设置界面如图 8-20。在 File 项中设置浏览器应用程序，可以单击右边的浏览按钮查找，也可以单击
Autotect让程序自动检测（不一定能检测到）。在 Caption文本框中输入外部浏览器名称，单击 Add按钮，就可
以将该浏览器加入到列表框中，选中列表框中的某一浏览器前面复选框，表示使用该浏览器。 

 

图 8-20  External Browser标签项 
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在 Viewers标签项中可以设置网页查看器，在 Editors标签项中可以设置网页编辑器，具体设置步骤与前面

类似。 

l Advanced  

单击 Advanced标签项，程序给出设置界面如图 8-21。在Map mode项中，可以设置Map窗口显示方式，

只显示选择的下载项目中的下载文件或显示所有下载项目中的下载文件。Autosave项可以设置是否自动保存以

及间隔时间。Confirmations项设置当删除文件或退出程序时是否确认。Tools window项设置工具栏的显示方式。

在 Appearance项中，Run in system tray表示在系统任务栏中运行，Display splash screen at startup表示显示程序

的启动画面。Double-click on a project to设置当双击下载项目时，程序打开浏览器浏览该项目还是打开项目属性

对话框。 

Advanced 还有两个子标签，Download Directory 可以设置保存下载文件的文件夹，程序默认为“c：

\download\”。在 Disk Space中，可以设置当保存下载文件的硬盘分区小于多少时，Offline Explorer将停止下载。 

 

 

图 8-21  Advanced标签项 

8.2.3  新建文件夹 

新安装 Offline Explorer后，程序界面左边的 Project列表框中只有一个 default文件夹，当用户添加下载项

目时就保存在该缺省文件夹下。为了方便分类保存下载数据，用户可以自己添加文件夹，有两种方法。一种单

击工具栏中的 New按钮旁边的下拉按钮，选择 Folder，程序在左边的项目列表框中添加一个新的文件夹，如图

8-22。用户输入文件夹的名称即可，例如输入“电脑商情”，项目列表框中就新增了一个“电脑商情”文件夹。 

 

图 8-22  新建文件夹 

还有一种方法是单击程序菜单条 File → New …，或在项目列表框内单击鼠标右键，在弹出的关联菜单中
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选择 New…，程序弹出 New窗口如图 8-23所示，在其中选择 Folder图标，效果与前面相同。 

 

图 8-23  New窗口 

8.2.4  创建下载项目 

 首先在项目列表框中选择一个文件夹，例如“电脑商情”，单击工具栏中的 New按钮旁边的下拉按

钮，选择 Project，程序给出项目设置对话框如图 8-24。 

 

图 8-24  Project标签项 

在 Adress（URL）项中输入准备下载的网站主页地址或某一网页的地址，方法是用浏览器浏览该网页，然

后将该网页的 URL粘贴过来。一般建议用户不要轻易下载整个网站的内容，那将会很浪费下载时间和硬盘空间，

我们可以用浏览器浏览网站中我们感兴趣的内容，然后将该网页的 URL复制粘贴到这里，下载该网页及其相关

的内容。 

在 Project name项中为该下载项目起一个名称。Level limit可以设置下载链接的深度，一般设置 3至 5即可，

不过为了避免错过某些内容，用户可以取消该项限制。在 File modfication check 项中，用户可以设置 Offline 

Explorer更新下载网页的方式：Download only Modified files表示只下载改变的文件；Download All Files表示下

载所有的文件，而不论是否文件是否改变；Do not download existing files 表示不下载已存在的文件两；Skip 

existing files on levels higher than 表示不下载超过 x层的链接，具体层数可以在右边的下来文本框中设置。 

 切换到 File Filters标签项，如图 8-25，设置下载文件过滤。一般来说，如果只是下载网页进行离线

浏览，可以只选择 Text和 Images两项。选择某一文件类型，界面右边给出了具体的设置选项。 
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图 8-25  设置下载文件过滤 

 切换到 URL Filters标签项，设置下载文件过滤。其中有四个选项： 

l Protocol：通过协议过滤，http://www.server.com/dir1/dir2/file.htm； 

l Server：通过服务器名过滤，http://www.server.com/dir1/dir2/file.htm； 

l Directory：通过文件目录过滤，http://www.server.com/dir1/dir2/file.htm； 

l File：通过文件名过滤，http://www.server.com/dir1/dir2/file.htm。 

选择某一过滤类型，界面右边给出了具体的设置选项。以 Server为例，如图 8-26。 

 

图 8-26  Server子标签项 

其中有四个选项： 

l Load files from all servers：下载所有服务器中的关联文件； 

l Load files only within the starting domain：只下载起始主机中的关联文件； 

l Load files only within the starting server：只下载起始服务器中的关联文件； 

l Custom servers configuration：自定义服务器过滤，选择该项后，可以加入下载关键字（对于服务器名），

方法是在 Keyword文本框中输入关键字，然后单击 Add按钮将其加入到列表框中。 

通常一个网页中会有很多链接，有些是和其他网站主页（服务器）的链接，例如很多广告链接，友情连接

等，这些是我们应该避免下载的，所以建议用户选择的三项，只下载起始服务器中的关联文件，选择第四项自

定义关键字也可以。 

 切换到 Advanced标签，其中 Parsing项中可以设置是否下载网页中的 JavaScript和 Java小程序。 

该标签下还有三个子标签，其中 Link Translation（链接转换）可以定义下载到硬盘的网页中的 HTML链接

如何转换，共有三种转换模式：Offline Translation（离线浏览）、On-line Translation（在线浏览）和 No Translation

（不作转换），一般设置为离线转换。设置为 On-line的好处是方便上网查找未下载回来的链接或下载软件，缺

点是用户如果单击此类链接，即使不想上网系统也会自动与目标网页链接。 

切换到 Scheduling子标签，程序给出如图 8-27所示设置界面。在其中可以设置计划任务的时间安排。 
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图 8-27  Scheduling子标签项 

 设置好项目属性后，单击 OK保存。此时在主界面中的 Project列表框的“电脑商情”文件夹中就添

加了一个“今日市场”下载项目。 

在 Project列表框中选择某一下载项目，单击工具栏中的 Download按钮  ，程序就会自动连接到目标

网页并开始下载。此时该项目前的小图标由  变成  。如果想停止下载，单击工具栏中 Stop按钮即可。

Offline Explorer支持多个项目同时下载。 

在下载过程中，用户可以从下载状态窗口中了解每个进程所下载文件的 URL、大小、已下载比例、连接状

态等信息，从程序状态栏中则可了解各个项目中已下载的文件个数、总计大小、等待下载的队列个数和平均下

载速度。当状态栏最左边显示 Ready时，表明该下载项目已经下载完成。 

8.2.5  下载项目管理 

单击工具栏中的 Delete、Cut、Copy和 Paste按钮可以删除、剪切、复制或粘贴选定的下载项目。 

选定某一下载项目，单击该项目的名称，然后在文本框中输入新的名字，即可重命名该下载项目。 

选定某一下载项目，单击工具栏中的 Properties按钮，可以修改下载项目的属性。 

8.2.6  创建模板与快速下载 

为了省去每次创建下载项目都要重新设置的麻烦，我们可以将所有的参数设置保存在模板（Template）中。 

单击菜单命令 File → Templates …，程序弹出模板编辑窗口，如图 8-28。可以看到其中只有一个系统默认

的模板“Template 0”，可以修改该模板，也可以创建一个新的模板。 

 

图 8-28  模板编辑窗口 

可以看到其中只有一个系统默认的模板“Template 0”，我们可以修改该模板，也可以创建一个新的模板。
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我们选择后一种方法。 

单击界面中的 New…按钮，程序给出对话框如图 8-29。 

在 Template name文本框中键入新模板的名称，例如“Tempate 1”，剩下的参数设置方法与第四小节创建下

载项目相同。参数设置完毕，单击 OK，回到模板编辑器，可以看到新模板已经加入其中了。用鼠标选择该模

板，然后单击 Default 按钮，就可以将该模板设置成缺省模板，标志是该模板图标上多了一个小的对号，如图

8-30。 

以后程序建立新的下载项目时，就会自动使用该模板的参数设置，用户也可以单击工具栏中 New按钮旁边

的下拉按钮，在弹出的菜单中选择任何一个模板，如图 8-31。 

 

 

图 8-29  设置模板参数 

 

图 8-30  设置缺省模板 

 

图 8-31  选择模板创建下载项目 

根据自己的需要设置好模板后，用户就可以快速创建一个下载项目。方法是在程序主界面 Address 文本框

中粘贴需要下载的网页的地址（URL），在 Level下拉文本框中设置限制的链接层数（如果对链接层数无限制，

则应将该文本框清空），然后单击右边的 Download 按钮  ，程序即自动创建一个新的下载项目并

立即开始下载，用户可以在 Project窗口中设置该下载计划的名称。 



常用工具软件大全 204

8.2.7  离线浏览 

浏览已下载到硬盘中的网页，共有三种方法。 

第一种是如果在第二小节运行环境设定中，在 Advanced 项中设置双击下载项目可以浏览该项目，则在

Project窗口中直接双击需要浏览的下载项目即可，如图 8-32。也可以选择某一下载项目，然后单击鼠标右键，

在弹出的关联菜单中选择 Browse（使用内置浏览器）或 Browse with（选择外置浏览器）即可。 

 

图 8-32  离线浏览界面 

第二种是单击 Map 标签，在 Map 窗口中会显示该网页及其关联网页的结构，在其中直接双击某一页面即

可浏览。 

第三种是直接到下载文件夹中用外置浏览器打开 HTML文件浏览。不过还是第一种方法比较方便。 

8.3  WebZip 

 

 

 

 

 

 WebZIP是非常著名的离线浏览工具，它的主要特色是将下载的整个网站文件以 Zip格式压缩打包保

存，这样可以有效的节省磁盘空间占用，并且如果是在程序界面中进行离线访问，还可以直接调用 Zip文件中

压缩的网站文件，而不用解开压缩再进行浏览。 

WebZIP 内置了一个浏览器，直接使用 IE 内核，可以在线或离线浏览站点；WebZIP 还具有流行的多点传

输功能，它能将需要下载的多个页面同时下载，从而加快了整体下载速度。 

WebZIP 有非常直观的下载状态以及下载历史纪录显示，它将以图示方式给出当前下载速度状态信息。

WebZIP的界面形式如图 8-33所示。 

版本 3.5 

类别 共享软件 

功能 离线浏览 

主页 http://www.spidersoft.com/ 
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图 8-33  WebZIP程序界面 

8.3.1  创建下载任务 

我们首先介绍一下在任务列表窗口中建立新的目录的方法。首先在列表窗口中选择一个目录（根目录为

Task），单击任务列表框右边竖向按钮条中的 New Category按钮  ，程序便在该目录下建立了一个子目录，

输入子目录的名称，直接回车即可。 

下面是创建下载任务的步骤。 

 在任务列表窗口中选择一个目录，单击竖向按钮条中的 New Task按钮  ，或选择菜单命令 File 

→ New Task…，程序给出如图 8-34所示设置界面。 

 

图 8-34  Download URLs标签项 

此时显示的是 Download URLs标签项。在 Download URLs项中选择需要采用的下载方式，Download a Web 

page and follow links from this start page表示下载网页及其所有链接内容，并保持原来的相对链接；Download a 

list of URLs表示下载一组指定的网页。在此选择前者。在该复选框关联的 URL文本框中输入需要下载的站点

URL地址。此时程序会自动在 Task Name文本框中创建该下载任务的名称（也可以自行设定）。在 Category项

中选择任务列表窗口中的目录，在 Save to文本框中提供了程序默认保存下载文件的路径，用户可以自行修改 

 切换到 Download Method标签项，用户可以在 Profile下拉列表框中选择一种预设的下载方案。程

序一共提供了六种方案 

l Selected Directory（All）：下载选择目录中的所有文件。 

l Selected Directory（Text Images）：下载选择目录中的文本和图形文件。 



常用工具软件大全 206

l Selected Page（All）：下载选择页面及与其链接的所有文件（只有一层链接）。 

l Selected Page（Text Images）：下载选择页面及与其链接的文本和图形文件（只有一层链接）。 

l Selected Site （All）：下载选择页面及其所有链接（没有链接层数限制）。 

l Selected Site（Text Images）：下载选择页面及其所有链接的文本和图形文件（没有链接层数限制）。 

通常我们选择最后一项 Selected Site（Text Images）即可。 

 

图 8-35  Download Method标签项 

 一般设置到这里，用户就可以单击界面下方的 Run Now按钮开始进行下载了。用户也可以继续进

行详细的设置，切换到 FileTypes 标签项，程序会给出如图 8-36所示界面，从中可以选择下载的文件类型。清

除界面中的 All复选框，然后在下面的列表框中选择需要下载的文件类型，单击每一类型前面的扩展“＋”号，

还可以列出每一类型的子类型。如果只是以离线浏览为目的，一般选择 HTML和 Images 即可。程序还提供了

自定义下载文件类型、编辑当前列表中的文件类型和删除无用的文件类型等功能，用户可以根据自己的需要使

用。 

 

图 8-36  FileTypes标签项 

 切换到 Followed Links标签项，程序给出如图 8-37所示界面。在 Followed links-Levels项中，用户

可以设置可下载的页面链接层数，其中包括只下载当前页面 This page only、用户自己定义下载层数“This page 

and ___ level/s”和所有链接页面 All levels。在 Followed page links - Location项中提供了链接页面的下载范围，

其中包括只下载当前页面所属目录下的页面 Within current directory、属于当前服务器中的链接页面 Within 

current site、任意位置的链接页面 Anywhere。在 Followed media links - Location项中提供了链接媒体文件的下载

范围，其选项与下载页面相同。 
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图 8-37  Followed Links标签项 

 URL Filters标签项中有两个子标签，其中可设置一些简单的网站下载过滤。Include Filters可以过滤

需要下载的内容，Exclude Filters可以过滤不想下载的内容。以 Include Filters为例，界面如图所示。其中包括

三种过滤对象：All Links（所有链接）、Page Links（页面链接）和 Media Links（媒体链接）。用户可以在上面

的文本框中输入过滤关键字，然后单击 Add按钮，将其加入到下面的列表框中即可。 

 

图 8-38  Include Filters子标签项 

 在 Advanced标签项中包含两个子标签，Followed Links（Adv）可以设置下载页面的脚本控制，Link 

Conversion可以设置下载的文件链结地址的方式，一般使用程序的默认设置即可。在 Password标签项提供了需

要使用授权口令登录登录下载服务器时的用户名和登录口令设置，根据需要设置即可。 

 切换到 Schedule标签项，如图 8-39所示。 
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图 8-39  Schedule标签项 

可以设置是否使用定时下载，分三个选项：Now表示立即开始下载、“At：”表示在设定的时间开始自动下
载、Don’t schedule this task表示不对这个任务进行预定。如果选择定时下载，需要单击界面中的 Schedule按钮 

 ，程序会给出 Schedule Task设置界面，如图 8-40。在其中提供了只下载一次 Schedule（Once-off）和周期
性下载同一网站 Schedule （recurring）两个设置项目，其中后者非常适合经常更新、而又需要经常下载的网站。
如果网站内容非常重要，极具保存价值，而网站更新速度有极快，使用这项功能非常合适。 

 

图 8-40  定时下载设置界面 

 全部设置结束后，单击 Run Now!按钮，程序回到主界面并自动开始下载操作。下载过程中，程序

会在状态窗口中显示下载速度曲线，非常直观。 

8.3.2  快速下载 

以上我们给出的是以创建下载任务方式进行网站下载的方法，从介绍中可以看到，这个操作有点繁琐，实

际上如果你对下载站点中所要下载的内容捕获得很准确，在 WebZIP 中进行网站下载是非常简单的：使用浏览
器打开需要下载的网站，记录下网址（将其复制到系统剪贴板），然后切换到WebZIP界面，先在左边的任务窗
口中选择一个目录，然后将该地址复制到界面上部的 Address文本框中，在上面的 Download下拉列表框中选择
一种下载方式，通常选择 Seleted Site（Text Images），单击右边的 Download按钮  ，程序便在选定的目录中
创建该任务，并自动开始下载操作。 

 

图 8-41  快速下载 
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8.3.3  下载任务管理 

l 删除下载任务：选择某一下载任务，单击任务窗口右边的  按钮。 

l 刷新下载任务窗口：单击任务窗口右边的  按钮。 

l 设置下载任务属性：选择某一下载任务，单击任务窗口右边的  按钮。 

l 开始下载任务：选择某一下载任务，单击任务窗口右边的  按钮。 

l 停止下载任务选择某一下载任务，单击任务窗口右边的  按钮。 

l 查看下载任务的下载状况选择某一下载任务，单击鼠标右键，在弹出的右键菜单中选择 Explore命令。 

8.3.4  离线浏览 

当下载项目全部完成以后，就可以离线浏览了。在程序界面左边的任务窗口中选择某一任务，单击鼠标右

键，在弹出的快捷菜单中选择 Browse → Offline，程序会自动在系统默认的浏览器中打开起始页面，我们就可

以进行离线浏览了。 

8.3.5  运行环境设定 

单击程序界面菜单 View → Options → Preferences…，程序弹出设置界面如图 8-42。 

l 首先给出的 General Settings标签项，Show summary on task completion表示当任务完成后显示摘要信

息。Beep on task completion表示当任务完成后发出提示声音。最下面的一项可以设置 URL地址文本

框中的保留历史信息的数目。 

l 在 Default Folders标签项中可以设置存放临时文件的目录。 

l 在 Personal Intranet标签项中设置存放下载文件的默认路径。 

l Connection标签项如图 8-43。在 Proxy项中可以设置代理服务器。在 Agent Identity项可以进行程序识

别设置，因为有些服务器需要认证访问者的浏览器信息或者需要口令，用户可以选择匿名

（Anonymous）、告诉服务器是WebZip或伪装成 IE等其他程序。 

  

图 8-42  运行环境设定界面                        图 8-43  Connection标签项 
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现在网上免费邮箱方兴未艾，很多网上用户都有一

个以上的邮箱，所以拥有一个 E-Mail客户端软件对于邮

箱的管理就会非常方便。 

FoxMail是最著名的国产电子邮件客户端软件，以其

功能强大、容易使用、符合中国人的使用习惯等特点深

受国内广大用户的青睐，甚至在国外也有一些支持者，

曾获得过 ZDNet的五星级软件称号。 

The Bat！是一个短小精悍、功能强大的邮件客户端

软件，在众多的同类工具中，它的收发速度显得非常突

出，而且具有支持多用户、多信箱、地址薄、邮件过滤、

PGP 加密等强大功能，但其大小却不到 2M。由于 The 

Bat！是由外国人编写的，所以对各类中文编码方式的支

持不如 FoxMail。 

 
 

第九章  电子邮件 

 

＝＝ 本章导读 ＝＝ 

 

 

 

 

 

 

 

 

9.1  FoxMail 3.1 

 

 

 

 

 

 

 FoxMail是目前最著名的的国产邮件客户程序，该工具提供极好的中文兼容性，支持 GB，BIG5，HZ

等格式编码。程序支持多个邮箱帐户，同时从多个服务器下载邮件。程序支持远程邮件管理，支持从邮件服务

器直接删除邮件。此外，它也提供本地邮箱加密功能，共享地址簿功能。程序内置拨号网络管理，可以实现自

动拨号和断开连接。程序内置 BIG5码与 GB码转换功能，可以直接阅读或发送 BIG5码的邮件。程序提供 HTML

格式的邮件的支持，提供一个服务器邮箱监视工具 Notifier等等，都是非常实用的功能。 

下面介绍程序的常用功能。 

9.1.1  创建新帐户 

 FoxMai安装到系统后，第一次启动时程序会给出创建新帐户向导，如图 9-1所示。 

版本 3.1 

类别 免费软件 

功能 邮箱管理 

主页 http://www. aerofox.com/ 
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图 9-1  FoxMail用户向导 

 单击“下一步”，程序给出向导界面如图 9-2。在“用户名”文本框中输入用户姓名或代号。如果用
户有多个邮箱，并且准备建立多个账户管理多个邮箱，建议输入与对应邮箱相关的信息，例如“263.net”。“邮
箱路径”是用来设置收到的信件的存储路径。一般选择默认路径，即安装 FoxMail所在的路径。用户也可以自
行设定路径，单击“选择”按钮，在弹出的目录树窗口中选择某个目录即可。 

 

图 9-2 建立新的用户帐户 

 单击“下一步”，程序给出向导界面如图 9-3。“发送者姓名”用来在发送信件时追加用户姓名，以
便于 E-mail 的接收者识别邮件到底是由哪个用户发送过来的。“邮件地址”信息则是在发送的邮件中显示发送
者的 E-mail地址，以便于接收者给您回信。 

 

图 9-3  邮件身份标记 



常用工具软件大全 212

 单击“下一步”，程序给出向导界面如图 9-4。在其中设置 POP3服务器地址、POP3帐户名及 SMTP

服务器，POP3的全称是 Post Office Protocol，即邮局协议，用于电子邮件的接收。SMTP的全称是 Simple Message 

Transfer Protocol，即简单邮件传输协议,用于电子邮件的传输。例如 263.net网站提供的免费 E-mail服务的 POP3

服务器地址为 263.net，SMTP服务器地址为 smtp.263.net。具体的地址应该根据您的 ISP提供的地址进行设置。

在申请免费邮箱时，页面一般会告诉用户 smtp和 pop3的填写方法，可重新到邮箱申请页面查看。 

 点击“下一步”，程序给出“帐户建立完成”界面。单击“完成”按钮，完成第一个帐户的建立，

同时 FoxMail安装完成。程序界面如图 9-5所示。 

 
图 9-4  指定邮件服务器 

 
图 9-5  Foxmail程序界面 

9.1.2  帐户属性设置 

通过“账户属性”对话框，可以对账户的个人信息、邮件服务器、接受和发送邮件的方式等方面进行设定。

首先选定需要设置属性的帐户，然后单击鼠标右键，在弹出的关联菜单中选择“属性”命令，或单击菜单“账

户”→“属性”命令，可以打开“账户属性”对话框，如图 9-6。 

 
图 9-6  帐户属性对话框 
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下面简要介绍一下左边窗口中的重要选项。 

l 个人信息：填入用户的姓名（发送邮件时用户的名字标识）、单位、电子邮件地址和回复地址。其

中回复地址是指在发出的邮件中加上回复地址标记，对方回信时将回复给此地址。如果希望对方

回复到用户的默认电子邮件地址，就不必填写此项。 

l 邮件服务器：用户的邮件将通过 SMTP 服务器发送出去。POP3 服务器保存了外界发给用户的邮

件，用户可以通过 FoxMail 将这些邮件下载到硬盘中，再处理这些邮件。帐号和口令是指 POP3

服务器的帐号。用户通过此帐号和相应的口令从 POP3 服务器上收取您的邮件。如果用户对口令

的安全性不放心，可不在这里输入口令，当收取邮件时再输入口令。在“高级”中可以设置 SMTP

和 POP3的端口号，一般默认即可。 

l 发送邮件：如果选择“发送邮件后立即取新邮件”，工具条上的“发送”按钮功能将变为“发送并

接收”（按钮文字不变化）。如果在默认 E-mail域名中填写一个邮箱地址的后缀，那么在邮件编辑

器中可以只填写使用该后缀的收件人 E-mail地址的账号。7 

l 接收邮件：“在服务器上留下备份”表示收取邮件时，将不删除服务器上的邮件。  退出时自动

压缩邮箱：邮件删除后，需要压缩才能真正将其物理删除。用户可以设置一个比例，当邮箱浪费

空间超过某一比例时就自动进行压缩。 

l 其他 POP3：如果用户有多个服务器的邮箱帐号，可以在此处将服务器及帐号信息录入，这样就

可以同时从多个服务器收取邮件。 

l 模板：模板让用户可以轻松地写/回复/转发邮件。用户可以用鼠标右键添加各种 FoxMail的宏定义。

当撰写邮件时会自动进行替换。 

l 网络：在此可以指定使用系统的网络设置，或者使用本帐户的网络设置。 

9.1.3  撰写、发送和接收邮件 

1．撰写邮件 

新版的 FoxMail提供了一个功能强大的邮件撰写编辑器。单击工具栏中的“撰写”按钮，可以打开该编辑

器，如图 9-7。它主要有以下几个特点：一是提供了大量的文本编辑功能，并可以自由地设定字体的大小及背

景的颜色；二是像WORD2000那样支持鼠标即点即输；三是对中文支持得更好。 

首先是邮件头信息的填写，“收件人”一栏可以手工填入收信人的 E-mail 地址（如输入不同的多个地址，

则必须用逗号分隔），也可以单击该按钮，程序会弹出“选择地址”对话框，把其中的一个或多个地址名单或者

一个组添加到“收件人”列表框即可（在使用“选择地址”以前，必须先建立一个地址簿）。“抄送”表示信件

将同时被发送给其他人，所有接受邮件的人都知道有谁收到了该邮件。单击“其他邮件头信息”按钮  可以

增加“暗送”和“回复”栏。“暗送”与“抄送”不同，“暗送”该邮件，则邮件的任何一位接收者不会知道此

邮件到底被同时发送给了哪些人。“发件人”一栏填写的是发件人的 E-mail 地址。“回复”一栏填写的 E-mail

地址将会在收信人回复此信时作为收件人地址。在“主题”一栏中可以输入关于邮件的简短描述。 

 

图 9-7  邮件撰写窗口 
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如果需要从程序的地址簿中选择，可单击  按钮，程序给出如下图 9-8 所示的“选择地址”对

话框。在左边的收信人地址列表中选择接收地址，然后单击界面中的“->”按钮将其添加到界面右边的列表框

中。在界面右边提供了“收件人”、“抄送”、“暗送”三个项目，如果需要发送邮件的多个副本，可分别进行设

置。 

 

图 9-8  从地址薄中选择地址 

在正文框中填写信件正文。所谓附件是随附邮件一同寄出的文件，文件的格式不受限制，这样电子邮件不

仅仅能够传送纯文本文件，而且还能传送包括图像、声音以及可执行程序在内的二进制文件。如果需要添加附

件，在“邮件编辑器”窗口中，单击工具栏上的“增加附件”按钮  ，弹出一个标准的 Windows 文件选择

窗口，在其中选择需要添加的“附件”文件即可。可以重复以上操作，选择多个附件。 

2．发送邮件 

写好一个新的邮件后，有三个选择： 

l 立即发送：信件在发件箱中留一个备份，并立即发送出去。工具栏中的相应按钮为  。 

l 放入收件箱，等候发送：信件保存在发送队列中，并不立即发送出去。用户可以写好很多待

发送的信件后再一次性地发送出去，这样可以缩短连线时间。工具栏中的相应按钮为  。 

l 只保存，但不发送：作为草稿保存，供下次修改后再发送。工具栏中的相应按钮为  。 

3．接收邮件 

单击程序主界面工具栏上的“收取”按钮，将激活一个收取邮件对话框，收取当前账号所包含的邮箱的邮

件，如图 9-9；该操作也可以通过右键关联菜单的“收取邮件”命令执行。按 F4键或者单击“文件”菜单的“收

取所有账户邮件”命令，则收取所有账户邮箱中的邮件。 

 

 

图 9-9  收取邮件 

4．阅读邮件 

邮件收取结束后，点击账户下的“收件箱”将会在“邮件列表框”上看到所有的邮件。还未阅读的邮件前

有一个未拆开的信封标识。点击任何一个邮件，信件的内容即显示在“邮件阅读框”中。双击邮件，将打开邮
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件阅读窗口，便于阅读内容较多的邮件。 

如果邮件是 HTML格式的邮件,默认情况下使用嵌入式 IE浏览器显示 HTML邮件，同时阅读框右上方出现

“手指”和“地球”两个小图标。单击手指图标，弹出一个菜单，利用它可以把 HTML文件保存到指定路径，

也可以改用浏览器进行浏览；地球图标用于切换文本和超文本显示方式。 

如果邮件包含了附件，主窗口上将会自动增加一个附件框，显示附件的文件图标和名称。双击“附件”的

图标，弹出一个对话框。其中包含：“打开”、“保存为”、“取消”三个按钮，单击“打开”按钮，则打开附件文

件；单击“保存为”按钮，则把附件保存到指定路径位置。 

9.1.4  Foxmail管理功能 

1．邮件管理 

FoxMail提供了强大的邮件管理功能。主要的邮件管理操作有： 

l 保存邮件 

点取主窗口“文件”菜单的“保存为”命令，将弹出一个Windows对话框，输入文件名，再点击“保存”

按钮，所选邮件即被存为相应的文本文件。在“文件”菜单的选项中还有一个是“附加保存”，单击该命令，程

序弹出和前述一样的对话框，选择一个文本文件，单击“保存”按钮后，邮件内容将被添加在这个已经存在的

文本文件的末尾，并用一行“*”作为不同邮件之间的分隔。 

l 导出、导入邮件 

单击“文件”菜单中的“邮件导出”导出命令，程序给出“另存为”对话框。导出的邮件用户可以选择不

同的格式保存，在“保存类型”中有四个选项：*.eml 表示以 Outlook Express 的邮件格式存放，*.msg表示以

OutlookExchange的邮件格式存放。用户也可以一次性的将多个邮件导出，按住 Ctrl或者 Shift键，可以用鼠标

在邮件列表框中选择多个邮件，然后一起导出。所有邮箱中的邮件均可导出。 

导入与导出相反，可以一次把一个或多个邮件文件导入到当前的邮箱中。 

l 删除、转移邮件 

选中信箱中的一个或多个邮件，通过按键盘上的 Delete键，或者点击“邮件”菜单和弹出式菜单的“删除”

命令，邮件即被删除。这种删除实际上是把邮件转移到了 FoxMail的“废件箱”中。要想真正从硬盘上删除邮

件，需要再到“废件箱”中将其删除。如果希望直接删除，可以先选择要删除的邮件，再用 Shift+Del键完成删

除工作。 

选中信箱中的一个或多个邮件，通过“邮件”菜单或者右键关联菜单中的“转移到”命令，就可以把选中

的邮件转移到任何邮箱中；也可以直接用鼠标拖拉邮件到另一个信箱。 

l 查找邮件 

当收件箱中堆积了很多邮件时，要找到用户所需的邮件就很不容易了，如果根据邮件头信息逐个进行查找，

将会浪费大量的时间。为此，FoxMail提供强大而实用的邮件查找功能。 

在 FoxMail主窗口下打开一个收件箱，然后单击菜单“编辑”→“查找邮件”，此时弹出一个对话框。其中

有两个选项：“只查找邮件头”和“区分英文大小写”。在“查找”栏中输入与所查邮件有关的信息，然后单击

“查找下一个”按钮，FoxMail就开始进行邮件查找了。按 F3键可以继续查找下一封信。 

2．邮箱管理 

每个账户系统都会定义以下几个邮箱： 

·  收件箱：默认时，所有收到的邮件放在此箱中。 

·  发件箱：撰写的和等候发送的邮件放在此箱中。 

·  已发送邮件：已经发出的邮件可自动转移到此邮箱中。 

·  废件箱：保存删除了的信件。您可以通过转移信件将废件箱中的信件恢复到别的其他邮箱中。 

下面介绍对邮箱的一些常用操作： 

l 新建邮箱 

选中一个账户或者一个邮箱，然后点击“邮箱”菜单或者单击鼠标右键弹出的菜单的“新建邮箱”命令，即可

在该账户或者邮箱下建立一个新的邮箱。 
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l 删除邮箱 

选择需要删除的邮箱（只能是用户建立的邮箱），然后点击“邮箱”菜单或者弹出式菜单的“删除”命令，系统

会询问是否确实要删除此邮箱。邮箱被删除后，该邮箱中的邮件将不可恢复 

l 邮箱更名 

选择需要更名的邮箱（只能是用户建立的邮箱），然后点击“邮箱”菜单的“更名”，您也可以两次单击该邮箱，

这时邮箱的名称变为可编辑状态。输入新的名称，再按回车即完成邮箱的更名。 

l 邮箱加密 

选择需要加密的邮箱（只能是用户建立的邮箱），然后点击“邮箱”菜单或者弹出式菜单的“加密”命令，会弹

出口令输入对话框，在“口令”和“确认”栏输入相同的口令，再按确认按钮即可。被加密的邮箱前面将会有一枚

钥匙形状的标记，表示此邮箱已经加密。要想查看加密邮箱里面的邮件，必须先给该邮箱解密。在加密邮箱处

点击鼠标右键，在弹出的菜单选项中选择“解密”，接着将出现一个对话框，要求您输入解密口令。输入先前加

密用的口令，然后点击“确定“按钮，邮箱恢复为非加密状态。此时，才可查看该邮箱中的邮件。 

l 邮箱压缩 

由于一般的删除邮件，实际上是把邮件转移到了“废件箱”中，它仍然占用着硬盘的空间。邮箱压缩的目的

一方面是把已经删除的邮件从磁盘上彻底清除，从而节约磁盘空间，另一方面就是对邮件进行压缩以减小邮件

的冗余度。使用“邮箱”菜单的“压缩”和“压缩全部”可以减少当前邮箱和当前账户中所有邮箱中邮件的冗余度；

使用“清空废件箱”将永远地清除一封废件箱中的邮件。 

l 远程邮箱管理 

远程邮箱管理可使用户在下载所有服务器上的邮件之前，直接对服务器上的邮件进行操作。例如，用户可

能会收到太长的垃圾邮件，希望直接将它删除，并挑选出希望下载的邮件，该功能在一定程度上也可以防止病

毒邮件的攻击。 

从菜单“工具”下的“远程邮箱管理”命令打开远程邮箱管理窗口点击“信息”按钮，可以取得服务器上信件头

的信息。选取一个或多个邮件信息，使用单击鼠标右键弹出的菜单或者“文件”菜单，可以设定对邮件执行“收取”、

“不收取”、“收取并删除”或者“在服务器上删除”操作。设定完成后，单击工具栏上的“执行”按钮执行即可。 

3．多账户管理 

从 FoxMail 3.0起增加的一个突出特点就是对多用户、多帐户以及多邮箱的管理。一般来说，如果是单个用

户使用 FoxMail，可以只用一个帐户进行邮件的收发。但是当用户拥有多个不同用途的 E-mail地址，或者有多

个用户使用同一台机器上的 FoxMail软件收发 E-mail时，添加多个帐户将会带来很大的方便。  

以下是账户管理的一些常用操作：  

l 新建账户 

点击“帐户”菜单下的“新建”，FoxMail帐户向导将帮助我们新建立一个帐户，具体操作步骤可参考建立第一

个账户。 

l 账户加密 

选择需要设置口令的账户，然后点击“账户”菜单或者弹出式菜单的“访问口令”命令，会弹出口令输入对话

框，在“口令”和“确认”栏输入相同的口令，再按确认按钮即可。被加密的账户前面将会有一把锁作为标记，表

示此账户已经加密。双击该账户，或者使用该账户收发邮件，将出现一个口令对话框，输入正确的口令方可继

续执行。 

l 账户更名 

选择需要更名的帐户，然后点击“帐户”菜单的“更名”，这时帐户的名称变为可编辑状态。输入新的名称，

再按回车即完成帐户的更名。要注意的是，这里的改名只是改变帐户显示的名称，账户的实际名称不变。例如，

您建立了一个名为 aaa的账户，然后把它改名为 bbb,接着又建立一个名为 aaa的账户，系统将给出“账号已经存

在”的错误信息。 

l 删除账户 

选择需要删除的帐户，然后点击“帐户”菜单的“删除”命令，系统会询问是否确实要删除此帐户。帐户被删

除后，该帐户中的邮件将不可恢复。最后一个账户不可删除。（加密后的帐户必须在输入密码，将其打开后，方

可删除）。 
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l 账户导入 

FoxMail3.1全面兼容 Outook Express，使用“导入 Internet账号”可以轻而易举地把 Outlook的账户导入到

FoxMail。FoxMail2.1版本的用户可以点击“从 FoxMail2.1导入”菜单，按照向导的提示，打开 FoxMail.ini文

件，即可把 FoxMail2.1的账户导入进来。 

 

9.2  The Bat! 

 

 

 

 

 

 The Bat！是一个功能非常强大的邮件收发工具，由于它可以同时链接所有设置的邮件服务器，接收或

发送邮件，所以在众多的邮件工具中，收发速度最快。 

下面介绍程序的主要功能。 

9.2.1  创建一个新帐户 

 The Bat！安装完成后，第一次启动时会给出新建邮箱向导，如图 9-10。在 Account name一栏中填

入帐户名称。 

 单击 Next，程序给出如图 9-11所示的设置界面。在界面中的 Your full name文本框中设置你的名字，

在 E-mail address文本框中设置你的电子邮件地址，在 Organization文本框中输入你所属的组织。以上设置的信

息将会在发送邮件时添加的邮件头中。 

 

图 9-10  新建帐户向导之一 

版本 1.45 

类别 共享软件 

功能 邮箱管理 

主页 http://www. ritlabs.com/ 
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图 9-11  新建帐户向导之二 

 单击 Next，程序给出如图 9-12所示的设置界面，在其中的 SMTPserver文本框中设置当前邮箱的邮

件发送服务器地址，在 POP3 server文本框中设置邮件接受服务器地址。 

 单击 Next，程序给出如图 9-13所示的界面，在其中的 Username文本框中设置邮箱的登录用户名，

在 Password项中设置登录口令。 

 

图 9-12  新建帐户向导之三 
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图 9-13  新建帐户向导之四 

 单击 Next，切换至下一界面，程序询问用户是否要察看以上的各项设置，选择 No，单击界面中的

Finish按钮确定，回到程序主界面，此时可以看到设置的邮箱已经添加到界面中左边的邮箱列表窗口中了。 

9.2.2  撰写、发送、接收邮件 

1．撰写邮件 

首先在邮箱列表框中选择要发送邮件的邮箱，然后单击程序界面按钮条中的 Create a new massage 按钮 

 ，程序给出如图 9-14所示的界面。 

 

图 9-14  邮件编辑窗口 

在界面中的 To文本框中输入收件人地址，在 Subject文本框中设置邮件主题。如果需要抄送该邮件给其他

收件人，可在 CC（抄送）文本框中设置，否则切换到邮件文本输入窗口，在其中输入邮件正文。如果需要添

加邮件附件，可单击该界面按钮条中的 Attach a File按钮  ，程序给出如图 9-15所示的 Add a File对话框，

在其中的系统文件列表窗口中选择需要附加的附件文件，之后单击“打开”按钮回到程序的邮件编辑窗口。 
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图 9-15  添加附件 

如果需要设置发送邮件的优先级，可使用鼠标右键单击邮件编辑窗口下边状态条中的按钮  ，程序会

给出一个关联菜单，其中包括 High priority（高优先级）、Normal priority（正常）、Low priority（低优先级）三

个命令，直接选择即可。此外，在这个邮件菜单中也提供了 Confirm Receipt（确认接收）、Reading confirmation

（阅读确认）两个附加设置，使用这两项功能可以让你了解到发送的邮件是否已经发送到指定的邮箱中了。 

2．发送邮件 

邮件写完以后，如果此时计算机与 Internet是连通的，单击编辑窗口中的 Send the letter按钮  ，即可立

刻发送当前邮件。如果是离线状态，单击按钮条中的 Put the letter to Outbox按钮  ，将邮件保存到 Outbox

发件箱中，回到程序界面，可以看到相应邮箱中的 Outbox文件夹变为绿色的，这就表明其中有待发送的邮件。

发送邮箱中的待发邮件的方法是：首先在邮箱列表中选择该邮箱，然后单击程序界面按钮条中的 Send Queued 

mail按钮  ，程序会给出一个发送进程对话框，并开始发送当前邮箱中保存的所有待发送邮件。 

3．接收邮件 

如果需要接收当前邮箱中的邮件，可单击程序界面按钮条中的 Get newmail 按钮  ，如果此时已经与

Internet 连通，程序会给出连接邮件服务器对话框，并接收其中的邮件，此时程序也会给出如图 9-16 所示的邮

件接收对话框，其中可以看到服务器上的邮件数、总共的容量、当前接收的邮件容量等信息，非常详细。 

 

图 9-16  接收邮件 

此时，如果单击该对话框中的 Cancel按钮，将中止邮件的接收，而且多数收到的邮件也不会从邮件服务器

中删除，如果重新从邮件服务器收信，还是会收到以前收到的信的。 

The Bat！支持多帐号同时收信。所谓多帐号同时收信，也就是当用户按下了 Alt＋F2组合键后，程序会为

每个帐号开启一个收信窗口，互不干扰。而在某些 E-mail软件中，是按顺序逐个检查每个信箱的，如果其中有

一个服务器的登录速度比较慢，就会使整个收信过程延长。 

如果重复收到相同的邮件，可使用程序提供的快速删除相同邮件功能将多余的邮件删除，方法是首先在程

序界面中的邮箱列表框中选择收件箱 Inbox，然后单击界面中的 Folder 菜单中的 Kill Dupes命令，程序会自动

扫描其中的相同邮件，并将其删除。此外，在这个菜单中，程序也提供了压缩邮箱邮件功能，其中比较有用的

命令是 Compress All命令，直接单击该命令即可压缩所有的邮箱及其中的所有文件夹中的邮件。 

垃圾邮件也是近来的网上热点问题之一，想必每个用户都收到过诸如“如何迅速在网上发财”、“警惕××病毒”

这样的垃圾邮件以及一些无法退订的 E-mail杂志等，要将这些邮件拒之门外，第一当然是做好自我保护，不要

轻易泄漏自己的 E-mail地址，此外，还要学会使用邮件过滤系统。The Bat！具有十分强大的过滤功能，不但能



常用工具软件大全 

 

221 

自动分拣转移邮件，还可以根据不同的条件设定将邮件直接从服务器上删除。 

在 Account（菜单下，选择 Sorting Office/Filters（邮件整理及过滤），便可以打开图 9-17这样一个窗口，单

击 New即可创建一个新的过滤规则，Rule标签条下显示了这个规则的条件、操作等。如果点击 Actions（执行

操作）标签条，还可以根据设定的条件对邮件进行自动回复、转发、删除、输出为一个文件、执行一个外部程

序等等多个操作。在条件设定上还可以定义多种组合，配合“或”、“且”这样的类型更加准确地执行各项过滤操

作。 

 

图 9-17  邮件过滤设定 

9.2.3  编辑邮箱属性 

使用鼠标右键单击邮箱列表中的邮箱图标，程序给出如图 9-18所示的设置界面。 

 

图 9-18  设定邮箱属性 

l 首先看到的是 General 标签项。在这个界面中提供了有关写信和回信时的地址、联系人

设置。如果在 FromAddress文本框中添加一个假的发信地址、在 Replay-To Address文本

框中添加一个假的回复地址，并使用共有发送邮件服务器，这样可以发送匿名邮件，收

信人是不会知道发信人的信箱的。 

l 切换到 Transport标签项，在该界面中提供了本邮箱使用的 SMTP发信服务器地址、登录

用户名、登录口令、POP3 Mailserver收信服务器地址等的设置，这些项目一般在创建邮

箱时已经设置，如果需要修改，在其中输入需要的内容就可以了。 
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l 切换到 Options标签项，在其中提供的主要设置项目有：Check mailbox at start-up表示启动程序后是否

自动检测有无新邮件，Periodical checking each表示是否定期检测邮件，Empty Trash folder onexit表示

在退出程序时是否自动删除垃圾桶中的邮件，Time of reading tomark a message as read表示选中新邮件

多长时间将该邮件标记为已读等，用户可以根据自己的需要进行设置。 

l 切换到 Templates 标签项，在该项的展开列表中，程序给出了有关写信、回复、转发等的模板文件设

置。使用模板文件的好处是可以创建同一个信纸格式，而不用每次写信时重复设置，感觉非常方便。

设置方法是：首先，在界面左边的列表框中选择需要编辑默认的项目，如 New message，然后切换光

标到界面右边的模板设置文本框中，将光标移动到相应的位置，在其中设置信纸的文本格式，然后单

击Macros（宏）按钮，程序会给出一个模板命令列表菜单，其中包括可使用的文本信息、发件人信息、

收件人信息、可打包文件、包括的临时文件或文本文件等，直接从菜单中选择相应的套用命令就可以

了。 

l 此外，在设置界面中的 Sound标签项中提供了收到邮件时是否可以给出声音提示，在 Network标签项

中提供了使用的 Internet 接入方式设置，在 Memo 标签中只提供了一个文本框，其含义是设置该邮箱

的备忘录。全部设置结束后，单击 OK按钮退出即可。 

9.2.4  地址薄管理 

使用鼠标单击程序界面按钮条中的 Address Book按钮  ，程序给出如图 9-19所示的设置界面。 

 
图 9-19  地址薄界面 

用户可以根据自己的需要添加和删除地址薄，添加的方法是单击菜单 File → Add New Address Book …，

程序给出一个 Edit address book properties设置界面。在其中的 Name项中设置创建的地址簿名，然后单击 OK

按钮确定，程序给出一个对话框，要求用户设置保存地址簿信息文件的文件夹和文件名，在其中输入相应的内

容，击回车键确定后，回到程序主界面，此时可以看到设置的新地址簿已经显示界在面左边窗口中的列表框中

了。删除地址薄的方法很简单，用鼠标选择需要删除的地址薄，直接按键盘上的 Delete键即可。 

在一个地址薄内，用户既可以添加邮件地址，也可以添加邮件列表组。 

添加邮件地址的方法是选择一个地址薄，单击工具栏中的 Create a New Contack按钮  ，程序给出如图

9-20所示的设置界面。此时看到的是 General标签项。在其中的 First name、Middle name、Last name项中设置

收件人的名字，中国人使用第一个就可以了。在 E-mail address(es)文本框中输入联系邮件地址。如果有这个朋

友的照片，可单击界面右边的 Change按钮，并在关联的系统文件列表框中选择相应的图片文件。在 Gender下

拉文本框中提供了联系人的性别设置，此外，该界面中还提供了极为丰富的设置，这对于一般用户来讲意义不

大。单击界面中的 OK按钮，回到 Address Book界面窗口，可看到设置的新地址已经添加到其中了。 
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图 9-20  添加新的收件人地址 

TheBat!提供的地址簿功能是非常强大的，通过它，不但可以保存地址，而且可以用作发布消息邮件，比如

你需要通知所有的高中同学一件事情，并不需要写一封信，然后设置抄送给所有的人，你需要做的只是选择一

个发送邮件列表组，程序会自动将其中的所有地址添加到发送队列中，非常方便。创建一个邮件列表组的方法

是单击窗口界面按钮条中的  按钮，程序给出如图 9-21所示设置界面。在 Name栏中创建的新组名称，因为

用户可以在一个地址薄中建立多个相同名称的邮件列表组，所以必须在 Distinctive name栏中填入一个特定的名

称以示区别。单击 OK按钮确定后，回到 Address Book主界面，此时可以看到设置的新组已经添加到界面左边

的列表框中了。现在可以在创建的新组中添加新联系人了。 

The Bat！地址簿的最大特点是将地址簿与邮件撰写紧密结合在一起。在地址薄界面中选择任何一个地址薄、

邮件列表组或邮件地址，然后单击界面工具栏中的 Create a message按钮  ，程序立即打开一个新邮件编辑

窗口，同时收件人一栏已经填好，效率远高于一般的地址簿。 

 

图 9-21  添加邮件列表组 

在地址薄设置中，程序提供了一项设置当前地址为 Favorite 的功能，即将当前的地址设置为最经常使用的

发送地址。方法是在邮件地址列表项中，选中 Favourite列中的复选框，如图 9-22。 
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图 9-22  设置 Favourite属性 

如果在程序主界面中，单击工具栏中的 Create a new message按钮右边的小下拉按钮，程序给出所有具有

Favourite属性的邮件地址，如图 9-23。选择一个地址，程序立即打开一个新邮件编辑窗口，同时收件人一栏已

经填好。 

 
图 9-23  选择 Favourite邮件地址 

如果现在处于邮件编辑窗口，当单击 To文本框最右边的 Address Book按钮  时，程序会弹出地址薄

窗口，用户可以在其中方便地选择要发送邮件的收件人。与 To相关的另一个按钮  的作用是将当前显示的

邮件地址添加到地址簿中。 
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现在网上的 HTTP 下载越来越成为文件下载的主流

方式，但如果文件比较大，或者用户的网络状况不佳，

直接下载简直就会像恶梦一般。所以各种断点续传的下

载软件已是上网的必备工具。 

GetRight和 NetVampire是国外著名的断点续传下载

工具。GetRight 的特点是性能稳定，而且定时下载功能

比较完善。NetVampire 虽然只支持单线程下载，但其下

载速度不愧称为“网络吸血鬼”。 

网络蚂蚁 NetAnt是国内最著名的多线程下载工具，

其最大特点是能够将下载文件分成几个部分同时下载，

大大提高了文件下载速度。FlashGet（JetCar）即网际快

车，是新一代的国产下载软件，它和网络蚂蚁很相像，

同样支持多线程下载，但其文件分类下载管理功能显得

更突出一些。 

 
 

第十章  下载工具 

 

＝＝ 本章导读 ＝＝ 

 

 

 

 

 

 

 

 

 

 

10.1  网络蚂蚁 NetAnts 

 

 

 

 

 

 NetAnts 是非常优秀的国产下载软件，程序的突出特点是同时创建多达 5 个与下载服务器的连接，并

同时进行软件下载操作，大大加快了下载速度。NetAnt具有以下功能特点： 

l 支持 HTTP和 FTP协议，如果服务器支持续传的话，可同时用 1-5个连接来下载文件； 

l 用户可随时中止正在下载的任务，任务将自动保存当前状态； 

l 可灵活的成批处理下载任务来下载多个文件； 

l 裁剪板自动监视，并可指定将捕获的文件类型； 

版本 1.22 中文版 
类别 免费软件 
功能 多线程软件下载 
主页 http://www.netants.com/ 
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l 把要下载的文件从浏览器上拖到拖曳窗口中即可下载； 

l 下载文件可自动分类存放；  

l 具有多种自动和定时功能；  

10.1.1  程序界面介绍 

启动 NetAnts，程序界面如图 10-1所示。 

 

图 10-1  NetAnts程序界面 

l 数据传输曲线图：实时显示数据传输速率，可以由此直观地判断网速的状况。 

l 任务列表窗口：主窗口的右上方部分。所有任务在这里根据其状态分类列表。从中可以看出一个任务

的状态（运行中、停止、排队等待、下载完毕等等），如果一个任务处在运行中，还可以看到下载文件

的大小，下载百分比，下载速度等参数。 

l 任务状况窗口：主窗口右下部分是下载任务的细节描述部分。在 任务列表中先选中某下载任务，该任

务的详细信息即列在这里。在 “区块”标签页中可以看到许多排整齐的圆点。白色的代表全部文件，红

色的代表蚂蚁，若设置为 5个点同时下载，就有 5个红色圆点在不断地向右移动。蓝色的代表已经下

载的文件量。这样，你就可以看到这 5个蚂蚁勤奋地从网络上往硬盘中搬运文件了，非常形象。 

l 状态栏：最左边显示共有 xx个任务（xx个运行中，xx个队列中），中间显示的是数据传输速度（单位

是字节/秒），最右边的数据是已经下载的字节数。 

l 虚拟文件夹：主窗口左边是树形结构的“虚拟文件夹”。可以管理下载任务和显示、查看所有的已下载

和未下载的任务的状况，虚拟文件夹分为任务状态和下载历史两个部分。 

在 NetAnts中，任务状态定义如下：  

l 正常：未激活的任务。 

l 运行中：正运行的任务。 

l 排队：待进行的任务。如果用户要 NetAnts 下载很多文件，把超过了规定的“最大下载任务数”的放在

这里。每当完成一个文件下载时，排在队列最前面的即开始下载。  

l 错误：失败的任务。 

l 已下载完：下载完的任务列在这里  

如果需要在列表中查看全部任务，可以点击虚拟文件夹的树形结构的根。在 NetAnts 中，下载任务的历史

纪录分为四种类型：昨天、 今日、上星期和一星期以前。用这些历史纪录，用户能更好的管理从网上下载的文

件。  

10.1.2  下载文件方法 

下载文件以前首先进行初始设置。单击菜单“选项”→“参数设置”，弹出如图 10-2所示的设置窗口。 
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图 10-2  初始设置 

选择“默认设置”标签项，设置下载文件的缺省存储目录，可以单击浏览按钮  进行选择。使用网络

蚂蚁下载文件，最独特的功能就是多点连接，即将文件分成几个部份同时下载，蚂蚁数目设置的即是多点连接

的个数，程序默认是 5(最高设置数)，一般情况下，可以不变。但有些网站不支持断点续传，即使设置为多点连

接，实际上也只有一个点连接下载。另外由于某些网站以及线路的原因，有时将蚂蚁数设定为 1反而要快些。 

下面介绍用 NetAnts下载文件的几种方法。 

1．拖曳链接地址 

启动 NetAnts后，除了程序主窗口外，还会出现一个拖放小窗口可以通过程序主界面工具栏中的按钮  

控制该拖放窗口的开启或关闭。当我们使用浏览器找到需要下载的应用程序的链接地址时，可以直接使用鼠标

将该地址拖到小拖放窗口上方，此时拖放窗口变成如图 10-3所示。 

 

图 10-3  拖放小窗口 

可以选择其中列出的目录，然后松开鼠标左键，程序弹出“添加任务”对话框。在“另存为”一栏中设置

下载文件的存放目录，如果取消最下边的“立即下载”复选框，表示只将该下载任务添加到任务列表中，并不

立即开始下载。设置完毕，单击“确定”，程序开始下载文件。 
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图 10-4  添加任务对话框 

除了拖放窗口外，将链接地址拖到程序主界面的任务列表窗口中也可以。在下载过程中，如果因为断线或

其他原因，致使下载任务停止，可以单击工具栏中的“开始下载”按钮  ，继续下载。还有时虽然下载任务

还在运行，但传输速度变得非常低，甚至几乎为零，此时可以利用断点续传的功能，在任务列表框中选择相应

的下载任务，先单击“停止下载”按钮  ，然后单击“开始下载”按钮，这样一般可以提高下载速度。 

2．浏览器点击检测 

使用该项功能前，需在程序中进行设置。单击菜单“选项”→“参数设置”，选择“自动操作”标签，设置

界面如图 10-5 所示。“与浏览器点击整合”复选框可以选择是否启用这项功能。然后设置捕获文件类型（注意

文件类型间用空格隔开）。如果启用这项功能，当在浏览的网页中单击下载链接地址时（符合捕获文件类型），

程序会自动接管，并弹出和图 10-4相同的“添加任务”对话框，单击确定即可进行软件下载操作。 

 

图 10-5  自动操作标签项 

3．系统剪贴板检测 

在图 10-5中，同样可以设置系统剪贴板检测。在浏览器窗口中在文件下载链接地址上单击鼠标右键，然后
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在弹出的快捷菜单中选择“复制快捷方式”，如果此时 NetAnts在后台运行，会自动给出和图相同的“添加任务”

对话框，单击确定即可开始下载。 

4．鼠标右键菜单功能 

在浏览器窗口中在文件下载链接地址上单击鼠标右键，弹出的快捷菜单如图 10-6所示，单击“Download by 

NetAnts”，如果此时没有运行 NetAnts，系统会自动调用 NetAnts，然后弹出“添加任务”对话框，设置完毕，

单击确定即可开始下载。 

 

图 10-6  右键关联菜单 

有时如果你需要下载某一网页面上链接的多个文件，这时可以使用右键快捷菜单上的另一个命令 Download 

All by NetAnts，此时 NetAnts被激活并弹出“添加多个任务”窗口。如图 10-7所示。 

 
图 10-7  添加多个任务对话框 

NetAnts 通过检查该页面，将所有的超链接内容都显示在列表中，我们在需要下载的文件前面打勾，再单

击“保存选项”标签，可以使用默认保存路径，也可以重新选择保存路径。 

10.1.3  下载任务管理 

1．编辑下载任务 

对于已列在下载任务窗口里的下载项目，如果需要改变其内容，可以单击工具栏中的按钮  ，则弹出

Edit job对话框。它的界面和 Add job对话框基本一样，可以在其中修改下载设置。 

2．删除下载任务 

单击工具栏中的删除按钮  ，也可用 Delete 键，即可把下载任务栏窗口里选中的下载任务项删除。在

已开始对某任务下载后，Download菜单中的 Edit 和 Delete 菜单就会被屏蔽，工具栏中相关按钮也同样，这时

便不能再编辑和删除任务项。在 NetAnt参数设置对话框中的“高级”标签项中，有一个复选框“下载结束后从
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列表中删除任务”，选中该项可以免去手工删除完成的下载任务的麻烦。但如果需要保持下载历史纪录、更新或

再下载该文件，应该不选此项。 

3．自动分类 

NetAnts 可以根据文件扩展名对下载文件自动分类。 单击菜单“选项”→“参数设定”，在弹出的参数设

定对话框中选择“保存到”标签，单击界面中的“添加”按钮，用户可以自行设定保存类别，如图 10-8。 

 
图 10-8  设定保存类别 

例如，要把所有*.ZIP文件放在 C：\ZIPFILES目录中，可以在“类别”设定为“压缩文件”、“扩展名”设

定为 ZIP、目录设定为“C：\ZIPFILES”。 

设置完成后，NetAnts将自动按分类进行处理。当把 URL拖到拖曳窗口中，可在弹出的菜单中选择存放文

件的目录。这就可代替了原先设定的存放目录。 

4．自动下载管理 

NetAnts可以对下载过程进行自动管理，点击程序界面工具栏中的按钮  ，则设置 NetAnts在下载任务

完成后自动关闭电脑，这对有 ATX机箱的用户在半夜下载大文件非常有用。用户还可以设置定时下载，在单击

菜单“选项”→“参数设定”，在弹出的参数设定对话框中选择“定时”标签，可以设置定时下载。在程序界面

的工具栏中，按下  按钮启动定时下载功能，按下  按钮启动定时挂断功能。 

10.2  GetRight 

 

 

 

 

 

 

 GetRight是一个老牌的下载工具，曾被多家著名下载站点给予最高评价。 GetRight提供了一个在系统

后台运行的下载操作监视程序 GetRight Monitor，当通过浏览器下载文件时，它会自动接管用户的点击操作。

GetRight主要具有以下特点： 

l 支持断点续传。 

l 支持定时下载。 

l 支持建立镜相站点列表。Getright可以对文件可能下载的位置（镜相站点）建立一个列表。当某个 URL

版本 4.2c 

类别 免费软件 

功能 软件下载 

主页 http://www.getright.com/ 
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地址的服务器繁忙或出现问题时，可以在各个 URL之间切换。 

安装 GetRight 时，程序默认设置成自动随系统启动而运行，如果程序没有自动启动，可以在开始菜单的

Getright程序组中选择 GetRight Tray Icon程序，其标志是在系统任务栏中添加一个 Tray图标  。使用鼠标

双击该图标，程序给出如图 10-9所示的下载状态窗口（Download Status），界面主要分为两个窗口，左边为下

载文件分类管理窗口，右边为下载文件列表窗口。 

 

图 10-9  GetRight程序界面 

10.2.1  下载文件分类管理 

在程序界面左边的窗口中，分成 Folders（文件夹）和 Filters（文件过滤）两个列表，Folders的作用是分类

保存下载的文件，程序在 Folders下预设了 Demos、Games等文件夹，用户可以对文件夹进行管理。 

l 创建文件夹：在左边的分类管理窗口中单击鼠标右键，在弹出的关联菜单中选择 New Folder …，程序

给出如图 10-10所示对话框，在 Folder Name中输入文件夹的名称。在 Default Directory中输入该文件

夹对应的实际路径（必须是已经存在的路径），也可以单击右边的浏览按钮进行路径定位。在 Folder 

Download项中选择下载优先级，一般缺省值 Normal即可。 

 

图 10-10  创建文件夹 

l 删除文件夹：在左边的分类管理窗口中用鼠标选择需要删除的文件夹，然后单击鼠标右键，在弹出的

关联菜单中选择 Delete Folder即可。 

l 修改文件夹属性：选择需要修改属性的文件夹，然后单击鼠标右键，在弹出的关联菜单中选择 Folder 

Properties即可。 

l Filters（文件过滤）的作用是分类显示下载的所有文件。例如单击 Applications项，在右边的文件列表
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窗口中将列出下载的所有可执行应用程序。Filters的管理方法与前面的 Folders管理基本类似，这里不

再介绍。 

10.2.2  文件下载方法 

GetRight 提供了四种下载文件的方法：浏览器点击监测下载、剪贴板监测下载、拖放窗口下载和手工输入

URL 地址下载。如果要使用前两种方式，用鼠标右键单击系统任务栏中程序的 Tray 图标，在弹出的关联菜单

中要保证选中最上方的复选框 Clipboard and Click Monitoring。下面分别介绍各种方法的使用。 

1．浏览器点击监测 

当用户使用浏览器浏览网页时，GetRight 监测用户在浏览器窗口中点击的下载链接地址，当程序捕获到有

下载点击任务时，会自动识别并弹出如图所示对话框。用户可以选择下载文件保存文件夹，单击 Quick Folder

下拉列表框可以快速选择保存路径,如图 10-11。 

 
图 10-11  保存下载文件对话框 

单击“保存”，程序开始下载并给出下载进度对话框，如图 10-12。 

 

图 10-12  下载进度对话框 

2．剪帖板监测 

GetRight能够监测系统剪帖板的内容，只要发现剪贴板上存在Web网址，就会自动触发文件下载机制。将

URL拷贝到剪贴板的方法视所用的 Internet软件而定。 

对于 Netscape浏览器，用鼠标右键单击要下载文件的超链接，在弹出的菜单中选择 Copy Linklocation命令，

即可将该 URL拷贝到剪贴板中。对于中文版的 IE，则是在菜单中选择“复制快捷方式”选项，将 URL拷贝到

剪贴板中。对于其他 e-mail、字处理、浏览器或可以看到Web网址的程序，选定链路并且按 Ctrl-C，可将URL

拷贝到剪贴板中。 

如果这样做以后 GetRight并未启动下载，可能是以下情况： 

要下载的文件类型不属于自动下载的文件类型（如：HTML,.TXT,.GIF等），这时可以手工输入，也可以修

改 GetRight Configuration中Monitor选项卡中的文件类型。方法是单击程序界面按钮条中的  按钮，在程序

给出的运行环境设置界面中选择Monitor标签项，如图 10-13。其中的 Automatically start down-loading files文本
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框中给出了程序可以检测的下载文件类型设置，如果需要添加新的文件类型，可以直接输入，输入格式为在文

件扩展名前加“.”号，在文件扩展名后加“；”号和一个空格。此外，也可以删除其中不需要捕获的文件类型。 

 

图 10-13  自动下载设置 

3．拖放窗口下载 

GetRight 提供了下载链接地址的拖曳下载功能，但已经不是程序的默认功能，每次使用时需要调出拖放窗

口后才能使用，方法是用鼠标右键单击程序的 Tray 图标，在弹出的关联菜单中选择 Tools → GetRight Drop 

Target …，桌面上出现一个一个小的拖放窗口。直接用鼠标左键将浏览器或其他软件中的 URL超链接拖到该窗

口中，然后松开鼠标左键，程序给出存盘对话框。选择路径和输入文件名以后，GetRight开始下载。 

4．手工输入 URL 

单击 File菜单中的 Enter NewURL …命令，程序给出如图 10-14所示对话框，在其中直接输入 URL即可。

如果剪贴板已经有Web网址，可以按 Ctrl-V键粘贴 URL，如果剪贴板内容以“http://”或 ftp://开头，程序会自

动粘贴，单击 OK，GetRight开始下载文件。 

 

图 10-14  添加新 URL对话框 

10.2.3  文件下载控制 

1．相关工具栏按钮介绍 

l  ：续传按钮，在界面右边文件列表窗口中选择由于某种原因停止下载的任务，单击该按钮，即可

实现断点续传。 

l  ：停止按钮，停止某一正在执行的下载任务。 

l  ：打开下载文件所在的网页。 

l  ：给下载文件添加注释。 

l  ：停止所有下载任务。 

l  ：设置成 Automatic模式，GetRight自动执行所有未完成的下载任务。 
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l  ：设置定时下载的开始时间。 

l  ：设置时下载的结束时间。 

l  ：选择下载窗口模式。缺省的下载窗口的模式为普通模式，如图。如果用户不想显示该窗口，可

以选择 Hide（隐藏）。 

l  ：下载任务完成以后关闭计算机。 

l  ：文件下载结束断开网络连接，如果 GetRight 处于 Automatic 模式，所有文件下载后，GetRight

自动和 Internet脱离连接。否则 GetRight在当前进行下载的文件下载结束以后就和 Internet脱离连接，

即使还有文件未下载。 

l  ：设置当下载过程因某种原因中断时，让 GetRight重新拔号和恢复下载。选择此项以后，重新拔

号和连接工作由 GetRight自动完成。如果 GetRight处于 Automatic模式，这一功能自动打开。不过，

该功能只有在使用Windows拔号网络时才能使用。 

2．右键控制菜单 

在程序界面窗口中选择某一下载任务，然后单击鼠标右键，程序会给出一个关联菜单，如图 10-15所示。 

 

图 10-15  右键关联菜单 

其中 Resume表示从断点处续传，Pause表示暂停下载，OpenSource Web Page表示打开下载文件所在网站，

File Comment 表示显示/编辑文件注释，View Transfer Details 表示察看下载细节，Delete表示从下载任务列表

中删除当前选定的下载任务及硬盘中对应的没有下载完全的文件，Change Local File Names表示改变当前保存

的下载文件名，Change URL表示改变下载链接地址，Change Username and Password表示改变登录到下载服务

器的用户名和用户口令，Copy URL(s) to Clipboard表示将当前的 URL地址复制到系统剪贴板，Set Priority表示

设置下载操作优先级，其关联菜单中包括五个等级，直接选择即可。 

该菜单中的 Alternate URLs项表示设置替换下载地址（镜像下载地址），如果知道速度更快的保存有该文件

的下载地址，可在下载任务的鼠标右键中选择 Alternate URLs命令，此时程序会给出如图 10-16所示的设置界

面。 

 

图 10-16  设置镜像下载地址 

单击界面中的 Add按钮，在关联的对话框中输入镜像下载地址，或者是其他速度更快的保存该文件的下载
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服务器，然后单击 OK按钮回到如上图所示的界面，此时可以看到设置的 URL地址显示在界面列表窗口中。选

择该地址，然后单击界面中的 Set按钮，确定后回到程序主界面就可以了。 

10.2.4  定时下载功能 

目前国内 Internet 接入速度比较慢，用户如果经常从网上下载软件，就需要避开网路繁忙的时间上网，这

时就可用到 GetRight的定时下载功能了。 

在程序的下载状态窗口中选择需要定时下载的任务，然后单击界面工具栏中的  按钮，程序给出如图

10-17所示的设置界面。 

 

图 10-17  设置定时下载开始 

在 Start downloading files at项中设置下载任务的开始时间，然后在界面中设置该计划任务的日期，其中只

有星期几和当天（Today only），直接选择就可以了。界面中的 Redial modem if disconnected表示断线后重新连

接，Hang up modem when done表示下载任务完成后自动断开连接，Turn off computer when done表示下载任务

完成后关闭计算机，根据自己的要求选择即可。 

单击界面按钮条中的  按钮，程序给出如图 10-18所示的设置界面。在该界面中提供了设置挂起的时间

设置，其中 Hang up at a specific time 表示在特定的时间挂起（断开连接），Hang up by number of minutes 

afterGetRight dial表示在程序拨号成功后指定的时间断开连接，Hang up bynumber of minutes from Now表示在当

前时刻后指定时间断开连接，用户根据自己的要求选择。然后可以设置挂起时间，此外，界面中的Always hang 

up modem at this time表示总是在设定的时间断开连接。Delay hanging up if any files being downloaded can not be 

resumed later复选框表示当下载任务连接的服务器不支持断点续传时，挂起延时，直到下载任务完成。 

 

图 10-18  设置定时下载挂断 
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10.2.5  运行环境设定 

在 GetRight下载状态窗口中，单击工具栏最右边的  按钮，或用鼠标右键单击程序的 Tray图标，在弹

出的关联菜单中单击 Tools → GetRight Configuration…命令，程序给出如图 10-19所示对话框。 

用户可以直接选择界面中的标签项进行运行环境的设定，也可以利用程序提供的向导方式进行设定。下面

我们以向导设定方式为例进行说明。 

 单击上图界面中的 Switch and use the Wizard for Configuring GetRight …按钮，程序切换到向导方式，

如图 10-20。 

 

图 10-19  GetRight参数设置对话框 

 

图 10-20  参数设置向导界面 

 

 单击 Next，作为注册用户，程序会询问是否取消界面中的广告条，可以在这里取消 Show the 

advertising banners复选框，下次启动 GetRight时，会发现界面中的广告条已经去掉。 

 单击 Next，切换到下一界面，如图 10-21。可以设置程序的运行模式，其中包括基本功能模式(Basic 

GetRight)和全部功能模式（Full GetRight）。如果选择基本模式 Basic GetRight，程序界面将变得非常简洁。 

 单击 Next，切换到下一界面如图 10-22。其中提供了系统与 Internet 连接方式设置，主要是设置连

接速度，对于一般拨号用户，使用“Medium”复选框就可以了。 
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图 10-21  设置程序的运行模式 

 
图 10-22  设置 Internet连接方式 

 切换到下一设置界面，在其中提供了程序可以监视捕获的下载链接地址点击设置，程序全面支持

Netscape和 IE，根据自己使用的浏览器进行设置就可以了。 

 
图 10-23  下载链接地址点击捕获设制 

 单击 Next，切换到下一界面，用户可以设置缺省保存目录，Remember the last directory I used表示

使用上一次的保存目录，用户也可以选择 Use This directory，自行设定缺省保存目录。最下面一个复选框表示

对每一个下载文件自动使用缺省文件名。 
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图 10-24  设置缺省保存目录 

 切换到下一界面，设置 GetRight 捕获下载地址并设定保存路径后采取的动作，Always start 

downloading files immediately表示立即开始下载。Add to list without starting to download表示只是添加到下载文

件列表窗口中，但并不立即开始下载。Ask me表示程序给出询问是否下载的对话框。 

 
图 10-25  设定 GetRight采取的动作 

 单击 Next，切换到下一设置界面。在这个界面中提供了程序可以使用的镜像服务器扫描来提供较快

的下载站点设置，程序提供了两种选择方式，其中 Use list of common mirrors虽然速度较快，但是支持的站点

有限，Use FTP search to find mirrors速度较慢，但是可以支持的镜像服务器可能会多一些，如图 10-26。 

 单击 Next 按钮，如图 10-27 切换到下一界面，在这个界面中提供了扫描镜像服务器地域设置，一

般来说，美国的服务器下载速度是最快的，对于国内用户，如果从本地下载文件，这项设置意义不大。 

 

图 10-26  设定镜像服务器 
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图 10-27  扫描镜像服务器地域设置 

 单击 Next，切换到下一界面，其中的复选框表示连接到 Internet后自动开始下载或续传文件。 

 

图 10-28  设定自动下载 

 单击 Next，切换到下一界面，该界面中提供了程序可使用的声音方案设置，一般使用 GetRight 默

认提供的声音提示方案即可。 

 

图 10-29  设置声音方案 

 单击 Next，切换到下一界面，用户可以选择为每一个下载任务建立一个记录文件，也可以为所有的

下载任务建立一个公用的记录文件。 
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图 10-30  设置记录文件的建立 

 单击 Next，如图 10-31切换下一界面，在该界面中提供了程序可使用的病毒检测工具即时检测下载

文件功能，如果用户希望在文件下载结束后立刻进行病毒检测，可选中 Use a virus scanner to check files复选框，

然后单击界面中的 Browse按钮，在弹出的关联的系统文件列表窗口中选择病毒监测工具。 

 单击 Next按钮，切换到下一界面，单击界面中的 Finish按钮，设置完成。 

 
图 10-31  设置病毒检测工具 

 

10.3  NetVampire 

 

 

 

 

 

 

 NetVampire，即所谓的网络吸血鬼，是非常著名的软件下载工具，该工具以下载速度快而著称。这个

工具的界面做的非常华丽，提供的资料也非常详细，其中包括软件下载地址、下载文件信息、下载速度、续传

次数、剩余下载时间等。目前的最新版本为 3.3，这个版本的除了以前的更改信息包的优先级以实现下载加速外，

又新增一项重要功能功能以加速下载，即可以自动的选择下载路径。以前我们下载一个软件，有时下载到一定

时间传输速率就变得特别低。这时我们通常的办法是把这个 job 停下，然后再从断点重新开始就可以了。这样

版本 3.3 

类别 免费软件 

功能 软件下载 

主页 http://www. netvampire.com/ 
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做的原因是因为吸血鬼每次和目标地址连接的时候，都要选择一下下载路径。当当前路径阻塞的时候，我们断

开重新连接目标地址，就会避开当前路径的阻塞，从一个新的路径开始下载。在这新版本中，这一切由NetVampire

自动完成，大大提高了下载速度的稳定性。 

除此以外，NetVampire还做了以下方面改进： 

l 查看下载的 Zip压缩包：打开网络吸血鬼的主界面，如果左边选择下载任务窗口 jobs，会发现右边的

信息窗口多了一个 zip标签。当用户下载的是 zip文件时，这个窗口中显示的将是这个 zip包里的被压

缩文件详细的信息，包括文件名，类型，日期以及压缩文件时包括文件的路径信息。 

l 自动文件修复：有时下载很多文件，会发现其中有些文件用不了，这很有可能是因为文件在下载的过

程中发生了错误。现在 NetVampire提供了文件修复功能，如果文件下载出错，只要保留着这个文件下

载的 job，再次连接的时候，会进行自动修复。 

l 病毒防护：新版的 NetVampire可以对下载的文件进行病毒防护。如果下载软件里有病毒，程序自动报

警。 

10.3.1  程序界面介绍 

启动 NetVampire，程序界面如图 10-32所示。 

 

图 10-32  NetVampire程序主界面 

程序界面左侧窗口中有三个标签项，选择每个标签项，右侧的窗口都会随之发生变化。Job 显示正处在工

作进程中的下载文件名称及其状态（停止、 正在进行、延时下载），此时与 Jobs相对应的右侧窗口中也有四个

标签项。Info 显示关于下载文件的信息，如地址、时间、大小、速率、出错信息等等；Log 显示了登录运行的

情况；Links 页中通常都是空白的；zip 显示的是下载的 zip 压缩包的详细信息，包括文件名，类型，日期以及

压缩文件时包括的文件的路径信息等。Sites记录了曾经下载过文件的站点，右侧与 Sites对应的 Statistics 中记

录了关于下载站点的一些信息（服务器类型、是否支持续传等等）。Find 里是吸血鬼自带的一些国外的搜索站

点,你可以在 File Name 中填入要下载的文件名 ,然后选中想要使用的搜索站点，再按下搜索按钮  ，

NetVampire开始查找，，搜索到的结果会在右侧的 Search Results显示出。不过该项功能对于通常使用本地下载

的国内用户来说，意义并不很大。 

程序主界面右上角的两个窗口分别是下载速率与下载进度两个显示窗口，用户可以更好的监视当前的软件

下载情况。 

在主界面的工具栏中，程序提供了七个快捷按钮，其功能分别为： 

l  ：开始下载。 

l  ：定时延迟下载。 

l  ：停止下载。 

l  ：添加新任务。 

l  ：从剪贴板粘贴链接（下载） 

l  ：工作设置。 
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l  ：删除工作。 

10.3.2  文件下载 

1．建立预设存放目录（Category） 

NetVampire提供了下载文件分类保存的功能，选择 Options菜单中的 Destination Folders …命令，程序给出

如图 10-33所示对话框。程序只提供了一个 DEFAULT 缺省目录，用户可以自己添加新的目录，也可以删除目

录和修改目录属性。 

 

图 10-33  分类保存目录对话框 

如果要添加新的存放目录，单击 Add按钮，程序给出 Category对话框如图 10-34。在 Category name中输

入目录名称，在 Folder中输入目录的实际路径（可以单击 Browse按钮进行路径定位）即可。 

 

图 10-34  添加新的存放目录 

2．文件下载方法 

NetVampire和 GetRight相同，也提供了四种常用的下载文件的方法，即浏览器点击监测下载、剪贴板监测

下载、拖放窗口下载和手工输入 URL地址下载。单击程序界面中的 Input菜单，Monitor Clipboard表示监测系

统剪贴板，Monitor browser clicks表示监视浏览器点击的超链接，Show Drop Basket表示显示文件拖放下载窗口。

用户可以自行选择或禁止以上下载方法。下面分别介绍各种方法的使用。 

l 拖放窗口下载 

NetVampire 提供了下载链接地址的拖曳下载功能，用鼠标左键将浏览器中的 URL 超链接拖到程序的文件

拖放下载窗口中，该窗口形状变成如图 10-35所示。 
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图 10-35  拖放窗口下载 

可以在此选择预设的存放目录，也可以在后面自行选择存放路径。松开鼠标左键，程序给出存盘对话框，

如图 10-36。 

 

图 10-36  下载文件保存对话框 

如果前面已经选择了预设存放目录，可以直接单击 Start按钮下载文件。Schedule按钮可以设置定时下载，

Just add表示仅将当前下载任务加入到下载任务列表框中，并不立即开始下载。如果想对下载任务进行设置，单

击 Job settings按钮，程序给出对话框如图 10-37。在 Save to folder or <categary>项中，单击下拉列表框按钮可以

设置预设的存放目录（Categary），单击 Browse按钮可以自行设置存放文件夹（folder）。 

 

图 10-37  设置下载任务属性 
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l 浏览器点击监测 

当用户使用浏览器浏览网页时，NetVampire监测用户在浏览器窗口中点击的下载链接地址，当程序捕获到

有下载点击任务时，会自动识别并弹出和图相同的下载任务对话框。单击 Start，程序开始下载文件。 

l 剪帖板监测 

NetVampire 能够监测系统剪帖板的内容，只要判断出剪贴板上存在属于下载文件类型的 URL 地址，就会

自动弹出下载任务对话框，用户设置完毕，单击 Start，即可开始下载文件。 

l 手工输入 URL 

单击 Job菜单中的 Add …命令，或单击工具栏中的 Add new job按钮  ，程序给出如图所示下载任务对

话框，在其中输入 URL并设置其他参数后，单击 Start按钮，程序开始下载文件。 

10.3.3  运行环境控制 

1．设置定时下载 

单击 Options 菜单中的 Start/Stop …命令，程序给出如图 10-38所示设置界面。在该界面中可以设置定时下

载功能，如果需要下载任务必须在某个时段进行，可首先选择使用 Time constraints 复选框，然后在界面中的

Don’t start jobs before项中设置下载操作的开始时间，在 Stop all jobs at项中设置下载任务的截止时间。在界面

中的Upon completion项中可以设置当下载任务完成后的程序采取的动作，其中包括Do nothing（不作任何动作），

Exit NetVampire（关闭 NetVampire），Shut Down Windows（关闭Windows）和 Power Off（关闭计算机）。 

 

图 10-38  设置定时下载 

2．系统设定 

单击 Options菜单中的 System命令，程序给出如图 10-39所示设置界面。 
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图 10-39  运行环境设置对话框 

其中有六个标签项，下面分别简要介绍如下。 

l General 

在该界面中的 Start minimized表示启动程序后自动最小化。在 Icons in SysTray项中提供了在系统任务条中

显示 Tray图标的方式，其中包括 Never（从不显示）、When minimized（最小化时显示）、Always（总是显示）

三个设置项目。在 Confirm项中提供了操作确认设置，其中包括在删除文件时给出确认对话框（File deletion）、

删除下载任务时给出确认对话框（Job deletion）、创建下载任务时给出确认对话框（Job creation）。界面中的 Drop 

Basket animation项中提供了有关浮动图标动画显示设置，程序提供了使用任意文件替换自身默认的文件功能，

当然这个文件必须是 AVI文件，设置方法很简单，单击界面中的 Browse 按钮，并在关联的系统文件窗口中选

择即可。如果要恢复使用程序默认的动画文件，可单击界面中的 Default按钮。 

l Pro-processing 

在该界面中提供了当捕获下载任务时，何时开始下载操作设置，程序默认立刻下载 Immediately，用户也可

以在 In项中设置延时下载，或在 At项中设置定时下载，Manually表示手动设置下载。Import cookie from the 

browser表示使用来自浏览器的 Cookie信息。切 

l Post-processing 

在该界面中提供了有关下载文件的控制设置，其中 Restore file date/time 表示保存下载文件的创建时间/日

期，Preserve log表示保存 Log日志文件，Process .VSL files表示创建.VSL文件，Delete from the job list表示从

下载任务列表中删除，Create .NFO file表示常见.NFO文件。Run Program表示在下载完成后自动运行应用程序，

其中包括使用系统中与下载文件类型有关联的应用程序打开下载文件，或者是使用任意应用程序管理下载文件，

比如杀病毒程序检测下载文件。设置方法是选择 Associated with the file type项下边的复选框，然后在其关联的

文本框中设置。 

l Messages 

在该界面中提供了当下载任务完成、连接失败、所有下载任务中断后给出提示对话框设置。 

l Sounds 

该界面中提供了有关声音提示设置，程序提供了默认的声音设置方案，也可以在界面列表框选择动作，然

后在界面中的下拉文本框中选择相应的声音即可。此外，该界面中 Sounds enabled复选框设置使用或禁止声音

提示。 

l Indicators 

在界面中的 Histogram settings项中提供了界面速度图形显示窗口中可提供的下载速度上限设置，Horizontal 
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grid和 Vertical grid复选框表示给出水平或者垂直显示网格，这样便于确定显示数值。在 Histogram colors项中

给出了速度图示窗口的显示颜色设置，在 Progress bar colors项中提供了下载进程图示窗口的显示颜色设置，直

接在其中选择即可。 

3．网络设定 

单击 Options菜单中的 Network命令，程序给出如图 10-40所示设置界面。 

其中共有三个选项卡。 

l General：Max.concurrent connections项设置可以同时连接的最大数目。 

l Proxies：设置代理服务器。用户可以根据需要添加、删除和设置代理服务器。 

l Dial-Up：用户可以设置可使用的系统连接、登录用户信息、重复连接次数、各次连接之间的时间间隔

等参数，这是程序可以自动连接到 Internet并进行下载操作的必要保证，Dial-up when needed复选框表

示在必要的时候自动拨号，Hang up when done复选框的含义是在下载完成后断开连接。 

 

图 10-40 网络设定对话框 

10.4  FlashGet中文版 

 

 

 

 

 

 

 FlashGet即网际快车（又称 JetCar），是和 NetAnts类似的国产多点传输下载软件。它通过把一个文件

分成几个部分同时下载，可以成倍的提高速度。该工具最多可把一个文件分成 10个部分同时下载，同时允许 8

个下载任务同时进行，并支持断点续传。不过需要注意的是，多点传输中并不是“点”越多越快。这与网络的状

况有关。总的来说，在网络速度较慢的时候，为了充分利用带宽，采用多点传输是有效的提高下载效率的方法。

但是，物极必反，在网络的状况较好的情况下，采用多点传输不但不能提高下载速度（因为已经“饱和”了），有

时反而还会影响下载效率。所以要根据网络状况状况合理地设置“点”的个数。一般情况下，将文件分成 5-6 部

分同时下载比较合适。 

FlashGet最大的特色是对下载文件的管理。下载的文件按树状结构分门别类的保存起来，有下载，已下载，

已删除，三种基本类别。用户也可以根据自己的需要建立新的类别，把下载的文件分门别类的存放。FlashGet

版本 0.88 

类别 免费软件 

功能 软件下载 

主页 http://www. amazesoft.com/ 
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充分支持拖放功能，下载完毕的文件就可以方便地拖来拖去，很容易进行归类管理。* 可将下载任务输出为

HTML文件，成为详细的日志。 

FlashGet的程序界面如图 10-41所示。 

 

图 10-41  FlashGet程序界面 

程序左边为文件分类窗口，右边上半部分为文件列表窗口，下半部分为下载状况显示窗口。右上角的小窗

口为传输速率显示窗口。整个界面的设置非常便于管理和查看下载状态。 

10.4.1  文件下载方法 

1．监视浏览器点击 

FlashGet可以监视浏览器的点击,当点击 URL时,FlashGet可监视该 URL,如果该 URL符合下载的要求(扩展

名符合设置的条件)，程序给出如图 10-42所示对话框，由于本软件是中文版，所以各个选项的含义不再介绍。

设置完毕，单击“确定”，程序将该下载任务添加到文件列表框中。 

 

图 10-42  添加新的下载任务 

为了和浏览器有更好的兼容性,可设置为需要使用 Alt键时才允许捕获浏览器点击。方法是单击“工具”菜

单中的“选项 …”命令，在程序给出的设置界面中选择“监视”标签项，界面如图 10-43所示，在其中选中“使

用 Alt键”即可。 
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图 10-43  设置浏览器点击捕获 

2．IE的右键弹出式菜单 

FlashGet会添加“使用网际快车下载”和“使用网际快车下载全部链接”两个菜单项到 IE的弹出式菜单中，如

图 10-44。用户可以选择下载当前网页的所有链接或者选择的单个链接。 

 

图 10-44  IE的右键弹出式菜单 

3．监视剪贴板 

当拷贝一个合法的 URL到剪贴板中时，无论是从浏览器或者一个简单的文本框，如果该 URL符合下载的

要求（扩展名符合设置的条件），该 URL就自动添加到下载任务列表中。 

4．拖放窗口下载 

FlashGet提供了下载链接地址的拖曳下载功能，用鼠标左键将浏览器或其他软件中的 URL超链接拖到程序

的浮动窗口中，如图。然后松开鼠标左键，程序给出存盘对话框。选择路径和输入文件名以后，程序将该下载

任务添加到文件列表中并开始下载。 

5．直接输入 URL 

从菜单中选择“任务”→“新建下载任务”，程序可手动添加任务。 

10.4.2  下载文件管理 

对下载文件进行归类整理，是 FlashGet最为重要和实用的功能之一。FlashGet使用了类别的概念来管理已

下载的文件，每种类别可指定一个磁盘目录，所有指定下载完成后存放到该类别的下载任务，下载文件就会保

存到该磁盘目录中。比如对于 mp3文件可以创建类别“mp3”，指定文件目录“c:\download\mp3”，当下载一个
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mp3 文件时，指定保存到类别“mp3”中，所有下载的文件就会保存到目录“c:\download\mp3”下。如果该类

别下的文件太多还可以创建子类别，比如可以在类别“mp3”下创建子类别“Disk1”和“Disk2”等等，相应

的目录对应“c:\download\mp3\disk1”和“c:\download\mp3\disk2”等等，FlashGet 允许创建任意数目的类别和

子类别。下载的文件存在的类别可以随时改变，具体的磁盘文件亦可以在目录之间移动。对于类别的改变

FlashGet提供了拖拽的功能，只需简单的拖动，就可以把下载的文件进行归类。 

FlashGet缺省创建“正在下载、已下载、已删除”三个类别,所有未完成的下载任务均放在“正在下载”类

别中,所有完成的下载任务均放在“已完成”类别中,从其他类别中删除的任务均放在“已删除”类别中,只有从

“已删除”类别中删除才会真正的删除,这就和Windows的回收站的功能一样.如果下载文件很少就不需改变。 

如果下载的文件较多,就需要创建新的类别。从主菜单中“类别”或者鼠标右键弹出的菜单可以对类别进行

管理,包括“新建类别”、“移动”、“删除”、“属性”。  

同样在移动和删除任务时，FlashGet 给出了多种选择，下载的文件可以随之被删除或者移动也可以不移动

或者删除，具体设置见“选项”中的“文件管理”标签项。 
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MP3 现在是网上最流行的字眼了，各类音乐网站浩

如烟海，各种 MP3 播放工具也层出不穷，本章介绍

Winamp、JetAudio和 Sonique就是这方面的翘楚。Winamp

是目前最流行的MP3播放工具，它的主要特点是对系统

的占用率很低，播放音质好，支持它的插件非常多，而

且程序的升级速度很快。JetAudio 是一个非常优秀的多

媒体播放平台，支持目前绝大多数多媒体文件格式，而

且该工具的混音效果是目前所有播放器中最好的，绝对

不同反响。Sonique的播放效果不错，但最大的特点是提

供了三种运行界面，而且其界面华丽无比，让人过目难

忘。 

超级解霸 2000是豪杰解霸系列的最新版。超级解霸

系列是目前最有影响的国产软解压软件，国内用户耳熟

能详，希望大家积极购买正版，支持国产精品的发展。 

 
 

第十一章  媒体播放工具 

 

＝＝ 本章导读 ＝＝ 

 

 

 

 

 

 

 

 

11.1  Winamp  

 

 

 

 

 

 

 Winamp 是当今最流行的 MP3 播放器，除了 MP3以外，还可以支持目前常见的各种音频文件格式。

程序提供了一个播放调整均衡器，可以使用户非常方便的控制播放的声音效果。Winamp还提供了 Plug in （接

口），现在基于该工具的插件非常丰富，使播放面板和播放效果更加出色。 Winamp 具有操作简便、播放控制

功能丰富、CPU占用率较低等优点，是必备的音频播放工具。 

11.1.1  播放音频文件 

启动程序，其程序界面如图 11-1所示。 

版本 2.64 

类别 共享软件 

主页 http://www.winamp.com/ 

功能 音频文件播放 
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图 11-1  Winamp主界面 

单击播放面板底部的“打开文件”按钮  ，或按下键盘上的 L键，程序弹出“打开文件”对话框，如

图 11-2。在其中的文件列表窗口中选择需要播放的文件，按住 Shift或 Ctrl再加上鼠标左键，可选择多个文件。

单击“打开”按钮回到程序界面，开始播放所选择的文件。 

 

图 11-2  Open file（s）对话框 

11.1.2  使用播放控制列表 

使用鼠标单击程序界面中的 PL按钮，程序弹出 Play List播放控制列表框，如图 11-3。 

 

 

 

 
图 11-3  播放控制列表框 

添加 

文件 

删除 

文件 

选择 

文件 

排序 

信息 

播放 

控制 

保存/载入 

播放列表 

播放列表 

播放控制列表 

均衡器列表 

声道控制 

循环播放 播放控制 

随机播放 打开文件 

歌曲信息显示 音量控制 视觉外观显示 

菜
单
按
钮 
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如果想向播放列表中添加文件，单击  按钮，弹出按钮框如图 11-4。 

 

图 11-4  Add按钮框 

l ADD URL按钮：网络远程播放。按下后弹出对话框如图 11-5，输入 URL地址后单击 Open按钮，即

可实现 internet网络资源的播放。 

 

图 11-5  Open location 对话框 

l ADD DIR按钮：添加目录。按下后弹出对话框如图 11-6，选择好目录后单击“确定”按钮，即将该目

录下的文件加入到播放列表中。Recurse subdirectries可选择是否包含子目录。 

 

图 11-6  Open Directory对话框 

l ADD FILE按钮：添加文件。按下后弹出对话框如图 11-7，选择好文件后单击“确定”按钮，即将所

选择的文件加入到播放列表中。 

 

图 11-7  Add file（s）对话框 

如果想删除播放列表框中的文件，用鼠标左键选择需删除的文件（用 Shift键和 Ctrl键与鼠标左键配合可以

包含子目录 
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选择多个文件），然后直接按 Delete键，也可以单击  按钮，弹出按钮框如图 11-8。 

 

图 11-8  REMOVE按钮框 

l REM ALL按钮：删除所有文件。 

l CROP按钮：保留所选择的文件，删除其他文件。 

l REM SEL按钮：删除所选择的文件，保留其他文件。 

如果想快速选择文件，单击  按钮，弹出按钮框如图 11-9所示。 

 

图 11-9  SELECT按钮框 

l INV SEL按钮：反向选择。选择除了已被选择的文件以外的其他所有文件。 

l SEL ZERO按钮：不选择任何文件。 

l SEL ALL按钮：选择所有文件。 

还有其他一些常用选项。单击  按钮，弹出按钮框如图 11-10。 

 

图 11-10  Misc按钮框 

l SORT LIST按钮：对文件列表框中的文件排序。单击后弹出关联菜单。包括有：Sort list by title（按标
题排序）；Sort list by filename（按文件名排序）；Sort list by path and filename（按路径和文件名排序）；
Reverse list（反向排序）；Randomize list（随机排序）。 

l FILE INFO按钮：单击后弹出关联菜单。选择 File info命令，程序给出歌曲 ID3标签编辑对话框，如
图 11-11。我们可以在其中修改文件信息，包括 Title（标题）、Artist（歌手）、Album（专辑）、Year（年
代）、Genre（流派）、Content（评价）。添加或修改后播放时可在歌曲信息显示栏出显示。选择 Playlist 
entry命令，可以修改文件在播放列表中的入口。当文件所在的位置发生变化后，可在此重新修改文件
的位置，以便播放。 

 

图 11-11  歌曲 ID3标签编辑对话框 
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我们还可以保存或载入播放清单。这是一项很方便的功能。单击  按钮，弹出按钮框如图 11-12。 

l NEW LIST：新建一个播放清单。单击后，播放列表框被清空，我们可以重新选择要加入播放清单中

的文件。 

l SAVE LIST ：将要选择的文件加入到播放列表框后，单击此键保存该播放清单。 

l LOAD LIST ：载入一个已经存在的播放清单。 

此外，播放列表还支持鼠标右键菜单，在播放列表框内的任意位置单击鼠标右键，会弹出关联菜单如图 11-13

所示，可以快速选择相关命令。 

         

                         图 11-12  List Options按钮框          图 11-13  鼠标右键菜单 

11.1.3  使用音频均衡器 

单击控制面板中的 EQ按钮，程序给出 EQ（Equalizer）均衡器窗口，如图 11-14。 

 

图 11-14  EQ（Equalizer）均衡器窗口 

单击窗口左边的 ON按钮，然后调节频谱设置滑快进行调整即可。 

如果要使用预设的频谱，可单击 PRESETS → Load → preset …，弹出 EQ选择框如图 11-15，从中选择相

应的预设方案，然后单击 Load按钮即可。 

 

图 11-15  EQ预设方案选择框 

如果需要保存当前设置的频谱方案，可单击 PRESETS → Save → to EQF …，并在关联界面中设置保存文

件名和保存路径即可。 

使用频谱 

自动载 

入频谱 

载入/保存 

频谱设置 
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11.1.4  使用插件 

提供插件接口是Winamp的一项特色功能，目前关于Winamp插件非常丰富，除了 Nullsoft(Winamp的发行

公司)提供的官方插件外，一些高手也提供了一些非常漂亮、实用的 Winamp 插件。这些插件都是以 DLL 文件

的形式存在的，下面是安装使用一个插件的步骤。 
 单击Winamp界面左上角的菜单盒，或在程序界面中单击鼠标右键，在弹出的菜单中选择Options → 

Preferences，或直接利用快捷键 Ctrl+P，打开参数设置对话框如图 11-16所示。 

 

图 11-16  参数设置对话框 

 单击 Plug in选项，在对话框右部的 Plug in setting中设置外观插件（visualizaion）或音频效果插件

（DSP/Effect）的目录，缺省为Winamp安装目录下的“Plug in”子目录，也可以自己重新设置。 
 一般得到的插件都是从网上下载的。下载的如果是压缩文件包，可以使用 Winzip 或其他解压缩工

具将这些文件解压到上面已经查看或修改过的插件目录。如果是.DLL文件，直接拷贝到相应的目录下即可。 
 再次打开参数设置对话框，Winamp会自动识别插件目录下的所有插件程序。例如选择 Plug in项中

的 Visualizaion项，对话框界面如图 11-17。 

 

图 11-17  Visualizaion 插件选择框 

 在 Visualizaion Plugin中选择“Winamp喇叭 v2.0beta1”，可以单击 Configue设定该插件的运行参数。

然后单击 Start按钮开始。 

 单击 Close关闭参数设置对话框。如图 11-18，Winamp的外观多出了一对音箱，而且喇叭会随着音

乐震动，非常形象。以后可以通过快捷方式 Ctrl+Shift+K来控制插件的打开/关闭。 
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图 11-18  运行外观插件的Winamp 

Winamp 还提供了更改程序控制面板外观（skin）的插件借口，使用这项功能可以得到不同界面风格的

Winamp。如果经常使用Winamp，而又觉得经典界面有些枯燥，可以下载一个 Skin插件。Skin插件的安装步骤

和前面所述基本类似，Skin插件缺省目录为Winamp安装目录下的 Skins子目录。 

11.1.5  winamp的运行环境设定 

Winamp提供了非常丰富的运行环境设定，他们大多包括在程序鼠标右建菜单中 Options项中，其中主要的

运行环境设置项目是 Preference项。下面对其中一些重要的设置项目作一下介绍。 

l Setup：设置界面如图 11-19所示。 

 

图 11-19  运行环境设定中的 Setup项目 

Language pack按钮选择程序界面使用的语言。Add Start Menu group可以在系统开始菜单中添加Winamp

程序组，Add Desktop icon可以在桌面上创建Winamp快捷方式。Add QuickLaunch icon可以在系统快速启动栏

内创建快捷方式。Internet settings中可以设置 internet连接方式，代理服务器以及是否自动升级Winamp版本等。 

Setup还有两个子选项：File types和 Agent。 

File types：Associated extensions选择和程序相关联的文件类型。Associated with CD Audios可以选择是否和

CD音轨相关联。 File icon滚动条可以选择程序支持的音频文件的显示图标。Playlist icon滚动条可以选择播放

清单文件的图标。 

Agent：Enable Winamp Agent选择是否启动Winamp管理器。 

l Options：其中重要的有 Process priority class：程序的优先回放级，共有四个级别：Low（低）、Normal

（正常）、High（高）、和 Realtime（同期）四个级别。 

还有两个子标签。Display可以选择程序界面的显示方式。Visualization可以选择频谱分析器的显示方式。 

l Plug-in：Input和Output可以选择和设置输入输出插件。例如我们单击Output标签，选择Nullsoft Waveout

插件，单击界面底部的 Configure按钮，弹出设置对话框如图 11-20，可以根据需要进行设置。 

篇幅所限，其他插件不再介绍。 

l Skins：选择和设置Winamp外观插件。 
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l Bookmark：书签，可快速选择所需的播放文件。例如在播放列表框中用鼠标左键选择 mp3文件“北风”，

单击鼠标右键，在弹出菜单中选择“Bookmark item（s）”，如图 11-21，也可以用快捷键 Alt+I，将该

文件作为书签加入。 

 

图 11-20  Nullsoft waveOut 插件设置对话框 

 

图 11-21  右键快捷菜单的 Bookmark命令 

以后不论“北风”是否在播放列表框中，都可以随时播放。方法是在 Winamp的播放面板内任意单击鼠标

右键，在弹出的右键菜单中选择 Bookmark → “北风”即可。 

11.2  Jet-Audio 

 

 

 

 

 

 

 Jet-Audio是 COWON system公司的产品，是一个非常出色的多媒体播放平台。它支持目前流行的绝

大部分多媒体文件，包括 AVI、MOV、MPG、CD唱片、WAV、MP3、Real Audio、MIDI、VCD等都可以用它

播放。而且其内置的 CD音轨抓取功能也很强大。 

Jet－Audio 界面如图 11-22，包括声音效果器、混音器、CD 播放器、数字音频播放器、MIDI 播放器、数

字视频播放器。除此之外，Jet－Audio还有一个视频窗口（用来显示 VCD等视频信息）和一个精美小巧的多功

能遥控器。一般来说我们并不需要使用其中的全部，此时可直接单击程序界面最上边总控制面板中的显示项目

按钮来显示或禁止显示其中的部分播放面板。如果需要禁止显示某个面板，也可以单击该面板左上角的红色点

亮按钮  即可。 

版本 4.71 

类别 共享软件 

主页 http://www.cowon.com/ 

功能 多媒体播放、抓取 CD音轨 
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图 11-22  Jet－Audio主界面 

11.2.1  播放音频/视频文件 

Jet-Audio播放音频和视频文件的步骤基本上是一样的。下面我们以播放 mp3文件为例做一下说明。 
 启动 Jet-Audio，为了减少桌面占用空间，关闭除数字音频播放器  以外的其他播放器。 

 单击数字音频播放器播放面板中的“Open”按钮  ，或按键盘上的“O”键，弹出打开对话框

如图 11-23。在上方的文件列表框中选择需要播放的文件，然后单击界面中的  按钮，将其加入到界面下方

的播放任务列表 Play list中。如果想删除播放任务列表中的文件，可以选定文件之后，单击  按钮。 
 单击“打开”按钮，回到主界面，开始播放选定的文件。 

 

图 11-23  “Open”对话框 

11.2.2  Jet-Audio的专辑管理 

还是以播放 mp3文件为例。 
 单击数字音频播放器播放面板中的 Album Management按钮  ，弹出专辑管理对话框，如

图 11-24。 
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图 11-24  Album Management对话框 

 单击 new album按钮  ，弹出对话框如图 11-25，输入专辑名称，歌手，流派，评价，Link to folder

可以选择连接到目录。输入完毕，单击确定。 

 然后可以向专辑中加入文件，可以有三种添加方式：添加单个或多个文件，单击  按钮 ；添加

整个目录下的文件，单击  按钮；添加整个目录下的文件（包含子目录），单击  按钮。想删除专辑中的

文件，可选定想要删除的文件，然后单击  按钮或直接按 delete键。 

 
图 11-25  专辑信息编辑对话框 

 如果想修改专辑属性，可以单击  按钮，可以修改专辑名称，歌手，流派，评价等。 
 如果想欣赏不同专辑中的文件，可以利用专辑管理对话框底部的播放列表，而不用建立新的专辑。

在专辑中选定想要播放的文件（可以利用 Shift / Ctrl +鼠标左键选择多个文件），单击  按钮，即可将其加入
到播放列表（PlayList）中。 

 jet-audio 还提供了存储和载入文件列表功能，单击  可以将当前专辑的文件列表存储成各种通
用的播放任务列表格式如。单击  按钮可以为当前专辑载入已经存在的播放任务列表文件。 

 将专辑管理对话框关闭，回到程序主界面，单击 Quick Album Select按钮，快捷键为 Ctrl＋A，如图
11-26。 

 

图 11-26  “快速专辑选择”按钮 

播放列表框 
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程序给出 Quick Album Select对话框如图 11-27。从中可以快速选择想要播放的专辑。如果想要欣赏播放列

表，选择“[PlayList]”。 

 

图 11-27  “快速专辑选择”对话框 

11.2.3  播放和录制音轨 

Jet-Audio能够自动识别放入光驱内的 CD碟片，播放比较简单。播放界面如图 11-28。 

 

图 11-28  Jet-Audio CD播放面板 

Jet-Audio还提供了 CD音轨的录制功能。以下是具体步骤： 

 将 CD碟片放入光驱内，单击程序界面数字音频播放器  上的 Record按钮，如图 11-29。 

 

图 11-29  Record按钮 

 程序给出录制类型对话框，缺省选择 Audio CD Recording（录制音乐光盘）。 

 单击“下一步”给出“录制光盘曲目”对话框，如图 11-30。在 Track 选择框中选择需要录制的音

轨。下面的录制方式选择 Digital Audio Extraction（读取数码音效）。 

 

图 11-30  “录制光盘曲目”对话框 

 单击“下一步”，在程序给出的界面中设置存放录制文件的目录。 

 单击“下一步”，程序给出“建立光盘信息”对话框，缺省选择为建立有光盘信息的专辑。 

 单击“下一步” 选择录制文件格式，缺省选择为录制MPEG音频（mp3）格式。 

 单击“下一步” 选择录制 mp3的参数，一般缺省设置即可。 

录制按钮 
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 单击“下一步” 选择完成，开始录制。 

11.2.4  播放控制设置 

Jet-Audio提供了丰富的播放控制，下面我们介绍一下各项控制的具体方法。 
l 对于音频文件的播放，Jet-Audio 声效器面板上提供了一个图形频谱器，如图 11-31，其中提供了许多
特殊音效修饰选择，对于频谱模式，可以选择 ROCK（摇滚乐模式）、POP（流行乐模式）、JAZZ（爵
士乐模式）、CLASSIC（古典乐模式）、VOCAL（歌唱模式）、FLAT（标准模式）、USER（用户模式）
七种。对于回响模式，可以选择 HALL（走廊模式）、ROOM（房间模式）、STAGE（舞台模式）、STADIUM
（运动场模式）、“F / X”（残声）五种。这些功能的设置比较简单，用鼠标直接在该显示面板上选择
即可。 

 

 

 

 

 
图 11-31  Jet-Audio图形频谱器 

l 上图的声效器面板上还提供了三个音效修饰深度调节控制，其中包括 Reverb（回响效果）、3D（3D效

果）、Wide（广角效果）。可以使用鼠标拖动设置项的滑条移动调节。单击滑条下方的按钮  ，可

以打开 / 关闭某个控制。 

l 在每个播放面板中程序也提供了很多的控制项目，以数字音频播放器为例，如图 11-32。 

 

 

 

 
图 11-32  播放面板中的控制项目 

播放显示面板显示了歌曲信息、播放时间、播放方式、循环方式等参数。播放控制面板包括 Repeat（循环
方式）、Play Method（播放方式）、Time（时间显示方式）和 Program（播放清单）。播放清单是在当前专辑中再
选择一部分文件播放。“快速曲目选择”按钮单击后，程序给出“快速曲目选择”列表框如图 11-33所示。选择
需要播放的文件，直接单击即可。 

 

图 11-33  “快速曲目选择”列表框 

图形频谱器 

频谱模式选
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特殊音效修饰 

播放显示面板 

播放控制面板 

歌
曲
窗
口
控
制 

快速曲目选择 

专辑管理 

快速打开 

快速专辑选择 

录
制 



常用工具软件大全 262

11.2.5  运行环境设置 

单击程序界面最上边总控制面板中的 Preferences按钮  ，程序给出如下设置界面，如图 11-34。 

 

图 11-34  Display 标签 

l 首先给出的是 Display 标签。其中提供了显示设置选项，包括当程序最小化时是否只在系统任务条中

显示 Tray图标、在程序的播放面板中是否显示播放文件名及其它文件信息等。比较重要的是最下方的

复选框 Display Song Information in File，选中后上图的“快速曲目选择”列表框中可以显示歌曲信息。 

l 切换到 CD标签，如图 11-35，提供了有关光盘播放选项。重要的有是否自动播放插入的 CD碟片，播

放时是否自动在曲目之间插入间隔、是否自动连接 CDDB库，如果是，需要设置收发 E-mail的服务器

地址，以及是否将 Jet-Audio设置成默认的 CD播放器。 

 
图 11-35  CD标签 

l 切换到 Digital Audio标签，如图 11-36，提供了数码音频设置。其中包括是否设置 Jet-Audio于相应文

件的关联创建、是否使用程序自身提供的MPEG Audio音频加速功能，以及 MPEG音频的回放质量、

解码方式等。在 Advanced 按钮项中还提供了设置音频输出设备、音频缓存、解码优先级等设置。这

里值得注意的是如果你的计算机的性能比较高，建议在 Decoding选项中选择 64 bit Floating Point，可

以获得最高的回放质量。 
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图 11-36  Digital Audio标签 

我们还可以设置歌词文件夹（lyrics Folder），将包含歌词文件的目录加入其中。注意歌词文件一般是.rtf或.txt

文件。而且歌词文件和歌曲文件（.mp3）必须同名。 

设置完毕后，当我们播放 mp3时，如果在歌词文件夹中有同名歌词文件，当歌曲窗口控制开关打开时，见

图 11-32，就会出现当前歌曲的歌词。如图 11-37。 

 

图 11-37  歌曲窗口 

l 在程序设置界面中的MIDI和Digital Video标签中主要提供了程序本身于这两种文件类型的关联创建，

是否使用 VCD2.0交互菜单等设置，可以根据自己的习惯设置。 

11.3  Sonique 

 

 

 

 

 
 Sonique是由 Night55公司出品的MP3播放新秀。它与一般的MP3播放器的最大区别是其新颖别致的

界面设计，整个界面融合了大理石的纹理与半透明的质地，看起来金属质感极强。Sonique 的播放功能也首屈
一指，它提供了对多种音频文件（如.xm、.it、.s3m、.cdda、.mpg、.mod、.mp3等）以及 Audio CD的播放支持；
提供了 20段音频频谱均衡调节器，可以对音乐进行精细调节；自带 Plug-in插件；支持网络在线播放；可以设
置解码优先级与预读缓存，以占用更少的 CPU时间，降低系统资源的占用。 

Sonique 还有一个匠心独运之处在于它提供了最大化、中等化、和最小化三种运行模式。下面分别作一介
绍。 

版本 1.50 

类别 共享软件 

主页 http://www.sonique.com/ 

功能 MP3播放 
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11.3.1  最大化运行界面 

启动 Sonique，程序缺省以最大化界面运行。中间的主窗口现在显示的是绿色的主菜单，右上角较小的一
排蓝色按钮是导航按钮。窗口的外面包以深色岩石纹理的外框，上面嵌有几组精心设计的按钮，整个界面十分

赏心悦目。 

 

 

 
图 11-38  Sonique主界面 

1．主菜单 

主菜单是导航控制台的中心，主要包括五项：visual mode（可视模式）、playlist editor（播放列表编辑）、find 

music（音乐搜索）、setup options（设置选项）、audio controls（音频控制）。 

l visual mode（可视模式） 

单击 visual mode选项，主窗口切换成如图 11-39所示界面。 

 

 

图 11-39  visual mode设置界面 

上面的窗口是频谱分析器窗口，会随着音乐节奏的变化，呈现出不断变换的图象。Sonique 自带了几种频
谱插件，我们可以通过界面右下角的两个半圆形的翻页按钮选择自己满意的频谱图像。还可以单击分析器窗口

右上角的缩放控制来改变窗口的大小。较大按钮的是全屏显示，全屏显示时按 ESC键可以退回来。较小的按钮
是在主窗口内全窗口显示。 
下方有两个进度显示条，playlist progress表示播放列表中的播放进度，把鼠标移到该进度显示条的上方，

文件信息 
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在最下面的信息显示栏中会显示相应的音频文件名称，在相应的位置上单击鼠标左键，可以选择播放任一文件。

track progress表示当前播放文件的播放进度，把鼠标移到该进度显示条的上方，在最下面的信息显示栏中会显
示文件中的相应位置，单击鼠标左键，可以选择从任一位置开始播放文件。 

track为当前播放曲目在播放列表中的序号。序号右边为播放时间显示，可以在上面直接单击切换播放时间
显示（显示已播放的时间或剩余的播放时间）。 
界面右边的 file项显示了音频文件的格式信息。单击下方的 file info按钮，程序弹出对话框如图 11-40所示，

可以编辑歌曲文件的 ID3标签信息，如歌手、歌曲名称、专辑名称、评价等。 

 

图 11-40  歌曲信息设置对话框 

在主窗口内任何一处单击鼠标右键可以退到上一层的主菜单。单击右上方的导航按钮栏中的“back”按钮 

 也可以。 

l playlist editor（播放列表编辑） 

单击 playlist editor选项，主窗口切换成如图 11-41所示界面，从这里可以看出 Sonique对于国内用户来说

的一个缺陷就是不支持汉字显示，希望能在将来的版本中改善这项功能。 

窗口底部有两排按钮，上排有四个，分别是： 

·  sort：按字母顺序对播放列表中的文件进行排序。 

·  shuffle：将播放列表中的文件随机排列。 

·  reverse：按字母顺序对播放列表中的文件反向排序。 

·  clear：清除播放列表。 

 

图 11-41  播放列表编辑界面 

下排包括三个按钮： 

·  add：加入文件，单击后弹出对话框如图 11-42所示，在上面的文件列表框中选择想要播放的文件，单
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击“打开”即可。 

 

图 11-42  “打开”文件对话框 

·  remove：从播放列表中删除选定的文件。 

·  save：保存当前的播放列表。单击后弹出对话框如图所示，设置保存文件的路径和文件名称（播放列

表文件为.pls格式），单击“保存”即可。 

 

图 11-42  保存播放列表对话框 

在主窗口内任何一处单击鼠标右键可以退到上一层的主菜单。 

l find music（音乐搜索） 

单击 find music选项，主窗口切换成如图所示界面 

 
图 11-43  find music界面 

在 search using项中选择搜索引擎。在 enter search keywords文本框中键入搜索关键字，单击旁边的 go按钮 

 开始搜索。 

因为 Sonique搜索的一般都是国外音乐站点，且不支持中文搜索，所以这项功能对于国内用户意义不大。 

在主窗口内任何一处单击鼠标右键可以退到上一层的主菜单。 

l setup options（设置选项） 
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单击 setup options选项，主窗口切换成如图 11-44所示界面 

 
图 11-44  Sonique选项设置界面 

Sonique的设置选项分成 general（常规）和 plug-ins（插件）两个部分。限于篇幅，现只介绍一些常用的选

项。 

在 general标签中， 

·  system（系统）：Enable Sonique QuickStart 是选择打开或关闭快速启动器（在系统任务栏中的图标为 

 ）。如果选择该选项，无论打开或关闭 Sonique，快速启动器都会在后台运行。show Sonique on taskbar

选择最小化时是否图标。 

·  Playlist（播放列表）：Auto CD insert是否自动检测 CD。Always display filename显示文件名。 

·  Audio（音频）：Select Output（选择输出），默认选择 windows Audio Output，单击 config按钮，界面

上的 Select Out Device可以选择输出设备，可以选择默认的“wave mapper”或系统中的声卡（例如笔

者的是“Maestro playback”），Buffer Fragment Size缓冲区大小，缓冲区越大，播放越流畅。Numbers of 

Buffers为缓冲区数目。 

·  Visual（视觉）：Animation smoothness设置动态界面的平滑程度。Animation speed设置动态界面的速

度。 

·  Filetypes（文件类型）：设置和 Sonique关联的文件类型。 

·  Vis fx：设置视觉特殊效果。包括 Blur（钝化）效果、smoke（烟雾）效果、zoom（缩放）效果和 reverse

（反向变化）。 

·  Internet：有关 internet的设置。 

Skins：选择程序的外壳插件。 

在 plug-ins项中，可以设置程序各种插件的选项，限于篇幅略。 

l audio controls（音频控制） 

单击 audio controls选项，主窗口切换成如图 11-44所示界面，同时打开界面底部的调音控制面板。 
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图 11-44  音频控制界面 

调音面板上有 20段音频频谱均衡调节器，通过调节各声音频段可以调出自己喜欢的音色，调节过程中相邻

的几个频段调音滑块会关联移动，同时在调音面板上方显示音频曲线。对于调节满意的方案可以单击 save按钮

保存，单击 load按钮可以调用预设的 EQ设定，包括 Rock（摇滚）、Pop（流行）、Jazz（爵士）、Classical（古

典）等。单击 reset按钮清除设定。调音面板右边还提供了三个调音按钮，分别用于控制 AMP（调音幅度）、BAL

（声道平衡度）、PTCH（音速调节）。 

2．导航按钮栏 

导航按钮栏在主窗口的右上角，各按钮的功能依次为 

l  ：退回。 

l  和  ：Sonique 有提供了最大化、中等化、和最小化三种运行模式，单击这两个按钮可以在这

三种运行模式中转换。其实还有一个更简单的转换的方法，在程序的深色岩石纹理外框上双击鼠标左

键即可。 

l  ：帮助。 

l  ：最小化。 

l  ：关闭程序。 

3．回放按钮 

l  ：播放上一首。 

l  ：播放下一首。 

l  ：暂停键。 

l  ：播放/停止键。 

4．控制按钮 

播放面板上方有三个控制按钮，分别为： 

l  ：open files（快速打开文件），单击后弹出“打开文件”对话框，选择需要播放的文件，单击“打

开”即可。 

l  ：选择重复模式。共有三种模式，loop（all）（所有文件反复播放）、loop（1）（单个文件反复）、loop

（none）（取消反复）。可以在信息显示栏内看到选择的是何种模式。 

l  ：随机播放模式。 
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5．翻页按钮 

在许多情况下相当于上下选择。 

11.3.2  中等化界面 

中等化运行时 Sonique 像一个望远镜，如图 11-45 所示。上方圆圈的右上角是导航按钮栏，只要将鼠标移

进该圆圈内，便浮现出一个 VIS（视觉效果选单），单击选单两侧的箭头，可以选择频谱分析图像，圈内壁有一

圈小灯，用于曲目列表定位。单击鼠标左键，可以选择播放文件。 

下方圆圈中显示歌曲的名称、序号、播放时间等信息。内圈的小灯表示当前播放文件的播放进度，单击鼠

标左键，可以选择从任一位置开始播放文件。界面中的按钮与最大化界面相同，在此不再赘述。 

 

图 11-45  Sonique中等化界面 

11.3.3  最小化界面 

最小化模式时的 Sonique如图 11-46所示。 

 

图 11-46  Sonique最小化界面 

界面十分小巧玲珑，纤巧的面板两端辉映着淡淡的蓝、绿色光辉，并随着音乐节奏的变化而闪亮。面板中

间显示播放顺序、时间等数字信息，平时只显示上面的面板，当把鼠标移到面板上时，程序下拉出一个功能齐

全的控制板块。 

11.4  超级解霸 2000 

 

 

 

 

 

版本 2000 

类别 / 

主页 http://www.herosoft.com/ 

功能 多媒体播放、制作 
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 超级解霸 2000 是豪杰解霸系列的最新版。超级解霸系列是目前最有影响的国产软解压软件，具有众

多独特的功能，主要有： 

l 支持 VCD、CVD、DVD、SVCD、DVCD及 CD、MP3等多种影音格式，包括无文件影碟。支持万能

轨道方式播放。 

l DirectCDROM 和 DirectDVDROM“防读死”技术，轻易读取各种烂碟。 

l 支持 3D加速，支持软件平滑处理。 

l 支持 AVI转MPG、MPG转 AVI、MPG转 GIF，MPG合并，MPG转标准 VCD格式（可用于刻盘）。 

l 支持多种音频格式的播放及压缩成MP3，包括 TEXT文本文件的朗读。 

l 自动禁止屏幕保护和节能状态。 

l 新增图像浏览器，方便浏览各种图片格式。 

《超级解霸》主要由以下几个部分组成： 

1）超级解霸 

2）超级音频解霸 

3）界面编辑器 

4）视频电话 

5）图像浏览器 

6）豪杰实用工具集 

下面我们介绍其中常用的几项功能。 

11.4.1  超级解霸 2000 

启动超级解霸 2000，其界面如图 11-47所示。 

 
图 11-47  超级解霸 2000 

如果是播放 VCD或 DVD等标准格式影碟，直接单击工具栏中的“播放影碟”按钮  即可。如果

是播放 SVCD、DVCD 或无文件影碟，可以选择“文件”菜单上的“播放万能轨道模式”。如果是打开视

频文件，选择“文件”菜单上的“播放多个文件”或“打开单个文件”。 

单击工具栏中的“窗口切换”按钮  ，可以切换到全屏显示。在全屏显示时，在原来超级解霸主界面所

在的地方单击鼠标左键，可以重新调出该主界面。如图 11-48所示。 

播放时在视频画面上单击鼠标右键出现如图 11-48所示选项一般都是播放时常用的。 

播放时在视频画面上双击鼠标左键出现如图 11-49所示的“控制选择板”，通过它可以快捷选择影视的不同

段落。 
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图 11-48  全屏播放 VCD 

         

                 图 11-48  鼠标右键快捷菜单           12-49  控制选择板 

在播放过程中如果想截取图片，可以在想要截取的画面出现时，按下“停止”键  ，然后单击工具栏

中的  按钮，程序给出“保存图像”对话框，设置保存文件的路径、名称和格式即可。 

在播放过程中如果想截取 VCD 片断，首先单击工具栏中的“区域选择”按钮    ，程序界面中的播放进

度条变成如图 11-50所示。 

 

图 11-50  截取 VCD片断时的界面 

用鼠标拖动进度滑块到需要截取的开始位置，此时播放窗口会出现相应的画面，单击工具栏中的  按

钮，然后拖动进度滑块到需要截取的结束位置，单击工具栏中的     按钮。选择好需要截取的区域后，单击 

 按钮，程序给出“保存数据流”对话框，在其中设置截取视频片断地文件名及文件格式即可。 

为了得到更好的播放效果，用户还可以进行一些选项设置。 

单击播放面板上的“控制”菜单，选择“控制设置”，弹出设置界面如图 11-51。可在其中设置是否启用

DirectCDROM功能。 
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图 11-51  “其他设置”对话框 

单击“音频”菜单，可以选择立体声或左右声道，如果用户的机器性能较好，可以选择“精密 44100赫兹”。 

单击“视频”菜单，选择“单显示器设置”，程序给出如图 11-52 所示的对话框。如果用户的显示卡有 3D

加速功能，而且整机性能较好，可以选上软件平滑处理和支持 3D加速（针对 DVD播放），以提高播放性能。 

 
图 11-52  “单显示器设置”对话框 

按下停止播放按钮，单击“控制“菜单中的“测试速度”命令，可以测试播放 VCD 的帧数，该数据与机

器的性能、光驱的读盘速度和光盘是否易读均有关系。 

我们还可以改变控制面板的外观，选择“插件”菜单中的“程序界面插件”命令，程序给出如图所示对话

框。 
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图 11-53  “外挂程序”对话框 

例如我们可以选择如下外观的控制面板。 

 

图 11-54  改变超级解霸 2000的外观 

如果想改回原来的外观，用鼠标右键单击界面中的任何位置，在弹出的关联菜单中选择“返回主窗口”即

可。 

11.4.2  超级音频解霸 2000 

启动超级音频解霸 2000，程序界面如图 11-55所示。 

 

图 11-55  超级音频解霸 2000主界面 

该界面和超级解霸界面很类似，相似的地方在此就不再介绍。 

和以前的版本相比，新版本增加了“列表播放”功能。选择菜单“文件”→“播放列表”，或单击工具栏中

的  按钮，可以打开如图所示的“播放清单”对话框，可在其中编辑播放文件，并可以将列表保存和读取。 
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图 11-56  播放清单 

使用列表播放音频文件时，程序控制面板中会多出一项“曲目”菜单，可以从中快速选择播放列表中的文

件。 

如果需要随机播放，可单击菜单命令“控制”→“随机顺序播放”。 

如果需要调节频带均衡，可单击菜单命令“音频”→“设置功放”，程序会给出设置界面。如图 11-57。 

 
图 11-57  “频带均衡调节”对话框 

11.4.3  图像浏览器 

图像浏览器是超级解霸 2000新增的工具。其主要功能有： 

l 支持多种图象文件格式的浏览。 

l 支持多种文档格式的编辑修改和网页浏览。 

l 支持网页浏览。 

启动后，程序界面如图 11-58所示。 



常用工具软件大全 

 

275 

 

图 11-58  图像浏览器主界面 

界面中有三个窗口，左边称为目录树，底部称为工作区，这两部分主要用来浏览机器的内容，工具栏上左

边两个按钮用来控制目录树与工作区的显示。目录树与工作区的边界上分别有两个按钮，一个向上的箭头和一

个“X”, “X”用来关闭此窗口，箭头可以将当前的目录向上退一级。 

工具栏的“图象浏览”按钮是用来显示所支持的图象格式缩略图。在此工作模式下，默认将工作区关闭，

打开一个叫做"缩略图"的窗口，程序会在目录树上当前选择目录中查找可以显示的图片，并将其以固定大小显

示在窗口中，如果需要图片的详细资料可以将鼠标放在图片上等待片刻，这时会弹出一个小窗口，其中显示了

图片的详细资料。如果需要看到图象的真实大小，可以在缩略图的小图片上双击，程序会打开一个窗口进行显

示。 

程序默认在启动时自动打开一个主页，这个主页地址可由用户自行配置。也可以在窗口工具条上的组合框

中直接输入后，按回车。网页工具条与 IE工具条类似。 

通过在工作区文件上双击，可以浏览与编辑 txt、doc、rtf、cpp、c、hpp、h 等文件。 

11.4.4  mp3数字 CD抓轨 

豪杰实用工具集中提供了多种实用工具，下面我们介绍其中的“mp3数字 CD抓轨”程序。该工具采用独

创的 DirectCDROM技术，可抓 CD、DVCD、VCD、SVCD、CVD和其他各种类型的光盘，而且速度快，支持

IDE和 SCSI等各种类型的光驱，（CDR可能顺序不正常）。可以直接抓取 CD为 48KHZ高质量 16位WAV，支

持非音乐 CD（如 DVCD）的抓取，而且自动去除多余补助数据，使数据最小。可以自动连续轨道抓取，支持

任意位置开始抓取，不必从头开始。支持直接压成MP3文件，1分钟左右即可压完一首 48KHZ的 CD歌曲。 

启动该工具，程序界面如图 11-59所示。 

 

图 11-59  数字 CD抓轨设置界面 
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如果想要直接压成MP3文件，选中右下角的复选框“直接压缩成MP3”，如果要抓取 CD上的所有歌曲，

可以选中“连续读取所有轨道”。其他的选项设置完毕，单击“开始读取”按钮，程序开始读取压缩操作，并同

时显示读取进度。 
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很多电脑用户都喜欢收藏精美的图片，有时也喜欢

将游戏中的图片保存下来，所以需要有一个功能强大的

看图工具和截图工具。 

看图工具中本章介绍了ACDSee3.0和Compupic5.0。

ACDSee在浏览图片领域里就像压缩工具里的WinZip一

样，一直居于领导地位，新版本 3.0 功能更加强大。

Cpmpupic也是一个非常优秀的图片浏览和管理工具，其

雾化般的界面让人印象深刻。 

本章介绍的两个截图工具是 Hypersnap-DX pro 和

SnagIt，前者是一个老牌的专业抓图工具，后者的特点是

既可以抓图，也可以抓文字和视频片断，各有特色。 

 
 

第十二章  五彩缤纷 

 

·＝＝ 本章导读 ＝＝ 

 

 

 

 

 

 

 

 

 

 

12.1  ACDSee 3.0 

 

 

 

 

 

 

 ACDSee是Windows环境下非常著名的专业图片浏览器，具有操作简便、显示质量高、显示速度快等

优点。它不仅支持多种格式的图片文件，其最新版本 3.0 还拥有强大的多媒体文件浏览能力，支

持.wav、.mid、.cd、.mp3 等声音文件和.avi、.mov、.mpg 等影音文件的播放。ACDSee 还支持部分格式的压缩

文件。ACDSee强大的功能使其成为Windows下浏览图片文件的首选工具。 

12.1.1  ACDSee的界面控制 

ACDSee安装后，在系统开始菜单的程序项中开始任务栏中将添加 ACDSee Browser和 ACDSee Viewer两

个菜单项。一个用于浏览图片，一个用于观看图片。 

启动 ACDSee Browser，程序界面如图 12-1。 

版本 3.0 

类别 共享软件 

主页 http://www.acdsystems.com/ 

功能 图片浏览 
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图 12-1  ACDSee Browser默认界面 

按照系统的默认设置，界面最顶端为菜单和工具栏，左边为系统路径列表窗口，右边是文件列表窗口，中

间为文件预览窗口。最下面是状态栏，显示一些目录和文件的信息。 

我们可以随意改变界面的布局。例如想要改变预览窗口的位置，可以用鼠标双击预览窗口顶端，如图 12-1

鼠标所在的位置，预览窗口从界面中独立出来，如图 12-2。 

 

图 12-2  独立出来的预览窗口 

拖动独立出来的预览窗口到路径窗口的下方，松开鼠标左键，适当调整三个窗口的边界，界面就变成了如

图 12-3所示。如果想关闭路径窗口或预栏窗口，单击该窗口右上角的关闭按钮  即可，如果想重新打开，

可以选择菜单 View → Controls → Folder Tree（路径窗口）或 Preview Area（预栏窗口）。界面上的工具栏的

位置也可以随意调整，ACDSee可以让我们按照自己的喜好来布置界面格局。 

路径列表 

窗口 

文件预览 

窗口 

文件列表 

窗口 
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图 12-3  改动后的 ACDSee Browser界面 

12.1.2  浏览图片文件 

首先在系统路径列表窗口中找到图片文件存放的目录，然后在文件列表窗口中用鼠标点击想观看的图片文

件，图片就会出现在中间的预览窗口中。如果用单击工具栏中的“查看”按钮  ，或用鼠标双击图片文件

或预览窗口，程序就会自动切换到 ACDSee Viewer窗口，进行完全的显示，如图 12-4。 

 

图 12-4  ACDSee Viewer主界面 

在“ACDSee Viewer”窗口中，可以单击工具栏上的放大按钮  或缩小按钮  进行图片的缩放，如

果想恢复图片的原始尺寸，单击  按钮。如果图片在窗口内显示不下，可以按住鼠标左键上下左右移动观察。

如果想全屏显示，可以单击菜单栏中的 View → Full-screen，也可以在窗口中单击鼠标右键，从弹出的快捷菜

单中选择 Full-screen，如果想回到程序界面，则重新选择 Full-screen即可。 

单击“向前”按钮  或“向后”按钮  可以查看同一目录中的其他文件，利用键盘上的 Page Up键

和 Page Down键也很方便。如果想切换到 ACDSee Browser窗口，可以在 ACDSee Viewer窗口内双击鼠标左键，

或单击菜单栏上的“Browse”按钮  。 

ACDSee还有两个常用的浏览功能。 

l Slide Show（幻灯显示） 

当浏览大量的图片文件时，使用 ACDSee的自动连续显示功能比较方便。首先在 ACDSee Browser中切换
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到图片文件所在的目录，然后单击工具栏中的“查看”按钮，或用鼠标双击图片文件或预览窗口，切换到 ACDSee 

Viewer 窗口，单击菜单条中的 Slide show 按钮  ，进入图片文件的自动连续显示状态。显示过程中单击工

具栏中的 Slide show按钮，可以终止自动显示。 

我们还可以改变系统自动连续播放的方式。单击 Browser或 Viewer窗口上的工具栏中的 Option按钮  ，

在程序给出的对话框中选择 Slide Show标签，设置界面如图 12-5所示。Sequence项可以选定自动连续播放的顺

序：Forward（升序）、Reverse（降序）、Random（随机）、Wrap around（循环播放）、。项中，Timed (automatic) 

slide show表示自动播放时的时间间隔，可以用鼠标拖动滑块控制。Delay flip until next image is fully decoded为

延迟显示, 直到下一个图片读取完毕才更换。Caching/read-ahead中，Read ahead表示提前对下一个图片解码，

Cache behind表示仍然读取上一次在内存里的图片。 

 

图 12-5  Slide Show标签 

l Thumbnails（缩略图显示） 

对于大量图片文件的检索，ACDSee 提供了一项缩略图功能，比图片预览更快，更直观。首先在 ACDSee 

Browser 窗口中找到图片所在的目录，然后单击工具栏上的 Thumbnails 按钮  ，或选择菜单 View → 

Thumbnails，这时在 Browser 窗口右边的文件列表框中就能看到一排一排的小图片，如图 12-6，很方便我们查

找。 

 

图 12-6  ACDSee的 Thumbnails显示 

我们还可以改变缩略图的显示方式。单击工具栏的 Options 按钮  ，在弹出的系统设置界面中单击

Thumbnails标签，出现如图 12-7所示界面。其中 Thumbnail Size表示显示的图片大小，Border Size项表示显示
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图片的边框大小，Information displayed表示显示的信息：File name（文件名称）、File size （文件大小）、Image 

dimensions（图片尺寸）。Item shows项中，All Files 表示显示所有文件（包括非图片文件），Folders表示显示

目录。Stretch small Thumbnails表示拉伸小缩略图。 

 

图 12-7  Thumbnails标签 

12.1.3  管理图片文件 

l 复制 

在浏览图片的过程中，如果想把某个图片拷贝到别处，首先用鼠标选择该图片，然后单击工具栏上的 Copy 

to按钮  ，程序弹出如图 12-8所示的对话框，在 Destination Directory文本框中直接键入目的路径，或单击

“Browse…”按钮设置路径，然后单击 OK即可。 

 

图 12-8  复制图片对话框 

l 移动 

其操作方法和设置界面与前面的复制完全相同，只是按下的按钮应该是  。 

l 删除 

选择所要删除的文件，单击工具栏中 Delete按钮  ，或直接按 Delete键。 

l 重命名 

选择需要重命名的文件，单击工具栏内 Rename按钮  ，此时该文件名被框起来，并出现闪动的光标，

输入新的文件名并回车即可。 
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l 添加文件信息 

选择需要添加信息的文件，单击工具栏内 Properties 按钮  ，程序会弹出如图 12-9 所示对话框，在其

中输入各种信息，单击确定即可。 

 
图 12-9  Properties对话框 

12.1.4  ACDSee的其他功能 

1．制作墙纸 

ACDSee提供的设置墙纸功能具有速度快，操作简便等优点。如果不是.bmp文件，它会自动将其转换为.bmp

格式，然后在Windows目录下生成一个名为“ACDWallpaper.bmp”的文件，并将其设置为桌面的墙纸。整个操

作很简便，首先在 ACDSee Browser窗口中用鼠标选中准备作为墙纸的图片，让它在预览窗口中显示出来，或

在 Viewer窗口中显示出来，然后用鼠标单击工具栏中的“Wallpaper”按钮  即可。也可以在 ACDSee Browser

窗口中准备作为墙纸的图片上点击右键，或在 Viewer窗口中单击右键，从弹出的快捷菜单中选择Wallpaper命

令。                                                                                                                                                                                                                                                                                                       

2．图片格式转换 

首先在 ACDSee Browser窗口中用鼠标选中准备转换格式的图片，选择菜单 Tools → Convert …，弹出格式

转换对话框，如图 12-10，在项中选择需要的转换格式和输出路径，单击 OK即可。 

 

图 12-10  格式转换对话框 

3．照片编辑 

ACDSee提供了简单的照片增强处理功能，在 Browser或 Viewer窗口中点击 Photo Enchancer按钮，程序切

换到照片编辑窗口中，如图 12-11所示。 

加入密码 
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图 12-11  照片编辑窗口 

下面对其工具栏作一些简要说明。 

 ：当图片不能完全显示时，可用这只小手移动。 

 ：选中一个区域，然后双击，剩下的就是选中的部分了。 

 和  ：缩小和放大图片。 

 ：改变照片大小。界面中的Width和 Height表示宽和高，Maintain aspect ratio表示保持外观比例。 

 ：旋转。点击箭头按钮，可以将图片旋转。 

 ：翻转。点击箭头按钮，将图片上下左右倒置。 

 ：色彩平衡调节。可以调节图片的色调、饱和度、亮度。 

 ：对比。可以调节图片的黑白对比、亮度、伽玛值等。 

 ：自动水平调节。单击后，系统自动将照片调节至最优化。 

 和  ：柔和与锐化。可以调节照片的朦胧和清晰程度。 

 ：去除杂点。这个功能对处理扫描的照片很有用处。 

 ：将照片的色彩转换为棕褐色。 

 ：色彩化。包括有色调和饱和度两个选项。 

 ：底片效果。 

 ：浮雕效果。 

4．多媒体文件浏览 

新版本的 WinZip 可以浏览多媒体文件，支持.wav、.mid、.cd、.mp3 等声音文件和.avi、.mov、.mpg 等影

音文件的播放。如果在 ACDSee Browser窗口中单击一个.mp3文件，程序会自动播放。预览窗口如图 12-12。 

 

图 12-12  播放 mp3文件 
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如果在 ACDSee Browser窗口中单击一个.mpg文件，自动播放界面如图 12-13。 

 

图 12-13  播放 mpg文件 

5．压缩文件显示功能   

新版本的 ACDSee支持部分常用格式的压缩文件，如 ZIP文件。在 Browser窗口中 ACDSee把压缩包文件

当作一个文件目录来处理。例如我们选择一个 ZIP压缩包，如图 12-14所示。 

 

图 12-14  选择一个 ZIP压缩包 

双击该压缩包，就像打开一个目录一样，可以浏览和运行里面的文件。如图 12-15所示。 

 

图 12-15  打开 ZIP压缩包 

12.2  CompuPic 5.0 

 

 

 

 

 

 

 CompuPic是由 Photodex公司推出的一个优秀的图形浏览和编辑工具。程序支持的文件格式相当丰富，

几乎包括所有常见的图形文件、视频/音频等多媒体文件以及Windows的帮助文件和 TXT文本文件等。除了浏

版本 5.0 

类别 共享软件 

主页 http://www.compupic.com/ 

功能 图片浏览 
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览和编辑图片以外，CompuPic提供了压缩图形文件大小、转换图形文件格式、创建索引图片、随机改变屏幕壁

纸、将相关图形及声音文件转换为屏保、截取图片等功能，完全可以满足普通用户处理图形文件的需要。 

12.2.1  浏览图片 

启动 CompuPic，界面如图 12-16所示。新版本提供了具有雾化效果的菜单栏和动态的显示效果，整个界面

看起来十分华丽。 

 

图 12-16  CompuPic主界面 

从界面左边的系统文件夹列表框中选择图形文件的所在的目录，程序在右边的文件列表框中列出该目录下

的文件缩略图列表。选择界面菜单条中的 Listing菜单，可以改变文件列表框中文件的列表格式。Listing菜单中

共有五种列表格式：Details（详细信息）、File Listing（文件列表）、Icon Thumbnails（图标缩略图）、Tile Thumbnails

（平铺缩略图）、Windows Style（窗口风格）。可以根据需要从中选择。 

使用鼠标选择图片的图标，程序会在界面右下角地预览窗口显示该图片。使用鼠标双击图片文件图标和预

览窗口，该图片以全屏显示。如图 12-17所示。 

 
图 12-17  全屏显示图片 

使用鼠标右键单击全屏显示的图形或移动鼠标到显示屏幕的顶端，程序会给出关联的右键菜单和浮动菜单

条，两者的内容完全一致。按下键盘的“Alt”键，也可以弹出浮动菜单条。下面是几条程序提供的显示控制技

巧（在全屏显示状态下）。 

l 利用键盘上的 Page Up键和 Page Down键可以查看同一目录下的上一个或下一个图形文件。 

l 按下小键盘中的“＋”号，图像自动放大 5％，按下小键盘中的“－”号，图像自动缩小 5％。在进行

文件列表框 

预览窗口 

系统文件夹列表框 
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图像缩放的过程中，如果想要切换到全屏显示，可单击鼠标右键，从关联菜单中选择 View → Fit to 

screen命令即可，该项操作的快捷键为“F”。 

l 当显示的图像尺寸超过显示屏幕时，如果想观察图像其它没有显示的部分，可以单击鼠标右键，从关

联菜单中选择 View → Pan命令，鼠标指针变成手形，按住鼠标左键可以带动图像一起移动。该项操

作的快捷键为 P，如果想取消 Pan操作，随时按键盘的 Esc键即可。 

l 如果想对图像中的一部分放大，可单击鼠标右键，从关联菜单中选择 View → Modify 命令，鼠标指

针变成放大镜状，移动鼠标指针导需进行放大显示的位置，单击鼠标左键即可。该项操作的快捷键为

M。显示完成后，单击鼠标左键或按下键盘的 Esc键，可回到程序主界面。 

程序还提供了两种快速显示当前路径下所有图片的方法：Slide Show和Maxi-show。以下分别介绍。 

l Slide Show 

首先切换到需要显示文件的文件夹，使用鼠标选择需要显示的第一个文件，然后单击程序界面工具栏中的

Slide Show按钮  ，程序自动切换到全屏显示状态，并自动连续显示所有图形文件。如果想结束显示，单击

鼠标左键或按下 Esc键，可回到程序主界面。 

l Maxi-show 

也是自动连续显示图片，但和 Slide Show不同的是全屏显示多个文件。方法是首先切换到需要显示文件的

文件夹，使用鼠标选择需要显示的第一个文件，然后单击程序界面工具栏中的 Slide Show 按钮  ，程序自

动切换到全屏显示状态，并自动连续显示所有图形文件。如图 12-18 所示。如果想结束显示，单击鼠标左键或

按下 Esc键，可回到程序主界面。 

 
图 12-18  Maxi-show方式显示图片 

12.2.2  编辑图片 

CompuPic的图片编辑功能只有在全屏显示状态下才能使用，其图像处理命令主要集中在 Image菜单中，使

用鼠标右键单击全屏显示的图形或移动鼠标到显示屏幕的顶端，程序会给出关联的右键菜单和浮动菜单条，从

中选择 Image，弹出 Image单如图 12-18所示。 

 
图 12-18  Image菜单 

其中常用的处理命令介绍如下： 

l Adjust（调节） 

单击Adjust命令，程序给出图形调节器如图 12-19所示。其中一共提供了 11种图形属性设置，包括Brightness
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（亮度）、Contrast（对比度）、Color（色彩饱和度）、Hue（色调）、Black Point（黑点调节）、White Point（白点

调节）、Red（Green、Blue）Gamma（三原色调节）、Sharpen/ Blur（锐化/柔化）、Add Noise（混沌化处理）。设

置方法很简单，直接使用鼠标拖动相应设置项目中的滑块到合适的位置即可，也可以在右边的文本框中输入需

要的数值。可以从左边的预览窗口直接观察设置结果。如果要恢复到原始设置，单击界面上的 Reset 按钮，如

果要保留设置，单击 OK。 

 

图 12-19  图形调节器 

l Colorize（色彩化） 

单击 Colorize命令，程序给出色彩调节器，如图 12-20所示。和上节的图形调节器不同的是，图形调节器

中的色彩选项是对整个图像中的色彩进行调节，而本节中的色彩调节器把整个图像中的色彩分成三个色彩范围

（color range），可以分别进行调节。 

 

图 12-20  色彩调节器 

界面左边上方是预览窗口，左边下方的 Color Strength滑动条调节色彩调节强度。右边有三个色彩调节盘，

分别对应： 

Light Tones：浅色调。比整个图像平均色彩浅的颜色。例如接近白色的都符合该范围。 

Dark Tones：深色调。比整个图像平均色彩深的颜色。例如接近黑色的都符合该范围。 

Mid Tones：中间色调。 

下面再介绍一下色彩调节盘的用法，如图 12-21 所示，中间的彩色环形中有一个白色圆环，用鼠标将其在

彩环上拖动，可以选择色彩。彩环中间的三角形可以调节色彩饱和度，用鼠标拖动上面的一个小的黑色园环即

可。下方的两个按钮可以选择色彩的表现方式：RGB 或 HEX。可以在最下方的文本框中直接输入数值。右上
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方的三角形为色彩预览窗口。左上方的滴管状图标为色彩拾取器，按下该图标，鼠标指针变成滴管状，在屏幕

上任何地方单击鼠标左键即可拾取该点的色彩。 

 

图 12-21  色彩调节盘 

l Rotate（旋转） 

单击 Rotate命令，弹出级联菜单，可以直接选择预设值，如 90°、180°、270°，也可以自行选择旋转角

度，单击级联菜单中的 Any Angle，弹出设置界面如图 12-21所示。 

 

图 12-21  图像旋转对话框 

可以按住鼠标左键在预览窗口中旋转图像，也可以用鼠标在下方的 Rotation Angle滑动条中设定旋转角度，
或直接在滑动条右边的文本框中键入数值。界面右边的色彩调节盘可以设定旋转后的图像背景颜色。Show 
alignment lines表示在预览窗口中旋转图像时显示校准线。 

l Flip（图像翻转） 
包括 Horizontal（水平翻转）和 Vertical（垂直翻转）。 
l Resize（改变尺寸） 
单击 Resize命令，弹出级联菜单，可以直接选择预设值，如 800X600 frame等，或用小键盘上的“＋”或
“－”号改变图像在屏幕的显示尺寸后，单击级联菜单中的 Shown命令，将图像改变成当前的显示尺寸。也可
以自行选择尺寸，单击级联菜单中的 Any Size，弹出设置界面如图 12-22所示。 
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图 12-22  改变图像尺寸对话框 

在 New Image Size项中填入新的Width和 Height值，单击 Resize即可。Keep aspect ratio复选框表示保持

图像的高宽比不变。 

l Convert（色彩转换） 

将图像转换成指定的色彩数。 

l Invert（底片处理） 

将图像的色彩反转。 

l Place Text（插入文本） 

单击 Place Text命令，程序弹出相应的 Text Overlay对话框，如图 12-23。在文本框中设置需要插入的文本

内容，在 Font Face下拉列表框设定字体，在 Font Sytle设置字体风格：bold（粗体）、Italic（斜体）和 Underline

（下划线）。在 Alignment项中设置文本对齐方式。在 TextColor和 Background Color颜色调节盘中设置输入的

文本颜色和背景颜色。 

 

图 12-23  Text Overlay对话框 

单击 OK，回到全屏显示状态，屏幕上出现一个文本框，程序同时提供了一个 Text Toolbar设置窗口，其中

Talk Bubble将文本框形状设置成说话模式，Use thought style将文本框形状设置成思考模式。下面的三个滑动条

均是设置 Talk Bubble的，有大小和引出线位置设置等。单击界面中的 Options按钮，可以激活 Text Overlay设

置窗口。单击 Done保存设置。 
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图 12-24  Text Toolbar设置窗口 

l Crop & Autocrop（剪切/自动剪切） 

单击 Crop，此时鼠标指针变成交叉状，按住鼠标左键拖出一个截取范围，松开鼠标左键，移动鼠标到方框

中，鼠标指针变为剪刀状，单击鼠标左键，截取完成。 

Autocrop是程序提供的自动剪切功能，当打开的图片有单色背景时，可使用该功能快速剪切掉背景。 

12.2.3  CompuPic的其他功能 

1． 创建图片检索文件 

CompuPic提供了创建图片检索文件的功能，就是将多个图形文件浓缩在一个图形中进行显示。首先切换到

图形文件所在的文件夹，单击工具栏中的 Pict.Index按钮  ，程序给出如图 12-25所示对话框。 

 
图 12-25  创建图片检索文件对话框 

界面左边是索引图形预览窗口，右边的 Layout Option项中，Across表示横向可以排列的图片数目，Down

表示纵向可以排列的图片数目，Spacing表示图片的间隔距离。在 Page Options项中，可以设置 Page Header（索

引文件的页题头）、Page Footer（索引文件的页题尾）、Image Headers（图片的题头）、Image Footers（图片的题

尾）。设置界面基本类似，以 Page Header为例，单击 Page Header按钮，弹出 Text Editor对话框如图 12-26所

示。在 Header Text文本框中键入题头文字，可以单击下面的蓝色文字 Advanced Text Macros可以得到各种文本

宏的提示。在“Text Colors & Opacity”中设置文字的颜色和不透明度。在 Font Style项中设置字体大小和风格。 

设置完毕，单击 OK回到上一界面。在 Output Options项中提供了输出到打印机（Printer）或输出到图形文

件（Files），在此选择后者（Files），单击 Files Setup按钮，程序弹出设置界面如图 12-27所示，Saving Location

项中设置文件的默认名称和保存路径；Background项中设置背景颜色、背景图片、图片文件亮度；在 Image Size

项中设置文件大小；在 Image Format项中设置文件格式。 
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图 12-26  Text Editor对话框 

 

图 12-27  File Setup对话框 

设置完毕，单击 OK 回到图 12-26 所示界面。单击 Create，程序给出生成图形文件设置界面，如图 12-28

所示。在其中设置 Compression（压缩比）、Color Depth（颜色深度）、Format（优化方式），然后单击 OK，程

序开始在后台创建相应的索引图形文件。 

 

图 12-28  JPEG Format Options对话框 

2． 图片格式转换 

在程序界面的文件列表窗口中选择需要转换的图形文件（可以利用键盘上的 Ctrl和 Shift键一次选择多个文

件），然后单击菜单命令 Utilities → Batch Conversations → Direct Conversation，程序弹出 Direct Conversation

对话框。在 Destination Folder文本框设置转换文件的存放路径，在 Output Color Depth项中设置颜色深度，在

Output File Format项中设置转换的文件格式。单击 Convert，程序开始在后台进行转换操作。如果需要中止转换，

单击菜单命令 Utilities → Batch Conversations → Halt Current Conversations。 
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图 12-28  Direct Conversation对话框 

3． 制作墙纸 

首先在界面中的文件列表窗口中选择需要作为墙纸的图形文件，然后单击工具栏中的Wallpaper按钮  ，

程序弹出关联菜单如图 12-29所示。Tiled Wallpaper表示以平铺方式设置系统墙纸、Single Image表示以居中方

式设置墙纸，Single Image（Full Screen）表示以居中方式设置墙纸并拉伸到全屏幕。 

 

图 12-29  WallPaper关联菜单 

12.2.4  运行环境设定 

CompuPic 提供了详细的环境参数设定，由于篇幅所限，现介绍其部分常用的选项。单击菜单 Edit → 

Preferences命令，或单击工具栏中的 Preferences按钮  ，程序给出运行环境设定界面，如图 12-30。单击左

边的设置项目，在右边就可以进行相关的参数设定。 

 

图 12-30  CompuPic运行环境设定界面 

l File List：界面窗口中的列表文件显示设置。Sort Order项中提供了文件列表的排序方式，包括文件名、

扩展名、文件大小、图像大小、创建时间、以及顺序、倒序等。Enable type filtering复选框表示使用文
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件过滤器，选中后程序的文件列表窗口中将只显示程序可支持的文件。在该项中还有三个过滤设置对

象，其中Show Hidden表示显示隐藏属性文件，Show System表示显示系统属性文件，Show Unrecognized

表示显示在系统注册表中没有任何文件关联创建的文件类型。Show Recognized项中提供了在界面中可

以显示的，程序支持的文件类型。 

l Image Viewer：设置图片观察器。其中的“View images full screen（vs.Overlapped Windows）”表示使

用全屏方式显示图形。Exiting项中可以选择是否使用单击退出、退出时程序是否确认。Centering项可

以设置图形的显示位置，包括是否使用居中方式显示，以及图形尺寸大于屏幕时的显示方式（垂直居

中，水平居中）。 

l Screen Saver：制作屏幕保护。首先在文件列表窗口中选择用于制作屏保的文件（可以事先将其拷贝到

同一目录下），可以选择图形文件，也可以选择视频文件（AVI、MPG等），如果需要加入声音，也可

以同时选择音频文件。然后激活本设置界面，选择使用“Enable screen saver”复选框，在其中设置屏

保激活时间（Activate after）、图形文件或视频文件的显示时间间隔（Image delay）、声音文件的显示时

间间隔（Sound delay），Order项中选择图像或声音是否乱序显示或播放。单击界面中的 Use Selected 

Image按钮确定，程序会自动创建相应的屏保程序。 

l Slide Show：其中可以设置以 SlideShow和MaxiShow方式显示时的时间间隔，在“Ordering & sounds”

项中可以设置显示排序方式及是否播放背景音乐 Centering项可以设置图形的显示位置，包括是否使用

居中方式显示，以及图形尺寸大于屏幕时的显示方式（垂直居中，水平居中）。 

l Thumbnails：可以设置缩略图的尺寸。既可以在左边的窗口中用鼠标拖拽方框来设置缩略图的大小，

也可以在右边的 Quick Sizes项中选择用户预定义或系统预定义的模式。 

12.3  SnagIt 5.0 

 

 

 

 

 

 

   SnagIt是由 TechSmith公司推出的一款基于Win95/NT的专业抓图工具，功能强大，但操作非常简单。

它的主要特点有： 

l 捕捉对象广泛，既能抓取屏幕上的静态图像，也能抓取文本字符或动态视频输出。 

l 带有 Auto Scroll功能，抓取超过一个屏幕的图像时可以自动卷动画面抓图。 

l 自带 Snagit Studio工具，通过添加标题、注释、图形等元素使所抓的图像看起来更具专业性。 

虽然和 Capture Professional等专业抓图软件相比，SnagIt的功能还有局限的地方，比如不支持各种形状的

抓图等，不过凭着其特有的功能和简捷的操作，仍不失为一款优秀的抓图软件。 

启动 SnagIt，程序界面如图 12-31所示。 

版本 5.0 

类别 共享软件 

主页 http://www.techsmith.com/ 

功能 抓图工具 
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图 12-31  SnagIt界面的 Normal View模式 

SnagIt的界面有三种模式：Compact View、Normal View、Profile View。可以单击菜单 Options或工具栏中

的  按钮进行选择。程序第一次启动时缺省为 Normal View（如上图）。我们可以选择 Compact View，如图

12-32，这样比较节省桌面空间。 

 

图 12-32  SnagIt界面的 NormalView模式 

12.3.1  抓取静态图像 

1．截图前的选项设置 

如图 12-32所示的 SnagIt的主界面中工具栏的第二组图标，分别对应 SnagIt的三种捕捉类型： 
 ：Image Capture：抓取屏幕内容后生成图形文件。 
 ：Text Capture：抓取屏幕内容后生成文本文件。 
 ：Video Capture：抓取屏幕内容后生成视频文件。 

单击  按钮，选择抓取静态图像，然后用鼠标单击菜单 Input，选择屏幕截取的方式。下面是该菜单中
相关命令的解释。 

l Screen：截取整个屏幕。 
l Window：以窗体为最小单位截取屏幕上的各种窗体及其中的内容。 
l Active Window：截取当前活动窗体。 
l Region：截取矩形区域。 
l Fixed Region：截取特定大小的矩形区域。 
l Graphic File：从图形文件中输入图形信息。 
l Clipboard：从系统剪贴板中输入图形信息。 
l Full-screen DOS：截取 DOS屏幕。 
l Menu：截取下拉式菜单。 
本例中选择 Region，如果截取图像时想要包括鼠标光标，选中菜单命令 Input \ Include Cursor或按下工具栏

中的按钮  。如果想要自动卷动画面抓图，选中菜单命令 Input \ Auto Scroll或按下工具栏中的按钮  。 
然后单击菜单 Output，选择输出设备。下面是该菜单中相关命令的解释。 
l Printer：将截取的图像输出至打印机。 
l Clipboard：将截取的图像输出至系统剪贴板。 
l File：将截取的图像保存至文件中。 
l Send Mail：将截取的图像作为电子邮件发送给其他用户。 
l Catalog：将截取的图像保存至系统内建的目录册中。 
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l Web：将截取的图像发送到网络服务器上。 

本例中选择 File。如果想使用多个输入设备，可以选中菜单命令 Output → Multiple Outputs。如果希望预
览截取的图像，可以选中菜单命令 Output → Prewiew Window或按下菜单栏内的按钮  ，来打开预览窗口。
单击菜单 Output → Properties …，弹出如图 12-33所示对话框，可以选择输出图形文件的类型，也可以让程序
自动为输出文件设置名称。 

最后设置截图热键，单击菜单 Options → Program Preferences …，在弹出的设置界面单击 Hotkeys 标签，
界面如图 12-34所示，在 Capture Hotkey项中可以自定义截图热键。图中定义为 F12键。需要说明的是如果选
择截取 DOS屏幕（Full-screen DOS），截图热键必须是键盘上的 Print Screen键（无须设置）。 

 
图 12-33  Output Properties对话框 

 

图 12-34  Hotkeys标签 

另外单击 Program Options标签，在 General Options项中，Hide SnagIt before capture表示截图前隐藏 SnagIt

界面窗口，一般选中该项。 

2．截取图像 

以上各项设置完毕，运行要进行截图操作的应用程序。当屏幕上出现想要保存的画面时，立即按下键盘上

的截图热键（本例为 F12 键），屏幕上出现一个手形的十字光标，按下鼠标左键选取屏幕上相应的区域，在光

标的右下角有一个图框说明当前选取得区域的大小，选定后松开鼠标左键即可。如果前面选择了预览图像，截

取的图像被保存在预览窗口（SnagIt Capture Preview）中，如图 12-35所示。 
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图 12-35  SnagIt预览窗口 

3．处理图像 

如果不想额外处理截取的图像，可以跳过该节。 

SnagIt 的预览窗口不仅是一个图像观看窗口，而且是具有大量图像处理命令的处理窗口，命令大多集中在

Image菜单和 Colors菜单中，每个命令的操作都比较简单，下面分别予以介绍。 

Image菜单如图 12-36所示，有关命令如下： 

 

图 12-1-6  Image菜单 

l Flip：对图像进行垂直方向的翻转操作。 

l Reverse：对图像进行水平方向的翻转操作。 

l Shear：将图像进行水平方向的倾斜变化。 

l Resolution：修改图像的分辨率。 

l Rotate：对图像进行旋转操作，旋转方向按逆时针进行。 

l Scale：按比例进行图像的放大或缩小。建议选上 Smooth Scaling，会使图像缩放时比较平滑。 

l Effects：用特殊效果对图像进行修饰。单击此命令，弹出级联菜单，其中常用命令有：Mosaic将图像

的内容网格化模糊处理（马赛克化）；Average将图像每个色素附近的色彩进行均化处理，整个图像有

点像聚焦不准的感觉；Median 另一种均化效果，整个图像有点水彩画的感觉；Sharpen 将图像进行柔

化和锐化处理；Add Noise在图像上杂乱地添加一些指定类型的色彩；Emboss将图像浮雕化。 

Colors菜单如图 12-37所示，有关命令如下： 

 

图 12-37  Colors菜单 
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l Halftone：将图像变为半色调。 

l GrayScale：将图像变为灰度图像。 

l Color Resolution：设置图像色彩分辨率。 

l Invert：将图像颜色进行翻转处理。 

l Brightness：调节图像的明亮度。 

l Contrast：调节图像的对比度。 

l Hue：调节图像的色调。 

l Saturation：调节图像色彩饱和度。 

l Gamma Correction：调节图像伽玛值。 

以上是图像处理时的常用命令。如果只想保留图像中的一部分，可以移动十字光标，按住鼠标左键选择合

适的范围，然后单击工具栏中的“剪切”按钮  ，即可只保留选择范围内的图形。如果不想破坏图像的完整

性，可以选择合适的范围后，单击工具栏中的“复制”按钮  ，然后单击“保存”按钮  ，将选择范围

内的图像保存到硬盘的文件中。 

4．保存结果 

如果对预览结果满意，单击工具栏中的 Finish Output 按钮  ，程序将结果送到预先设定的输出设备并

关闭预览窗口；否则单击“Cancel Output”按钮  ，重新开始新的截取操作。 

12.3.2  截取视频输出 

按下  按钮，选择抓取动态视频信息。本例中将 Input设置为Window、Output设置为 File、Hotkey为

F12。如果想同时记录麦克中的声音，按下  按钮。如果想设置输出 AVI文件的参数，单击菜单 Output → 

Properties …，弹出对话框如图 12-38，取消 Auto configure AVI options复选框后即可设置，不过一般缺省即可。

单击 Audio Setup…按钮可以设置音频格式。 

设置完毕，按下捕捉热键 F12，屏幕中出现一个随手形光标移动的红色方框，将光标移动到相应的窗口内

单击鼠标左键即可选中该截取窗口，随后弹出对话框如图 12-39所示。单击 Start，程序开始捕捉。 

    

图 12-38  Output Properties对话框                 图 12-39  视频捕捉对话框 

当再次按下捕捉热键时，该对话框重新弹出，如果想结束视频捕捉，单击 Stop，程序弹出预览窗口，如图

12-40所示，在工具栏内提供了一系列播放按钮，单击 play按钮  ，程序调用系统中和 AVI格式相关联的播

放程序（如 QuickTime）进行播放。如果对预览结果满意，单击  按钮，程序将结果送到预先设定的输出设

备并关闭预览窗口。 
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图 12-40  视频捕捉预览窗口 

12.3.3  截取文本信息 

单击  按钮，选择抓取文本信息。本例中将 Input设置为 Region、Output设置为 File、Hotkey仍为 F12。

按下捕捉热键，屏幕上出现一个手形的十字光标，按下鼠标左键选取屏幕上相应的区域，选定后松开鼠标左键

即可。如果前面选择了预览图像，截取的图像被保存在预览窗口中，如图 12-41 所示。如果对预览结果满意，

可以进行保存。 

 

图 12-41  截取文本信息预览窗口 

12.3.4  SnagIt自带的两个工具 

1．Catalog Browser（目录册浏览器） 

SnagIt 内置了一个称为“Catalog”的功能，可以将输出结果保存在一个称为 Catalog 的目录中，方法是在

Output菜单中选择输出方式为 Catalog，或者使用Multiple outputs功能，同时使用多个输出设备并选上 Catalog

方式，当完成捕捉工作后，系统自动将捕捉结果取一个默认的名字保存在 Catalog（目录册）中，并弹出 Catalog 

Browser 窗口，如图 12-42 所示，在此窗口中可以进行图像查找、观看等操作。也可以在 SnagIt 的主界面上直

接单击按钮  调用 Catalog Browser。 
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图 12-42  Catalog Browser窗口 

2．SnagIt Studio 

SnagIt自带了一个称为“Snagit Studio”的程序，它通过对截取的图像添加标题、注释、图形等元素使所抓

的图像看起来更具专业性。在 SnagIt的主界面上单击  按钮，可以调用 SnagIt Studio，界面如图 12-43所示。 

 

图 12-43  SnagIt Studio窗口 

程序整个界面比较简单，左边的 Catalogue箱（图形元素目录箱）中包括各种用于修饰的图形元素，如 Stamps

（标签）、Shapes（图形）、Pointers（指针）、Arrows（箭头）等，使用时首先单击其目录将其打开，然后用鼠

标将选定的图形元素拖曳到工作区的某一位置即可。对于右边的工具箱，用鼠标左键选定某一工具，然后用鼠

标在工作区中拖拉出其大小和形状即可。对于添加的各种元素，还可以修改其属性，方法是在选定的元素上单

击右键，在弹出的关联菜单中选择 Object Properties，程序给出类似图 12-44所示的属性对话框。（不同元素的

属性对话框稍有不同）。 
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图 12-44  属性对话框 

工具栏中虽然项目较多，但使用比较简单，这里需要说明的是有关文件输入输出的几个命令按钮。 

SnagIt Studio可以处理两种文件：一般的图形文件和 SnagIt Studio专有文件（.ssd）。这两种文件的区别是

图形文件中添加的元素已经和原先的图像合为一体，不能单独修改，而.ssd 文件则可以任意修改其中的添加元

素的属性。如果想修改某一图形文件中的添加元素，可以修改其相应的 ssd文件，然后再输出成图形文件即可。 

下面介绍相关的几个按钮： 

l  ：新建一个 ssd文件。 

l  ：打开一个 ssd文件。 

l  ：输入一个图形文件。 

l  ：存储一个 ssd文件。 

l  ：输出一个图形文件。 

由于篇幅所限，剩下的部分按钮不再介绍。 

12.4  HyperSnap-DX Pro 

 

 

 

 

 

 

 HyperSnap-DX是目前最流行的基于Win95/NT的专业屏幕抓图工具。该软件的特点是界面简单明了，

将多种功能集中统一在一个窗口中。该工具可以轻松截取基于微软的 DirectX、3dfx的 Voodoo I/II，以及最新的

DVD驱动的屏幕图形。同时，它也可以很好的截取使用 YUV方式加速的视频图形静止画面，功能很强大。 

启动 HyperSnap-DX Pro，程序界面如图 12-45所示。 

版本 3.62 

类别 共享软件 

主页 http://www.hyperionics.com/ 

功能 抓图工具 
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图 12-45  HyperSnap-DX Pro主界面 

12.4.1  截取屏幕图形 

1．定义热键 

程序对所有的截图方式都定义了快捷键，用户可以使用缺省设定，可以根据自己的习惯对所有的截图热键

进行重定义。单击菜单 Options → Configure Hot Keys，程序弹出 HyperSnap Hot Keys对话框，如图 12-46。 

 

图 12-46  HyperSnap Hot Keys对话框 

如果需要修改某个快捷键定义，例如 Capture Region，可以单击相应的按钮，程序会给出一个 Select Hot Key

对话框，如图 12-47。 

 

图 12-47  Select Hot Key对话框 
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按下新的键盘定义 F5，程序在文本框显示 F5，单击 OK按钮确定。 

2．截图方式 

HyperSnap提供了多种截图方式，可以选择菜单 Capture中的截图命令，也可以直接按相应的快捷键。Capture

菜单如图 12-48所示 

 

图 12-48  Capture菜单 

下面介绍该菜单中的一些重要命令： 

l Full Screen 

截取全屏幕的所有内容。系统默认的快捷键为 Ctrl＋Shift＋F。执行命令后程序自动截完图后弹出主窗口显

示截取的内容。 

l Virtual Desktop 

截取屏幕上的所有内容，包括系统中有多个显示器的情况。系统默认的快捷键为 Ctrl＋Shift＋V。 

l Window 

以窗体为最小单位来截取屏幕上的各种窗体及其中的内容，如可以截取屏幕上的按钮、状态条、工具栏、

工作窗口、滚动条等。系统默认的快捷键为 Ctrl＋Shift＋W。在主界面工具栏中有一个对应的命令按钮  。

执行命令后屏幕上出现一个随鼠标指针移动的粗方框，移动该方框到需要截取的位置按下鼠标左键即可，系统

弹出主窗口显示截取的内容。 

在该方式下有一个卷屏功能。当一个窗口中的内容太多而在窗口中不能完全显示出来时，选中 Capure菜单

中的 Auto Scroll Window功能，截取该窗口时可以将自动卷动画面截取全部内容。但只支持上下滚动，不支持

左右滚动。 

l Active Window 

截取当前正在前台显示的应用程序窗口。系统默认的快捷键为 Ctrl＋Shift＋A。 

l Active Window without Frame 

截取当前正在前台显示的应用程序窗口，但不包括该窗口的活动标题栏（最顶端的那一行）。系统默认的快

捷键为 Ctrl＋Shift＋C。 

l Region 

截取屏幕上任意选定的矩形区域。系统默认的快捷键为 Ctrl＋Shift＋R。在主界面工具栏中有一个对应的命

令按钮  。执行命令后在屏幕上出现一个随鼠标移动的十字光标线，如图 12-49。在要截取的区域左上角点

击鼠标左键，十字光标变成一个矩形区域。拖动方框选取合适的区域，然后再点击鼠标左键截图即可完成。 
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图 12-49  使用 Region方式抓图 

在图中右下角有一个文本框，里面是对 Region方式的一些帮助信息。当移动鼠标时它会自动变化位置以避

开十字光标线，如果需要取消该文本框的显示，可以按下键盘上的 F1键或取消 Options 菜单中的 Hide Help in 

Region Capture 选项。另外，当用十字光标线选择截取范围时，在矩形方框中会显示两个动态数字提示当前所

截图像的大小。 

l Pan last Region 

选择该命令屏幕会出现一个随鼠标光标移动的固定的矩形，其尺寸与上一次截取操作的矩形相同。缺省的

鼠标光标处于矩形的左上角，可以按键盘上的 Tab键改变鼠标光标的位置。 

l Repeat last capture 

截取和上一次操作相同的屏幕区域。 

l Enable Special Capture（DirectX、Glide、DVD） 

该命令可以实现截取基于 DirectX、Glide、DVD的屏幕图形，但该方式只能截取全屏幕的图像，不能截取

某个窗体或屏幕上的一部分。如果想要得到屏幕上的一部分，可以在截取完成后进行图像处理。 

单击该命令，程序给出 DirectX/Direct3D and Glide Capture对话框，界面如图 12-50。首先在最下方的三个

单选按钮中选择 3D引擎。如果用户计算机中的图形加速卡为 Voodoo1，选择第二个选项；如果为 Voodoo2，选

择第三个选项；否则选择第一个选项，同时选中上面两个和 DirectX有关的两个复选框。设置完毕，单击 OK。 

现在就可以截取 3D游戏或 DVD中的画面。此功能的快捷键为 Scroll Lock，且不能自定义。启动需要截图

的应用程序或游戏，当需要截取画面时 ，按下“croll Lock，如果此时能够使用 Alt＋Tab 组合键切换到

HyperSnap-DX 主窗口，可以看到程序已经截取了相应的图像。如果游戏中不能切换，可以利用后面介绍的程

序的 Quick Save功能。 

l Include Cursor Image 

该项表示截取图像时包括鼠标的图形。 

l Restore After Capture 

该项表示截取图形后自动显示 HyperSnap-DX主窗口。 
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图 12-50  DirectX/Direct3D and Glide Capture对话框 

12.4.2  编辑截取图形 

在截取屏幕上的图像后，HyperSnap-DX 默认方式会自动在主程序窗口显示所截得的图像。程序提供了丰

富的图像编辑和处理功能，这些命令主要集中在主界面上的 Edit菜单和 Image菜单中，许多命令在界面的工具

栏内也有相应的图标。以下介绍一些常用的编辑处理命令。 

1．Edit菜单 

单击主界面上的 Edit菜单，如图 12-50所示。 

 

图 12-50  Edit菜单 

l Copy 

将程序主窗口中的图像拷贝到系统剪贴板上，可供其它程序使用。快捷键为 Ctrl＋C。该命令在主界面工具

栏中对应的按钮为  。 

l Paste 

将剪贴板中的图形粘贴到 HyperSnap-DX主窗口中。快捷键为 Ctrl＋V。该命令在主界面工具栏中对应的按

钮为  。 

l Clear 

清除程序主窗口中的图像。快捷键为“Ctrl＋X”。该命令在主界面工具栏中对应的按钮为  。 

 

l Copy Format 

向系统剪贴板拷贝图像时，奖图像转换成某种位图格式。单击该命令，弹出相应对话框如图 12-51。复选

框 Auto select color format best for current display mode表示自动选择最适合的颜色。取消该复选框，用户可以自

行选择单色、13色、256色或 24位真彩。 
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图 12-51  剪贴板复制图像对话框 

l Undo 

取消上一操作。该命令在主界面工具栏中对应的按钮为  。 

2．Image菜单 

单击主界面上的 Image菜单，如图 12-52所示。 

 

图 12-52  Image菜单 

l Crop 

剪切屏幕上任意矩形区域。快捷键为 Ctrl＋R。该命令在主界面工具栏中的快捷按钮为  。执行该命令

后在屏幕上出现一个随鼠标移动的十字光标线，在要截取的区域左上角点击鼠标左键，十字光标变成一个矩形

区域。拖动方框选取合适的区域，然后再点击鼠标左键即可将该区域外的图像剪切掉。 

l Crop Out Rectangle 

保留选择范围以外的图像，与 Crop正相反。该命令在主界面工具栏中的快捷按钮为  。 

l Select Background Color 

设置执行完 Crop Out Rectangle命令后，在屏幕上留下的空白区域中所填充的颜色。 

l Gamma Correction 

校正图像的伽玛值。 

l Black and White Only 

将程序主窗口中的图像转换成黑白图像。单击该命令后弹出图像黑白度设置对话框，如图 12-53。默认数

值为 50，设置完毕单击 Apply。 

l Invert Black and White 

将图像中的黑白颜色对调。 

l Change Image Resolution 

改变图像的分辨率（将该图像保存到文件中或打印输出时有效）。 

l Resize 

重新调整图像大小。单击该命令弹出相应对话框如图 12-54。可以移动上面的滑动条来缩放图像，也可以

在Width和 Height文本框中直接设置宽度和高度。Keep Aspect表示缩放时保持图像的纵横比。Interpolate表示

缩放时对图像进行插值运算。设置完毕，单击 Done即可。单击 Revert可以撤销刚才所做的改变。 
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图 12-53  图像黑白度设置对话框                  图 12-54  Resize对话框 

l Color Resolution 

改变图像的色彩分辨率。单击该命令弹出相应对话框如图 12-55。在 Bits Per Pixel项中设置色彩分辨率。

在右边的 Dithering Method项中设置色彩优化处理方法。在 Palette项中可以选择调色板的类型：Optimized（优

化过的调色板）、Std.Windows（标准调色板）、Netscape的调色板、Black & White（黑白调色板）。 

 

图 12-55  Color Resolution对话框 

l Gray Scale 

将当前图像转换为灰度图像。 

 

l Halftone 

将当前图像转换为半色调图像。 

l Mirror Image 

对当前图像进行翻转操作。包括 Horizontal Mirror（水平翻转）和 Vertical Mirro（垂直翻转。 

l Rotate Image 

对当前图像进行旋转操作。单击该命令，程序给出 Rotate Image对话框，如图 14-56所示。在其中可以设

置旋转角度，单击 Done即可确认。 

 

图 12-56  Rotate Image对话框 

12.4.3  保存截取图形 

如果想把截取的图形保存到磁盘中，单击工具栏上的 Save按钮  ，程序给出如图的 Save as对话框。

在“保存类型”下拉列表框中选择保存的文件格式，在“文件名”文本框中键入保存文件名，在上面的文件列

表框中选择保存的文件夹，单击“保存”即可。 
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图 12-57  Save as对话框 

除了把图像保存到磁盘上，还可以在 HyperSnap-DX 窗口中直接将图像送到打印机打印出来。用鼠标单击

工具栏中的 Page Setup按钮  ，设置页面格式，然后单击 Print按钮  ，程序将截取的图像打印出来。 

12.4.4  Quick功能 

HyperSnap-DX提供了一组 Quick功能，可以在截图的同时由系统自动替用户完成相应的工作。该组命令集
中在主界面的菜单 Capture中。 

l Quick Crop & Scale（快速剪切） 
单击该命令，程序给出如图 12-58所示对话框。Crop Image项表示截取指定的屏幕范围，选中该复选框，

在 Left和 Top中设置指定范围的左上角坐标，“Width中设置宽度，在 Height设置高度。也可以单击 Digitize from 
Image直接在图像中定位。当被截取对象大于范围时，程序会自动剪切图形。Scale Image表示设置截取对象的
大小，选中该复选框，在Width和 Height中设置宽度和高度，in pixel表示以象素为单位。单击 OK回到主界面。 

 

图 12-58  Quick Crop & Scale对话框 

l Quick Copy（快速复制） 

该选项表示截取图形时，程序自动将截取的图形复制到系统剪贴板中，以供其它程序调用。 

l Quick Print（快速打印） 

该选项表示截取图形时，程序自动将截取的图形送到打印机打印输出。 

l Quick Save（快速保存） 

该选项表示在截取图形时，自动将截取的图形保存到磁盘上。单击该命令，程序给出如图 12-59 所示对话

框。 

 

图 12-59  Quick Save对话框 
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Prompt for name on each capture表示每当截取一个图像时弹出对话框，由用户自己定义保存文件名。如果

选择自动保存，单击 Change按钮可以设置保存文件的文件夹和文件名称。单击 OK回到主界面。 
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本章介绍了目前最流行的计算机防病毒软件，其中

包括目前互联网上最流行的 McAfee VirusScan、世界范

围内最热卖的 Norton AntiVirus、趋势科技的 PC-cillin 

2000和国内最著名的 KV300和 Kill98。 

在以上推荐的工具中，McAfee VirusScan和 Norton   

AntiVirus 都是世界范围内最著名的杀毒工具，查杀病毒

非常准确。KV300、Kill 98和 PC-cillin是国内非常著名

的杀毒品牌，它们提供了中文界面，非常容易上手。值

得一提的是 KV300 对于修复被 CIH 破坏的硬盘非常有

效，笔者的一块硬盘就是用 KV300修复的。Kill 98是由

公安部下属的金辰软件开发的，由于近来又和美国 CA

公司合作，建立了全球范围的病毒检测网络，是目前国

内最权威的杀毒工具。 

 
 

第十三章  病毒克星 

 

·＝＝ 本章导读 ＝＝ 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

13.1  Norton AntiVirus 2000 

 

 

 

 

 

 

 Norton AntiVirus for Windows 95（NAV）是由 Symantec公司推出的非常著名的查杀病毒软件。NAV

采用了一项称为“Bloodhound（侦探）”的新技术，它基于探索式检测方法，能够自动判断出病毒可能做崇的那

些操作模式（如试图修改硬盘引导区纪录等），大大提高了对未知病毒的判断能力。NAV 提供了病毒在线监测

（Auto Protect）功能，可以监测所有运行的应用程序，如果发现有感染病毒或病毒发作的特征，即中断程序的

运行并建议用户进行查杀。防病毒免疫功能也是程序提供的一项很好的功能，可以防止运行感染病毒但又暂时

不能杀毒的文件，避免系统遭受病毒感染。 

下面介绍程序的主要功能。 

版本 6.0 

类别 商业软件 

主页 http://www.symantec.com/ 

功能 病毒检测和清除 
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13.1.1  使用 NAV 检测/杀病毒 

 启动 Norton AntiVirus，程序首先对系统内存进行检测，若没有发现病毒，给出如图 13-1所示的界

面。 

 

图 13-1  NAV程序主界面 

 单击 Scan for Viruses按钮，程序界面变成如图 13-2所示，可在其中选择扫描对象，共有五个选项：

Scan all hard disks for viruses（检测所有硬盘）、Scan all removable drives (floppies, CD, etc.) for viruses（检测所有

活动磁盘，如软盘、光驱等）、Scan a floppy disk for viruses（检测软盘驱动器）、Scan one or more drives or folders 

for viruses（检测一个或多个驱动器或文件夹）和 Scan one or more files for viruses（检测一个或多个文件）。本例

中选择 Scan one or more drives or folders for viruses。 

 

图 13-2  选择扫描对象 

 单击 Run scan now按钮，出现文件夹列表窗口，如图 13-3所示，选择需要检测的驱动器或文件夹。 



常用工具软件大全 

 

311 

 
图 13-3  选择扫描文件夹 

 单击界面中的 Scan按钮，程序开始扫描病毒，出现进程对话框如图 13-4所示，如果没有检测到病
毒，检测完成以后，程序给出一个 Scan Results检测结果对话框，单击该界面中的 Close按钮退出并回到程序主
界面。 

 如果发现病毒，出现 Repair Wizard（修复向导）对话框，如图 13-5所示，上面列出了发现病毒的
名称。如果想让程序自动清除病毒，修复文件，选择 Automatic，单击“下一步”继续。 

 

图 13-4  显示扫描进度 

 

图 13-5  修复文件向导之一 
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 程序给出感染病毒的文件列表，单击“下一步”继续。 
 程序自动清除文件中的病毒，完成之后给出结果对话框，单击 Finish完成。 

程序安装完成以后，会自动在系统的右键菜单中加入 Scan with Norton AntiVirus 命令，所以我们可以在

Windows 资源浏览器窗口中直接用鼠标右键单击需进行检测的对象，在弹出的菜单中选择 Scan with Norton 

AntiVirus，即可进行病毒检测。 

13.1.2  在线病毒监测 

在线监测功能是 NAV 提供的一项非常严密的在线病毒防御措施，程序可对系统磁盘访问、文件操作、文

件下载等行为进行监测，发现可疑情况及时提供信息。这项功能在程序安装时默认随系统自动启动，系统任务

栏会加入一个图标  。用鼠标右键单击该图标，程序给出如图 13-6 所示的菜单。单击其中 Disable 

Auto-Protect，可以关闭在线监测功能，图标变成  。此时右键关联菜单中的第二项变成 Enable Auto-Protect，

我们可以随时控制在线监测功能的打开和关闭。 

 

图 13-6  Tray图标的右键关联菜单 

NAV在线监测功能虽然能够提高系统的安全性，但由于监测内存和应用程序的运行或多或少导致系统运行

系统速度的降低，而且有可能因为程序的兼容性问题导致系统的当机。所以如果不是经常拷贝数据时，建议关

闭此项功能，而在需要拷贝外来数据或运行来历不明的程序时，才打开这项功能。 

13.1.3  使用 NAV 计划任务功能  

NAV提供了自动定时监测功能，在用户预先设定的时间自动运行，并对相应的对象进行检测，操作过程完

全不用用户干预。实际上除了定时检测病毒功能外，NAV计划任务功能还包括定时进行病毒代码升级操作、定

时显示提示信息、自动运行系统中的任意应用程序，这对于用户来说是很方便的。 

下面以设置 NAV定时检测为例来说明具体设置步骤。 
 单击 NAV程序界面中的 Scheduling按钮，如图 13-7所示。 

 

图 13-7  NAV计划任务界面 

 单击计划任务栏下方的“New Event…”按钮，出现“计划任务向导”界面，如图 13-8所示。 
 单击“下一步”，出现向导界面如图 13-9所示。缺省计划任务为病毒扫描。 
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图 13-8  计划任务向导之一 

 

图 13-9  计划任务向导之二 

 单击“下一步”，出现向导界面如图 13-10所示。在检测对象列表框中只有一项 Scan all hard disks for 

viruses（检测所有硬盘），单击“下一步”。 

 

图 13-10  计划任务向导之三 

 在图 13-11所示向导界面中输入任务名称，单击“下一步”。 
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图 13-11  计划任务向导之四 

 在图 13-12所示向导界面中选择检测频率，例如Weekly，单击“下一步”。 

 

图 13-12  计划任务向导之五 

 在图 13-13所示向导界面中设定检测时间。单击“下一步”。 

 

图 13-13  计划任务向导之六 

 继续单击“下一步”，在弹出的向导界面中单击“完成”，建立的检测任务如图 13-14所示。 
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图 13-14  新建的计划任务 

13.1.4  命令行病毒检测 

当 Windows 系统染毒时，或当病毒发作时破坏了Windows时，用户可以在 DOS环境下利用 NAV查杀病

毒。用户可以用一张干净的系统盘启动计算机进入 DOS，然后进入 Norton AntiVirus 目录，运行该目录下的

NAVDX.exe程序。 

命令行 NAVDX /A /REPAIR表示扫描所有本地驱动器（不包括软驱）并清除病毒。 

13.1.5  系统急救盘的制作 

NAV提供了系统急救盘的制作功能。在程序界面中单击 Rescue按钮，程序给出如图 13-15所示的对话框。 

 

图 13-15  制作急救盘 

首先选择好备份的路径，通常选择软盘（在硬盘上备份的意义不大），共需要五张 1.44Mb的软盘。在软驱

中插入第一张软盘后，单击 Creat 按钮，备份开始。当第一张软盘写满时，程序回提示用户换盘，按程序的指

示做，直至备份工作结束。 

13.1.6  运行环境设定 

单击程序界面中的 Options按钮，运行环境设置界面如图 13-16所示。 
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图 13-16  运行环境设置界面 

对于图 13-16中各项设置简略介绍如下： 

l Manual Scans：在 Items to scan in addtion to files设置程序可以扫描的对象，包括Memory（内

存）、Master boot record（主引导纪录）、Boot record（根纪录）。How to respond when a virus is 

found项中提供当发现病毒时的处理方法，程序默认为向用户询问操作。File types to scan项

提供了扫描文件设置，可以选择 All files（扫描所有文件）或 Program files and documents only

（只扫描可执行文件和文档），如果选择后者，可以单击 Selected extentions按钮，自定义扫

描文件类型。复选框 Scan within compressed files表示扫描压缩文件。 

l Auto-protect：Scan files when windows starts up表示当系统启动时自动载入在线检测功能。Scan 

files when they are以选择程序监测的文件操作，包括 Run or Opened（运行或打开）、Created or 

Downloaded（创建或下载）。How to respond when a virus is found和 File types to scan项与前

面相同。在 Other options项中，可以选择是否在系统任务栏中显示 Auto-protect图标。 

l Email protection：选择是否对电子邮件进行监测。 

l Startup Scan：选择是否启动时检测系统文件。 

l Alerts：设置当程序检测到病毒时给出的提示信息。 

l Activity log：设置生成的病毒扫描日志文件。 

l Exclusions：扫描过程中可以排除的扫描对象。 

l General：Backups of repaired files表示当程序清除文件中的病毒时，先对该文件进行备份。

Password  protection可以添加口令。logo screen选择当 NAV启动时是否显示其徽标。 

13.2  McAfee VirusScan 5.0 
 

 

 

 

 

 

 McAfee VirusScan for Windows 95 是由美国著名的反病毒公司McAfee Associates推出的杀毒工具，是

世界范围内极为权威的杀毒工具之一。该工具查杀病毒范围广泛，准确率高。它采用全新设计病毒检测过滤算

法，可全面检测机器的内存、I/O控制器，全面杀除基于Word和 Eexcel的宏病毒、系统的引导扇区及磁盘分配

表，可以最大限度的防止病毒的入侵。该工具除了提供在线病毒检测、压缩包文件扫描、以计划任务方式扫描

病毒等功能外，还强调了对 Internet的支持，包括 E-mail附件病毒扫描、软件下载扫描、Internet病毒过滤等。 

Virus Scan可直接对压缩包中的文件扫描，而不需打开压缩包，程序可以支持的压缩包类型有 ARC、ARJ、、

版本 5.02 

类别 / 

功能 查杀病毒 

主页 http://www. antivirus.com/ 
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CAB、LZEXELHA/LZH、TD0、PKLite和 ZIP，非常丰富。因为现在许多病毒都是隐藏在压缩包中并开始扩散

的，而来自 Internet 的软件都是经过打包后发送的，所以如果你经常下载文件，使用这个选项是必须的，这样

可以最大限度防止病毒入侵系统。 

VirusScan还提供了 ScreenSaver Scan功能，可以在运行屏幕保护程序时检测硬盘中的文件，既保证安全，

又节省用户时间。 

程序每月发布最新病毒扫描升级文件，有条件的用户可以直接下载，升级，以对付不断涌现的新病毒。 

13.2.1  扫描/清除病毒 

 从开始菜单McAfee VirusScan程序组中启动McAfee VirusScan Central程序，程序给出如图 13-17

所示的界面，该界面称为控制台。 

 
图 13-17  VirusScan控制台界面 

 单击程序左边的 Scan按钮，程序界面变成如图 13-18所示。在Where & What列表框中选择需要扫

描的驱动器和文件夹。 

 

图 13-18  选择驱动器/文件夹 

 单击界面左下角的 Settings按钮，出现 Scan Settings对话框，如图 13-19所示。 
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图 13-19  扫描设置对话框 

其中有三个标签项。在 Detection标签项中，What to Scan项可以设置扫描对象。Scan Memory表示扫描内

存，Scan boot sectors表示扫描系统引导扇区，Compressed files表示扫描压缩文件，All files表示扫描所有文件，

Program files only表示只扫描特定的文件类型，程序默认包括可执行文件、动态链接库文件、系统文件、虚拟

设备文件、Office 文档等等，由于病毒通常隐藏在这些文件类型中，使用这个选项可以提高扫描速度，所以一

般病毒维护使用它即可，而当程序发现系统中有病毒存在时，再选择 All files，对系统进行彻底扫描。Program 

Files only复选框还提供了由用户添加可扫描的文件类型的功能，单击该复选框右边的 Extensions按钮，程序会

给出 Program Files Extensions对话框，单击其中的 Add按钮，并在关联的 Extensionto add文本框中设置即可。

单击对话框右下角的 Heuristics按钮，程序给出对话框如图 13-20所示。Enable heuristics scanning表示激活启发

式扫描功能，启发式扫描就是对一个应用程序（Program）或一个 Office宏（macro）的特征进行分析，判断该

程序或宏是一个已知病毒的变种的可能性，从而可以有效地预防新病毒。Remove all macros when cleaning 

infected documents表示清除文档中的宏，不论该宏是否是潜在的病毒。 

 

图 13-20  启发式扫描设置 

在 Action标签项中，在When virus is found下拉文本框中选择发现病毒时的处理方式，其中共有五个选项。 

l Prompt user for action：表示发现病毒时提示用户选择处理方式。 

l Quarantine：对染毒文件采取免疫处理，就是将无法杀毒的文件或无法确定是否含毒的文件暂时转移到

特定目录中，待以后进行处理。 

l Clean infected files automatically：自动清除文件中的病毒。 

l Delete infected files automatically：自动删除染毒文件。 

l Continue scanning：不作任何处理，继续扫描。 

为了安全起见，建议用户选择 Promp user action。 
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在 Exclusion标签项中，用户可以设置不进行扫描的文件或文件夹。 

 设置完毕，单击确定，回到主界面。单击界面中的 Scan Now按钮，程序开始扫描。如果程序发现

系统的内存或主引导纪录中有病毒存在，此时应该单击 Stop，停止病毒扫描，然后使用干净的系统引导盘重新

引导系统启动进入 DOS环境，进入 VirusScan程序所在的文件夹，并运行该文件夹中的 Scan.exe来清除病毒除。 

如果系统内存或主引导纪录中没有发现病毒，程序开始扫描指定驱动器或文件夹，如果发现病毒，出现对

话框如图 13-21所示。 

其中 Continue 表示继续进行检测，Stop 表示停止检测并返回程序界面，Clean表示清除病毒，Delete 表示

删除染毒文件，Move Files to表示将染毒文件移到指定路径下。在此建议首先选择 Clean命令清除病毒，如果

程序不能清除该病毒，可选择停止检测，或选择删除该文件，并使用备份文件恢复。 

 

 

图 13-21  发现病毒对话框 

 扫描结束，程序回到主界面，并给出扫描和处理结果，如图 13-22所示。单击界面中的 Home按钮 

 ，可以回到上一层界面。 

 

图 13-22  显示扫描处理结果 

另外，VirusScan安装到系统之后会在系统鼠标右键菜单中添加 Scan for Viruses一项，所以进行病毒检测/

杀毒的另一种简单方法是：使用鼠标右键单击需进行病毒检测的对象图标，从关联的右键菜单中选择 Scanfor 

Viruses命令，程序给出如图 13-23所示对话框，具体设置和操作与前面相同。 
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图 13-23  扫描病毒对话框 

13.2.2  在线病毒检测 

McAfee Vshield是程序提供的在线检测工具，即所谓的病毒防火墙，该功能会随系统启动自动加载，标志

是在系统任务条中添加一个盾牌装的 Tray图标。如图 13-24。该项功能提供文件监测、E-Mail监测、下载监测、

Internet过滤等监测功能，非常全面。 

 

图 13-24  Vshield的 Tray图标 

用户也可以对 Vshield进行设置。步骤如下： 

 单击程序主界面右上角的 Options菜单，选择其中的 Vshield Wizard命令，程序给出欢迎界面，单

击 Next按钮，向导界面变成如图 13-25。程序给出是否可在系统后台自动扫描系统病毒，选择 Yes。 

 
图 13-25  防火墙设置向导之二 

 单击“下一步”，程序给出是否即时扫描邮件附件设置和可扫描的邮件客户程序设置，一般应选择 

Internet e-mail client（电子邮件客户）复选框，如果用户使用 Outlook 97/98或者是Microsoft Exchange，应选择

MAPI compliant e-mail client复选框。 
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图 13-26  防火墙设置向导之三 

 单击 Next按钮，程序给出是否扫描下载文件设置，如果用户经常下载文件，选择使用该功能。 

 

图 13-27  防火墙设置向导之四 

 单击 Next按钮，程序给出是否监测 Internet浏览过程中有害的 Java & ActiveX程序设置，如果经常

上网又担心安全性，选择该项功能。 

 

图 13-28  防火墙设置向导之五 

 切换到下一界面，单击 Finish按钮，程序弹出如图 13-29所示设置界面。界面中给出了系统监测、
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E-Mail监测、下载监测、Internet过滤等监测功能的具体设置，这里不再介绍。 

 

图 13-29  防火墙设置界面 

13.2.3  免疫文件管理 

单击主界面中的 Quarantine按钮，程序给出如图 13-30所示界面。单击 Add按钮可以添加免疫文件，单击

Clean按钮可以清除选定的免疫文件中的病毒，单击 Restore按钮可以将清除病毒后的免疫文件恢复到原来的位

置中，如果无法清除文件中的病毒，可以单击 Delete按钮删除选定文件。 

 

图 13-30  免疫文件管理 

13.2.4  计划病毒扫描 

使用计划任务方式进行定期自动病毒扫描是一项非常方便的功能，这样你可以设置在系统空闲时开始扫描

操作，而不用一直守在机器旁边。 

单击程序主界面左边的 Schedule按钮，程序给出如图 13-31所示的界面。程序已经给出了四个默认的扫毒

日程安排，其中两个比较常用的日程是：Scan My Computer（扫描所有磁盘），ScanDrive C（扫描 C:盘），但是

并没有激活时间设置。 
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图 13-31  扫描日程管理 

左边的四个按钮可以对操作日程进行管理。下面我们新建一个计划任务。 

 单击界面中的 New Task按钮，程序给出如图所示对话框。 

 

图 13-32  设置计划任务属性 

 在对话框中的 Description文本框中设置该任务的描述信息。单击界面中的 Configure按钮，程序给

出如下图 13-33所示的界面。 
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图 13-33  设置病毒扫描参数 

对话框中共有六个标签项，其中常用的有 Detection、Action和 Exclusion三个标签。在 Detection标签项中，

在中间的列表框中设置扫描对象，此处我们设置成 C盘，在What to scan项中，Scan Memory表示扫描内存、

Scan boot sectors扫描根区、Compressed files扫描压缩文件、All files扫描所有文件、Program files only只扫描

程序文件、Start automatically表示自动开始扫描。 

在 Action标签项中可以设置程序检测到病毒时采取的处理方式。在 Exclusion 标签项中可以设置不检测的

文件/文件夹。设置完毕，单击“确定”，回到如图 13-32所示的上一级界面。 

 单击界面中的 Schedule 标签，回到程序主设置界面，然后切换到 Schedule 标签项，界面形式如图

13-34所示。 

 

图 13-34  设置计划任务时间安排 

选中 Enable复选框，在 Run项中设置该计划任务的运行循环方式，其中包括 Once（只一次）、Hourly（每

小时）、Daily（每天）、Weekly（每周）、Monthly（每月）。在 Start at项中设置该计划任务的启动时间。界面中

的 Randomize within an hour复选框的含义是每小时随机运行一次。至此全部设置结束，单击 OK按钮确定退出，

你可看到设置的计划任务已经添加到程序界面中的列表框中了。 

VirusScan安装后，当Windows启动时自动加载McAfee VirusScan Schedule（计划任务管理器）。要保证计

划任务的运行，必须保证 VirusScan Scheduler处于运行状态。 

13.2.5  命令行病毒扫描 

当Windows系统染毒时，或当病毒发作时破坏了Windows时，在 DOS环境下进行病毒扫描清除工作似乎
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是唯一的办法。VirusScan提供了传统命令行防病毒工具 SCAN.exe。SCAN.exe既可以扫描病毒，也可以同时清

除病毒。用户可以用一张干净的系统盘启动计算机进入 DOS，然后运行 SCAN程序。 

SCAN 的命令行参数很多，最需记住的就是 /CLEAN 和/SUB这两个，/CLEAN 表示直接清除病毒，/SUB

表示包含子目录，例如 

SCAN D：/CLEAN  /SUB表示清除 D盘全部文件中的病毒。 

13.2.6  屏幕保护扫描病毒 

VirusScan 提供了当系统启动屏幕保护时自动后台扫描病毒的功能。在 Windows 桌面上单击鼠标右键，在

弹出的关联菜单中选择“属性”，Windows 弹出“显示 属性”对话框，可以看到其中多出了一项 McAfee 

ScreenScan，切换到该标签下，设置界面如图 13-35。 

 

图 13-35  设置屏保病毒扫描 

选中 Enable scanning while in screen saver mode复选框，激活该功能。可以在下面的列表框中选择扫描对象。

在What to scan项中，Include subfolder表示包含子目录，用户可以选择是否扫描压缩文件（Compressed files），

扫描所有文件（All files）还是指定程序文件（Program files only）。Resume scanning from where ScreenScan left off

表示从上一次屏保结束的地方继续扫描。 

单击 Advanced按钮可以设置扫描操作的优先级，以及是否为扫描操作建立日志。 

13.2.7  创建启动盘 

单击程序主界面上的菜单命令 Options → Tools → Emergency Disk，程序给出紧急启动盘制作向导

（Emergency Disk Wizard），用户按照向导的指示操作即可。 

13.3  KV300 

 

 

 

 

 

 

版本 Z.11 

类别 / 

主页 http://www.symantec.com/ 

功能 检测清除病毒 
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KV300是由北京江民新技术有限公司推出的老牌的杀毒软件，经过多年的发展，已由最早的 KV100、KV200

升级到目前最新的 KV300+。KV300是目前国内市场占有率最高的国产杀毒软件。 

13.3.1  KV300特点简介 

KV300杀毒功能比较先进，本身具有如下等特点： 

l 采用独特的开放式系统，用户可以自行扩充病毒特征代码库，可以使 KV300不断增加查杀新病毒的能

力。 

l KV300采用独特的病毒特征代码过滤器，很容易查出部分变种和变换自身代码的变形病毒，也能很容

易地查出宏病毒。 

l KV300 同时具备扩展开放式和封闭式的杀毒软件。扩展开放式是指 KV300 采用了开放式外部病毒光

谱特征库过滤法，或一般查毒软件采用的接口编程加载法查杀病毒。封闭式是指采用内部定位法查杀

病毒。用户可任选其一或分别使用，查病毒准确而广泛。 

l 在对抗病毒时，由“特征代码过滤法”、“步步跟踪法”、“逻辑判断法”和“逆转显影法”等几套不同

的查毒方法，使病毒难以逃脱。 

l KV300 可以备份硬盘的主引导纪录，能够直接查看硬盘物理扇区主引导和 BOOT引导扇区是否正常，

能测试、修复和重建硬盘分区表。 

13.3.2  KV300 的使用 

运行 kv300之前，首先将原盘插入软驱中，让系统从软驱启动进入 DOS后，执行 KV300.exe，启动后主程

序界面如图 13-36。 

 

图 13-36  KV300程序主界面 

下面对界面中的功能分别介绍如下： 

l F1：扩展病毒检测。使用 KV300 的外部开放式可扩展的病毒特征库（VIRUS.DAT）和扫描过滤法对

引导区和所有文件进行全代码扫描并搜索病毒。这种方法通常查毒的灵敏度和准确度较高，但速度较

慢。 

l F2：高速病毒检测。用 KV300的程序内部封闭的扫描方法，快速对引导区和所有文件中的病毒进行扫

描。这种方法速度较快。 

l F3：清除病毒。快速清查已知名的病毒 

l F4：扩展病毒清除。用 KV300 的外部开放式可扩展的病毒特征库（VIRUS.DAT）和扫描过滤法对引

导区和.COM、.EXE 文件进行全代码扫描并搜索病毒。灵敏度和准确度很高但速度稍慢，可以搜索网

络服务器。 

l F5：选择检测目录。对某已指定子目录下的文件进行扫描或清除病毒。 

l F6：察看硬盘分区信息。可察看不属于 DOS 管理的硬盘隐含扇区。察看硬盘零道零柱第一扇区主引

导纪录以及分区表，可以在硬盘隐含扇区内查找被移动的主引导记录和分区表。并可以按下 S键向软
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盘备份保存，以后需要时可以在 DOS环境中使用 KV300 /hdpt.dat命令恢复备份的主引导纪录。 

l F7：显示病毒名称及其基本性质。在应用该项功能之前要先启动中文环境。否则只能看到乱码。 

l F8：显示使用说明。在应用该功能之前也要先启动中文环境。 

l F9：显示版本号和简易说明。在应用该功能之前也要先启动中文环境。 

l F10：自动测试和快速修复硬盘分区表。常见的 CIH 病毒破坏硬盘分区表的情况采用此项功能修复的

成功率可达 99%。 

 

除了这些基本的操作外，KV300还提供了一些命令行参数，包括： 

l KV300 /B 

备份硬盘主引导信息。向软盘中备份一个无病毒的硬盘主引导信息档案，文件名称为 hdpt.dat。将该计算机

的型号、硬盘容量、分区大小等信息详细记录并保存，以便在硬盘主引导信息被病毒破坏或者主引导纪录损坏

硬盘不能启动时，可以恢复正确的主引导区。 

l KV300 /HDPT.DAT 

恢复正确的硬盘主引导信息。将备份在软盘上的硬盘主引导信息恢复到硬盘中。和备份硬盘主引导信息命

令结合使用可以解决大部分硬盘主引导信息损坏引起的计算机不能启动的问题。需要注意的是，必须使用该硬

盘以前的备份信息，不能使用其它硬盘的主引导信息备份，而且该硬盘没有改变分区。 

l KV300 /K 

清除引导区病毒。通过该命令，可以安全地清除所有引导区型病毒，并保存当前的主引导信息于软盘。 

l KV300 /VIRUS.DAT 

用外部的开放式可扩充病毒特征库检测病毒。VIRUS.DAT是 KV300的扩展病毒特征码数据文件，它是文

本文件，用任何文本编辑器打开后如图 13-37所示。 

 

图 13-37  查看 VIRUS.DAT文件 

从图 13-37中可以看出，每一行左面是某一个病毒的特征代码，右面是 KV300在发现该病毒后显示的报警

信息。用户只需使用一般的文本编辑工具，将一些计算机类的报纸或杂志上提供的病毒代码严格按照这种格式

添加到该文件中，即可使 KV300具有查杀该病毒的能力。 

13.3.3  使用注意事项 

使用 KV300时有几个需要注意的地方。使用 KV300前，应设置计算机用软驱启动，可以用KV300原盘启

动，不过为了减少原盘的磨损，建议先用无毒的系统盘启动后，用原盘查杀病毒。 

 

另外使用 KV300检查病毒时，为了安全起见，应该首先使用扫描功能。如果检查出引导区有病毒，在清除

病毒之前，应先对引导区进行备份，然后再使用杀毒功能。在清除文件中的病毒时，也应该先备份文件。 
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13.4  KILL 98 

 

 

 

 

 

 

 Kill98是世界第二大软件公司 CA公司和中国金辰公司的合作产品，是目前国内最权威的杀病毒软件

之一。该版本可在WIN95/98下安装和使用,具有实时监测及防火墙功能，可以实时地从正在下载的各种压缩文

件中查杀病毒(包括 CIH等运用 vxd技术的最新病毒)。KILL 98是真正的 32位Windows应用程序，程序提供了

非常丰富的运行环境设置和一个功能强大的在线病毒监测功能（病毒防火墙），是普通用户必备的杀病毒工具。 

新病毒随时可能出现，因此要不断地更新 KILL，方法是使用“更新”功能连接到 Cheyenne Software   web 

站点处下载最新的病毒特征文件。这样可以确保系统避免受到最新发现的病毒的侵害。 

13.4.1  扫描/清除病毒 

 启动程序，程序会自动扫描系统内存，如果没有发现病毒驻留，会给出程序主界面，如图 13-38。 

 

图 13-38  KILL 98主界面 

 在左边的系统文件结构列表框中选择需要扫描的对象，然后单击界面中的“开始扫描”按钮，程序

开始进行病毒扫描，并给出相应的进程对话框。 

 

图 13-39  显示扫描进度 

版本 5.0 

类别 / 

功能 查杀病毒 

主页 http://www. cheyenne.com/ 
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 如果未发现病毒，扫描会正常结束。当程序发现病毒存在时，会给出如下图 13-40所示对话框。 

 

图 13-40  清除病毒向导之一 

在对话框中程序给出修复建议。一般默认为“清除病毒”。如果用户想选择其他处理方式，可以选择“显示

所有选项”复选框，然后单击“下一步”按钮继续，程序给出如下图 13-41 所示的对话框。其中包括程序可以

采取的各项措施，一般应选择“清除”。如果选中“对该类型的所有感染文件采取这一操作”复选框，程序每次

发现同种病毒时不再提问。 

 单击“下一步”，程序给出如下图 13-42 所示的对话框，通知用户将清除染毒文件中的病毒，如果

不想清除该文件中的病毒（防止清除操作破坏文件），可以单击“跳过文件”，否则单击对话框中的“完成”按

钮确定。程序继续进行病毒扫描。为方便操作，用户可选择“不再显示该页面”复选框。 

 

图 13-41  清除病毒向导之二 
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图 13-42  清除病毒向导之三 

 

 程序扫描结束，给出结果对话框。单击完成回到程序主界面。 

 

 

 

图 13-43  显示扫描结果 

 

13.4.2  在线病毒监测功能 

KILL 98安装后，会自动设置当系统启动时加载实时监测器。用户也可以自行设置是否加载该程序。方法

如下： 

单击程序界面工具栏中的“选项”按钮，程序给出运行环境设置界面，切换到“实时监测器”标签项，如

图 13-44所示，选中或取消“在系统启动时初始化实时监测器”复选框即可。 
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图 13-44  设置“实时监测器” 

如果取消了实时监测器的自动加载，用户可以随时从开始菜单中 KILL程序组中运行“实时监测器”程序。

启动实时监测器后，程序会在系统任务栏中显示一个 Tray图标，如图 13-45所示，表示实时监测器已经启动。 

 

图 13-45  KILL 98的 Tray图标 

双击该图标，程序会给出当前的检测结果对话框，从中可以了解到监测历史纪录。单击该对话框中的“确

定”按钮，可关闭监测器窗口，并将其切换到系统后台运行模式。 

当用户在运行程序、进行文件操作或从网络中下载文件时，实时监测器会密切监视每一个文件，KILL 98

支持监视扫描压缩包文件。当发现病毒时，程序会立即中止用户操作，并弹出对话框，如图 13-46 所示。随后

的操作前面已有叙述。 

 

图 13-46  清除病毒向导 
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13.4.3  计划任务功能 

 在程序界面的系统文件结构列表中选择计划任务需要扫描的对象，例如 C盘。单击程序界面按钮条
中的“预定”按钮，程序给出如图 13-47所示的设置对话框。 

 

图 13-47  预定扫描对话框 

 单击对话框中的“新建”按钮，程序给出如图 13-48所示的设置界面。其中给出了我们需要的扫描
对象列表。 

 单击“下一步”按钮，在关联的对话框中设置本计划任务的激活时间，以及运行周期设置，如图
13-49所示。 

 程序给出如图 13-50所示的对话框，其中提供了三个与扫描有关的选项设置。在此我们选择使用“现
在指定自定义选项”复选框，单击“下一步”按钮继续。 

 

图 13-48  预定任务向导之一 

 

图 13-49  预定任务向导之二 
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图 13-50  预定任务向导之二 

 程序给出“安排扫描选项”设置界面，在其中的不同标签项中选择你需要使用的项目，由于全部是

中文界面，具体含义不再复述。其中重要的设置项目是“扫描”、“清除”标签项，其中包括了扫描方式、扫描

目标、发现病毒时程序可提供的操作等。 

 

图 13-51  安排扫描选项设置 

 单击“确定”按钮，回到主设置界面，程序给出设置项目列表，单击界面中的“完成”按钮，新计

划任务创建结束。程序给出“预定扫描”对话框，其中提供所有的计划任务列表，在其中你可进行扫毒计划任

务的编辑、删除等操作。如果觉得没有问题，单击“关闭”按钮退出。 

13.4.4  命令行病毒检测 

当Windows系统染毒时，或当病毒发作时破坏了Windows时，用户可以在 DOS环境下利用 KILL 98查杀

病毒。用户可以用一张干净的系统盘启动计算机进入 DOS，然后进入 KILL 98目录，运行该目录下的 Killcmd.exe

程序。 

命令行 Killcmd C：/CUR表示扫描 C：盘并清除病毒。 

13.4.5  制作系统急救盘 

 单击程序界面按钮条中的“急救”按钮，程序给出如图 13-52所示的对话框。选择“创建一个新的

急救盘”。 
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 单击“下一步”按钮继续，程序提示插入一张新的软盘，然后单击界面中的“完成”按钮确定。 

 程序给出格式化软盘确认对话框，在此建议选择“完全格式化”复选框，虽然这样的时间会长一些，

但是可以保证软盘中没有损坏区域，也可以保证急救盘的数据安全。 

 程序给出操作进程对话框，并开始急救盘的制作，完成之后，会给出创建成功对话框，单击“确定”

按钮退出。 

 

图 13-52  制作系统急救盘向导之一 

13.5  PC-cillin 2000 

 

 

 

 

 

 

 PC-cillin 2000是由趋势科技公司推出的著名的杀毒工具。它提供了包括智慧型病毒陷阱、先知扫描专

家分析系统、已知和未知宏病毒克星Macro Trap在内的多项专利技术，能随时不断地监控所有潜在的病毒来源，

尤其是潜伏在 Internet 上的病毒来源，在病毒入侵系统之前阻拦所有已知及未知病毒，甚至是未知宏病毒，达

到全面保护电脑免受病毒侵扰的目的。 

PC-cillin 2000作为 PC-cillin系列的最新版本，新增以下特点： 

l 支持Windows 2000。 

l 支持 POP3电子邮件的病毒检测。 

l 支持对各种驱动器进行病毒检测，包括 CD-ROM, CD-R, CD-RW, PD, FDD, DVD,  ZIP and LS120等。. 

l 程序的 DOS下的命令行检测支持大于 1.44Mb的病毒库文件。 

l 在程序安装完成之后，会自动启动 PC-cillin病毒监控器，程序也会在系统任务条中给出一个蓝色的Tray

图标，如图 13-53。使用右键单击该图标，从关联菜单中选择 Open PC-cillin 也可快速启动程序。 

 

图 13-53  PC-cillin病毒监控器 

13.5.1  检测/清除病毒 

启动 PC-cillin 98，程序提供了两种查毒方式：向导方式和任务方式，下面我们分别进行介绍。 

版本 7.51 

类别 / 

功能 查杀病毒 

主页 http://www. antivirus.com/ 
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1．向导方式 

 单击程序主界面左边 Scan标签下的 Scan Wizard按钮，出现向导界面如图 13-54所示，可以从中选

择扫描对象。其中 Drives/directories表示检测驱动器/文件夹，Individual file表示检测单个或多个文件，All macro 

documents表示检测所有带宏的文档，Foppy boot sector表示检测软盘引导扇区、Internet related files表示检测与

Internet相关的文件。 

 

图 13-54  病毒扫描向导之一 

 单击 Next，程序给出如图 13-55所示向导界面。 

 

图 13-55  病毒扫描向导之二 

其中 Scan options项中设置扫描对象，All files types表示扫描所有文件，Include boot sector表示扫描系统引

导扇区，Selected files表示扫描选定文件类型，单击 Selected File Types按钮可以设置程序可以扫描的文件类型。

在Action when virus found项中可以设置当程序发现病毒时采取的动作。Clean表示清除病毒，Back up files before 

cleaning表示清除病毒前备份文件。Quarantine（免疫）表示将暂时无法确定是否含毒或程序无法杀毒的文件移

动到一个专门的目录中。Delete删除病毒。Rename表示给文件换名。Pass指程序不进行任何处理，跳过该文件。

Rename表示给文件重命名。在 Action on uncleanable files项中可以设置当程序无法清除文件中的病毒时，程序

采取的动作。 

 单击 Next，程序给出如图 13-56所示向导界面。在图中的列表框中选择需要扫描的文件/文件夹。 
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图 13-56  病毒扫描向导之三 

 单击界面右边的 Scan按钮，程序开始扫描，并给出操作进度，如图 13-57。 

 

图 13-57  显示病毒扫描进度 

2．任务方式 

单击界面左边 Scan标签下的 Scan Manager按钮，或单击菜单命令 File → Scan → Scan Manager，切换成

手动方式，程序界面如图 13-58。 

 

图 13-58  扫描任务管理界面 
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在界面的列表框中列出了很多程序预先提供的任务，用户可以直接选择某一任务，单击工具栏中的 Run按

钮执行扫描操作，也可以根据自己的需要建立一个新任务。以下为操作步骤： 

 单击界面中的 New Task按钮，程序给出对话框如图 13-59。在 Task Name文本框中新任务的名称。

在 Select what to scan项中设置扫描对象，其中 Scan all drivers表示检测所有驱动器，Scan selected drive表示检

测选定驱动器，Scan selected files/folders表示检测选定的文件/文件夹。 

 
图 13-59  设置扫描对象 

 单击“下一步”，程序给出检测设置对话框。其中 Files to scan项中设置检测对象。在 Action when virus 

found项中可以设置当程序发现病毒时采取的动作。在 Action on uncleanable files项中可以设置当程序无法清除

文件中的病毒时，程序采取的动作。 

 

图 13-60  设置扫描选项 

 单击“下一步”，程序给出计划任务对话框。在其中可以设置计划任务的时间、频率等参数。如果

想立即执行该任务，选中 Yes复选框，单击“完成”，程序开始检测病毒。 
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图 13-61  计划任务对话框 

用户也可以利用工具栏中的按钮对列表框中的任务进行编辑、复制、粘贴和删除等操作。 

13.5.2  实时监测病毒 

实时病毒监控就是所谓的病毒防火墙，程序通过在线监测机器 I/O 访问，来试图发现病毒入侵，这是预防

已知病毒入侵系统的最好方法。 

PC-cillin在系统安装之后会随系统启动自动运行，并会在系统任务栏中添加一个 Tray图标。我们也可以对

程序的实时检测功能进行设置，选择菜单命令 Options → Real-time Scan → Scan Options，程序给出设置界面

如图 13-62。其中 Enable real-time scanning表示实时检测功能。在 Files to scan项中设置扫描文件，All files表

示检测所有文件，Selected files表示检测选定文件，单击右边的“Select File Types...”按钮可以设置扫描文件类

型。在 Action when virus found项中可以设置当程序发现病毒时采取的动作。在 Action on uncleanable files项中

可以设置当程序无法清除文件中的病毒时程序采取的动作，这里选择 Clean。用户可以根据自己的需要选择合

适的设置，然后单击 Apply按钮，以上设置生效。 

 
图 13-62  病毒防火墙设置界面 

单击菜单 Options → Real-time Scan → Scan Exceptions，程序给出设置界面如图 13-63所示。用户可以在

其中设置不检测的文件或文件夹。 

 

 

 

 



常用工具软件大全 

 

339 

 

 

 

 
 

图 13-63  设置不检测的文件/文件夹 

 

设置完毕，当用户在进行文件操作时，如果实时检测程序发现文件中含有病毒，会按照用户设定的动作对

该文件进行操作，例如上面我们选择的是 Clean操作，则当程序发现病毒时，会给出如图 13-64所示对话框。 

 

 

 

 

图 13-64  发现病毒对话框 

 

13.5.3  命令行病毒检测 

当Windows系统染毒时，或当病毒发作时破坏了Windows时，用户可以在 DOS环境下利用 PC-cillin 2000

查杀病毒。用户可以用一张干净的系统盘启动计算机进入 DOS，然后进入 PC-cillin 2000目录，运行该目录下

的 PCScan程序。 

命令行 PCScan /C /V表示扫描所有驱动器并清除病毒。 

13.5.4  制作系统急救盘 

从系统开始菜单“Trend PC-cillin 2000”程序组中启动“Create rescue disk”程序，程序给出紧急启动盘制

作向导，如图 13-65。用户按照向导的指示一步步操作即可。 
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图 13-65  急救盘制作向导 
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